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Thank you for purchasing the FX1000 (hereafter referred to as “FX”).
This User’s Manual explains how to use the FX. To ensure correct use, please read this 
manual thoroughly before operation.
The following manuals are provided for the FX:

• Paper Manual
Manual Title Manual No. Description
FX1000  

Safety Precautions and Installation Guide
IM 04L21B01-03EN

This guide is printed on A3-size paper and explains how 

to install and wire the FX
How to Use the CD 

Installing FXA120 DAQSTANDARD and 

Opening FX1000 Manuals

IM 04L21B01-66EN

This guide is printed on A4-size paper and describes how 

to install DAQSTANDARD, how to open the electronic 

manuals, and the mode menu map of the FX.

• Electronic Manuals Provided on the Accompanying CD-ROM
 FX1000

Manual Title Manual No. Description
FX1000

First Step Guide
IM 04L21B01-02EN Explains the basic operations of the FX.

FX1000

User’s Manual IM 04L21B01-01EN

This manual. Describes how to use the FX. The 

communication and network functions, custom display 

functions, and some of the options are excluded.
FX1000

Communication Interface  

(/C2, /C3, and /C7)

IM 04L21B01-17EN
Describes how to use communication functions through 

an Ethernet or serial interface.

FX1000

Safety Precautions and Installation Guide
IM 04L21B01-03EN This is the same as the printed copy.

 DAQSTANDARD for FX1000
Manual Title Manual No. Description
FXA120 

DAQSTANDARD for FX1000

Data Viewer

IM 04L21B01-63EN Describes how to use the DAQSTANDARD viewer.

FXA120

DAQSTANDARD for FX1000

Hardware Configurator

IM 04L21B01-64EN
Describes how to use the DAQSTANDARD hardware 

configurator.

How to Use the CD

Installing FXA120 DAQSTANDARD and 

Opening FX1000 Manuals

IM 04L21B01-66EN This is the same as the printed copy.

Notes
• The contents of this manual are subject to change without prior notice as a result of 

continuing improvements to the instrument’s performance and functions.
• Every effort has been made in the preparation of this manual to ensure the accuracy 

of its contents. However, should you have any questions or find any errors, please 
contact your nearest YOKOGAWA dealer.

• Copying or reproducing all or any part of the contents of this manual without 
YOKOGAWA’s permission is strictly prohibited.

• The TCP/IP software of this product and the document concerning the TCP/IP 
software have been developed/created by YOKOGAWA based on the BSD Networking 
Software, Release 1 that has been licensed from the Regents of the University of 
California.

 

3rd Edition: January 2013 (YK)
All Right Reserved, Copyright © 2011, Yokogawa Electric Corporation
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Trademarks
• vigilantplant is a registered trademark of Yokogawa Electric Corporation.
• Microsoft and Windows are registered trademarks or trademarks of Microsoft 

Corporation in the United States and/or other countries.
• Adobe and Acrobat are registered trademarks or trademarks of Adobe Systems 

Incorporated.
• Company and product names that appear in this manual are registered trademarks or 

trademarks of their respective holders.
• The company and product names used in this manual are not accompanied by the 

registered trademark or trademark symbols (® and ™).

Revision History
1st Edition:  November, 2011
2nd Edition: September, 2012
3rd Edition: January, 2013

Revision Product Added or Changed Features
1 Firmware version 1.00 New edition
2 Firmware version 1.1x Italian, Spanish, Portuguese, Russian, and Korean 

have been added to the available display languages. 
Log input option has been added. Improvements to 
descriptions.

3 Ditto Revised for DAQSTANDARD 9.03 Release
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How to Use This Manual

Structure of the Manual
Before reading this manual, familiarize yourself with the basic operations of this 
instrument by reading the First Step Guide. For a description of the communication 
function and the accompanying software program, DAQSTANDARD for FX1000, read 
the respective manual.
This user’s manual consists of the following sections.

Chapter Title and Contents
1 Overview of Functions

Explains the features of the FX.
2 Common Operations

Describes the procedure to set the time and the operating procedure using the 
keyboard (/USB1 option).

3 Measurement Channels and Alarms
Describes how to set the measurement conditions and alarms.

4 Switching Operation Screens
Describes the operations on the operation screen.

5 Operations for Changing the Displayed Contents
Describes how to change the displayed contents on the operation screen and how 
to write messages.

6 Saving and Loading Data
Describes how to acquire and store data. Also describes the procedure to load 
measured data/setup data on the CF card or the USB flash memory (/USB1 
option).

7 Customizing Actions Using the Event Action and Remote Control Functions 
(/R1 and /PM1 Options)
Describes how to carry out specific actions when a given event occurs, when a 
remote control signal is applied, and when the USER key is pressed.

8 Using the Security Function
Describes how to use the key lock function and the function that allows only 
registered users to operate the FX.

9 Computation and Report Functions (/M1, /PM1, and /PWR1 options)
Describes how to use computation channels and how to create reports such as 
hourly, daily, weekly, and monthly reports.

10 Troubleshooting
Describes error messages and troubleshooting.

11 Maintenance
Explains how to inspect and calibrate the FX.

12 Installation and Wiring
Contains information about where to install the FX, how to install the FX, and how 
to wire the FX.

13 Specifications
Contains the specifications of the FX.

14 Setup Items
Contains the FX setting mode menu map, basic setting mode menu map, and 
setup items

Appendix Describes how to estimate the file size, the types of data that the FX can 
generated and how to use them, the data format of text files, etc.

Index

Note
• This user’s manual covers information regarding FX1000s that have a suffix code for 

language “-2” (English).
• For details on setting the display language, see section 2.6, “Changing the Displayed 

Language.”
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Conventions Used in This Manual

  

 

Unit 
     Denotes 1024.  Example: 768 KB (file size) 
    Denotes 1000. 
 
Markings 

WARNING 

Procedure 

Setup Screen 

Setup Items 

Explanation 

CAUTION 

Improper handling or use can lead to injury to the user or 
damage to the instrument.  This symbol appears on the 
instrument to indicate that the user must refer to the user’s 
manual for special instructions.  The same symbol appears in 
the corresponding place in the user’s manual to identify those 
instructions.  In the manual, the symbol is used in conjunction 
with the word “WARNING” or “CAUTION.”

Calls attention to actions or conditions that could cause serious 
or fatal injury to the user, and precautions that can be taken to 
prevent such occurrences.

Calls attentions to actions or conditions that could cause light 
injury to the user or damage to the instrument or user’s data, and 
precautions that can be taken to prevent such occurrences.

Calls attention to information that is important for proper 
operation of the instrument.

 

 

 

Note 

Indicates character types that can be used. 
 
 
 
Carry out the procedure according to the step numbers.   
All procedures are written with inexperienced users in mind;   
depending on the operation, not all steps need to be taken. 
Explanation gives information such as limitations related the  
procedure. 
 
Indicates the setup screen and explains the settings.  A  
detailed description of the function is not provided in this  
section.  For details on the function, see chapter 1. 

Subheadings 

A a # 1 
A  a  #  

1 

Uppercase alphabet, lowercase alphabet, symbols,   
numbers. 
 

 

Bold characters Denotes key or character strings that appear on the screen.
Example: Volt

K 
k 

How to Use This Manual 
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1.1 Input Section

Measurement Channel
• Number of Measurement Channels and Scan Interval
  The FX acquires data by sampling measurement channel input signals at the set scan 

interval. The table below shows the relationship between the number of measurement 
channels and the scan interval

Model
Number of Measurement 

Channels
Scan Interval A/D Converter 

Integration Time
FX1002 2

125ms, 250ms AUTO1/50Hz/60HzFX1004 4
FX1006 6

1s, 2s, 5s
AUTO1/50Hz/60Hz/

100ms2
FX1008 8
FX1010 10
FX1012 12

1 AUTO:  The FX automatically switches between 50 Hz and 60 Hz depending on the power 
supply frequency.

2 You can only set the integration time to 100 ms on models FX1006 through FX1012.
  If you set the integration time to 100 ms, you can only set the scan interval to 2 seconds or 

5 seconds.
 For the setting procedure, see section 3.1.

• Integration Time of the A/D Converter
 The FX uses an A/D converter to convert sampled analog signals to digital signals. 

By setting the integration time of the A/D converter to match the time period 
corresponding to one cycle of the power supply or an integer multiple of one cycle, the 
power supply frequency noise can be effectively eliminated.
• Because 100 ms is an integer multiple of 16.7 ms and 20 ms, this setting can be used to 

eliminate the power frequency noise for both frequencies, 50 Hz and 60 Hz.
 For the setting procedure, see section 3.1.

Input Type and Computation
You can make measurements using the following input types.

Input Type Description
DC voltage You can measure DC voltages in the range of ±20 mV to ±50 V.

DC current
You can measure a DC current signal by converting it to a voltage signal using a shunt1 
resistor attached to the input terminal. The converted signal can be measured within the DC 
voltage range (see above).

Thermocouple
You can measure temperatures corresponding to these thermocouple types: R, S, B, K, E, J, 
T, N, W, L, U, and WRe3-25. It is also possible to measure using other thermocouples, such 
as PR40-20 and PLATINEL.2

RTD
You can measure temperatures using RTD types Pt100 and JPt100.
It is also possible to measure using other RTD types such as Pt50 and Ni100.2

ON/OFF input

You can display contact input or voltage input signals correlated to 0% or 100% of the 
display range.
Contact input: A closed contact is on (1). An open contact is off (0).
Voltage input: Less than 2.4 V is off (0). 2.4 V or more is on (1).

Pulse input3 You can count pulses. Use the dedicated input terminal.

AC voltage and current4 You can measure the power and electric energy. Use the dedicated input terminal.

Logarithmic DC voltage5 Use the Log scale to display and record the physical quantity.

1 Item sold separately. For example, you can use a 250 Ω shunt resistor to convert a 4 to 
 20 mA signal to a 1 to 5 V signal.
2 /N3F option
3 /PM1 option
4 /PWR1 option
5 /LG1 option

Chapter 1 Overview of Functions
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The following input processing and computation are available.

DC Voltage

DC current

Shunt resistor

1 - 5 V
Burnout detection

Burnout detection

RJC

Square root computation

√

Thermocouple

RTD

ON/OFF input

Convert to number of pulses over 1 second

Moving average Linear 
scaling

Calibration 
correction 

(/CC1 option)

Difference 
computation

Low cut Measured 
value

Dotted lines indicate that the function can be selected.

Pulse input
(/PM1 option)

Logarithmic 
DC voltage
(/LG1 option)

AC voltage and 
current
(/PWR1 option) (for LogType1)

Measured  
value 

Moving Average 

External reference junction 

Internal  
reference  
junction 

Performs reference junction compensation on  
the thermocouple. 

Reference Junction Compensation Burnout Detection 
Detects and indicates a burnout in the sensor. 

1 - 5 V 
Detected on the  
1-5 V value. 

Burnout 

For the setting procedure, see section 3.2. For the setting procedure, see section 3.2. 

For the setting procedure, see section 3.4. 

Burnout 

Indicated as  
Burnout. 

Indicated as  
Burnout. 

Thermoelectromotive  
force 

1 
2 
3 

10.0 mV 
5.0 mV 
0.0 mV 

 
5.0 mV 

15.0 mV 
10.0 mV 
5.0 mV 

 
10.0 mV 

10.0 mV 
15.0 mV 
10.0 mV 

 
11.7 mV 

Clear 

nth time n + 1th time n + 2th time 

Clear 
(Moving average) 

New sampled  
data 

New sampled  
data 

Operation example when the number  
of moving average data points is 3 

Number of moving  
average data points: 2 to 400 Sampling data  

in the buffer 

Sampling 

Eliminates noise. 

FX

Thermocouple 

Thermocouple 

1.1  Input Section
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Difference computation

Square Root Computation

Calibration Correction (/CC1 Option)

Input 
value

Input 
value

Input 
value

Input 
value DC voltage

Single-phase 
two-wire system

Single-phase 
three-wire system

Three-phase 
three-wire system

Electric power
Electric energy

Measured value on the reference channel

–

The measured value of the channel is set to the 
difference with respect to the measured value of the 
reference channel

Low-cut

Converts the unit to obtain the measured value.Takes the square root of the input value and converts 
the unit to obtain the measured value.

Counts the pulses. Use the computation channels 
(/M1, /PM1, and /PWR1 options).

You can apply a logarithmic voltage that has been 
converted from a physical value to the FX, and then use 
the FX’s Log scale (logarithmic scale) to display and 
record the physical value.

Measure the measurement elements of electrical power. 
Use the computation channels (/M1, /PM1, and /PWR1 
options).

Pulse Input (/PM1 Option)

Logarithmic DC Voltage (/LG1 option)AC Voltage and Current (/PWR1 option)

Linear Scaling

10 V

0 V

300 °c

–100 °c
a

b

x

a b

B

B

X

A

A
X = (B – A) + A

x – a

b – a

Pulse that can be counted FX input

Counted on the FX

For the setting procedure, see section 3.3. For the setting procedure, see section 3.3.

For the setting procedure, see section 3.3.

For the setting procedure, see section 3.12. For the setting procedure, see section 3.13.

VT ratio
CT ratio

Low-cut power

Input 
value

AC (45 to 65 Hz)
Voltage and current

Measured 
value

Input 
value

Corrects the input value with the characteristics 
specified by segments to obtain the measured value.

Number of break 
points: Up to 16

Measured 
value

Output 
value

For the setting procedure, see section 3.9.

(               )

Measured 
value

Input 
value

For square root computation, measured values below 
the specified value are cut.
For 1-5 V input, values below 0 % are cut.

Result of square root
computation

Low-cut value

For the setting procedure, see section 3.3.

Measured 
value

Measured 
value

5 ms or more

100 Hz or less
Pulse

Contact

or

Open 
collector

FX

The contact changes from open to close.

The signal level at the input terminal changes from high 
to low.

For the setting procedure, see section 3.10.

Measured 
value

Measured 
value

1.1  Input Section
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Note
Difference computation is executed even if the input type or range is not the same between 
the difference computation channel and the reference channel. The difference is computed 
discarding the decimal place and unit, and the decimal place and unit of the difference 
computation channel are applied.

 Example 1: If the input value of the difference computation channel is 10.00 and the measured 
value of the reference channel is 100.0, the computed result is  
10.00 – 100.0 = –90.00.

 Example 2: If the input value of the difference computation channel is 10.00 V and the 
measured value of the reference channel is 5.00 mV, the computed result is  
10.00 V – 5.00 mV = 5.00 V.

1.1  Input Section



1-5IM 04L21B01-01EN

O
verview

 of Functions

3

2

1

4

5

6

7

8

9

10

11

12

13

14

App

Index

1.2 Alarms

This function generates an alarm when the measured data meets a certain condition. Up 
to four alarms can be set for each channel.

Alarm Type
You can use the alarms shown below. The character inside the parentheses is the 
symbol denoting each alarm.
For the alarm setting procedure, see section 3.7.

High Limit Alarm (H) 

Alarm value 

Alarm output ON Alarm output ON 

Alarm output ON Alarm output ON 

Alarm value 

Hysteresis Measured value Measured value Hysteresis 
Low Limit Alarm (L) 

Alarm output ON Alarm output ON 

Delay time Delay time 

Alarm value Alarm value 
Measured value Measured value 

Delay High Limit Alarm (T) Delay Low Limit Alarm (t) 

High Limit on Rate-of-Change Alarm (R) Low Limit on Rate-of-Change Alarm (r)

Alarm value 
Alarm value 

Hysteresis Hysteresis 
Difference in the measured values of two channels Difference in the measured values of two channels 

Difference High Limit Alarm (h) Difference Low Limit Alarm (l)

Change in the  
measured value 

Change in the measured value 

Measured value Measured value 

Time Time 
Interval (t2-t1) Interval (t2-t1) 

Amount of change in  
the setting 
| | 

T2 

T1 

t1 t2 

T2 

T1 

t1 t2 

 T2-T1 
Amount of change in  
the setting 

|  T2-T1 

• Alarm Hysteresis
 You can set a width (hysteresis) to the value used to activate and release alarms.
 For the setting procedure, see section 3.5.

• Delay High Limit Alarm and Delay Low Limit Alarm
 An alarm occurs when the measured value remains above or below the alarm value 

for a specified time period (delay time).

•  High Limit on Rate-of-Change Alarm and Low Limit on Rate-of-Change 
Alarm

 The rate-of-change of the measured values is checked over a certain time (interval). 
An alarm occurs if the rate-of-change of the measured value in the rising/falling 
direction is greater than or equal to the specified value.

 The alarm value of the rate-of-change alarm is set using an absolute value. The 
interval is derived using the following equation and set using the number of samples.

  Interval = the scan interval × the number of samples
 For the setting procedure, see section 3.5.

• Difference High Limit  Alarm and Difference Low Limit Alarm
 An alarm occurs when the difference in the measured values of two channels is 

greater/less than or equal to the specified value. These alarms can be specified on 
measurement channels set to difference computation.
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Alarm Indication
The alarm conditions are displayed as alarm icons in the status display section and on 
the operation screen such as the trend, digital, bar graph, overview displays. Detailed 
information about the alarms is displayed in the alarm summary.

• Hold/Non-hold of Indications
The alarm indication can be set to operate in the following fashion when the condition 
is no longer met.
• Clear the alarm indication (non-hold).
• Hold the alarm indication until the alarm ACK operation is executed (hold).
The default setting is non-hold.

 For the setting procedure, see section 3.5.

• Alarm Hide Function
 No indication is made when an alarm occurs. The alarm is also not recorded in the 

alarm summary. However, the FX will output alarm information to the relay (/A[ ] and 
/A4A options) or internal switch. This function can be set for each channel and each 
alarm.

 For the setting procedure, see section 3.6.

1.2  Alarms
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Alarm Output Relay Operation
The FX can generate a contact signal from an alarm output relay (/A[ ] and /A4A options) 
when an alarm occurs. The alarm output relay operation can be changed.
For the setting procedure, see section 3.5.

Alarm

Alarm output relay
(Reflash on)

Alarm output relay
(Reflash off)

Channel 1

Channel 3
Channel 2

Energize or De-energize

AND/OR

Alarm
Channel 1

AND

Channel 2

OR

Alarm output relay
or
internal switch

NO
Energize

De-energize

C NC NO C NC NO C NC

NO C NC NO C NCNO C NC

When power
is shut down

NO: Normally Opened
C: Common
NC: Normally Closed

Normal
operation

When an alarm
is occurring

Alarm

Normal

Alarm

Normal

Reflash

(You can set AND/OR for the alarm output relay and internal
switch. For details about the internal switch, see the next 
page.)

(when a relay is set to OR logic)
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R
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ay
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Occurrence

Activated

Deactivated

Activated

Deactivated

Activated

Deactivated

Release

or

Activated

Deactivated

or
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H
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ay
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N

on
-h
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Non-hold/Hold

Relay is activated
at the next scan
interval.

Relay is activated
when the next
alarm occurs.

Alarm ACKAlarm ACK

500 ms

• Reflash
 When multiple alarms are assigned to one alarm output relay, this function notifies the 

occurrence of subsequent alarms after the relay is activated by the first alarm. When 
subsequent alarms occur, the output relay is released temporarily. The relays are 
deactivated for 500 ms.

 The reflash function is set on the first three output relays*.
* I01 to I03. I01 and I02 for the /A1 option.

Note
When reflash is enabled, the first three output relays are used exclusively as reflash relays. The 
first three output relays are set to OR logic and non-hold operation regardless of the AND/OR 
and non-hold/hold settings explained below.

• AND/OR
 When multiple alarms are assigned to one alarm output relay, the condition for 

activating the output relay can be selected from the following: You can select AND 
operation also for the internal switch.
• AND: Activated when all assigned alarms are occurring simultaneously.
• OR: Activated when any of the specified alarms is occurring.

1.2  Alarms
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• Energize or De-energize Operation
 You can select whether the alarm output relay is energized or de-energized when an 

alarm occurs. If you select de-energize, the alarm output relays will be in the same 
state when the power is shut off as they are when an alarm occurs. The setting applies 
to all alarm output relays.

• Non-Hold/Hold
 The alarm output relay can be set to operate in the following fashion when the alarm 

condition is no longer met.
• Turn OFF the relay output (non-hold).
• Hold the relay at ON until the alarm ACK operation is executed (hold).
The setting applies to all alarm output relays.

• Alarm ACK Operation
 The alarm acknowledge (alarm ACK) operation releases all alarm indications and 

relay outputs. For the action of alarm indication and alarm output relay when you 
carried out the alarm ACK operation, see the previous page.

Note
When you enter the basic setting mode, the hold/non-hold condition of the alarm output relay 
immediately before is retained. In the basic setting mode, alarms are not detected, and you 
cannot acknowledge alarms.

Internal Switch
The alarm status can be output to software switches (30 internal switches). The values of 
the internal switch are shown below. Like the alarm output relay, you can specify AND/
OR operation (see the previous page). The internal switches cannot be operated other 
than for alarm output.

  
Alarm

Alarm occurrence

Alarm release

Internal switch
1

0

The internal switches can be used events of the event action function (see section 1.6). 
Internal switches can also be written into computation channel (/M1, /PM1, and /PWR1 
options) equations.

1.2  Alarms
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1.3 Display

This section will explain the FX display.

Common Items Related to the Display
• 5.7-Inch Color LCD and Parts of the Display
 The FX has a 5.7-inch TFT color LCD (240 × 320 dot resolution). The screen consists 

of the status display section and the data display section.

   

Status display section

Data display section

 Status Display Section
 The status display section indicates the display name, date/time, batch name (when 

using the batch function), user name (when using the login function), internal memory 
and CF card (when the FX is equipped with a CF card slot) usage, alarm occurrence, 
computation status (/M1, /PM1, or /PWR1 option), key lock status, and e-mail 
transmission (/C7 option).

 Data Display Section
 The data display section shows the measured data using numeric values, waveforms, 

and bar graphs. It also shows the setup screen when setting functions.

• Group Display
 On the trend, digital, and bar graph displays, the data of channels is displayed by 

groups that are set in advance. Up to 10 groups can be registered, and up to six 
channels can be assigned to each group. Groups are common to the trend, digital, 
and bar graph displays.

 The displayed group can be switched automatically at a specified time interval (5 s to 
1 min).

 For the setting procedure, see section 5.1.

• Channel Number Display and Tag Display
 You can choose to label displayed channels according to their tags or according to 

their channel numbers. This setting applies to all channels.
 For the setting procedure, see section 5.2.

• Update Interval of Measured Values
 The values are updated every second. However, if the scan interval is greater than 1 s, 

the values are updated at the scan interval.
 For the setting procedure, see section 5.3.

• Alarm Indication
 Alarms that are set for each channel are checked at all times and are indicated with 

the symbol representing the alarm type on each display.
Alarm Type Symbol Alarm Type Symbol

High limit alarm H High limit on rate-of-change alarm R
Low limit alarm L Low limit on rate-of-change alarm r
Difference high limit alarm h Delay high limit alarm T
Difference low limit alarm I Delay low limit alarm t
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Status Display Section
The following information is displayed in the status display section during operation mode 
or setting mode.

Memory sampling status

CF card icon (on FXs that have a CF card slot)
Waiting.

Light blue icon: CF card in the slot is not 
recognized. Remove and reset it. 
CF card error.
Carry out the procedure below to reset the CF 
card icon to normal.
• Remove the CF card, and then reinsert it.
• Replace the CF card with a normal one.
• Use the FX to format the CF card (the CF 
 card data will be deleted).

The green level display indicates the amount of 
CF card used. If Media FIFO* is not enabled and 
the free space on the CF card falls below 10%, 
the level indicator changes to red.
* See section 1.4 in the FX1000 User’s Manual.

Memory sampling icon

Memory sampling
 stopped

Memory sampling
 in progress

Computation icon (/M1, /PM1, and /PWR1 options)

(Red)

(Green)

CF card is being accessed.

The status assigned to the status output 
(/F1 option) is occurring.

Keys are locked.

E-mail transmission (/C7 option) is enabled.

Status icon

Data type
DISP: Display data
EVENT: Event data

Memory sampling progress
Displays the progress using a green bar graph.  The frame indicates the file 
save interval (display data) or the data length (event data).

Error in internal memory. 
Contact your nearest YOKOGAWA dealer.

Displays the remaining memory sampling time for the left bar graph.

Date and time
Displayed in yellow while the time is being corrected.

Display name or group name
For all channel display on the trend display, “All” is 
displayed.

When using the batch function

If the “batch number-lot number” exceeds 20 characters, 
the “date and time” position is used to display the “batch 
number-lot number.”

Batch name and the display 
name are shown alternately. 
Date and time

Name of the user logged in

Batch name, the display 
name, and date and time are
shown alternately.

When using the login function

Name of the user logged in
When using the login and batch functions

Date and time and the 
display name are shown 
alternately.

Displayed when any alarm is activated.
Blinks when there are alarms that are 
occurring but have not been acknowledged.

All alarms have been released after they 
have occurred, but there are alarms that 
have not been acknowledged.

Alarm icon

White icon: Computation started

Yellow icon: Computation data dropout occurred

Red icon: Error in the power measurement 
section

Bar Graph
When event data recording is set to pretrigger, the FX will start recording pretrigger 
data after you press the START key. “Waiting” appears in the bar graph. At this time, 
the progress bar will turn orange. After the pretrigger time elapses, the length of the bar 
fixed at that point. However, the relevant data is updated until the trigger condition is met. 
When the trigger condition is met, the bar turns green, and data is recorded after the data 
in the pretrigger section.

1.3  Display
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Trend Display (T-Y)
Measured data is displayed in a waveform. For the operating procedure, see section 4.2.

Horizontal display
Display layout

Horizontal wide display

Trend interval

Current value mark

Scale

Color scale band

Alarm point mark

Current value indicated
by bar

Alarm mark
Alarm type

Tag or channel number,
measured value, unit, and specified alarm

1 division
(30 dots)

Trend Space function
Inserts a division-wide
space here.

Displays the maximum and minimum values 
sampled in the time corresponding to one dot.

Waveform (displayed with the set channel color)
To change channel colors, see section 5.5.
To change waveform line width, see section 5.10.
To display every channel’s waveform, see section 4.2.

See section 5.8

See section 5.7

See section 5.10

See section 4.2

Time at the grid position
Either displays the time,
or the date and time.

See sections 2.4 and 5.3

Grid
See section 5.10

See section 5.3

Trip line (up to four lines)
See section 5.1

See section 5.7

See section 5.8

Numeric display section
See section 4.2

Maximum value
Minimum value 1 dot

1.3  Display
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• Updating of the Waveform
 On the screen, 30 dots along the time axis is represented by a unit called division (see 

the figure on the previous page). The displayed waveform is updated at an interval 
corresponding to one dot. This interval is determined by the time corresponding to one 
division (referred to as the trend interval). The relationship between the trend interval 
and the speed of movement of waveforms on the screen is as follows:
Trend interval (/DIV) 15 s1 30 s 1 min 2 min 5 min
Time corresponding to one dot (in seconds) 0.5 1 2 4 10
Speed of waveform movement (approximation in mm/h) 2500 1250 625 312 156
Trend interval (/DIV) 10 min 15 min 20 min 30 min 1 h
Time corresponding to one dot (in seconds) 20 30 40 60 120
Speed of waveform movement (approximation in mm/h) 78 42 31 21 10
Trend interval (/DIV) 2 h 4 h 10 h
Time corresponding to one dot (in seconds) 240 480 1200
Speed of waveform movement (approximation in mm/h) 5.2 2.6 1.0
1 Selectable on the FX1002 and FX1004

 Switching the Trend Interval
 You can switch from the normal trend interval to the secondary trend interval during 

memory sampling and vice versa. For the operating procedure, see section 5.3.

• Writing Messages

   

Preset messages

Free message
Set the message when writing the message

1
2
3
4

Start
Material 1

Trend display

 Preset Messages
 Preset messages are recalled and written.
 The number of messages that you can use are 100 (message 1 to 10 are shared with 

free messages). For the operating procedure, see section 5.4.

 Free Messages
 Messages are entered when you need to enter them. The number of messages that 

you can use are 10. For the operating procedure, see section 5.4.

  Automatic Message Writing
• A message is written when the trend interval is switched during memory sampling. 

For the setting procedure, see section 5.3.
• A message is written when the power recovers from a power failure during memory 

sampling. For the setting procedure, see sections 5.3 and 5.15.

1.3  Display
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 Message display method
• Except for the vertical display, you can set the direction in which messages are 

displayed to horizontal or vertical. For the setting procedure, see section 5.10.
• Messages can be displayed consolidated at the upper left of the screen (list 

display). For the operating procedure, see section 4.2.

    

List display

Vertical display

• Zone Display
 You can display channels in specified zones. This function can be used to keep the 

waveforms from overlapping for easier view.
 In the example below, channel 1 is displayed in the 0 to 30% zone, channel 2 in the 

30 to 60% zone, and channel 3 in the 60 to 100% zone.

    

100%0%

Channel3Channel2Channel1

100%30%0% 60%
Zone 3Zone 2Zone 1

Enable the 
zone display.

 For the setting procedure, see section 5.6.

• Partial Expanded Display
 By compressing a section of the waveform display range, the rest of the section is 

expanded.
 In the example below, 0 V (boundary value) is moved to the 30% position of 

the display range (new boundary position). The 30% area below the boundary 
corresponds to “– 6 V to 0 V” and 70% area above the boundary corresponds to “0 V 
to 6 V.”

100100 30

0

50 

0 6V6V 

0

–6V–6V 

0 

Expanded portion
Compressed 

portion

Measured valueMeasured value 

Percentage 
of display span

Percentage 
of display span

Enable the partially 
expanded display.

 For the setting procedure, see section 5.9.

1.3  Display
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• Alarm Indication
 Alarm mark, alarm type, and measured value are displayed as follows according to 

the alarm status.

  

Alarm 
Release 

Red None Red None Red Red None None None None None 

Alarm ACK Alarm ACK 
Occurrence 

When indication is  
set to non-hold 

When indication is  
set to hold 

Alarm type 

Red Blue Red Blue Red Red Blue Blue Blue Blue Blue Measured  
value 

Blinking  
red 

Blinking  
green 

Blinking  
red 

Green Red Red Green Green Green Green Green Alarm mark 

Digital Display
Displays the measured data numerically using large numbers. For the operating 
procedure, see section 4.2.

   
Unit

Tag or channel number

Alarm mark

Measured value

Note
• Numeric display of measurement channels
 If a measured value of a measurement channel is over range (see below), the measured 

value is indicated as “+Over” or “–Over.” If a burnout is detected on a channel whose 
burnout detection function is enabled, the word “Burnout” is indicated. Otherwise, a numeric 
value is displayed.

 Over range of measurement channels
• For DC voltage input, over range occurs when the measured value of the measurement 

channel exceeds ±5% of the measurable range. For example, the measurable range 
when the measurement range is 2 V is –2.000 to 2.000 V. If the measured value exceeds 
2.200 V, + over range occurs; if the measured value falls below –2.200 V, – over range 
occurs.

• For thermocouple or RTD input, over range occurs when the measured value exceeds 
approximately ±10°C of the measurable range. For example, the measurable range 
when the measurement range is R is 0.0 to 1760.0°C. If the measured value exceeds 
approximately 1770.0°C, + over range occurs; if the measured value falls below 
approximately –10.0°C, – over range occurs.

• For channels that are linearly scaled, + over range occurs when the value exceeds 
30000 excluding the decimal point; – over range occurs when the value falls below  
–30000. However, + over range can be changed to greater than or equal to 105% of the 
scale width and – over range to less than or equal to –5% of the scale width within ±
30000. For the setting procedure, see section 3.11.

• Numeric display of computation channels
 See section 1.8, “Computation and Report Functions (/M1, /PM1, and /PWR1 options).”

1.3  Display
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• Alarm Indication
 The alarm mark and measured values are displayed in the following ways depending 

on the alarm status.

  

Alarm 
Release 

Alarm ACK Alarm ACK 
Occurrence 

When indication is  
set to non-hold 

When indication  
is set to hold 

Red Blue Red Blue Red Red Blue Blue Blue Blue Blue Measured  
value 

Blinking  
red 

Blinking  
green 

Blinking  
red 

Green Red Red Green Green Green Green Green Alarm mark 

Bar Graph Display
Waveform data is displayed in a bar graph. For the operating procedure, see section 4.2.

   

Horizontal

Vertical

Alarm point mark

Scale marks

Bar (displayed with
the set channel color)

Measured value

Unit of measurement
and lower limit

Upper limit

Tag or channel number
Alarm mark

The bar graph base position is set 
to Normal, Lower, or Upper.

Bar graph base position is set to
Center.

See section 5.7

See section 5.11

See section 5.10

See section 5.11

Bar graph base position is set to Center.
See section 5.11

See section 5.11

• Updating of the Bar Graph
 The bar graph is updated at the same interval as numeric values.

• Alarm Indication
 The alarm mark, alarm point mark,1 and measured values are displayed in the 

following ways, depending on the alarm status.

  

Alarm 
Release 

Red Green Red Green Red Red Green Green Green Green Green 

Alarm ACK Alarm ACK 
Occurrence 

When indication is  
set to non-hold 

When indication is  
set to hold 

Point mark1

Red Blue Red Blue Red Red Blue Blue Blue Blue Blue Measured  
value 

Blinking  
red 

Blinking  
green 

Blinking  
red Green Red Red Green Green Green Green Green Alarm mark 

1 Displayed when you are configuring alarms

1.3  Display
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Historical Trend Display
The waveform of the past measured data (display or event data) in the internal memory 
or external storage medium can be displayed. This function is called Historical trend.

• Methods of Displaying the Historical Trend
 There are four methods to display the historical trend of the measured data in the 

internal memory.
• Display from the alarm summary. For the operating procedure, see section 4.6.
• Display from the message summary. For the operating procedure, see section 4.7.
• Display from the memory summary. For the operating procedure, see section 4.8.
• Recall from the display selection menu. For the operating procedure, see section 4.3.

 Measured data on an external storage medium can also be displayed as historical 
trend. For the operating procedure, see section 6.8.

• Displayed Contents

   

Cursor

Historical trend

Present trend

Message

Waveform (channel display color)Background color
(changeable)

Location of the most
recent data

Date and time at the lower end of the time 
axis

Half screen display

Trip line

Date and time at the upper end of the time
axis, or the time at the cursor location
The time at the cursor location is
surrounded by a yellow square.

Unit

Tag or channel number 
(channel display color)

1 You can also display only the digital value of the cursor position 
 (the maximum value at the cursor position).

Measured values (maximum and
minimum values for the entire display)1

Measured values (maximum and
minimum values at the cursor position)1

Item Description 
Alarm summary Displays an alarm summary of the displayed data.
Message summary Displays a message summary of the displayed data.
Memory information   Displays the properties (such as the file name, start time, and end time) 

of the displayed data. 

• Added Messages
Added messages can be written. For the operating procedure, see section 5.4.

1.3  Display
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Overview Display
Displays a list of the statuses of all channels.
You can move the cursor to select a channel and display the trend, digital, or bar graph 
of the group containing the selected channel.
For the operating procedure, see section 4.4.

   

Measured value and unit

Cursor

Tag or channel number

Alarm type

Channels on which an alarm is  
occurring are indicated in red 

• Alarm Indication
 The channel display area, channel number or tag name, alarm type, and measured 

value are displayed in the following ways, depending on the alarm status.

  

Alarm 
Release 

Blinking  
white 

Blinking  
black 

Blinking  
white 

Black White White Black Black Black Black Black 

Alarm ACK Alarm ACK 
Occurrence 

When indication is  
set to non-hold 

When indication is  
set to hold 

Tag/Channel  

White None White None White White None None None None None Alarm type 

White Black White Black White White Black Black Black Black Black Measured  
value 

Red Green Red Green Red Red Green Green Green Green Green Channel  
area 

Alarm Summary
Displays a list of the most recent alarms.
• Up to 1000 alarms can be displayed.
• You can select arbitrary alarm information and recall the historical trend of the display 

data or event data that contains the alarm information.
For the setting procedure, see section 4.6.

  

To the historical trend display

The number of the alarm information entry displayed on the screen’s bottom line and the 
number of alarm information entries in internal memory

Number or tag of the channel on which the alarm occurred
Alarm level number (1, 2, 3, or 4) and type (H, L, h, l, R, r, T, or t)

Date and time of alarm occurrence/release

Cursor (selects an alarm)

: Alarm occurrence  
(     blinks until the AlarmACK operation is carried out if Indicator is set to Hold.)
: Alarm release
: Alarm output release (when blinking is cleared through the AlarmACK operation)

1.3  Display
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Message Summary
Displays a list of written messages and the time the messages were written.
• Up to 450 messages can be displayed.
• Up to 50 messages that are added to the past data section (added messages) can be 

displayed.
• You can select arbitrary message information and recall the historical trend of the 

display data or event data that contains the message.
For the setting procedure, see section 4.7.

   

To the historical trend display

The number of the message data displayed on the screen’s bottom line and the 
number of messages in internal memory

Cursor (selects the message)

Message
Added message 
(displayed in blue)

Date/Time when the message was written

Destination group to write the message
All groups “A”or a group number, or 
the second of the date/time when the 
message was written.  

• Switching of the Display Items
 You can switch between two sets of display contents.

• Message, time when the message was written, and group to which the message 
was written or second of the time when the message was written

• Message, user name that wrote the message

1.3  Display
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Memory Summary
Displays the information pertaining to the display data and event data in the internal 
memory.
• By selecting the display data or event data, the historical trend display can be recalled.
• The FX displays the number of manually sampled data samples and report data 

samples (/M1, /PM1, and /PWR1 options) in internal memory.
 For the operating procedure, see section 4.8.

   
To the historical trend display

Cursor (selects the file)
Date/Time of memory start

Date/Time of memory stop

Sampling count
Status

Number of data points in the internal 
memory/maximum number of data 
points that can be recorded in the 
internal memory

Date/Time of the most recent data

Data type
• Display data
• Event data

• Switching of the Display Items
 You can switch between two sets of displayed items.

• Display the start and end times
• Display the file name

• Saving the Data
 The data in the internal memory can be saved to a CF card or USB flash memory 

(/USB1 option).

1.3  Display
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Report Data (/M1, /PM1, and /PWR1 options)
Report data residing in the internal memory can be displayed.
For the operating procedure, see section 4.5.

   

Number of the displayed report data/number of report data in the internal memory

Start: Start date/time
Timeup: Report date/time

Channel number

Unit

Report data status
Indicates that the following occurred 
between the report interval.
E: Error data
O: Over data
P: Power failure
C: Time change
B: Burnout

Average, maximum, minimum, sum, 
or instantaneous value

Report type

Stacked Bar Graph (/M1, /PM1, and /PWR1 options)
You can display the report data (that is stored in the internal memory) of each report 
group in a stacked bar graph.
For operating instructions, see section 4.10.
For information about report groups, see section 9.5.
• Types of Displayed Data
 The type of displayed data is determined by the report kind, which is set using the 

report function.
Report Kind Displayed Report Data
Hour, H + D Sums for each hour and sums for the day
Day + Week Sums for each day and sums for the week
Day, D + M Sums for each day and sums for the month

Daily sums of each channel and the
daily sums of all channels of the 
report group
If you select a bar graph, the sum
of the hour selected with the cursor
is displayed.

Hourly report group sums (bar graph)

Sums for the day (bar graph) 
of a report group

Example: Hourly + daily display

1.3  Display
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• Display Modes
 You can switch the bar graph between single graph and dual graph display.

   

Single graph display
Dual graph display (Shows the data from 
two consecutive periods)

Status Display
The following displays are available.
For the operating procedure, see section 4.5.
• Relay Status Display
 Displays the status of the alarm output relay and internal switch.

•  Modbus Client Status Display (/C7 option) and Modbus Master Status 
Display (/C2 and /C3 options)

 Display the command status.

Log Display
Displays various logs (operation log).
For the operating procedure, see section 4.9.

Log Type Description
Login Log of login/logout, log of time setting, and log of power failure
Error Log of error messages
Communication1 Log of communication commands
FTP transfer2 Log of FTP transfers
WEB2 Log of Web operations
E-mail transmission2 Log of e-mail transmissions
SNTP2 Log of accesses to the SNTP server
DHCP2 Log of DHCP server access
MODBUS1 Log of communications using Modbus client or Modbus master
1 /C2, /C3, and /C7 options
2 /C7 option

Other Useful Functions
• Automatically Reverting to the Specified Display
 Show a preset display when there is no operation for a specific time.
 For the setting procedure, see section 5.14.

• Customizing the Menus
 You can change the contents of the Function menu, which is displayed when you 

press FUNC, and the display selection menu, which is displayed when you press 
DISP/ENTER.

 For the setting procedure, see section 5.16.

1.3  Display
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Setting the Display Conditions of the LCD
The display conditions of the LCD can be configured.

Display Attribute Setting
Background color of the  The background color of the display can be set to white or black. The 
operation display default value is White. For the setting procedure, see section 5.12.
Background color of the  You can select white, cream, black, or light gray for the background  
historical trend screen color of the screen. The default value is Black. For the setting  
 procedure, see section 5.12.
LCD brightness The brightness of the LCD can be set among eight levels. The default  
 brightness is 2. For the setting procedure, see section 2.7.
Backlight saver The lifetime of the LCD backlight can be extended by automatically  
 turning OFF or dimming the light when there is no key operation for a  
 specified amount of time. The display returns to the original  
 brightness with a key operation or an alarm occurrence. By default,  
 the backlight saver is disabled. For the setting procedure, see  
 section 2.7.

1.3  Display
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1.4 Data Storage Function

This section explains the types of data that the FX can record and how to store them.

Data Types
The FX can record the following types of data.
Data Type Description
Display data •  Waveform data displayed on the trend display. The measured data is recorded 

as a specified sampling interval. The sampling interval is specified using the 
trend interval.

•  The minimum and maximum values among the measured data within the 
sampling interval are saved.

• A header string (common to other files) can be written in the file.
• The display data contains alarm and message information.
• Data format: Binary (Undisclosed)

Event data •  Measured data that is recorded at a specified sampling interval. There are two 
modes. One mode starts recording when a trigger event occurs. The other 
mode records at all times.

• A header string (common to other files) can be written in the file.
• The event data contains alarm and message information.
• Data format: Binary (Undisclosed)

Manual sampled data
•  Instantaneous value of the measured data when a manual sample operation is 

executed.
• A header string (common to other files) can be written in the file.
• Data format: Text

Report Data (/M1, /PM1, and /PWR1 options)
•  Hourly, daily, weekly, and monthly report data. Report data is created at an 

interval that is determined by the report type (one hour for hourly reports, one 
day for daily reports, and so on).

• A header string (common to other files) can be written in the file.
• Data format: Text

Snapshot data (screen image data)
• FX screen image data.
• The data can be saved to a CF card.
• Data format: PNG

Setup data • The setup data of the FX.
• Data format: Binary (Undisclosed)

• Display data and event data
 Display data can be likened to the conventional recording on the chart sheet and 

are useful for long-term recording. Event data is useful when you wish to record the 
measured data in detail.

   Measured data per 
scan interval

Display data

Event data

Sampling interval of display data

Scan interval 
Time

Sampling interval of event data 

Maximum value per sampling interval
Minimum value per sampling interval

Instantaneous value during sampling
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Flow of Data Recording and Storage
Measured data is recorded once to the internal memory and then saved to the external 
storage medium.

...
...

Data from other devices (through 
communication interfaces)
(/C2, /C3, and /C7 options)

CF card* USB memory (/USB1 option)

External storage medium

Internal memory

Network FTP 
server
(/C7 option)

Save data

* This cannot be performed on models that do not have a CF card slot (suffix code -0).

Measurement 
channel

Computation 
channel

Sampling
Setup dataDisplay

Screen image   
data

 Display/Event  
 data

Save

Load

Internal Memory
Display data and event data are held in files in the internal memory. This data is also 
saved as files to an external storage medium.

  

Manual 
sampled data Report dataDisplay data and event data

Network FTP 
server

(/C7 option)

Internal memory

File

......

......

Sampling

Save the data

Directory on the external storage medium

1.4  Data Storage Function
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Recording Method of Display Data and Event Data
For the setting procedure, see section 6.1. For operating instructions, see section 6.4.
• Types of Data to Be Acquired
 Select display data only, display data and event data, or event data only.
 Deciding the Data to Be Recorded
 Record the data that suits your application. Refer to the following examples.
 Example 1: Continuously record the waveform data as with the conventional chart 

recorder.
  Record the display data.
 Example 2: Record waveform data under normal conditions but record details around 

the point of alarm occurrence when alarms occur.
  Continuously record display data and record event data when alarms 

occur.
 Example 3: Only record the most-detailed data at all times.
  Record event data by specifying the sampling interval.
 Example 4: No need to continuously record data. Record data only when alarms 

occur.
  Record event data only when alarms occur.

• Internal Memory
 The recorded measured data is divided at a specific time interval and saved to files. 

If the internal memory is full or if the number of display data files and event data files 
exceeds 400, files are overwritten from the oldest file.

• Recording Conditions of Display Data
Item      Description
Source channels  Select from measurement channels and computation channels.
Sampling interval   Specify the sampling interval with the trend interval (see the table 

below). You cannot specify a sampling interval that is faster than the 
scan interval.

File creation    Files are created at the specified file save interval.

Time 

File File File Adding data 

 Files are also created in the following cases.
 • When a file is created manually. 
 • When the memory sampling is stopped.
 • When file creation is executed with the event action function.
 • After recovering from a power failure.

Memory start/stop   Press the START key to start recording (memory start) and the 
STOP key to stop the recording (memory stop).

 Trend interval and the sampling interval of display data
Trend interval1 15 s2 30 s 1 min 2 min 5 min
Sample rate 500 ms 1 s 2 s 4 s 10 s
Trend interval 10 min 15 min 20 min 30 min 1 h
Sample rate 20 s 30 s 40 s 1 min 2 min
Trend interval 2 h 4 h 10 h
Sample rate 4 min 8 min 20 min
1 You cannot set a trend interval that corresponds to a sampling interval that is faster than the 

scan interval.
2 Selectable on the FX1002 and FX1004

1.4  Data Storage Function



1-26 IM 04L21B01-01EN

• Recording Conditions of Event Data
Item Description
Source channels Same as the display data.
Sampling interval Choices are available in the range of 125 ms to 10 min. However, you 

cannot specify an interval that is faster than the scan interval.
File creation A file is created when the specified data length is reached.
 Files are also created in the following cases.
 • When a file is created manually. 
 • When the memory sampling is stopped.
 • When file creation is executed with the event action function.
 • After recovering from a power failure.
Mode The available modes are Free (continuously record), Single, and 

Repeat. The recording operation varies depending on the mode as 
follows:

 Free
 Press the START key to start recording (memory start) and the STOP 

key to stop the recording (memory stop) .

 
Time 

File File File Adding data 
 Single
 Pressing the START key places the FX in the trigger-wait state. After 

a trigger event occurs, the FX will record data for the set time (data 
length). From this point, the FX does not record even if the trigger 
condition is met.  

 Time 

File 

Trigger condition met 

 Repeat
 Pressing the START key places the FX in the trigger-wait state. After 

a trigger event occurs, the FX will record data for the set time (data 
length). The FX enters the trigger-wait sate again and keeps recording 
the data for a specified time (data length) each time the trigger condition 
is met. To stop recording event data, press STOP.

 Time 

File File 

Trigger condition met Trigger condition met 

 Pretrigger of Event Data
 The pretrigger can be specified in trigger mode.
 This function is used to save the data before the point where the trigger condition 

is met as event data. This function is convenient when you wish to record the data 
before the occurrence of a certain event such as when an alarm occurs.

 Specify the pretrigger as a percentage (0, 5, 25, 50, 75, 95, or 100%) of the recording 
time (data length) of the event data. If set to 0%, the data after the trigger condition is 
met is recorded.

   
Time 

Trigger condition met 

Data before  
the trigger 

Data after  
the trigger 

 Trigger for Starting the Event Data Recording
 When set to trigger mode, you can set various conditions for starting the recording.
 Example: Key operation, alarm occurrence, specific time, or remote control

1.4  Data Storage Function



1-27IM 04L21B01-01EN

O
verview

 of Functions

3

2

1

4

5

6

7

8

9

10

11

12

13

14

App

Index

• Creating Files through Key Operation
 Files can be created using keys.

   
Time 

Previous files 

Key operation 

File File File 
Current file 

 For operating instructions, see “Creating a Display Data File or an Event Data File” in 
section 6.4.

Manual Sampled Data
 Manual sampled data is recorded to the internal memory. When the number of manual 

sampled data exceeds 400, the data is overwritten from the oldest data.

   Time 

Manual sampled data 

Report Data
 Report data is recorded to the internal memory. When the number of report data 

exceeds 100, the data is overwritten from the oldest data.

   Time 

Report data 

1.4  Data Storage Function
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Saving Data to the External Storage Medium
You can only use this feature on FXs that have a CF card slot or USB interface (/USB1 
option).
For the setting procedure, see section 6.2. For operating instructions, see section 6.4.
• Type of External Storage Medium

• CF card (32 MB or more)
• USB flash memory (/USB1 option)

• Auto Save
 Have the CF card inserted in the slot at all times. The data in the internal memory is 

automatically saved to the CF card.
 Auto Save Timing

Data Type Description
Display data The file is saved when the file is created.

Time

Save data to an external storage medium

File File File

Event data Same as the display data.
Manual sampled data The first time manual sample is executed, a manual sampled data 

file is created on the CF card. The data is appended to this file for 
each subsequent manual sample operation. A new file is created after 
manual sampled data has been stored 100 times. 
For operating instructions, see section 6.5.

Report data The first time report data is generated, a report data file is created on 
the CF card and report data is stored. The report data is appended to 
this file every time of report.
Dividing of the report files
The appending of the report data to the file is stopped at a specified 
time, and subsequent reports are saved to a new file. The file is 
divided in the unit shown in the table below. Also, when recording is 
stopped (memory stop), all report files are divided.
For the setting procedure, see section 9.5.

Report Type Report File
File for Each Type Combine

Hourly report  hourly reports of a day  hourly reports of a day
Daily report  daily reports for a month  daily reports for a month
Hourly and daily 
reports

 a file for each daily report  hourly reports for a day and a daily 
report hourly reports for a day

daily and weekly 
reports

 a file for each weekly report  daily reports for a week and a 
weekly report daily reports for a week

Daily and monthly 
reports

 a file for each monthly report  daily reports for a month and a 
monthly report daily reports for a month

 Save Destination
 CF card.

 Data Save Destination Directory
 You can set the data save destination directory name (DATA0 by default). The 

specified directory is created on the CF card, and the data is saved in the directory.

 Save Operation (If Media FIFO Is Disabled)
 The data in the internal memory can be saved only if there is sufficient free space on 

the CF card. Replace the CF card and save the data before the data in the internal 
memory is overwritten.

1.4  Data Storage Function
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 Save Operation (Always retain most recent data file/media FIFO)
 When saving the data files automatically, you can save the data so that the most 

recent data files are constantly retained in the CF card. With this method, you can use 
the FX continuously, without changing the CF card.

 • Operation

    File 1 File 2 File 3 File 4Deleted Saved

Update date

Medium

Old New

 If not enough free space is available when saving a new data file to the CF card, 
files are deleted in order from the oldest data update date/time to save the new file. 
This operation is referred to as FIFO (First In First Out).
• The FIFO operation is carried out only when saving the following files 

automatically. It is not carried out when saving files to the save destination 
directory using another method. 

 Display data files, event data files, report data files, manual sample data files, 
and snapshot data files.

• Files that are deleted
 All the files in the save destination directory are applicable to be deleted. 

However, the following files are excluded. Hidden files, read-only files, files in 
the subdirectory within the save destination directory.

•  The most recent 1000 files are retained. If the number of files in the save 
destination directory exceeds 1000, the number of files is held at 1000 by 
deleting old files even if there is enough free space.

•  If there are more than 1000 files already in the save destination directory, one or 
more files are always deleted before saving the new file. The number of files is 
not kept within 1000 in this case.

• Creating a Display Data File or an Event Data File
 The save destination is the CF card. You can create a file when display data is being 

recorded or when event data is being recorded in Free mode. Unsaved measured 
data is saved to the CF card.

 For operating instructions, see section 6.4.

• Manual Save (Collectively Storing Unsaved Data)
 Unsaved data in the internal memory is stored in unit of files to the external storage 

medium when an external storage medium is inserted and a given operation is carried 
out.

   

Time 

Saved the  
previous time 

Save operation 

File File File 

Saved this time 

 When using manual save, it is important that you save the data in the internal memory 
to the external storage medium before the data is overwritten. Determine the usage 
condition of the internal memory and save the data to the external storage medium at 
appropriate times.

1.4  Data Storage Function
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 Save Destination
 You can select a CF card or USB flash memory (/USB1 option).

 Data Save Destination Directory
 You can set the data save destination directory name (DATA0 by default).

• File Name
 The FX can name measured data files that are automatically saved to the internal 

memory in one of the following three ways.
Structure Description

Date Display data
Event data Specified stringSerial . Date Extension

Manual sampled data Example: 000123_AAAAAAAAAAA110928_174633.DAD
Snapshot data

Report data Serial Specified string Date . ExtensionType

Example: 000123_AAAAAAAAAAA11050928_174633HD.DAR
Serial Display data

Event data Specified string . ExtensionSerial

Manual sampled data Example: 000123_AAAAAAAAAAA.DAD
Snapshot data

Report data Specified string . Type ExtensionSerial

Example: 000123_AAAAAAAAAAAHD.DAR
Batch name Display data

Event data
. ExtensionBatch nameSerial

Example: 000123_BBBBBBBBBBBBBBBBBBBBBBBBBB.DAD

Report data . Serial Date ExtensionType

Example: 000123_110928_174633HD.DAR

Manual sampled data
Snapshot data

. Serial Date Extension

Example: 000123_110928_174633.DAM

 
Item Description

Serial
Construction: 6-digit number 1-character delimiter+
6-digit 
number

A sequence number in the order of occurrence.
The number ranges from 000001 to 999999. 
If the number reaches 999999, it returns to 000000.

1-character 
delimiter

Starts with ‘_’ and takes on the following values: A to Z and 0 to 9.
If a file with the same name exists in the specified directory, the file is 
saved by changing the delimiter to prevent overwriting.
Example:   If a file named “000123_AAAAAAAAAAA.DAD” already exists,  

the file is saved to the name “000123AAAAAAAAAAAA.DAD.”
Date YYMMDD_hhmmss YY: Year (lower two digits), MM: Month, DD: Day

hh: Hour, mm: Minute, ss: Second
Specified string AAAAAAAAAAAAA Up to 16 alphanumeric characters can be used

Batch name BBBBBBBBBBB . . . B Up to 40 alphanumeric characters can be used

Type H_, D_, W_, M_, 
HD, DW, DM

Report data type
H_: Hourly, D_: Daily, W_: Weekly, M_: Monthly, 
HD: Hourly and daily, DW: Daily and weekly, 
DM: Daily and monthly

Extension Display data: DAD
Event data: DAE

Report data:DAR
Snapshot data: PNG
Manual sampled data: DAM

1.4  Data Storage Function
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• Saving Data through Key Operation
 You can carry out the following data save operations regardless of whether auto save 

or manual save is used.
 For the operating procedure, see section 4.8.

Data Storage Description
All save Collectively saves all the data in the internal memory.
Selective save Saves the specified display data or event data file.
Manual sampled data save Collectively saves all the manual sampled data in the internal 

memory.
Report data save Collectively saves all the report data in the internal memory.

 Save Destination
 You can select a CF card or USB flash memory (/USB1 option).

 Data Save Destination Directory
 Creates a directory with the name of the data save destination directory name with the 

date/time added and saves the data.
 Directory name: “Specified string”_YYMMDD_HHMMSS
 Example:  If a file is saved on September 30, 2011 at 17:06:42, the file will be saved to 

a directory with the name DATA0_110930_170642. “DATA0” is the specified 
string.

Note
The number of directories that you can create on the external storage medium varies 
depending on the length of the directory names. If the length of the “specified string” is 5 
characters, approximately 170 directories can be created. If it is 20 characters, approximately 
120 directories can be created. An error occurs, if you try to create directories exceeding this 
limit.

Other Types of Data That Can Be Stored
• Setup Data
 You can save the FX setup data to a CF card or to USB flash memory (/USB1 option). 

The setup data is saved to the root directory.

   . PDLSpecified

Example: ABCD10005.PDL
Name of the setup data file 

 For the operating procedure, see section 6.9.

• Snapshot Data
 The FX display is saved to the CF card as a PNG file. It is saved in the same directory 

as display and event data. For the file name, see the previous page.

   
Time 

Snapshot 
Data file CF card 

 For the operating procedure, see section 6.9.

Saving Data through an Ethernet Network (/C7 option)
Using the FTP client function, display data, event data, report data (/M1, /PM1, or /PWR1 
option), and screen image data (snapshot data) can be automatically transferred and 
saved to an FTP server through an Ethernet network. You can also use the FX as an 
FTP server. You can access the FX from a PC and retrieve and store data files from both 
internal and external memory.
See the Communication Interface User’s Manual, IM 04L21B01-17EN.

1.4  Data Storage Function
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1.5 Batch Function

You can add the batch information listed below to display data files and event data files. 
You can use batch information to manage display data files and event data files.
For the setting and operating procedure, see section 6.3.

Batch Information
• Batch Number and Lot Number
 Display data files and event data files can be identified by their “batch number-lot 

number” (hereinafter referred to as batch name). The lot number does not have to be 
specified.
• Batch number (up to 32 characters).
• Lot number (up to 8 digits)

 

• Automatic Increment of the Lot Number
 The lot number can be automatically incremented when the memory sampling is 

stopped.

• Text Field
 You can enter text fields into a file. Eight text fields are available. Each text field 

consists of the following:
• Field title (up to 20 characters)
• Field string (up to 30 characters)

You can use the keys to display text fields on the FX screen.

• Batch Comment
 Three arbitrary comments can be entered in a file. Each comment can be entered only 

once while memory sampling is in progress.
• Comment 1, Comment 2, and Comment 3 (up to 50 characters each)

Using the Batch Function
See the figure below. For example, enter the operator and administrator in the text field. 

  
Time 

Memory start Memory stop 

Data file 

Comment 
Batch number + lot number 

Text field 

Comment 
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1.6 Event Action and Remote Control Functions 
(/R1 and /PM1 Options)

A specified action is carried out when an event occurs. This function is called event 
action. The remote control function (/R1 and /PM1 options) allows you to specify actions 
to be performed when the terminal receives a contact input or an open collector signal. 
The remote control function is configured using the event action function.
For the setting procedure, see section 7.1.

Events
• Events
 Select from the following events.

Event Level/Edge1 Description
Remote Level/Edge ON/OFF of the remote control input.
Output relay Level/Edge Activated/Deactivated condition of the alarm output relay.
Internal switch Level/Edge The value, 0 (off) or 1 (on), of the internal switch.
Timer Edge Timer timeout.
Match time timer Edge When the time matches.
Alarm Level/Edge The state in which any alarm is occurring and the state in 

which no alarm is occurring.
USER key Edge The operation of pressing the USER key.
1 For a description of level and edge, see “Miscellaneous” in this section.

• Output Relay, Internal Switch, Alarm
 The output relay, internal switch, and alarm have two states, state A and state B, 

which are explained in the table below.
Event State A State B
Output relay Deactivated Activated
Internal switch OFF ON
Alarm No alarms At least one alarm

 When Edge Is Selected
 An event occurs when state A changes to state B.

 When Level Is Selected
 There are action states that correspond to state A and state B.
 See “Miscellaneous” and “Level and Edge” in this section.
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• Timers
 Four timers are available. The timers are also used with the TLOG computation (/M1, 

/PM1, and /PWR1 options).

 Timer Type

   Time 

Relative timer Absolute timer 
Set the timer 
Reset the timer 

B: Interval Timeout 

Time 
Set the timer Ref. time 

A: Interval 
A B B A A A 

 • Absolute Time Mode
 The timer expires at the times determined by the reference time and the interval. 

The reference time is set on the hour (00 to 23).
Example: Reference time: 00:00
 Interval: 10 min
 The timer expires at 0 hour, 0 hour 10 min, 0 hour 20 min, ... 23 hour 40 

min, and 23 hour 50 min. For example, if the timer is set at 9 hour 36 
min, the timer expires at 09 hour 40 min, 09 hour 50 min, 10 hour, and 
so on.

 • Relative Time Mode
 The timer is started when the timer is set, and the timer expires every specified 

interval. In this mode, the timer stops when a power failure occurs.
Example: Interval: 00:15
 The timer expires every 15 minutes.

• Match Time
 You can set the time matching conditions for the four match time timers. Specify 

the date/time using the method described below. For each condition, you can select 
whether to use the condition once or continuously.
Specified Date/Time Description
Y hour of the X day The condition is met once a month.
Y hour of the X day of the week The condition is met once a week.
Y hour The condition is met once a day.

1.6  Event Action and Remote Control Functions (/R1 and /PM1 Options)
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Action
• Actions
 Select from the following actions.

Action Level/Edge1 Description
Memory start/stop Level Starts/stops memory sampling.
Memory start Edge Starts the memory sampling.
Memory stop Edge Stops the memory sampling.
Event trigger Edge Applies a trigger for starting the event data 

recording. 
This is valid when recording event data in trigger 
mode. See the next page.

Alarm acknowledge Edge Releases the alarm output. 
This is valid when the use of the alarm ACK 
operation is enabled.

Computation start/stop2 Level It is used to start/stop the computation.
Computation start2 Edge Starts the computation.
Computation stop2 Edge Stops the computation.
Computation reset2 Edge Resets the computed values on all computation 

channels. 
Save display data Edge The display data being recorded is saved to the 

internal memory as a file. This is the same function 
as the data save operation using the FUNC key.

Save event data Edge The event data being recorded is saved to the 
internal memory as a file.  
This is the same function as the data save operation 
using the FUNC key.

Message Edge Writes a message. 
This action can be executed while memory sampling 
is in progress.

Snapshot Edge Saves the screen image data.
Switch the display rate Level Toggles between the trend interval and the 

secondary trend interval. 
This action is valid when the FX is configured to use 
trend interval switching.

Manual sample Edge Executes manual sampling.
Reset the relative timer Edge Resets the relative timer. The timer restarts from 

that point. See the next page.
Switch the display group Edge Switches the display group when the trend, digital, 

or bar graph is displayed.
Flag2 Level The flag is zero for normal conditions and 1 when an 

event occurs. When the event is an edge operation, 
the value alternates between 0 and 1 whenever an 
event occurs.  
The flag can be written in a calculation expression 
of a computation channel.

Load the setup Edge Loads the setup data file in the root directory of the 
CF card into the FX and updates the FX settings. 
See the next page.

Adjust the time Edge Synchronizes the time to the nearest hour. See the 
next page.

1 For a description of level and edge, see “Miscellaneous” in this section.
2 This is an option.

1.6  Event Action and Remote Control Functions (/R1 and /PM1 Options)
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 Event Trigger Operation
 When the event is set to output relay, internal switch, or alarm
 If the output relay is activated, the internal switch is 1, or the alarm is occurring during 

memory sampling, the event trigger is always activated. However, the number of times 
the trigger is activated depends on the event data mode (single or repeat).

 Resetting the Relative Timer
 If the event is set to output relay, internal switch, match time timer, or alarm, the 

resetting of the timer is not considered a timeout. (The action is not executed even if 
the timer is used as an event.)

 Loading the Setup
 Can be specified as an action only when the event is set to remote control input.
 Loads the setup data file, LOAD1.PDL, LOAD2.PDL, or LOAD3.PDL, in the root 

directory of the CF card into the FX and updates the FX settings.
 You must create a setup file and save it to the CF card in advance.

 Time Adjustment
 Time adjustment can be specified as an action only when the event is set to remote 

control input. The internal clock of the FX is adjusted to the nearest hour through 
remote control input.

 • Operation When Memory Sampling Is Stopped
Difference from the Nearest Hour Operation
00 min 00 s to 01 min to 59 s Truncates the minutes and seconds.
 Example: 10 hours 01 min 50 s becomes 10 hours 00 min 

00 s.

02 min 00 s to 57 min to 59 s The time is not changed.
58 min 00 s to 59 min to 59 s Rounds up the minutes and seconds.
 Example: 10 hours 59 min 50 s becomes 11 hours 00 min 

00 s.

 • Operation during Memory Sampling (see section 1.10)
 If the time difference Td between the time of the event and the nearest “on the 

hour” hour is less than 2 minutes, the following operation is performed depending 
on different conditions.
• If Td is less than or equal to the preset time difference, the clock is adjusted 

gradually.
• If Td is greater than the preset time difference, the clock is adjusted immediately.

 If Td is greater than or equal to 2 minutes, the clock is not adjusted.

1.6  Event Action and Remote Control Functions (/R1 and /PM1 Options)
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Miscellaneous
• Limitations on the Combinations of Events and Actions
 The combinations that are checked in the table below can be used.

Event

Action

Remote Output
Relay

Internal
Switch

Timer Match
Time
Timer

Alarm User
Key

Alarm ACK    
Reset the relative timer      
Load the settings 
Adjust the time 
Other actions       

• Level and Edge
 The combinations of events and actions are summarized in the figure below.

   

Type Operation

Level

Level
State 1

State 2 Operation 
executed

Operation 
executed

Edge Edge

Edge

Event

Action

 Event Action Example
 The following is an example for when the event is Internal switch (Level or Edge) and 

the action is Memory start/stop (Level) or Manual sample (Edge).

   

Event Action Operation

OFF
ON

Memory start Memory stop ExecutionExecution

EdgeLevel

Event
(internal switch)

Action
Memory start/stop Manual sample

 Level and Edge of the Remote Control Input Signal

   

Level Edge 

ON 

OFF 
250 ms or more 

 For contact inputs, the remote signal rises when the contact switches from open to 
closed and falls when the contact switches from closed to open. For open collector 
signals, the remote signal rises when the collector signal (voltage level of the remote 
terminal) goes from high to low and falls when the collector signal goes low to high.

1.6  Event Action and Remote Control Functions (/R1 and /PM1 Options)
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1.7 Security Function

This section will explain the FX security functions.

Key Lock Function
Key lock is a function that prohibits key operations. You enter a password to release the 
key lock.
For the setting procedure, see section 8.1.

Key Lock Items Description
Keys The following keys can be locked independently.
 START key, STOP key, MENU key, USER key, DISP/ENTER 

key (prohibits switching the operation screen).

Access to the storage medium1 Prohibits all operations listed below.
 • Manually save the data
 • Load the display data and event data files
 • Save/Load setup data files
 • Listing of files stored on the external storage medium
 • Deleting files stored on the external storage medium
 • Formatting external storage media

Loading setup data2  Prevents external storage medium access for the purpose of 
loading setup files.

Function operation The following FUNC key operations can be locked 
independently.

 • [Alarm ACK]
 • [Message], [Free message], [Batch],
  [Add Message], [Add Free Message]
  [Text field]
 • [Math start],3 [Math stop],3 [Math reset],3

  [Math ACK]3

 • [Save display], [Save event],
  [Manual sample], [Trigger], 
  [Snap shot], [Timer reset], [Save stop],1

 • [E-Mail start],3 [E-Mail stop],3 [E-Mail test],3 [FTP test],3  
 operations to [Request] or [Release] network information3

 • [SNTP],3 time setting (operation in setting mode)
 • [Standard display], [Second speed], [Normal speed]

1 On FXs that have a CF card slot or USB interface (/USB1 option)
2 On FXs that have a CF card slot
3 Optional
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Login Function
With the login function, only registered users can operate the FX. Access from 
communication functions (/C7 option) can also be limited to users registered here.
For the setting and operating procedure, see sections 8.2 and 8.3 respectively.
• Login and Logout
 You enter your user name and password to log into the FX in the following cases.

FX Access Method Login Required
Keys • When the power is turned ON
 • When logging in after exiting the basic setting mode
 • When logging in after logging out

Communication (/C7 option) When accessing the setting/measurement server, FTP server, 
maintenance/test server, or Web server.

 Auto Logout (When Logged in Using Keys)
 When logged in using keys, you are automatically logged out when there is no key 

operation for a specified time. If you are automatically logged out from the setting 
mode, the setting changes are cancelled. You are not automatically logged out during 
basic setting mode.

 Operations That Can Be Carried Out When Logged Out
 When logged out, you can switch the operation screen using the DISP/ENTER key 

and arrow keys.

• User Levels
 A user can be an “administrator” or a “user.”
 Administrator
 Administrators can perform all operations on the FX. At least one administrator must 

be registered to use the login function.
Item Description
Number of users that  5 
can be registered
Range of operations All operations.
Login method Select key operation, via communication, or Web server login.
ID information User name and password

 User
Item Description
Number of users that 
can be registered

30

Range of operations Key operations
Operation Limitation
Basic setting mode Not allowed
Setting mode Menu customizes Not allowed

Other Specified with user privileges
Operation mode Key operations Specified with user privileges
• User privileges

You can set operation privileges for each user. The privileges are 
the same as with the key lock function.

For details about operations via communication, see the 
Communication Interface User’s Manual, IM 04L21B01-17EN.

Login method Select key operation, via communication, or Web server login.
ID information User name and password

1.7  Security Function



1-40 IM 04L21B01-01EN

1.8 Computation and Report Functions (/M1, /PM1, 
and /PWR1 Options)

Computation Function
Equations can be defined on special computation channels by using measured data, 
power data, or computed data as variables. The computation channel data can be 
displayed or saved.
For the setting procedure, see section 9.1.
• Channels Dedicated to Computations

Model Number of Channels Channel Numbers
FX1002 and FX1004 12 101 to 112
FX1006, FX1008, FX1010, and FX1012 24 101 to 124

• Computation Types
 In the table below, [001] represents the measured value of channel 001.

Type Example Description of the Example
Four arithmetic  001+002 Determines the sum of [001] and [002].
operation 001-002 Determines the difference between [001] and [002].
 001*002 Determines the product of [001] and [002].
 001/002 Divides [001] by [002].
Power 001**002 Determines [001] to the power of [002]. y = Xn

Square root SQR(001) Determines the square root of [001].
Absolute value ABS(001) Determines the absolute value of [001].
Common logarithm LOG(001) Determines the common logarithm of [001]. y = log10x
Natural logarithm LN(001) Determines the natural logarithm of [001]. y = lnx
Exponent EXP(001) Determines e to the power of [001]. y = ex

Relational  001.LT.002 The result is 1 when [001] is less than [002] or 0  
computation  otherwise.
 001.LE.002 The result is 1 when [001] is less than equal to [002] or  
  0 otherwise.
 001.GT.002 The result is 1 when [001] is greater than [002] or 0  
  otherwise.
 001.GE.002 The result is 1 when [001] is greater than equal to [002]  
  or 0 otherwise.
 001.EQ.002 The result is 1 when [001] is equal to [002] or 0  
  otherwise.
 001.NE.002 The result is 1 when [001] is not equal to [002] or 0  
  otherwise.
Logical computation 001AND002 The result is 1 when [001] and [002] are nonzero or 0  
  otherwise.
 001OR002 The result is 1 when [001] or [002] or both are nonzero  
  or 0 otherwise.
 001XOR002 The result is 0 when [001] and [002] are nonzero or 1  
  otherwise.
 NOT001 The result is 1 when [001] is zero or 0 otherwise.
TLOG computation* TLOG.SUM(001) Determines the sum of [001].
 TLOG.MAX(001) Determines the maximum value of [001].
 TLOG.MIN(001) Determines the minimum value of [001].
 TLOG.AVE(001) Determines the average value of [001].
 TLOG.P-P(001) Determines the difference between the maximum value  
  and minimum value of [001].
* See “Usage of TLOG Computations” in this section.
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Type Example Description of the Example
CLOG computation CLOG.SUM(001.002.003) 
  Determines the sum of [001], [002], and [003].

 CLOG.MAX(001.002.003) 
  Determines the maximum value among [001], [002],  
  and [003].

 CLOG.MIN(001.002.003) 
  Determines the minimum value among [001], [002], and  
  [003].

 CLOG.AVE(001.002.003) 
  Determines the average value of [001], [002], and [003].

 CLOG.P-P(001.002.003) 
  Determines the difference between the maximum value  
  and the minimum value among [001], [002], and [003].

Special computation PRE(001) Determines the previous value of [001].
 HOLD(101.GT.K01):TLOG.SUM(001)
  Under normal conditions, TLOG.SUM(001) is carried  
  out to derive the computed value. When [101] exceeds  
  K01, the previous computed value is held.

  
K01 

 Description
 HOLD(a):b When a is zero, b is carried out to derive the computed  
  value. Otherwise, the previous computed value is held.

 RESET(101.GT.K01):TLOG.SUM(001)
  Under normal conditions, TLOG.SUM(001) is carried  
  out to derive the computed value. When [101] exceeds  
  K01, the previous computed value is reset, and  
  TLOG.SUM(001) is carried out.

  
K01 Reset 

 Description
 RESET(a):b When a is zero, b is carried out to derive the computed  
  value. Otherwise, the previous computed value is  
  reset, and b is carried out to derive the computed value.

 CARRY(K01):TLOG.SUM(001)
  Under normal conditions, TLOG.SUM(001) is carried  
  out to derive the computed value. When the computed  
  value is greater than or equal to K01, the computed  
  result is the excess (computed value – K01).

  
K01 

 Description
 CARRY(a):b Only TLOG.SUM can be specified for b. If the  
  computed value X of b is less than a, the computed  
  result is X. If X is greater than or equal to a, the  
  computed result is the excess (X – a).

Conditional equation [001.GT.K01?001:001+002]
  When [001] is greater than K01, the computed value is  
  set to the value of [001]. Otherwise, the computed  
  value is set to the value of [001] + [002].
 Description
 [a?b:c] If the computed result of a is nonzero, b is carried out.  
  Otherwise, c is carried out.

1.8  Computation and Report Functions (/M1, /PM1, and /PWR1 options)
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• Data That Can Be Used in Equations
 The data listed below can be used.

Data Notation Description
Measurement channel data 001, etc. Specify the computed data using a channel number.
Computation Channel data1 101, etc. Specify the computed data using a channel number.
Constant K01 to K60 A value.
Communication input data C01 to C24 Data set through communications.
Status of the remote control 
input1

D01 to D082 The value is 1 when the remote control input is ON 
or 0 when it is OFF.

Pulse input1 P01 to P082

Q01 to Q082
Counts the number of pulses per scan interval.
Counts the number of pulses per second.

Internal switch status S01 to S30 1 or 0.
Alarm output relay status1 I01 to I06 and 

I11 to I16
The value is 1 when activated or 0 when 
deactivated.

Flag1 F01 to F08 Use the event action function to set the flag (for 
details, see section 1.6).

Power data1 WAT, etc. For details, see section 3.12.
1  An option.

 2  Values such as 01 are terminal numbers.

 Only the data that are checked in the table below can be used in TLOG, CLOG, and 
PRE.

Data
Comp

Meas.  
Channel

Comp.  
Channel

Constant Comm.  
Input

Remote Pulse Internal  
Switch

Relay Flag Power

TLOG       
CLOG  
PRE      
Other 
computations

         

Example: TLOG.SUM(S01), CLOG.AVE(001.002.K01), and PRE(S01) are not allowed.

• Processing Order of Computation
 Computation functions are performed every scan interval, starting with the smallest 

computation channel number.
 Example:  If you specify 102 = 101 + 103, the value of the previous scan interval is 

used for the 103 value.

• Handing of the Unit in Computations
 In computations, measured values are handled as values without units. For example, 

if the measured data from channel 001 is 20 mV and the measured data from channel 
002 is 20 V, the computed result of 001 + 002 is 40.

• Displaying the Computed Data
 The computed data is displayed by setting a measurement span for each computation 

channel. Computation channels can be displayed on various operation screens in the 
same fashion as the measurement channels.

 For the setting procedure, see section 9.3.

• Alarm
 Up to 4 alarms can be assigned to each computation channel. The alarm types are 

high limit alarm (H), low limit alarm (L), delay high limit alarm (T), and delay low limit 
alarm (t).

• Saving Computed Data
 As with the measured data, the computed data can be saved to display data, event 

data, manual sampled data, and report data.

1.8  Computation and Report Functions (/M1, /PM1, and /PWR1 options)
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• Computation Data Dropout
 A computation data dropout occurs if the computation is not completed within the scan 

interval. For the operating procedure, see section 9.4.
• The computation icon in the status display section turns yellow.
• When a computation data dropout occurs, the computed data of the scan interval in 

which the dropout occurred is set to the data immediately before the dropout.
• If computation data dropout occurs frequently, lessen the load on the CPU by 

reducing the number of computation channels or setting a longer scan interval.

• Numeric Display and Recording
 The range of displayed values of computed data is from –9999999 to 99999999 

excluding the decimal point. The decimal place corresponds to the decimal place of 
the lower limit span of the computation channel. On the numeric display, values are 
displayed if the computed result is within the above range regardless of the upper and 
lower limits of span. The following table indicates special displays.
Display/Recording Computed Data Status 
+Over • +Display over: When the computed result exceeds 99999999
 • +Computation over: When the value exceeds approximately  

 1.79E+308 in the middle of the computation
 • When a computation error* occurs (select +Over or –Over.)

–Over • –Display over: When the computed result is less than –9999999
 • –Computation over: When the value is less than approximately  

 –1.79E+308 in the middle of the computation
 • When a computation error* occurs (select +Over or –Over.)

* Computation error occurs when the following computation is carried out.
 • X/0, SQR(–X), or LOG(–X)
 • If a channel number set to skip or Off is used in the equation
 • If a channel number set to Log scale (/LG1 option) is used in the equation

• Rolling Average
 The rolling average of the computed result of the equation specified for the 

computation channel is determined, and the result is the computed data for that 
channel. The number of samples and the sampling interval can be specified for each 
computation channel. The rolling average is applied over the time corresponding to “the 
number of data samples × the sampling interval.” The maximum sampling interval is 1 
hour, and the maximum number of samples is 1500.

• Starting the Computation
 You can configure the FX to start the computation when you press the START key.

• Usage of TLOG Computations
 TLOG computation determines the sum, maximum, minimum, average, or the 

difference between the maximum and minimum of a specific channel for each interval 
determined by a timer.

 Timers That Are Used
 The timer that is used is assigned to each channel.

 Unit of Sum Computation
 Set the sum scale when using sum computation (TLOG.SUM).
 Select Off, /s, /min, or /h. For details, see page 1-45.

1.8  Computation and Report Functions (/M1, /PM1, and /PWR1 options)
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 Resetting the TLOG Computed Value
 You can select whether to reset the TLOG computed value at each interval. The figure 

below illustrates the reset operation for sum computation (TLOG.SUM).
 Example: Result of the TLOG.SUM computation

   

1 2 3 
ResetReset Reset

Reset: On 

Timer timeout 

Reset: Off 

 When reset is On, the sum value is calculated over each interval. When set to Off, the 
sum value from computation start is calculated.

  Power Failure Operation, Handling of Error Data, and Handling of 
Overflow Data

 See “Special Data Handling” in this section.

1.8  Computation and Report Functions (/M1, /PM1, and /PWR1 options)
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Report Function
This function is used to create hourly, daily, weekly, and monthly reports. For the setting 
procedure, see section 9.5.
• Report Data Types
 You can select from four types among maximum value, minimum value, average 

value, sum value, and instantaneous value. Report data is calculated from the 
measured values that have been sampled at the scan interval.

• Report Type
Type Description
Hourly report Creates report data every hour on the hour for the previous one hour.
Daily report Creates report data every day at a specified time for the previous one day.
Weekly report Creates report data every week at a specified time at a specified day of the 

week for the previous one week.
Monthly report Creates report data every month at a specified time at a specified day for 

the previous one month.

• Combinations of Reports That Can Be Created
 You can select from hourly reports only, daily reports only, hourly and daily reports, 

daily and weekly reports, and daily and monthly reports.

• Source Channels
 You can select from measurement channels and computation channels. The report 

data are not created for channels that are set to Skip or Off.
Model Number of channels
FX1002 and FX1004 12
FX1006, FX1008, FX1010, and FX1012 24

• Unit of Sum Computation
 In the sum computation, data are summed over the scan interval. However, for flow 

values that have units /s, /min, /h, or /day a simple summation results in the actual 
value not matching the computed result, because the scan interval and the unit of the 
input values are different. In such cases, set the sum scale to match the unit of the 
input value. In effect, the sum value with the same unit as that of the input value is 
calculated.

 For example, if the scan interval is 2 s, and the input value is 100 m3/min, a simple 
summation would add 100 every 2 s resulting in 3000 after one minute. However, if 
the sum scale is set to /min, then 2 s/60 s is multiplied every scan interval before the 
value is added giving a result that has an m3/min unit.

 The following converting equations are used to compute the sum. The unit of the scan 
interval is seconds.
Off: Σ(measured data every scan interval)
/s: Σ(measured data every scan interval) × scan interval
/min: Σ(measured data every scan interval) × scan interval/60
/h: Σ(measured data every scan interval) × scan interval/3600
/day: Σ(measured data every scan interval) × scan interval/86400

• Displaying the Report Data
 You can display the report data using keys.
 For the operating procedure, see section 4.5.

• Saving the Report Data
 See section 1.4, “Data Storage Function.”

• Numeric Display and Recording
 The numeric range of the report data is from –9999999 to 99999999 excluding the 

decimal point (except –3.4E+38 to 3.4E+38 for sum values).
 For the data handling of special cases, see “Special Data Handling” in this section.
 For details on the report file format, see appendix 3.

1.8  Computation and Report Functions (/M1, /PM1, and /PWR1 options)
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Special Data Handling
This section explains the handling of special data in TLOG computation, CLOG 
computation, and reports.
• Power Failure Operation (TLOG and Reports)
 If a power failure occurs when the report function is enabled or in the middle of the 

TLOG computation, the report operation and TLOG computation resume when the 
FX recovers from the power failure. The operation varies depending on whether the 
FX recovers from the power failure before or after the time to create a report or TLOG 
data.
Time of Recovery Operation
After the time to create the data The report or TLOG data is created immediately after the FX 

recovers. The measured data up to the time of the power 
failure is used. At the time the next report or TLOG data is 
created, the data after the recovery is used.

Before the time to create the data After the FX recovers, report or TLOG data is created at the 
normal time to create the data. The measured data excluding 
the power failure period is used.

• Error Data Handling (TLOG, CLOG, and Reports)
 If an error occurs in the channel data, the error data is discarded, and the computation 

continues. If all the data are in error, an error results.
 The following types of data are considered error data.

• Channels set to skip or Off.
• The measured result on a measurement channels is error (A/D converter failure, 

etc.).
• The input of the measurement channel is in a burnout condition.
• When an error value is returned as the computed result on a computation channel.
• Channels that are set to Log scale (/LG1 option).

• Handling of Overflow Data
* Refers to over range on a measurement channel and computation overflow on a computation 

channel.

 For TLOG, CLOG, and Reports
 When the channel data is overflow data, the FX handles the data as follows:

Computation Type Description
Average value or sum  Set the handling to ERROR, SKIP, or LIMIT.
value ERROR: Considers the data to be a computation error.
 SKIP: Discards the overflow data and continues the computation.
 LIMIT: Replaces the data with the limit value and continues the  
  computation.
  The limit value is the span upper or lower limit or the scale  
  upper or lower limit of the channel.

Maximum, minimum, Set the handling to OVER or SKIP.
Maximum – minimum OVER: Computes by using the overflow data.
 SKIP: Discards the overflow data and continues the computation.

 For Multiplication and Relation Computation EQ and NE
Computation Type Computation Computed Result
Multiplication 0*(+Over) 0
 0*(–Over) 0
 (+Over)*0 0
 (–Over)*0 0
.EQ. (+Over).EQ.(+Over) 1
 (–Over).EQ.(–Over) 1
.NE. (+Over).NE.(+Over) 0
 (–Over).NE.(–Over) 0

1.8  Computation and Report Functions (/M1, /PM1, and /PWR1 options)
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1.9 FAIL/Status Output Function (/F1 Option)

FAIL Output
When a failure occurs in the FX CPU, the FX generates a relay contact signal (1 signal). 
The relay is energized when the CPU is normal and de-energizes when a CPU failure 
occurs. Therefore, relay output is carried out also when the power is turned OFF (including 
a power failure). You cannot change this behavior.
 Relay Operation

NO C NC
During normal operation

NO C NC
When a failure occurs

NO C NC
When power is turned OFF

If a failure occurs, contact your nearest YOKOGAWA dealer.

Status Output
Outputs the status below with a relay contact signal (1 relay). The relay is energized 
when the status occurs. You cannot change this behavior.
For the setting procedure, see section 2.9.

Status Description Corrective Action
Status of the internal 
memory or CF card

Error in the internal memory. Contact your nearest YOKOGAWA 
dealer.

When the auto save function to the CF card is On.
• The free space on the CF card dropped 

to 10% of the total size (only when 
the media FIFO (see section 1.4) is 
disabled).

Replace the CF card.

• Error in the CF card. •  Replace the CF card with a 
normal one.

•  Use the FX to format the CF 
card (the CF card data will be 
deleted).

However, the status of the internal memory 
is output when the CF card is not inserted. 
• 10 MB or less of available space* 

remaining in internal memory. 
•  The number of files in internal memory 

for which Auto Save to the CF card has 
not been completed has exceeded 390. 

Insert a CF card.

When the auto save function to the CF card is Off.
• 10 MB or less of available space* 

remaining in internal memory. 
•  The number of files in internal memory 

for which Manual Save has not been 
completed has exceeded 390. 

Save the data in the internal 
memory to the CF card.

Measurement error Error in the A/D converter. Contact your nearest YOKOGAWA 
dealer.

Burnout is detected. Replace the thermocouple that 
has burned out.

Communication error A Modbus master or Modbus client 
communication error occurred.

Check the error in the Modbus 
master or Modbus client screen 
and carry out the corrective action.

Memory stop When the memory sampling is stopped. Start the data acquisition.
* The internal memory’s “available space” refers to the following quantities. 
 • Unused regions
 •  Regions of data for which Auto Save or Manual Save (see page 1-28) has been 

completed.
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 Relay Operation

   
NO C NC 

During normal operation 
NO C NC 

When specified status occurs 
NO C NC 

When power is turned OFF 

1.9  FAIL/Status Output Function (/F1 Option)



1-49IM 04L21B01-01EN

O
verview

 of Functions

3

2

1

4

5

6

7

8

9

10

11

12

13

14

App

Index

1.10 Other Functions

Time Related Functions
• Time Correction
 The FX internal clock can be changed in the following ways.

Method Description
Key operation Sets the FX internal clock to the specified time.
Event action function (clock synchronization using  remote control signals)
 Sets the FX internal clock to the nearest hour.

SNTP client function  Sets the FX internal clock to the time retrieved from an SNTP 
server.

 Time Correction Operation
 The time correction operation varies depending on whether memory sampling is in 

progress.
Status Operation
Memory sampling stopped The FX internal clock is changed immediately.
Memory sampling  The FX internal clock is gradually corrected. While the time is being 

gradually adjusted, the date/time in the status display section is 
displayed in yellow.

 Operation of Gradually Correcting the Internal Clock
 If the time deviation between the time of the FX internal clock and the correct time (the 

specified time) is within a specified value, the FX clock is adjusted gradually at a rate 
of 40 ms per second. Otherwise, the clock is corrected immediately. The maximum 
value of time deviation (tm in the figure below) can be selected in the range of 10 s to 
5 min. However, if the clock is being adjusted using the event action function (clock 
synchronization using remote control signals), only when the difference between the 
current time and the nearest “on the hour” hour is less than or equal to the preset 
value is the clock gradually adjusted to the hour (see section 1.6).

Time specified using keys or 
retrieved from an SNTP server

Range in which the time is gradually 
adjusted

Nearest 
hour

Time deviation

Time when the remote control 
signal is applied
(Time on the FX)

tm tm
Range in which the time is gradually 
adjusted

Time on 
the FX

Time deviation

tm tm

Example: When changing the time to 12 hours 55 minutes 35 seconds when the 
internal clock is 12 hours 55 minutes 32 seconds

 The time deviation of 3 seconds is adjusted 40 ms per second. The 
internal clock will be synchronized to the specified time 75 seconds later.

• Date Format
 You can select from the following ways of displaying the date: 2011/09/28, 09/28/2011, 

28/09/2011, and 28.09.2011.
 For the setting procedure, see section 2.4.

• Time Zone
 Set the time difference between the location where the FX is used and GMT.
 For the setting procedure, see section 2.2.
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• DST (Daylight Saving Time)
 If you are using the FX in an area with daylight saving time, enter the daylight 

saving time starting and ending dates, and the FX will automatically change the time 
accordingly.

 For the setting procedure, see section 2.1.

System Display
This displays the total number of inputs on the FX, the size of the internal memory, the 
communication functions, the external storage drive, the options, the MAC address, and 
the firmware version number.
For the operating procedure, see section 2.5.

Language
The displayed language can be set to English, Japanese, German, French, Chinese, 
Italian, Spanish, Portuguese, Russian, and Korean.
For the setting procedure, see section 2.6.

24 VDC Power Supply for Transmitter (/TPS2 or /TPS4 Option)
Provides 24-VDC power supply to up to two (/TPS2) or four (/TPS4) two-wire system 
transmitters. The measured values of the transmitter correspond to a current signal of 
4 to 20 mA on the same cable. Therefore, the signal can be connected to the FX input 
terminal and displayed.

  
– 

+ 

+ 

– 

Transmitter 

Current 
FX

Transmitter power  
supply output terminal 

Input terminal 
Shunt resistor: 250 Ω 

USB Interface (/USB1 option)
You can connect a keyboard or a USB flash memory device to the USB port on the front 
of the FX.
• You can operate the FX using a keyboard.
• You can save measured data and setup data to the USB flash memory and also load 

from it.
For the operating procedure, see sections 2.10 and 2.11.

1.10  Other Functions
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2.1 Setting the Date/Time

Set the date/time.

Setup Screen
• Date/Time
  Press MENU (to switch to setting mode), and select the Menu tab > Date/Time > 

Time Settings.

   

• DST
 Press MENU (to switch to setting mode), and select the Menu tab > Date/Time > 

Daylight Saving Time.

   

Setup Items
• Time set
 Enter the date and time, and press DISP/ENTER.

• Daylight savings time > Use/Not
 To set a daylight saving time period, select Use.

• Daylight savings time > Start time
 Specify the date and time when daylight saving time starts.

Item Description
Month Specify the month.
Day order (week order) Specify the week within the month. Specify Last for the last week in 

the month.
Day of the week Specify the day of the week.
Hour of the day Specify the hour using a value from 0 to 23.

• Daylight savings time > End time
 Specify the date and time when daylight saving time ends. The settings here are the 

same as those for Start time.

Chapter 2 Common Operations
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2.2 Setting the Time Difference from GMT

Set the time zone of the region in which the FX will be used. Make sure to set this value 
if you are using the Internet network functions or the DST function.

Setup Screen
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Time Settings.

   

Setup Items
• Time settings > Time zone(HHMM)
 Set the time zone of the region in which the FX will be used in terms of the time 

difference from GMT. Specify a value in the range of –1300 to 1300 (where the first 
two digits denote the hour and the last two digits denote the minute). A negative value 
indicates that the local time is behind the GMT.

 Example: The standard time in Japan is ahead of the GMT by 9 hours. In this case, 
enter “900.”
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2.3 Setting the Time Correction Operation during 
Memory Sampling

This function gradually corrects the time when the time is changed while Memory 
Sampling is in progress.
For a description of the time correction operation, see section 1.10.

Setup Screen
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Time Settings.

   

Setup Items
• Time settings > Time deviation limit

   

Time deviation limit 

Current time Specified time 

 Only when the time deviation between the FX’s time and the specified time is within 
± (the value that you specify here), the FX’s time gradually corrected. Otherwise, the 
clock is corrected immediately.
Settings Description
10 s to 5 min The time deviation limit.
Off Disables the function that gradually corrects the time.

 Example:  If Time deviation limit is set to 10s and the time on the FX is 10:21:15, 
the time on the FX will be gradually corrected to the specified time if the 
specified time is between 10:21:05 and 10:21:25.
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2.4 Setting the Date Format

Select the display format of the date.

Setup Screen
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Time Settings.

   

Setup Items
• Time settings > Date format
Settings Display Example  

(Example: September 30, 2011)
Time at the grid position in the trend display 
(example: 8 O’clock on Nov. 30)*

Y/M/D 2011/09/30 09/30 08
M/D/Y 09/30/2011 09/30 08
D.M.Y 30/09/2011 30/09 08
D,M,Y 30.09.2011 30.09 08

* Only if the trend interval is set greater than or equal to 1 h/div.

 Applied Range
 The format is applied to the date displayed on the screen. It does not change the 

date format on the setup screen of the date/time, the date in the output data via 
communications, the date saved along with the data, and the date used in the data file 
names.
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2.5 Viewing the FX Information

The FX information is displayed on the system information screen and the network 
information screen.

Procedure
• Displaying System Information Screen

1. In the operation mode, press FUNC.
The Function menu appears.

2. Press the System info soft key.
The system information screen is displayed.

• Displaying Network Information Screen (/C7 option)
1. In the operation mode, press FUNC.

The Function menu appears.

2. Press the Network info soft key.
The network information screen is displayed.

Explanation
• System Information Screen

  

ANALOG: Number of measurement channels 
MATH: Number of computation channels
 (/M1, /PM1 and /PWR1 options)

MEMORY: Internal memory size

Options

MAC address
Version: Firmware version

 The following items are displayed:
 • Number of measurement channels.
 • Number of computation channels.
 • Internal memory size
 • Options
 • MAC address
 • Firmware version
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• Network Information Screen (/C7 option)

 

The following items are displayed:
 • IP address
 • Subnet mask IP address
 • Default gateway IP address
 • MAC address
 • DNS server IP address
 • Host name
 • Domain name

2.5  Viewing the FX Information
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2.6 Changing the Displayed Language

Set the displayed language.

Setup Screen
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Operating Environment.

   

Setup Items
• Operating environment > Language
 Set the displayed language to English, Japanese, German, French, Chinese, 

Italian, Spanish, Portuguese, Russian, or Korean.
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2.7 Setting the LCD Brightness and Backlight 
Saver

Change the LCD brightness. In addition, set the backlight saver function to prolong the 
service life of the LCD backlight.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Display > LCD.

   

Setup Items
• LCD > Brightness
 Select a value from 1 to 8 (2 by default). Larger the value, brighter the display 

becomes.

• LCD > Backlight saver > Mode
Settings Description
Off  Disables the backlight saver.
Dimmer Dims the display if there is no operation for a given time.
Timeoff Turns the backlight OFF if there is no operation for a given time.

• LCD > Backlight saver > Saver time
 Select a value from 1 min to 1 h. If the specified time elapses without any key 

operation or alarm occurrence, the LCD backlight switches to the specified mode.

• LCD > Backlight saver > Restore
Settings Description
Key The backlight returns to the original brightness when a key is pressed.
Key+Alm The backlight returns to the original brightness when a key is pressed or when an 

alarm occurs.

Note
• If the backlight saver function has dimmed or turned off the backlight, pressing any key on 

the FX will cause the backlight to return to its original brightness. In this operation, the key 
does not perform its intended function.

• The degradation of the brightness and the discoloration of the screen (become yellowish) 
tend to progress faster as the brightness is set higher. Extended use at an unnecessary high 
setting should be avoided. It is also recommended that you use the backlight saver function.
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2.8 Initializing Settings and Clearing the Internal 
Memory

Initialize the settings to default values. In addition, clear the data in the internal memory.
For the default settings, see appendix 4.

Setup Screen
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the File/Initialize tab1 > Initialize.

   

1 On FXs that do not have a CF card slot or USB interface (/USB1 option), this is the Initialize 
tab.

Setup Items
• Initialize

Settings Description
Clear 1 Returns the basic setting mode and setting mode settings to their default values 

and clears the data in the internal memory (measured data and computed data).
Clear 2 Returns the setting mode settings to their default values and clears the data in 

the internal memory (measured data and computed data).
Clear 3 Clears the data in internal memory (measured data and computed data).

 *  Data in internal memory that is cleared: display data, event data, manual sampled data, report 
data (/M1, /PM1, and /PWR1 options), and log information.

1. Press the Clear 1, Clear 2, or Clear 3 soft key.

2. Press DISP/ENTER.
A confirmation window opens.

3. Select Yes and press DISP/ENTER.
The specified operation is executed, and the FX returns to the operation mode.
If you do not want to initialize, select No and press DISP/ENTER.
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2.9 Using the Relay Contact to Output the FX 
Status (/F1 option)

A signal is output to a dedicated relay when an error occurs in the FX CPU. In addition, a 
signal is output to a different relay when the specified status occurs.
For a description of the FAIL/status output function, see section 1.9.

Setup Screen
• Status Relay Details
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Status Relay.

   

Setup Items
• Status Relay > Memory/Media status
 On: The status of the internal memory and the CF card is relayed.

* On FXs that do not have a CF card slot, only Memory status will be relayed.

• Status Relay > Measurement error
 On: A relay signal is output when a measurement error occurs.

• Status Relay > Communication error
 On: A relay signal is output when a communication error occurs.

• Status Relay > Memory stop
 On: A relay signal is output when memory sampling stops.

Procedure
• FAIL Output
 There are no operations that are required. A signal is output to the relay contact when 

a CPU error is detected. A signal is also output to the relay contact when the FX is 
turned off.

• Status Relay
 A signal is output to the relay contact when a specified status occurs.
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2.10 Controlling the FX with a Keyboard (/USB1 
option)

This section explains how to connect and use a USB keyboard.

Connecting and Disconnecting a Keyboard
• Connection

1. Connect the keyboard to a FX USB port.

      

USB port

When a message is displayed informing you that a USB device has been connected, the 
keyboard is ready to be used.

• Removal
 Disconnect the keyboard cable from the FX USB port.

Note
•  You can connect and disconnect a keyboard at any time, regardless of what is shown on the 

display and whether the FX is on or off.
• Use a keyboard that matches the FX language setting.
 When the FX’s display language is set to German or French, the language selection window 

(prompting you to select between German and English or between French and English) is 
displayed when you connect a USB keyboard.

•  The statuses of the Caps Lock and Num Lock keys are retained even if the USB keyboard 
is disconnected.
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Operating from the Keyboard
Use the keyboard while viewing the FX screen. When an operation can be carried out on 
the FX, the same operation can be carried out from the keyboard.
 Example: Switch to setting mode
 When the FX is in operation mode, press Ctrl+M.
 The FX switches to setting mode, and the setting menu appears.

• Mapping of the Keys on the FX to the Keys on the Keyboard
Keyboard Keys FX Keys

Keys on the Keyboard
104 Keyboard (US)for the PC
Enter DISP/ENTER
← Left arrow key
↑ Up arrow key
↓ Down arrow key
→ Right arrow key
Num Enter DISP/ENTER
Esc ESC
F1 to F5 Soft key 1 to soft key 5
F9 FUNC
F12 Hold down FUNC for 3 seconds
Left-Windows MENU
Right-Windows MENU
Ctrl+S START
Ctrl+P STOP
Ctrl+U USER
Ctrl+M MENU
Tab, Shift+Tab Arrow keys*

*  Press Tab to move the cursor to the next item, or Shift+Tab to move to the previous item. 
However, this does not work in the following screens:

  Operation screens, Menu screens for Setting mode and Basic setting mode, screens for 
entering values and characters, “Menu customize” and “Save/Load” screens in Setting mode, 
and “Load setting, Initialize” screen in Basic setting mode

• Entering Alphabets, Numbers, and Symbols
 When alphabet characters, numbers, and symbols can be entered on the FX, the 

same input can be performed from the keyboard. The operations are the same as 
normal key operations.

 Symbols That Can Be Entered Using the Keyboard
 You can enter the following symbols. However, symbols that cannot be used on the 

FX are invalid. For example, the characters *, /, :, and ? cannot be used in the data 
save destination directory name.

    #  %  (  )  *  +  -  .  /  :  ?  @  [  ]  ^  _

* Press “^” on the keyboard to enter the temperature degree symbol.

• Invalid Keys
 Keys enclosed in frames are invalid.

   

The 104 Keyboard for a PC (US) 

2.10  Controlling the FX with a Keyboard (/USB1 option)
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2.11 Using USB Flash Memory (/USB1 option)

Connecting/Removing a USB Flash Memory
• Connecting a USB Flash Memory

1. Connect a USB flash memory device to the FX USB port.
After the message, “USB device has been connected.” appears, you can use the USB flash 
memory device.

2. In operation mode, possible operations are shown. Select the desired operation 
using the arrow keys and press DISP/ENTER.

When set to auto save   When set to manual save 

    

Setting Description
Save Manual Saves unsaved data in the internal memory to a USB flash memory device.
DATA SAVE MODE Switches to the DATA SAVE MODE display. When you select DATA SAVE 

MODE, the external storage medium to save data to is fixed to the USB 
memory device. For the procedure to save the data in internal memory, see 
section 4.8.

Load Settings  Moves to the setup load display of setting mode. For the procedure to load 
the setup data, see section 6.9. 
Load Settings will not be displayed:
•  When Media/USB loading is locked (see chapter 8 for details).
•  When the FX is accessing the external storage medium (formatting, 

saving, or FTP communication).
Cancel Closes the operation selection window.

• Removing the USB Flash Memory
1. In the operation mode, press FUNC.

The Function menu appears.

2. Press the Media eject soft key and then the USB soft key.
A message “Media can be removed safely.” appears.

3. Remove the USB flash memory.

Note
Be sure to carry out the procedure above when removing the USB flash memory. If you remove 
the USB memory without performing the above procedure, the data stored on it could be 
damaged.

Saving and Loading Data
The following data save/load and file operations can be carried out.

Save/Load setup data files (see section 6.9).
Save display data and event data files (see sections 4.8 and 6.4).
Load display data and event data files (see section 6.8).
List files and delete files (see section 6.7).
Format (see section 6.7).
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2.12 Setting the Decimal Point Type

You can set the decimal point type for the display and files saved in text format.

Setup Screen
Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 
setting mode), and select the Environment tab > Operating Environment.

  

Setup Items
• Decimal Point Types

Setting Display Example
Point 1234.56
Comma 1234,56

Explanation
• Decimal Point Types
 The decimal point type setting affects the following kinds of files and displays. The 

decimal point of any file or setting not listed below (the setup screen for example) is 
displayed using a period.
Type Item
File output Manual sampled data file

Report file1

Display Trend display
Digital display
Bar graph display
Overview display
Historical trend
Stacked bar graph
Report data display1

Web page2 All channel display
E-mail2 The instantaneous value data in alarm e-mails and scheduled e-mails.

The report data in report e-mails1

1 /M1, /PM1, and /PWR1 options
2 /C7 option
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3.1 Setting the Scan Interval and the Integration 
Time of the A/D Converter

Select the scan interval and the integration time of the A/D converter.
For a description of the scan interval and the integration time of the A/D converter, see 
section 1.1.

Setup Screen
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > A/D, Memory.

   

Setup Items
• Scan interval > Scan mode
 Fixed to Normal.

• Scan interval > Scan interval
 The selectable settings appear.

• Scan interval > A/D integrate
 Select the A/D integration time as necessary. Only the selectable settings are 

displayed.
Settings   Description
Auto The FX automatically detects the power supply frequency and sets the integration 

time to 16.7 ms for 60 Hz and 20 ms for 50 Hz. Fixed to 20 ms on /P1 models 
that use the 24 VDC power supply.

50Hz Sets the integration time to 20 ms.
60Hz Sets the integration time to 16.7 ms.
100ms Sets the integration time to 100 ms (when the scan interval is 2 s or 5 s).

Chapter 3 Measurement Channels and Alarms
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3.2 Setting the Burnout Detection and the 
Reference Junction Compensation of the 
Thermocouple Input

Set the function that detects burnouts in the sensor for thermocouple input and 1-5V 
input and the reference junction compensation method of the thermocouple.

Setup Screen
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Burnout, RJC.

   

Setup Items
• First-CH, Last-CH
 Select the target channels.

• Burnout set
 Detects thermocouple and 1-5V input sensor burnouts.

Settings Description
Off Does not detect burnouts in the sensor.
Up When the sensor burns out, the measured result is set to +over range. The 

measured value displays “Burnout.”
 For 1-5V input, the FX assumes that the sensor has burned out when the 

measured value exceeds the scale upper limit by 10% of the scale width. 
(Example: When the measured value is greater than 110 when the scale is from 
0 to 100) 

Down When the sensor burns out, the measured result is set to –over range. The 
measured value displays “Burnout.”

 For 1-5V input, the FX assumes that the sensor has burned out when the 
measured value falls below the scale upper limit by 5% of the scale width. 
(Example: When the measured value is less than –5 when the scale is from 0 to 
100) 

• RJC > Mode
 Sets the reference junction compensation method of the thermocouple input. Select 

Internal or External.
Settings Description
Internal Uses the reference junction compensation function of the FX.
External Uses an external reference junction compensation function. When set to 

External, Volt is displayed.

• RJC > Volt
Settings Description
Volt     The compensation voltage to be added to the input. Set the value in the range of 

-20000 µV to 20000 µV.
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3.3 Setting the Input Range

Set the input range for each channel.
 For the power monitor (/PWR1 option) input setting procedure, see section 3.12, “Measuring 
Power.”
For the log scale (/LG1 option) range setting procedure, see section 3.13, “Using the Log Scale 
to Perform Measurements.”

Setup Screen
• Temperature Unit
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Operating Environment.

   

• Input Range for Each Channel
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Range, Alarm.

   

Setup Items
• Temperature
 Select the temperature unit. The setting is applied to all temperature measurement 

channels.
Settings Description
C Use Celsius
F Use Fahrenheit
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• First-CH, Last-CH
 Select the target channels.

• Range > Mode
Settings Description
Skip Not measured.
Volt, TC, RTD, DI, 1-5V Input type. Represents DC voltage, thermocouple, RTD, ON/OFF 

input, and 1-5V inputs, respectively.
Delta, Scale, Sqrt Difference computation, linear scaling, and square root computation.

 Set the items with check marks in the table below according to the mode value.
Setup Item Mode

Volt TC RTD DI Delta Scale Sqrt 1-5V Skip
Type  
Range        
Span Lower        
Span Upper        
Scale Lower   
Scale Upper   
Unit   
Ref.CH 
Low-cut  
Low-cut value 

3.3  Setting the Input Range
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• Range > Type
 Input type when Mode is Delta or Scale. See the description on Mode above.

• Range > Range
 Input type details.

Setting Input Type Notes Setting Input Type Notes
20mV –20.000 mV to 20.000 mVDC Standard R Type R Standard
60mV –60.00 mV to 60.00 mVDC S Type S
200mV –200.00 mV to 200.00 mVDC B Type B
1V –1.0000 V  to 1.0000 VDC K Type K
2V –2.0000 V to 2.0000 VDC E Type E
6V –6.000 V to 6.000 VDC J Type J
20V –20.000 V to 20.000 VDC T Type T
50V –50.00 V to 50.00 VDC N Type N
Pt Pt100 W Type W
JPt JPt100 L Type L
Level On/off (voltage) U Type U
Contact On/off (contact) WRe Type WRe
1-5V 0.800 V to 5.200 V

   
Setting Input Type Notes
Kp Kp vs Au7Fe /N3F 

optionPLATI PLATINEL
PR PR40-20
NiMo NiNiMo
W/WRe W/WRe26
N2 Type N (AWG14)
XK XK GOST
Ni1 Ni100 (SAMA)
Ni2 Ni100 (DIN)
Ni3 Ni120
Pt100G Pt100 GOST
Cu100G Cu100 GOST
Cu50G Cu50 GOST
Pt200W Pt200 (WEED)

• Range > Span_L, Span_U 
 Input range. The selectable range is displayed on the screen.

Note
• You cannot set the same value to Span_L and Span_U.
• When the Mode is 1-5V or Sqrt, Span_L must be less than Span_U.

• Range > Scale_L, Scale_U 
 Input range after converting the unit.
 The selectable range is from –30000 to 30000. The decimal place is determined by 

the Scale_L setting. It can be set to the following positions: “X.XXXX,” “XX.XXX,” “XXX.
XX,” “XXXX.X,” or “XXXXX.”

Note
• The FX converts the measured value to a value within the range set by the Scale_L and 

Scale_U values with their decimal points removed. For example, if the scale setting is 
“–5 to 5,” the value is converted to a value within the span of “10”; if the scale setting is “–5.0 
to 5.0,” the value is converted to a value within a span of “100.” In this case, the resolution 
of the value converted to a span of “10” is lower than the value converted to a span of “100.” 
To prevent the display from becoming rough, it is recommended that the scale be set so that 
this value is greater than 100.

• You cannot set the same value to Scale_L and Scale_U.
• When the Mode is 1-5V or Sqrt, Scale_L must be less than Scale_U.

3.3  Setting the Input Range
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• Range > Unit 
 Set the unit (up to 6 characters, A a # 1 ).

• Range > Ref. CH 
 The reference channel for difference computation.

* Note that if you set the reference channel to a channel that is set to log scale (/LG1 option), 
an error will be returned as the computation result.

• Range > Low-cut 
 Select On to use the low-cut function.

* The low-cut value for 1 to 5 V input is fixed to 0% value of the input span.

• Range > Value
 On a square root computation channel, set the low-cut value in the range of 0.0% to 

5.0% of the input span.

   

Input value 

Low-cut value 

Result of square root computation 

Measured value 

3.3  Setting the Input Range
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3.4 Setting the Moving Average of the Input

Set the moving average function of the measurement channel. This function suppresses 
the effects of noise.
For a description of the function, see section 1.1.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Moving average.

   

Setup Items

   Average value 

Scan Interval 

Count 

Average value  

• First-CH, Last-CH
 Select the target channels.

• Moving average > On/Off
 To use moving average, select On.

• Moving average > Count
 Set the number of data points of the moving average in the range of 2 to 400.
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3.5 Setting the Auxiliary Alarm Function

Set the alarm display and operation of the output relays (/A[ ] and /A4A options).
For a description of the function, see section 1.2.

Setup Screen
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Alarm > Basic settings; Switch, Relay; or 
Hysteresis.
• Basic settings    • Switch, Relay

    

• Hystersis  

   

Setup Items
• Basic settings > Reflash
 To set the reflash operation on the alarm output relay, select On. The reflash function 

is set on the first three output relays.
Setting Description
Off Reflash is not used.
On Reflash is used. The relays are deactivated for approximately 500 ms.

• Basic settings > Rate of change
 • Decrease

 Set the interval for the rate-of-change calculation of the low limit on rate-of-change 
alarm in terms of the number of sampled data points (1 to 32). The actual interval is 
obtained by multiplying the value specified here by the scan interval.

 • Increase
 Set the interval for the rate-of-change calculation of the high limit on rate-of-change 

alarm in the same manner as the interval for the low limit on rate-of-change alarm.
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• Basic setting > Indicator
 You can choose to make the alarm displays behave in the following ways.

Settings Description
Nonhold Clears the alarm indication when the alarm condition is released (returns to 

normal condition).
Hold Holds the alarm indication until an alarm acknowledge operation is performed.

• Internal Switch > AND
 Select the internal switches that are to operate using AND logic. Set the range 

of internal switches (from the first internal switch) to take the AND logic. All 
subsequent switches will be set to OR logic.

• Relay > AND
 Select the relays that are to operate using AND logic. Set the range of relays (from 

the first alarm relay) to take the AND logic. All subsequent relays will be set to OR 
logic. Available settings are None, I01 (I01 only), I01-I02 (I01 and I02), I01-I03 (I01 
to I03), etc. Only alarm output relays that are installed are valid.

Note
When reflash is turned ON, the operation of the first three output relays is fixed to OR logic. 
Specifying AND produces no effect.

• Relay > Action
 Select whether the alarm output relay is energized or de-energized when an alarm 

occurs. The setting applies to all alarm output relays.

• Relay > Hold
 You can choose to make the alarm output relays behave in the following ways. This 

setting applies to all relays.
Settings Description
Nonhold Turns the output relay OFF when the alarm condition is released (returns to 

normal condition).
Hold Holds the output relay at ON until an alarm acknowledge operation is performed.

Note
When reflash is turned ON, the operation of the first three output relays is set to nonhold. 
Specifying Hold produces no effect.

• Relay > Relay Action on Ack
 You can select the relay output status that is enabled after the AlarmACK operation 

from the following two settings.
Settings Description
Normal The relay is deactivated when the alarm ACK operation is executed. If the 

condition for activating the alarm output relay is met in the next scan interval, the 
relay is activated. 
This operation is valid only when the alarm output relay is set to Hold.

Reset The relay is deactivated when the alarm ACK operation is executed. If a new 
condition for activating the alarm output relay is met, the relay is activated.

3.5  Setting the Auxiliary Alarm Function
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 An example of the relay action when alarm ACK is executed is shown below. This 
example is for the case when the output relay AND item is set to None.

  Normal

    

Alarm ACK

Alarm output relay

Alarm 2

Alarm 1

Relay is activated in the next scan interval

Activated

Alarm 
occurrence

Alarm 
occurrence

Deactivated

  Reset

    

Alarm ACK

Relay is activated on the next alarm occurrence

Alarm output relay

Alarm 2

Alarm 1

Activated

Alarm 
occurrence

Alarm 
occurrence

Deactivated

• Hysteresis > Meas CH
 • High/Low

 Sets the hysteresis width of the alarm occurrence/release of the high/low limit alarm 
specified on measurement channels.

 Selectable range: 0.0% to 5.0% of the span or scaling width
 If you set a limit to a channel that is set to log scale (/LG1 option), the alarm 

hysteresis will be fixed to 0%.
 • Delta High/Low

 Sets the hysteresis width of the alarm occurrence/release of the difference high/low 
limit alarm specified on measurement channels.

 Selectable range: 0.0% to 5.0% of the span

• Hysteresis > Math CH (/M1, /PM1, and /PWR1 options)
 Sets the hysteresis width of the alarm occurrence/release of the high/low limit alarm 

specified on computation channels.
Selectable range: 0.0% to 5.0% of the measurement span

3.5  Setting the Auxiliary Alarm Function
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3.6 Hiding the Alarm Indication

Select whether to enable the alarm hide function.
For a description of the function, see section 1.2.

Setup Screen
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Input, Alarm

   

Setup Items
• Alarm action > No logging
 To enable the function that turns off the alarm indicator and logging, select On. The 

Detect setup item is displayed in the alarm setting screen (see section 3.7).

 This function disables the alarm indicator and the logging of alarm events to the alarm 
summary.

• Settings for Each Channel and Each Alarm
 See section 3.7.
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3.7 Setting Alarms on Channels

Set the alarms after setting the range. All alarm settings of a channel are cancelled in the 
following cases.

* For details on the log scale (/LG1 option) alarm settings, see section 3.13, “Using the Log 
Scale to Perform Measurements.”

• When the input type (Volt, TC, etc.) is changed.
• When the input range is changed.
• When the upper or lower limit of the span or scale is changed on channels that are set 

to linear scale, square root computation, or 1-5 V (including changes in the decimal 
point position).

For a description of the function, see section 1.2.

Setup Screen
• Alarms for Each Channel
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Range, Alarm.

   

• Alarm Delay Time
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Tag, Memory, Delay.
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Setup Items
• First-CH, Last-CH
 Select the target channels. The target channels are common with the other items that 

are displayed on the screen.

• Alarm > 1, 2, 3, and 4
 For each alarm, 1 to 4, select On to enable it.

• Alarm > Type
 Select the alarm type.

Settings Name  Description
H  High limit alarm  –
L  Low limit alarm  –
h  Difference high limit alarm  Can be specified on channels set to difference 

computation.
l  Difference low limit alarm  Can be specified on channels set to difference 

computation.
R  High limit on rate-of-change alarm –
r  Low limit on rate-of-change alarm –
T  Delay high limit alarm  –
t  Delay low limit alarm  –

 Alarms on channels set to difference computation are inserted at the following 
positions.

   Input value 

Measured value on the reference channel 

H, L, T, t R, r, h, l 

Measured value 
- 

• Alarm > Value
 Set the alarm value for the selected alarm type.
 When the Mode of the Channel Is Set to Volt, TC, RTD, or DI

Type Value Example of a Range of Alarm Values
H, L Value in the measurable range –2.0000 to 2.0000 V for 2 V range
R, r 1 digit to the upper limit of the width  0.0001 to 3.0000 V for 2 V range 

of the measurable range
 However, less than or equal to 30000  0.1 to 1760.0°C for thermocouple type R 

excluding the decimal point.
T, t Same as H and L. Same as H and L.

 When the Mode of the Channel Is Set to Delta
Type Value Example of a Range of Alarm Values
H, L Value in the measurable range –2.0000 to 2.0000 V for 2 V range
h, l Value in the measurable range –1760.0 to 1760.0°C for thermocouple type R
R, r  1 digit to the width of the measurable  0.0001 to 3.0000 V for 2 V range 

range 
 However, less than or equal to 30000  0.1 to 1760.0°C for thermocouple type R 

excluding the decimal point.
T, t Same as H and L. Same as H and L.

 When the Mode of the Channel Is Set to Scale, Sqrt, or 1-5V
Type Value Example of a Range of Alarm Values
H, L –5% to 105% of the scale width. –5.0 to 105.0 when the scale is 0.0 to 100.0
 However, within –30000 to 30000  –120.00 to 300.00 when the scale is –100.00 

excluding the decimal point. to 300.00
R, r Within 1 to 30000 excluding the  0.1 to 3000.0 when the scale is 0.0 to 100.0 

decimal point. 0.01 to 300.00 when the scale is –100.00 to 
 300.00  

T, t Same as H and L. Same as H and L.

3.7  Setting Alarms on Channels
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• Alarm > Relay
 Select whether to turn On or Off the relay output.

• Alarm > No.
 Set the output relay number or internal switch number when performing relay output.

• Alarm > Detect
 This item appears when the alarm hide function (see section 3.6) is turned On. Select 

whether to show or hide the alarm indication when an alarm occurs. If set to Off, a 
signal is output to the alarm output relay or internal switch when an alarm occurs, but 
it is not indicated on the screen. The alarm is also not recorded in the alarm summary.

• Alarm delay > Time (for delay high/low limit alarms)
 Set the alarm delay time to an integer in the range of 1 to 3600 s.

Note
• The alarm delay time takes on a value that is an integer multiple of the scan interval. For 

example, if the alarm delay time is set to 5 s when the scan interval is 2 s, the actual delay 
time is 6 s.

• The delay alarm has the following special operations.
• If the computation is stopped in a condition in which the computed value is exceeding the 

alarm setting when a delay alarm is set on a computation channel, the alarm is turned 
On after the specified period (delay time) elapses.

• The alarm detection operation is reset if a power failure occurs. The operation restarts 
after the power recovers.

• If the alarm setting of the delay high limit alarm is changed when an alarm is already 
activated and the input is greater than or equal to the new setting, the alarm continues. 
For all other cases, the alarm detection operation starts at the new setting. This is also 
true for the delay low limit alarm.

3.7  Setting Alarms on Channels
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3.8 Releasing the Alarm Output (Alarm ACK 
Operation)

This operation is valid when the FX is set as follows:
• When Indicator is set to Hold in the basic setting mode.
• When Relay Hold is set to Hold and Relay action on ACK is set to Normal in the 

basic setting mode.
• When Relay action on ACK is set to Reset in the basic setting mode.
 For the Hold and Relay Action on ACK setting procedures, see section 3.5.

Procedure
This operation is carried out after an alarm occurs.

1. In Operation Mode, press FUNC.
The Function menu appears.

2. Press the AlarmACK soft key.
The alarm output is released. 

Explanation
• Alarm Acknowledge (ACK) Operation
 When an alarm acknowledge operation is carried out, the indicators and outputs (relays 

and switches) of all activated alarms are cleared.
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3.9 Performing Calibration Correction (/CC1 
Option)

The input value is calibrated using segments, and the result is used as a measured 
value.

* You cannot specify calibration correction for a channel whose log scale (/LG1 option) mode 
is set to LogType2.

For a description of the function, see section 1.1.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Calibration correction.

   

Setup Items

   

True val 

Number of set points 

Calibration set points 

Y5 
Y4 

Y3 
Y2 

Y1 

MES val 

X1 X2 X3 X4 X5 

Condition 
X1 < X2 < X3 < X4 < X5 

• First-CH, Last-CH
 Select the target channels. You can set consecutive channels whose range is set to 

the same value as the first channel. 

• Number of set points
 Select the number of points that make up the segments (including the start and end 

points) in the range of 2 to 16.
 To disable calibration correction, select Off.

• Number of set points > MES val, True val
 Press the Input soft key and enter the value.
 For the MES value, set a value that is greater than the previous value.
 Press the Measure soft key to set the measured value at that point to MES val. If 

you press the Measure soft key when setting multiple channels simultaneously, the 
measured value of the first channel are set to the MES val of all channels.

 Selectable Range of MES and True Values
 • Channels on which linear scaling is specified

 –30000 to 30000 (the decimal place is the same setting as the scale value)
 • Other channels

 Value in the measurable range of the selected range
 Example: –2.0000 to 2.0000 for 2 V range

Note
• The calibration correction setting is set to Off if you change the Mode or Range setting.
• Calibration correction cannot be specified on channels set to Skip.
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3.10 Counting Pulses (/PM1 Option)

The pulses applied to the pulse input terminal are counted on a computation channel.
For a description of the function, see section 1.1.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Expression, Alarm

   

Setup Items
• First-CH, Last-CH
 Select the target computation channels.

• Math
 Select On.

• Math > Calculation expression
 Enter the equation using symbols.
 Q01 to Q08: Displays the number of pulses per second.
 P01 to P08: Displays the number of pulses per scan interval.

* The numbers 01 to 08 correspond to the pulse input terminal numbers.
 For the procedure to set the computation channels, see section 9.1.

The procedure is explained below using examples.
• Example 1: Pulse Sum Value
 Display the sum value of the pulse signal applied to pulse input terminal number 6.

   
Number of pulses  
per scan interval 

TLOG.SUM
Pulse sum value 

Pulse input 
Scan interval 

Time 

(Sum) 

P6 

 Expression
 The following table shows which calculation expression to assign to which computation 

channel. Set the span lower/upper limit and unit according to the application.
Channel Expression Description

101 TLOG.SUM(P6) Sum of the number of pulses per scan interval
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• Example 2: Number of Pulses per Minute
 Using the FX1002 (scan interval set to 250 ms), count the number of pulses received 

by pulse input terminal 6, and calculate the number of pulses per minute.

   
 
Number of pulses  
per second 

101ch 
 

102ch 
  Number of pulses  

  per minute 

Pulse input 
Scan interval 

(250 ms)

Time 

(Moving average over a minute) 

(60x) 
 

 Expression
 Assign the computation channel as shown below and set the expressions. Set the 

span lower/upper limit and unit according to the application.
Channel Expression Description

101 Q6 Number of pulses per second
102 101*K01 Number of pulses per minute

Channel Value Description
K01 60 Coefficient for converting the number of pulses 

per second to the number of pulses per minute

Channel Rolling average Description
101 Sampling interval: 1s Moving average over a minute

Number of samples: 60

 Channel
 The computation is performed in order from the channel with the smallest channel 

number in one scan interval.
 Use a channel of a channel number larger than that of the channel counting the 

number of pulses per second for the computation channel that is to calculate the 
number of pulses per minute.

• Example 3: Reset When the Pulse Sum Value Exceeds a Certain Value
 Reset the sum value when the pulse sum value exceeds a specified value (reset 

value) and carry over the value exceeding the reset value to the sum after the reset. 
Count the number of resets and calculate the total sum value up to that point.

 Expression
 Assign expressions to the computation channels as shown below and set the 

constants.
Channel Expression Application
101 ((102+P01).GE.K01)+101 Pulse sum value reset count
102 CARRY(K01):TLOG.SUM(P01) Pulse sum value
103 K01*101+102 Total sum value

Symbol Description
P01 Counts the number of pulses per scan interval.
K01 Constant. The reset value. The sum value is reset when this value is exceeded.

3.10  Counting Pulses (/PM1 Option)
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0 0 1 1 1 2 2 

 P01 
Number of pulses  
per scan interval 

102ch 
Sum value 

101ch 
Reset count 

Pulse input 
Scan interval 

Time 

 K01 
reset value 

(Resets the value below the reset value) 

(Sum) 

 Channel 101: Reset Count
 Calculates the number of times the pulse sum value is reset.
 The expression “((102+P01).GE.K01)” is set to 1 when “the previous pulse sum value 

(102) + the current pulse count (P01)” is greater than the reset value (K01). Otherwise, 
the expression is set to 0. The value of channel 101 is incremented when the pulse 
sum value exceeds the reset value.

 Channel 102: Pulse Sum Value
 Calculates the pulse sum value.
 Under normal conditions, the pulse sum value TLOG.SUM (P01) is calculated. When 

the pulse sum value is greater than or equal to the reset value (K01), the pulse sum 
value is set to the amount exceeding K01.

 Channel 103: Total Sum Value
 Multiplies the reset value (K01) by the reset count (101) and adds the pulse sum value 

(102) to derive the total sum value.

Note
• The computation is performed in order from the channel with the smallest channel number 

in one scan interval. If the channel number in the expression is greater than or equal to the 
channel number in which the expression is assigned, the previous computed result (previous 
value) is used for the channel in the expression.

• If the pulse input value of the scan interval is greater than the reset value, correct 
computation cannot be achieved.

3.10  Counting Pulses (/PM1 Option)
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3.11 Setting the Method of Detecting Over-Range 
Values of Linearly Scaled Measurement 
Channels

Setup Screen
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Input, Alarm

   

Setup Items
• Input > Value on over-range

Settings Description
Free The value is set to –over range if the value is less than –30000 and +over range 

if the value is greater than 30000 excluding the decimal point. The value is 
displayed as –Over and +Over, respectively.

Over The value is set to –over range if the value is less than –5% of the scale and 
+over range if the value is greater than 105%. The value is displayed as –Over 
and +Over, respectively.

 Example: If the scale is 0.0 to 200.0, the value is set to –over range if the value is 
less than –10.0 of the scale and +over range if the value is greater than 210.0.

* The “Value on over-range” setting is not applied to channels that are set to log scale (/LG1 
option). (See section 3.13.)

Note
For computations such as TLOG, CLOG, and report, the handling of the scale over-range value 
can be set in advance.
See section 9.1.
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3.12 Measuring Power (/PWR1 Option)

Power Monitor Function
Measure the measurement elements of electrical power. Set an expression on a 
computation channel, and then start the computation to begin the measurement.
In addition, by using other operators, you can measure the maximum, minimum, average 
and electric energy.

Measurement Element Symbol Description
Active or regenerative power WAT Power values without the low-cut 

function applied.Active power WATP
Regenerative power WATN
Reactive power VAR
Reactive power (LAG) VARP
Reactive power (LEAD) VARN
Apparent power VA
Active or regenerative power (low-cut) _WAT_ Power values with the low-cut 

function applied. The electric energy 
is measured by summing these 
measurement elements. 
The low-cut function sets the 
measured value to 0 when the 
measured value is less than the set 
low-cut power. With no load, this 
function prevents the influence of noise 
present in each measurement element 
from accumulating in the power 
consumption (Wh) calculation.

Active power (low-cut) _WATP_
Regenerative power (low-cut) _WATN_
Reactive power (low-cut) _VAR_
Reactive power (LAG; low-cut) _VARP_
Reactive power (LEAD; low-cut) _VARN_
Apparent power (low-cut) _VA_

Voltage (V1) VOL1 This is the voltage.
Voltage (V2) VOL2 This is the voltage. This is only valid 

for single-phase three-wire systems.
Voltage (V3) VOL3 This is the voltage. This is only valid 

for three-phase three-wire systems.
Current (I1) CUR1 This is the current.
Current (I2) CUR2 This is the current. This is only valid for 

single-phase three-wire systems.
Current (I3) CUR3 This is the current. This is only valid for 

three-phase three-wire systems.
Frequency HZ This is the frequency.
Power factor PF This is the power factor.

Measuring Electric Energy
The electric energy is calculated by summing the measured values of the power 
measurement channels. To avoid the influence of noise in this calculation, normally use 
the low-cut function. On the FX, sum powers to which the low-cut function has been 
applied (_WAT_, _WATP_, _WATN_, _VAR_, _VARP_, _VARN_, and _VA_ in the above 
table) to measure the electric energy. You can set the low-cut point to any value that you 
want.

• Computation Channels
 You can write expressions in computation channels to measure the electric energy. 

You have to set an expression—one which will be used to sum the measured power 
values—in a computation channel. The sum is set using the TLOG expression and 
the timer (see example 4 in this section). The TLOG expressions are shown in the 
following table.
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Measurement Element Unit Expression
Active or regenerative energy Wh TLOG.SUM(_WAT_)
Active energy Wh TLOG.SUM(_WATP_)
Regenerative energy –Wh TLOG.SUM(_WATN_)
Reactive energy (LAG: +) Varh TLOG.SUM(_VARP_)
Reactive energy (LEAD: –) –Varh TLOG.SUM(_VARN_)
Apparent energy Vah TLOG.SUM(_VA_)

• Report Function
 By using the report function, you can output electric energy as a power measurement 

channel’s hourly, daily, or monthly report. In addition, on the stacked bar graph display, 
you can also display a list of items such as the total electric energy for a month and 
the electric energy for each day of the month (see example 5 in this section).

Update Interval of Measurement Elements
The update interval for each of the power measurement elements is 1 second.

Setup Screen
• Setting the Phase, Wiring System, and Input Voltage
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Power

   

• Setting the VT Ratio, CT Ratio, and Low-Cut Power
 Press MENU (to switch to setting mode), and select the Menu tab > Power.

   

• Setting the Power Computation
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Expression, Alarm

   

3.12  Measuring Power (/PWR1 Option)
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Setup Items
• Phase and wire system
 Set the phase and wiring system by selecting from the following options: 1P2W 

(single-phase two-wire system), 1P3W (single-phase three-wire system), and 3P3W 
(three-phase three-wire system).

• Input voltage
 Set the rated input voltage to 120V or 240V.

• VT Ratio, CT Ratio, and Low-Cut Power1

 Enter values within the ranges listed below for each of the settings.
Setup Item Setting Range Description
VT ratio 1.0 to 6000.0 The setting is fixed to one decimal 

place.
CT ratio 0.05 to 999.99

1000.0 to 9999.9
10000 to 32000

The setting range varies depending on 
the decimal place.

Low-Cut Power1 0.05 to 20.00 Set this value as a percentage of the 
rated power.2 The setting is fixed to 
two decimal places. This is applied to 
all measurement elements to which 
the low-cut function has been applied 
(_WAT_, _WATP_, _WATN_, _VAR_, 
_VARP_, _VARN_, _VA_).

1 This feature sets the active power (regenerative electric power), reactive power (LEAD/
LAG), or apparent power to 0 when the value becomes less than the set value of the low-cut 
power.

2 The rated power is determined by the phase, wiring system, and input voltage. (See “Power 
Monitor (/PWR1)” in section 13.5, “Options.”)

Note
• If the phase and wiring system is set to 1P3W, you can only set the input voltage to 240V. If 

you select a different value, it will be automatically changed to 240V.
• When you change the phase and wiring system, the VT ratio, CT ratio, and low-cut power 

settings under Power on the setting menu tab will be initialized, so set these settings again.
• Set the VT ratio and CT ratio so that they meet the following condition.

 Secondary rated power × 1.2 × VT ratio × CT ratio < 10 GW.

• First-CH, Last-CH
 Select the target computation channels.

• Math On/Off
 Select On.

• Math > Calculation expression
 Use symbols to enter the equation.
  For the computation channel setting procedure, see section 9.1.

Note
 Voltage V2 and current I2 are only valid for single-phase three-wire systems. Voltage V3 

and current I3 are only valid for three-phase three-wire systems. In other situations, you can 
set expressions so that they use invalid values, but if you do, an error will be returned as the 
measured result.

Set the following settings as necessary.

• TLOG
 This sets the method that is used to sum the powers for measuring the electric energy.
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

TLOG, Rolling average.
 For the computation channel setting procedure, see section 9.1.

3.12  Measuring Power (/PWR1 Option)
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• Timer
 This sets the timer that is used in TLOG computations (this is used when you are 

resetting the electric energy after the specified time has elapsed).
 Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event 

action > Timer.
 For the timer setting procedure, see section 7.1.

• Alarm
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Expression, Alarm.
 For the computation channel setting procedure, see section 9.1.

• Constant
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Constant.
 For the computation channel setting procedure, see section 9.1.

• Report
 For the report creation setting procedure, see section 9.5.

3.12  Measuring Power (/PWR1 Option)
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Examples of power measurement expressions are given below.

• Example 1: Active power
 Expression

Channel Expression Unit Description
101 WATP W Active power (W)

• Example 2: Voltage 1
 Expression

Channel Expression Unit Description
101 VOL1 V Input voltage (V) of 

voltage 1

• Example 3: Current 1
 Expression

Channel Expression Unit Description
101 CUR1 A Input current (A) of 

current 1

• Example 4: Active energy
 The following is an example of active energy that is calculated with a certain number 

of significant digits. When the active energy reaches the maximum value that can 
be indicated with the available number of digits, the value wraps around, like a 
commercial energy meter. In this example the active energy is calculated in the range 
of 0000.000 [kWh] to 9999.999 [kWh]. When the active energy reaches 9999.999 [kWh], 
it is restarted from 0000.000 [kWh].

 Expression
Channel Expression Unit Span Description
101 _WATP_*K01 (User-

specified)
0000.000 
to 
9999.999

The low-cut power (kW)

102 CARRY(K02):TLOG.
SUM(101)

kWh 0000.000 
to 
9999.999

The active energy that wraps 
around at a certain value (kWh)

 Constant
Constant Number Value Description
K01 0.001 Constant used to convert the value to kW
K02 10000 Threshold value to reset

 TLOG Settings
Channel Timer No. Sum Scale Reset Description
102 (User-

specified)
/h Off This is the sum scale. When settings are 

reset, this is set to Off.

Note
When you are performing an electric energy measurement that uses TLOG, use one of the 
following methods to ensure that a computation overflow does not occur. When a computation 
overflow occurs, the value is not automatically reset.
• Use the CARRY operator so that the value will be reset when it exceeds a specified value (see 

example 4).
• Reset the value at the specified time.

In this situation, change the settings in example 4 as shown below.
Operator: Remove the CARRY operator from channel 102.

 TLOG settings: Specify the timer number, and turn reset on. Use the timer settings for 
the timer specified in the TLOG settings to specify when the value will be reset (see 
section 7.1).

3.12  Measuring Power (/PWR1 Option)
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• Example 5: Using the stacked bar graph display of the report function
 Measure the active power, and create monthly and daily reports for that value. The 

sum of the reports will be the electric energy. You can use the stacked bar graph of 
the report data to display the total electric energy for a month and the electric energy 
for each day.

 For information on the stacked bar graph display, see section 4.10.

   

Active energy for each day Active energy for one month

 Expression
Channel Expression Unit Description
101 _WATP_*K01 kWh The low-cut power (kWh)*
* The unit will be displayed on the stacked bar graph, so set the unit string to “kWh.”

 Constant
Constant Number Value Description
K01 0.001 Constant used to convert the value to kW

 Set the report data that will be displayed on the stacked bar graph as shown below.
 For the report creation setting procedure, see section 9.5.

 Basic Report Settings
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Report > Basic settings.
Report Kind Date Time (Hour)
Daily and monthly reports 1 0

 The daily report is created at 00:00 every day. The monthly report is created at 00:00 
on the first day of every month.

 Report Settings
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Report settings. 
Report Channel 
Number

On or Off Channel Sum Scale

R01 On 101 /h
R02 to R06* Off
*  Report channels R01 to R06 can be shown on the stacked bar graph display. If you only 

want to display R01, set R02 to R06 to Off. If you are using channels R02 to R06, set the 
units of these channels to units that are different than the R01 channel unit.

3.12  Measuring Power (/PWR1 Option)
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Note
If a malfunction is detected in the power monitor function, the following will occur.
• All the power measurement elements will become error data.
• The computation icon will be displayed in red (section 1.3).
• “Detecting measurement error” in the communication status information becomes “1.”

 For information on the communication status information, see section 5.2 in the 
Communication Interface Manual, IM 04L21B01-17EN.

3.12  Measuring Power (/PWR1 Option)
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3.13 Using the Log Scale to Perform Measurements 
(/LG1 Option)

Log Scale Display Function
You can apply a logarithmic voltage that has been converted from a physical value to the 
FX, and then use the FX’s log scale (logarithmic scale) to display and record the physical 
value. The FX supports four types of input signals.
• Logarithmic Input
 This is referred to as “log input.” Log input is input in which the voltage corresponds 

to logarithmic values of physical values.

• Input That Is Linear on a Logarithmic Scale
 Log linear input is input in which the voltage values correspond to the logarithmic 

values of physical values at each decade division (for example, 1 × 102) and in which, 
within each decade, the voltage values correspond linearly to physical values.

• Pseudo Log Input
This input supports pseudo logs.

• Nonlinear Log Input
 This input supports nonlinear logs on which calibration correction (/CC1 option) is 

applied. Calibration correction is performed using voltage values.

On the trend display, the FX displays waveforms with the log scale. Digital values are 
displayed as exponents (for example, 1.2E+03).

  

Log scale

Digital values

Restrictions
Partial
You cannot set the partial display on a channel that is set to log scale.

Differential Computation between Channels
If you set the reference channel of a differential computation between channels to a 
channel that is set to log scale, an error will be returned as the measured result of the 
differential computation between channels.

Calibration Correction (/CC1 option)
You cannot set calibration correction on a channel whose log scale mode is set to 
LogType2.

Computation Channels (/M1, /PM1, and /PWR1 options)
Do not include channels that are set to log scale in a computation channel expression. If 
you include these channels, an error will be returned as the measured result.

Report Function (/M1, /PM1, and /PWR1 options)
You cannot create reports for channels that are set to log scale. An error will be returned 
as the result of report computations on channels that are set to log scale.
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Setup Screen
Input Range and Alarms
Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 
Range, Alarm.

  

Color Scale Band
Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 
Color scale band.

  

Number of Digits in the Mantissa of Digital Values, Input (LogType2 Type)
Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 
setting mode), and select the Environment tab > LOG Input.

  

Note
LogType2 in basic setting mode can be set to Linear or Pseudo.
For details on how to configure pseudo log of LogType2 and nonlinear log of LogType1, see the 
Setup Examples in this section.

3.13  Using the Log Scale to Perform Measurements (/LG1 Option)
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Setup Items
• Input Range

• First-CH, Last-CH
 Select the target channels.

• Range > Mode
Setting Name
LogType1 Log input (Nonlinear log input is possible through the use of calibration correction.)
LogType2 Log linear input or pseudo log input.

• Range > Range
Set the range to 20mV, 60mV, 200mV, 2V, 6V, 20V, 50V, or 1V.

• Range > Span_L and Span_U
 Set the settable range for the Range setting. You have to set these settings so that 

Span_L is less than Span_U.

• Range > Scale_L, Scale_U
 Set the values by specifying the mantissas and exponents. Set the mantissas with 

two decimal places.

 When Mode is LogType1
 Set the settings so that Scale_L is less than Scale_U. Set the mantissas to values 

in the range of 1.00 to 9.99. Set the mantissas using three digits. 

Mantissa of Scale_L Setting Range
1.00 1.00E–15 to 1.00E+15. However, the difference between the 

exponents must be at least 1.
The scale width must be 15 decades or less.

Scale_L Scale_U Notes
Example 1.00E+01 1.00E+02
Examples of 
invalid settings

1.00E+01 2.00E+01 The difference 
between the 
exponents is less 
than 1.

1.00E–01 1.00E+15 The scale width 
is greater than 15 
decades.

A value other than 1.00 1.01E–15 to 1.00E+15. However, the difference between the 
exponents must be at least 2.
The scale width must be 15 decades or less.

Scale_L Scale_U Notes
Examples 2.00E+01 1.00E+03

2.00E+00 5.00E+14
Example of invalid 
settings

2.00E+01 7.00E+02 The difference 
between the 
exponents is less 
than 2.

2.00E–01 1.00E+15 The scale width 
is greater than 15 
decades.

2.00E+03 2.00E+15 The upper limit 
is greater than 
1.00E+15.

3.13  Using the Log Scale to Perform Measurements (/LG1 Option)
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 When Mode is LogType2 (Log linear input)
 You can set the settings so that Scale_L is less than Scale_U or so that Scale_L 

is greater than Scale_U. Set the mantissas to values in the range of 1.00 to 9.99. 
Set the mantissas using three digits. The mantissa that you set for Scale_L is 
automatically set as the mantissa of Scale_U.

Mantissa of Scale_L Setting Range
1.00 1.00E–15 to 1.00E+15. However, the difference between the 

exponents must be at least 1.
The scale width must be 15 decades or less.

Scale_L Scale_U Notes
Examples 1.00E+01 1.00E+02

1.00E+15 1.00E+00
Example of 
invalid settings

1.00E–01 1.00E+15 The scale width 
is greater than 
15 decades.

A value other than 1.00 1.01E–15 to 9.99E+14. However, the difference between the 
exponents must be at least 1.
The scale width must be 14 decades or less.

Scale_L Scale_U Notes
Examples 1.33E+01 1.33E+02

1.33E+00 1.33E+13
1.33E+13 1.33E+00

Examples of 
invalid settings

1.33E–15 1.33E+00 The scale width 
is greater than 
14 decades.

1.33E+03 1.33E+15 The upper limit 
is greater than 
9.99E+14.

The scale displayed on the FX is zoomed in until the value that is 
less than the lower scale limit and whose mantissa is 1.00 and the 
value that is greater than the upper scale limit and whose mantissa is 
1.00 are displayed. See Example 4 under Scale Examples.

3.13  Using the Log Scale to Perform Measurements (/LG1 Option)
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 Scale Examples
 Examples of scales are shown below.

 Example 1
 In this example, the mantissa of the scale lower limit and the mantissa of the scale 

upper limit are both 1.
Lower Upper

Scale 1.00E+01 1.00E+04

     

 Example 2
 In this example, the mode is set to LogType1, and the mantissa of the scale lower 

limit and the mantissa of the scale upper limit are both a value other than 1.
Lower Upper

Scale 5.00E+00 2.00E+04

     

 The end points of the scale are displayed using single digits if there is space to 
display them.

 Example 3
 In this example, the mode is set to LogType2, and the settings are set so that 

Scale_L is greater than Scale_U. The input voltage (between Span_L and Span_U) 
is between 1 V and 5 V.

Lower Upper
Span 1 V 5 V
Scale 1.00E+04 1.00E+01

     

1 V

Scale

5 V

 Example 4
 In this example, the mode is set to LogType2, and the mantissa of the scale lower 

limit and the mantissa of the scale upper limit are both a value other than 1. The 
scale displayed on the FX is zoomed in until the value that is less than the lower 
scale limit and whose mantissa is 1.00 and the value that is greater than the upper 
scale limit and whose mantissa is 1.00 are displayed. Only the scale is zoomed in. 
Span_L equals Scale_L, and Span_U equals Scale_U.

Lower Upper
Span 1 V 5 V
Scale 1.33E+01 1.33E+04
Scale displayed on the FX 1.00E+01 1.00E+05

     
10 1 10 2 10 3 105Pa 10 4

5 V (1.33E+04)

Scale

1 V (1.33E+01)

Note
Regarding Log Scale Over-range
A value less than –5% of the voltage span is a negative over-range, and a value greater than 
105% of the scale is a positive over-range. They are displayed as –Over and +Over. The “Value 
on over-range” setting (see section 3.11) is not applied to channels that are set to log scale.
Example: If the span lower limit is set to 0 V and the span upper limit is set to 10 V, a value less 

than –0.5 V will result in “–Over” being displayed. A value greater than 10.5 V will result in 
“+Over” being displayed.

3.13  Using the Log Scale to Perform Measurements (/LG1 Option)
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• Range > Unit
 Set the unit (up to 6 characters, A a # 1 ).

• Alarm
  For details on items other than those listed below, see section 3.7, “Setting Alarms on 

Channels.”
• Alarm > Type
 The alarm types that you can select from are high limit alarm (H), low limit alarm (L), 

delay high limit alarm (T), and delay low limit alarm (t).
• Alarm > Value
 Set the alarm value by specifying the mantissa and exponent. The range is 1.00E–16 

to 1.00E+16. Set the mantissas to values in the range of 1.00 to 9.99.

Note
• If you set the number of mantissa display digits to 2, the second decimal place of the 

mantissa will be ignored. When you set the number of mantissa display digits to 2, set the 
second decimal place of the mantissa of the alarm value to 0.

 Example: If you set the alarm value to “1.56E+12,” the actual value will be “1.5E+12.”
• The alarm hysteresis on channels that are set to log scale is fixed to 0%. The alarm 

hysteresis setting (see section 3.5) is not applied to channels that are set to log scale.

• Color Scale Band
 For details on items other than those listed below, see section 5.8, “Displaying Alarm 

Point Marks and Color Scale Band on the Scale.”
• Display Position > Lower and Upper
 Set the display position by specifying the mantissas and exponents. The range is 

1.00E–16 to 1.00E+16. Set the mantissas to values in the range of 1.00 to 9.99. 
Set the settings so that Lower is less than Upper.

• Display digits > Digits
 You can set the number of digits in the mantissa of digital values to 2 or 3.
 Example: If the number of mantissa display digits is 2, “1.2E+02.” If the number of 

mantissa display digits is 3, “1.23E+02.”

 This setting also affects the alarm values in the alarm settings. See the Note under 
“Alarm” above.

• Input > LOG 
 You can select the LogType2 from Linear or Pseudo.

Linear: Sets a log linear input to LogType2 mode in the range setting.
Pseudo: Sets a pseudo log input to LogType2 mode in the range setting.
This setting applies to all channels.

3.13  Using the Log Scale to Perform Measurements (/LG1 Option)
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Setup Examples
LogType2 [pseudo log] and LogType1 [nonlinear log] setup examples are shown below.

• Setting the Pseudo Log Range (LogType2)
 This setting is for logging the pseudo log output (see the table below) of a vacuum gauge.

Pressure Reading [Pa] Output Voltage [V] Pressure Reading [Pa] Output Voltage [V]
1.30x10-7 0.13 5.00x10-4 3.50
5.00x10-7 0.50 1.00x10-3 4.10
1.00x10-6 1.10 5.00x10-3 4.50
5.00x10-6 1.50 1.00x10-2 5.10
1.00x10-5 2.10 5.00x10-2 5.50
5.00x10-5 2.50 1.00x10-1 6.10
1.00x10-4 3.10 9.90x10-1 6.99

1 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to 
basic setting mode), and select the Environment tab > LOG input

 Set LogType2 under Input to Pseudo.

   

2 Press MENU (to switch to setting mode), and select the Menu tab > Meas 
channel > Range, Alarm.

   

Set the range as shown below.
Mode: LogType2
Range: 20V
Span: Lower 0.000, Upper 7.000
Scale: Lower 1.00E-7, Upper 1.00E0

Display Example

   

3.13  Using the Log Scale to Perform Measurements (/LG1 Option)
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3.13  Using the Log Scale to Perform Measurements (/LG1 Option)

Note
•  Set the mantissa to 1.00.
•  The output voltage for pressure reading whose mantissa is 1.00 has a certain deviation.
 For example, if the pressure reading is 1.00E-5, the output voltage is 2.00 to 2.10 V. In this 

situation, set the range to the minimum value (2.00 V).

• Setting the Nonlinear Log Input (LogType1)
 To support the nonlinear output of vacuum gauges, use the calibration correction 

function (/CC1) to correct the recorder input values with linear approximation.
Conceptual Diagram
 The pressure scale is mapped to an input scale that has been multiplied by a constant 

number to derive the output scale.

   

10

9

8

7

6

5

4

3

2

1

0 1 2 3 4 5 6 7 8 9 10

10-1 10 0 10 1
0

10 2 10 3

Input value [V]

Pressure scale

Output scale

Output value [V]

1 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel 
> Range, Alarm.

   

 Set the range as shown below. To use the calibration correction function (/CC1 
option), be sure to set the mode to LogType1.

Mode: LogType1
Range: 20V
Span: Lower 0.000, Upper 10.000
Scale: Lower 1.00E-1, Upper 4.00E+3

 For the span and scale, assign the boundary values of the output scale and pressure 
scale in the conceptual diagram.
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2 Configure calibration correction. Press MENU (to switch to setting mode), and 
select the Menu tab > Meas channel > Calibration correction.

   

 Set points for the calibration correction
 Set the “MES val” values to the input scale values at the starting points of each line 

and the “True val” values to the output scale values at the starting points of each line.

Number of 
set points

MES 
value [V]

True 
value [V]

Number of 
set points

MES 
value [V]

True 
value [V]

1 0.25 1.30 6 4.00 6.60
2 0.45 2.80 7 7.48 8.30
3 0.70 3.70 8 8.52 9.00
4 1.80 5.10 9 9.25 9.40
5 2.50 5.70 10 9.50 9.80

Note
For details on calibration correction (/CC1 option), see section 3.9.

3.13  Using the Log Scale to Perform Measurements (/LG1 Option)
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4.1 Operations in Operation Mode

Switching the Screen with the DISP/ENTER Key and Arrow Keys
Press DISP/ENTER and arrow keys to show the display selection menu and sub menu 
to switch the display. The flow of operation is indicated below.

TREND

GROUP 1 GROUP 10

GROUP 10

GROUP 1 GROUP 10

DIGITAL

BAR

OVERVIEW

INFORMATION

TREND
HISTORY

LOG

Login log, error log, communication log,
FTP log, Web log, e-mail log, SNTP log,
DHCP log,  Modbus status log

ALARM
SUMMARY

MESSAGE
SUMMARY

MEMORY
SUMMARY

MODBUS
MASTER
MODBUS
CLIENT

GROUP 1

DISP/ENTER key and arrow keys
Sec. 4.2

Sec. 4.2

Sec. 4.2

Sec. 4.5

To display it, 
see section 5.16.

The Log menu is not displayed with the default settings.

Display selection menu
Sub menu

Sec. 4.6 Sec. 4.7 Sec. 4.8

REPORT DATA

COLUMN BAR

RELAY
Sec. 4.5

Sec. 4.10

Sec. 4.5

Sec. 4.4

Sec. 4.3

Sec. 4.9
The Modbus master and client and relay status 
are not displayed with the default settings.

To display these items, 
see section 5.16.

Chapter 4 Switching Operation Screens
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Operations Using Other Keys

  

FUNC key (see below)

Soft keys (see below)

USER key (see section 7.1)
START and STOP keys (see section 6.4)

Operation Using the FUNC Key
 Press FUNC to display the Function menu at the bottom of the screen. Press the Next 

soft key to switch the menu. Press the desired soft key.

 

Function menu
(Select using the soft keys)

Next soft key

Menu Item Refer to
Alarm ACK Section 3.8
Message Section 5.4
Free message Section 5.4
Media eject Sections 6.4 and 2.11
Snap shot Section 6.6
Manual sample Section 6.5
Trigger Section 6.4
Save display Section 6.4
Save event Section 6.4
Save stop Section 4.8
Math start/stop Section 9.4
Math reset Section 9.4
Math ACK Section 9.4
Timer reset Section 7.1
Keylock Section 8.1
Logout Section 8.3
Password change Section 8.3
Normal speed/Second speed Section 5.3
Batch Section 6.3
Text field Section 6.3
Standard display Section 5.14
System info Section 2.5
Network info Section 2.5
SNTP IM 04L21B01-17EN
E-Mail start/stop IM 04L21B01-17EN
E-Mail test IM 04L21B01-17EN
FTP test IM 04L21B01-17EN

4.1  Operations in Operation Mode
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Customizing the Menus
 You can change the contents of the display selection menu, which appears when you 

press the DISP/ENTER key, and the Function menu, which appears when you press 
the FUNC key.

 See section 5.16.

4.1  Operations in Operation Mode
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4.2 Displaying the Measured Data as Waveforms, 
Values, or Bar Graphs 

This section explains how to use the trend, digital, and bar graph displays.
For a description of the function, see section 1.3.

Procedure
• Showing the Display

1. Press DISP/ENTER to show the display selection menu.

2. Press the arrow keys to select TREND, DIGITAL, or BAR, and press DISP/
ENTER.
The selected display appears.

• Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.

2. Press the right arrow key to display the sub menu.

3. Press the up and down arrow keys to select the sub menu item.

  

SCALE ON: Displays the scale
SCALE OFF: Clears the scale

ALL CHANNEL: Displays the waveforms of all
 channels
GROUP CHANNEL: Displays the waveforms of the
 channels registered to groups

DIGITAL OFF: Clears the numeric display section
DIGITAL ON: Displays the numeric display section

MESSAGE DISP1: Displays the messages using 
 display method 1
MESSAGE DISP2: Displays the messages using 
 display method 2

AUTO SCROLL ON: Automatically switches the
 displayed groups
AUTO SCROLL OFF: Does not automatically switch
 the displayed groups

Group name: Displays the group

Trend display sub menu

TREND SPACE ON: Inserts a space at the right edge 
 (horizontal display) or
 the top edge (vertical display) in
 the waveform display area
TREND SPACE OFF: Does not insert a space
(Not displayed with the default settings. To display these items, 
see section 5.16.)
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Digital display sub menu

AUTO SCROLL ON: Automatically switches the
 displayed groups
AUTO SCROLL OFF: Does not automatically switch
 the displayed groups

Group name: Displays the group

       

Bar graph display submenu

Group name: Displays the group

AUTO SCROLL ON: Automatically switches the
 displayed groups
AUTO SCROLL OFF: Does not automatically switch
 the displayed groups

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

•  Starting the Waveform Display of the Trend Display/Stopping the 
Waveform Updating

 Press START to start the waveform display of the trend display. Press STOP to stop 
the waveform updating.

• Writing Messages
 See section 5.4.

• Switching the Displayed Group Using Arrow Keys
 Press the right arrow key to switch the displayed group in ascending order. Press the 

left arrow key to switch the displayed group in reverse.

•  Switching the Trend, Digital, and Bar Graph Displays Using the Arrow 
Keys

 Press the down arrow key while showing the trend, digital, or bar graph display to 
switch the display in the order trend, digital, bar graph, trend, and so on. Press the up 
arrow key to switch the display in reverse order.

4.2  Displaying the Measured Data as Waveforms, Values, or Bar Graphs 
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Explanation
• ALL CHANNEL/GROUP CHANNEL on the Trend Display
 On the group display, the channels that are assigned to the group are displayed. In 

all channel display, the waveforms of all channels that are configured to record data 
are displayed on the current group display. The waveforms of channels that are not 
assigned to the group are displayed in the waveform display area, but the scales, 
current value marks, and digital values of the channels are not displayed. 

• SCALE ON/OFF and DIGITAL ON/OFF on the Trend Display
 Select whether to show or hide the scale and numeric display sections.

• AUTO SCROLL ON/OFF
 The displayed groups can be automatically switched at a specified interval by 

selecting AUTO SCROLL ON. The display switches in ascending group order.
 For the procedure to set the auto scroll interval of groups, see section 5.13.

• MESSAGE DISP 1 and MESSAGE DISP 2 on the Trend Display
 Switches the message display method.

• TAG DISPLAY ON/OFF
 Tags are displayed with a fixed character length of 16 characters.
 The figure below shows an example for when six channels are being displayed.

   Tag  

   Tag  

   
Tag

 

4.2  Displaying the Measured Data as Waveforms, Values, or Bar Graphs 



Sw
itching O

peration Screens

4-7IM 04L21B01-01EN

3

2

1

4

5

6

7

8

9

10

11

12

13

14

App

Index

• TREND SPACE ON/OFF
 With TREND SPACE ON

   

Space

4.2  Displaying the Measured Data as Waveforms, Values, or Bar Graphs 
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4.3 Displaying Past Measured Data (Historical 
Trend Display)

There are five methods to display the past measured data.
For a description of the function, see section 1.3.
Recall from the display selection menu (see this section).
Display from the alarm summary (see section 4.6).
Display from the message summary (see section 4.7).
Display from the memory summary (see section 4.8).
Show the measured data stored on an external storage medium (see section 6.8).

Procedure
• Showing the Display
 Carry out the procedure below while memory sampling is in progress.

1. Press DISP/ENTER to show the display selection menu.
2. Press the arrow keys to select TREND HISTORY, and press DISP/ENTER.

The display appears.

• Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.
2. Press the right arrow key to display the sub menu.
3. Press the up and down arrow keys to select the sub menu item.

  

ALL CHANNEL: Displays the waveforms of all channels
GROUP CHANNEL: Displays the waveforms of the
 channels registered to groups

CURSOR TIME ON: Displays the time at the cursor position.
 When the trend display direction is vertical: 
 Upper right
 When the trend display direction is horizontal: 
 Lower right
CURSOR TIME OFF: Displays the date/time of the data at the
 right edge of the screen.

Group name: Displays the group

Historical trend display sub menu

MESSAGE DISP2: Displays the messages using 
 display method 2
MESSAGE DISP1: Displays the messages using 
 display method 1

SCALE ON: Displays the scale
SCALE OFF: Clears the scale

CURSOR VALUE: With display data, shows the maximum
 data value at the cursor position. With
 event data, shows the data at the cursor
 position.
DIGITAL MAX/MIN: Displays the maximum and minimum
 values at the cursor position and the
 maximum and minimum values within
 the displayed data in the digital value
 display area.
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Displays the alarm summary contained in the loaded data file

Switches to the specified display

Returns to the display that was shown before the historical trend

Displays the message summary contained in the loaded data file
Displays information about the loaded data file

Historical trend display sub menu

Expands or reduces the time axis

4.3  Displaying Past Measured Data (Historical Trend Display)
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INFORMATION: Shows information about the measured
 data that is currently displayed

For an explanation of the other menu items, see section 4.6.

Sub menu when the alarm summary is being displayed

Sub menu when the message summary is being displayed

INFORMATION: Shows information about the measured
 data that is currently displayed

For an explanation of the other menu items, see section 4.7.

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

4.3  Displaying Past Measured Data (Historical Trend Display)
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• Moving the Cursor and Scrolling the Waveform

   

Cursor

Cursor value mark

Moves the cursor up by 1 dot. 

Moves the cursor down by 1 dot. 

Hold down an arrow key to move 
the cursor by 1 division at a time.

Use the left and right arrow keys on the horizontal trend display. 

• Displaying the Continuing Data
 Approximately one screen of data is shown on the historical trend display. The 

continuing data can be shown as follows:

Move the cursor to the end of the waveform and
continue to press the arrow key to shift a half a
page and display the continuing data.

Move the cursor to the end of the waveform and
continue to press the arrow key to shift a half a
page and display the continuing data.

Use the left and right arrow keys on the horizontal trend display.

 Displayed

• Specifying the Display Range
 Specify the display range. Items inside the parentheses are for the horizontal trend 

display.
* When you clear the scale (see page 4-8), the screen switching icons appear in its place.

1. Press the right (up) arrow key.
The waveform of the entire data range is displayed at the right (top) section of the screen.

     
All data display 
(all of the data in the display memory)

Displayed highlighted. 
These icons are not displayed if the scale 
is displayed.

Frame indicating the display range

Loads as much of the continuous data as  
the display memory can hold and shows 
the data when switching to the all data 
display.

2. Press the up and down (left and right) arrow keys to set the display position 
by moving the frame that indicates the display range. If you hold down one of the 
arrow keys, the frame that indicates the display range will move continuously in 
the direction of the arrow that you hold down.

3. Press the left (down) arrow key.
The specified range is displayed.

4.3  Displaying Past Measured Data (Historical Trend Display)
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• If the Data Does Not Fit in the All Data Display
 Specify the range to be displayed in the all data display.
 Below is the procedure to display data that is older than the data displayed currently. 

Items inside the parentheses are for the horizontal trend display.

1. Press the right (up) arrow key.
The waveform of all the data in the display memory is displayed at the right (top) of the 
screen. At the same time, the data area in the internal memory that can be loaded is 
displayed. In addition, the data position of 8 MB that is displayed in the all data display is 
indicated using a rectangular frame in the loadable data area.

     

All data display
(all the display data in the display memory
amounting to 8 MB)
The green arrow indicates that loadable 
data exists in the arrow direction.
A frame indicating the 8 MB that is shown 
in the all data display.
A frame indicating the range shown in the 
screen.

Loadable data in the internal memory

2. Press the down (left) arrow key to move the frame indicating the display range 
to the edge of the all data display. If you press the down (left) arrow key again, 
the message “Overwrite old data?” appears.

3. Select Yes and press DISP/ENTER to replace 4 MB of data in the display 
memory.

4. Press the up/down (left/right) arrow key to move the frame indicating the 
display range to specify the range you want to display.

5. Press the left (down) arrow key.
The specified range is displayed.

•  Dividing the Screen into Halves and Displaying the Current Trend and 
Historical Trend Simultaneously

 This operation is possible only when the historical trend of the display data is being 
displayed. Items inside the parentheses are for the horizontal trend display.
* This operation is not possible when the scale is displayed.

 Press the left (down) arrow key.
 The current trend is displayed in the top half (right half), and the historical trend is 

displayed in the bottom half (left half) of the screen.

   

Current trend

Historical trend

 To revert to the original screen, press the right (up) arrow key.

• Writing Add Messages
 For the operating procedure, see section 5.4.

4.3  Displaying Past Measured Data (Historical Trend Display)
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Explanation
• ALL CHANNEL/GROUP CHANNEL
 In the group display, the waveforms of the channels that are registered to the group 

are displayed. In the all channel display, the waveforms of all channels that have 
been set to be recorded are displayed on the current group display. The waveforms 
of channels that are not registered to the group are displayed, without any additional 
information, in the waveform display area. 

 The waveforms of all
channels are displayed.

• SCALE ON/OFF
 Select whether to display the scale. The current value mark of the scale indicates the 

value at the cursor position.
 With SCALE ON    With SCALE OFF

   Scale

Cursor position mark

 
Time axis

Time axis expansion/reduction rate

Screen switching icons

• MESSAGE DISP 1, MESSAGE DISP 2
 Switch between message displays.

• CURSOR VALUE/DIGITAL MAX/MIN
 Switch between numeric displays.
 With DIGITAL MAX/MIN  With CURSOR VALUE

   

The maximum and minimum measured
values at the cursor position

The maximum and minimum values in 
the current display

 

Display data: Shows the maximum value at 
the cursor position

Event data: Shows the measured value at the 
cursor position

4.3  Displaying Past Measured Data (Historical Trend Display)
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• CURSOR TIME
 With CURSOR TIME ON

   The time at the
cursor position

• TIME AXIS > ZOOM+ and ZOOM-
The time axis can be expanded or reduced around the cursor position.
• Display data:  2 times the trend display to 1/60 minimum
• Event data:  Reduction only, up to 1/60 minimum
 The minimum magnification and the factor by which the display can be expanded 

or reduced with one operation vary depending on the trend interval for the display 
data and on the sampling interval for the event data. To expand or reduce further, 
repeat the procedure.

With TIME AXIS ZOOM+  With TIME AXIS ZOOM-

    

4.3  Displaying Past Measured Data (Historical Trend Display)
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• INFORMATION (Information on the Displayed Measured Data)
 The following information is displayed.

   

Page switch mark
Use the left and right arrow keys to switch
the page.

Display Description
File name Data in the internal memory is displayed as “Memory.” For a file on 

the external storage medium, the file name is displayed.
File type Display corresponds to display data, and Event corresponds to 

event data.
Serial number The serial number of the FX that was used.
Batch number, Lot number Displayed when the file is created using the batch function.
Start time, End time The start time and end time of recording.
User name Name of the user who performed the operation. Displayed when the 

login function is used.
Comment    A comment (when the batch function is in use).
Text field     A text field (when the batch function is in use).

Note
When measured data on the external storage medium is displayed, the serial number 
corresponds to that of the FX that was used to save the data.

• Background Color of the Historical Trend
 You can change the background color of the historical trend.
 For setting procedure, see section 5.12. 

4.3  Displaying Past Measured Data (Historical Trend Display)
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4.4 Display the Statuses of All Channels on One 
Screen (Overview Display)

This section explains how to use the overview display.
For a description of the function, see section 1.3.

Procedure
• Showing the Display

1. Press DISP/ENTER to show the display selection menu.

2. Press the arrow keys to select OVERVIEW, and press DISP/ENTER.
The display appears.

• Changing the Displayed Contents
1. Press DISP/ENTER to show the display selection menu.

2. Press the right arrow key to display the sub menu.

3. Press the up and down arrow keys to select the sub menu item.

     

Overview display sub menu

JUMP TO TREND: Switches to the trend display of
 the smallest group number that
 includes the channel selected
 with the cursor.

JUMP TO ALM SUM: Switches to the alarm summary

CURSOR OFF: Clears the cursor
CURSOR ON: Displays the cursor

JUMP TO DIGITAL: Switches to the digital display of
 the smallest group number that
 includes the channel selected
 with the cursor.
JUMP TO BAR: Switches to the bar graph display
 of the smallest group number that
 includes the channel selected
 with the cursor.
(Not displayed with the default settings. To display these items, 
see section 5.16.)

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

•  Showing the Trend, Digital, Bar Graph Display Containing the Specified 
Channel
1. Press the arrow keys to move the cursor, and select a channel.

     Cursor (white Frame)

2. Switch to the trend, digital, or bar graph display according to the procedure 
described in “Changing the Displayed Contents.”
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4.5 Displaying Various Information

This section explains how to display reports (/M1, /PM1, and /PWR1 options) and how to 
use the status displays.
For a description of the function, see section 1.3.

Procedure
• Showing the Display

1. Press DISP/ENTER to show the display selection menu.

2. Press the up and down arrow keys to select INFORMATION.

3. Press the right arrow key to display the sub menu.

4. Press the up and down arrow keys to select the sub menu item.
To close the menu without changing the displayed contents, press the ESC key.

     

Information display sub menu

MODBUS CLIENT: Displays the Modbus
 client status
MODBUS MASTER: Displays the Modbus master
 status
RELAY: Displays the relay status

REPORT DATA: Displays report data

ALARM SUMMARY: Displays an alarm summary
 See section 4.6.

(Not displayed with the default settings. To display, see section 5.16.)

MESSAGE SUMMARY: Displays a message summary
 See section 4.7.
MEMORY SUMMARY: Displays a memory summary
 See section 4.8.

COLUMN BAR: Displays report data using
 stacked bar graphs

5. Press DISP/ENTER.
The display appears.

• Displaying the Report
 • Switching the Displayed Report Data

 The Index item on the report display shows “the number of the report data being 
displayed/the number of report data saved in the internal memory.” The largest 
report data number corresponds to the most recent report data. Start is when the 
report is started and Timeup is when the report is created.

    

Number of the report data being displayed
Number of report data saved to the internal memory
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 Carry out the procedure below to switch the displayed report data.
 Up arrow key: Report data being displayed + 1.
 Down arrow key: Report data being displayed – 1.
 Left arrow key: Report data being displayed + 10.
 Right arrow key: Report data being displayed – 10.

Note
The display is not updated even if a new report is created while displaying the report data. 
Perform either of the operations below to display the most recent report data.
• Hold down the left arrow key until the latest report data is displayed.
• Press DISP/ENTER and display the report data again from the display selection menu.

• Switching the Report Channels
 Up to 12 report channels can be shown on one screen. If there are more than 12 

report channels, you can switch the displayed report channels.

1. Press DISP/ENTER to show the display selection menu.

2. Press the right arrow key to display the sub menu.

3. Press the up and down arrow keys to select CHANGE REPORT CH.

4. Press DISP/ENTER.
The displayed report channels are switched.

• Relay Status Display
Lists the statuses of the alarm output relays and internal switches. You cannot change 
the settings on this display.

   

Red: ON
Green: OFF

• Modbus Status Display
 Lists the statuses of the Modbus client or Modbus master commands.
 For the operating procedure, see the Communication Interface User’s Manual, IM 

04L21B01-17EN.

   

Communication conditions

Status
Command

Communication destination
FX channels

4.5  Displaying Various Information
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4.6 Using the Alarm Summary

This section explains how to use the alarm summary.
For a description of the function, see section 1.3.
For details on how to display the summary, see section 4.5.

Procedure
• Changing the Displayed Contents

1. Press DISP/ENTER to show the display selection menu.

2. Press the right arrow key to display the sub menu.

3. Press the up and down arrow keys to select the sub menu item.
  

     

ASCENDING ORDER: Sorts in ascending order
DESCENDING ORDER: Sorts in descending order

CHANGE SORT KEY: Sorts alarm information by 
 channel or alarm time

TO HISTORY (DISP): Switches to the display data
 historical trend display

TO HISTORY (EV): Switches to the event data
 historical trend display

Display name: Switches to the specified display

Sort symbol

TO OVERVIEW: Switches to the overview display

  Ascending sort
  Descending sort

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

• Moving the Cursor ( ) and Scrolling the Alarms

   

Scrolls the alarm information up by half a page 
Moves the cursor up 

Scrolls the alarm information down by half a page 

Moves the cursor down 

•  Recalling the Historical Trend Display at the Point When the Alarm 
Occurred
1. Select an alarm with the cursor.

2. Display the historical trend according to the procedure described in “Changing the 
Displayed Contents.”

Explanation
• CHANGE SORT KEY, ASCENDING ORDER, and DESCENDING ORDER

The alarms are sorted in ascending or descending order by the following keys. The 
sort symbol is displayed next the sort item (see the figure above).
• Channel number: Sorts the alarms by channel number even if tags are being used. 

Alarms in a channel are sorted by the alarm level number.
• Time of alarm occurrence/release



4-20 IM 04L21B01-01EN

4.7 Using the Message Summary

This section explains how to use the message summary.
For a description of the function, see section 1.3.
For details on how to display the summary, see section 4.5.

Procedure
• Changing the Displayed Contents

1. Press DISP/ENTER to show the display selection menu.
2. Press the right arrow key to display the sub menu.
3. Press the up and down arrow keys to select the sub menu item.

     

CHANGE DISP ITEM: Switches between displaying
    message times and groups
    and displaying the message
    user names

ASCENDING ORDER: Sorts in ascending order
DESCENDING ORDER: Sorts in descending order

DISP GROUP OFF: Displays the second of the time 
    when the messages were written
DISP GROUP ON: Displays the groups to which 
    the messages were written 
CHANGE SORT KEY: Sorts messages by message
    number, time, group, or user
    name

TO HISTORY (DISP): Switches to the display data
    historical trend display

Display name: Switches to the specified display

TO HISTORY (EV): Switches to the event data
    historical trend display

Sort symbol
    Ascending sort
    Descending sort

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

• Moving the Cursor ( ) and Scrolling the Messages

    

Scrolls the messages up by half a page 
Moves the cursor up 

Scrolls the messages down by half a page 

Moves the cursor down 

•  Recalling the Historical Trend Display at the Point When the Message 
Was Written
1. Select a message with the cursor.
2. Display the historical trend according to the procedure described in “Changing the 

Displayed Contents.”
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Explanation
• CHANGE DISP ITEM

Switches between the following two message display methods.
• Message, time, and group, or the second of the date and time when the message 

was written
• Message, user name

• CHANGE SORT KEY, ASCENDING ORDER, and DESCENDING ORDER
The messages are sorted in ascending or descending order by the respective key. The 
sort symbol is displayed next to the sort item (see the figure on the previous page).

• DISP GROUP OFF/ON
 You can select what is displayed on the right of the screen: the groups that the 

messages were written to or the second of the time when the messages were written.

4.7  Using the Message Summary
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4.8 Using the Memory Summary

This section explains how to use the memory summary.
For a description of the function, see section 1.3.
For details on how to display the summary, see section 4.5.

Procedure
• Changing the Displayed Contents

1. Press DISP/ENTER to show the display selection menu.

2. Press the right arrow key to display the sub menu.

3. Press the up and down arrow keys to select the sub menu item.

    

REPORT SAVE: Saves all report data
M.SAMPLE SAVE: Saves all manually sampled data

SELECT SAVE: Saves the selected file

DATA SAVE MODE: Switches to data save mode

ALL SAVE: Saves all data

(Not displayed with the default settings. To display these items, 
see section 5.16.)

FILENAME DISPLAY: Displays the file name
  For information about file names, see section 1.4.
TIME DISPLAY: Displays the times of the first
 and last items of data in the file

TO HISTORY: Switches to the historical
 trend display

Display name: Switches to the specified 
 display

CHANGE DATA KIND: Switches between display
 data and event data

The displayed data type is
indicated with a green mark.

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the displayed contents, press the ESC key.

• Moving the Cursor ( ) and Scrolling the Memory Information

    

Scrolls the memory information up by half a page 
Moves the cursor up 

Scrolls the memory information down by half a page 

Moves the cursor down 

•  Displaying the Historical Trend for the Data Specified by Memory 
Summary
1. Select the data with the cursor.

2. Display the historical trend according to the procedure described in “Changing the 
Displayed Contents.”
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• Saving the Data
 Save the data in the internal memory to the CF card or the USB flash memory (/USB1 

option). 
 For a description of the function, see section 1.4.

1. Press DISP/ENTER to show the display selection menu.

2. Press the right arrow key to display the sub menu.

3. Select DATA SAVE MODE with the up and down arrow keys.

4. Press DISP/ENTER.
The display switches to DATA SAVE MODE (a string indicating this mode is displayed in the 
upper left of the screen).

5. To save a specified file, select it with the cursor. This operation is not necessary in 
other cases.

     

Cursor
(move with the arrow keys)

6. Press DISP/ENTER to show the display selection menu.

     

7. Use the up and down arrow keys to select SELECT SAVE, ALL SAVE, M. 
SAMPLE SAVE, or REPORT SAVE.

8. Press DISP/ENTER.
* If you are using a CF card and a USB flash memory (/USB1 option), the message “Which 

media do you want save to?” appears. Select the destination medium using the arrow keys, 
and press DISP/ENTER.
The measured data is saved.

Note
To abort the data saving operation in progress, carry out the procedure below.
Press FUNC and press the Save Stop soft key.

4.8  Using the Memory Summary
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 Progress Display When Saving All Data of the Internal Memory
If you carry out All Save* on the memory summary screen, a pop-up window appears
showing the progress of the save operation.

* Function for saving all data in the internal memory to a CF card or USB flash memory.

    

Note
• The pop-up window appears only when the memory summary display is showing.
• If you press the ESC key, the pop-up window clears temporarily and reappears 

approximately 10 seconds later.
• The time estimate for saving all data is indicated in the table below (when the memory is full 

of data). It may take longer depending on the operating conditions of the FX.
Save Destination Time to Save All Data (Estimate)
CF Card Approximately 20 minutes
USB flash memory Approximately 40 minutes

• To abort the data saving operation in progress, carry out the procedure below.
 Press FUNC and press the Save Stop soft key.

Explanation
• Save directory

• When you have switched to data save mode from the memory summary display or 
the operation selection display (see page 2-13) when a USB device is connected 
to the FX, if you then try to continue saving the same file, a message asking you to 
confirm that you want to overwrite the file is displayed.

• In the following situations, the FX will create a new directory to store the data in 
each time you save data. Even if you save the same file, no message asking you to 
confirm that you want to overwrite the file will be displayed.

  If you exit data save mode and then switch back to data save mode.
   If you select the save format from the sub menu without switching to data save 

mode.
• The directory name structure is: Specified string_YYMMDD_HHMMSS (the values 

of YY to SS are the date and time of operation).

    

Save directory

File list example

• Display data or event data that is in the process of adding data cannot be saved.
• The save operation explained here merely copies the data in the internal memory. 

It does not save the unsaved data in the internal memory (see page 1-27).
• Data saving is aborted when there is insufficient free space on the storage medium. 

Use a storage medium with sufficient free space when saving data.

4.8  Using the Memory Summary
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4.9 Displaying a List of Operation Logs

Displays the following operation logs.
Login log, error log, communication log, FTP log, Web log, e-mail log, SNTP log, DHCP 
log, and Modbus status log

Procedure
• Displaying the Log

1. Press DISP/ENTER to show the display selection menu.

2. Press the up and down arrow keys to select LOG.
* LOG is not displayed with the default settings.
 To show LOG on the menu, see section 5.16. 

3. Press the right arrow key to display the sub menu.

4. Press the up and down arrow keys to select the sub menu item.
To close the menu without changing the displayed contents, press the ESC key.

5. Press DISP/ENTER.
The display appears.

 

Explanation
• Login Log

   

The log number of the last line and the 
total number of logs

User name

Operation method (see the table below)
Operation (see the table below)
Date/time

Action Description
Login Login
Logout Logout
NewTime Time change while memory is stopped
TimeChg Time change through key operation
PowerOff Power OFF (power failure occurred)
PowerOn Power ON (recovered from a power failure)
TrevStart Start the operation of gradually adjusting the time
TRevEnd End the operation of gradually adjusting the time
SNTPtimset Time change by SNTP
TimeDST Switch the daylight savings time
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Factor Description
KEY Key operation
COM Operations via communication
REM Operation through the remote control function
ACT Operation through event action
SYS Operation by the system

• Error Log

   

Error message*
Error code*
Date/time

* See section 10.1, “A List of Messages.”

• Communication Log

   

Message*
Input/output symbol (>: input, <: output)

User ID number (0: serial, 1 to 3: Ethernet)
Date/time

* See the Communication Interface User’s Manual, IM 04L21B01-17EN.

• FTP Log

   
File Name
FTP connection destination 
(P: primary, S: secondary)
Error message (detail code)*
Date/time

* See section 10.1, “A List of Messages.”

4.9  Displaying a List of Operation Logs
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• Web Log

   

Operation (see the table below)
Error code*
Requested operation (see the table below)
Date/time

* See section 10.1, “A List of Messages.”

Request Description
Screen Screen switch
Key Key operation
Message Message assignment/write

Parameter Description
TREND Trend display
DIGIT Digital display
BAR Bar graph display
HIST Historical trend display
OV Overview display
DISP DISP/ENTER key
UP Up arrow key
DOWN Down arrow key
LEFT Left arrow key
RIGHT Right arrow key
Messages Character strings that have been written

• E-mail Log

   
Recipient (mail address, message)
Recipient (1: recipient 1, 2: recipient 2)
Error code*
Event (see the table below)
Date/time

* See section 10.1, “A List of Messages.”
Type Description
Alarm Alarm mail
Time Scheduled mail
Report Report timeout mail
Fail Power failure recovery mail
Full Memory full mail
Test Test mail
Error Error message mail

4.9  Displaying a List of Operation Logs
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• SNTP Log

   

Error message (detail code)*
Error code*
Date/time

* See section 10.1, “A List of Messages.”

• DHCP Log

   

Error message (detail code)*
Error code*
Date/time

* See section 10.1, “A List of Messages.”

• Modbus Status Log

   
Command number, command type
(R: read, W: write)
Communication status*
Communication type (C: client, M: master)
Date/time

* See the Communication Interface User’s Manual, IM 04L21B01-17EN.

4.9  Displaying a List of Operation Logs



Sw
itching O

peration Screens

4-29IM 04L21B01-01EN

3

2

1

4

5

6

7

8

9

10

11

12

13

14

App

Index

4.10 Displaying Stacked Bar Graphs (/M1, /PM1, and 
/PWR1 Options)

This section explains how to use stacked bar graphs.

Procedure
• Changing the Displayed Contents

1. Press DISP/ENTER to show the display selection menu.

2. Press the right arrow key to display the sub menu.

3. Press the up and down arrow keys to select the sub menu item.

     

REPORT GROUP 1 through 4*: Select the report
    group that you want
    to display.
* Varies according to the model. For information about
 report groups, see section 9.5.

SELECT GROUP: Use the arrow keys to switch
   between displayed report groups.
SELECT COLUMN: Use the arrow keys to select a bar
   graph.

SINGLE GRAPH: Displays a single graph
DUAL GRAPH: Displays two graphs

Display name:  Switches to the specified display

4. Press DISP/ENTER to change the displayed contents.
To close the menu without changing the display contents, press ESC.

• Changing Groups, Selecting Bar Graphs, and Moving the Cursor
 The amount of data that the up and down arrow keys scroll through depends on the 

type of report data. For example, with an “H+D” report, you can use the arrows to 
scroll through the data one day at a time.

    

SELECT GROUP: Switches to the display for the report group with
  the next smallest number
SELECT COLUMN: Moves the bar graph selection cursor to the left
Switches to the previous day, week, or month’s data

SELECT GROUP: Switches to the display for the report group with
  the next highest number
SELECT COLUMN: Moves the bar graph selection cursor to the right
Switches to the next day, week, or month’s data
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Explanation
• SINGLE GRAPH/DUAL GRAPH
 You can display one or two bar graphs. The sums of the first channel in a group and of 

all other channels that have the same unit as it are displayed.
• SINGLE GRAPH

    

Numeric display section

Display area 1 Display area 2

 The displayed report data varies depending on the report kind, which is set using 
the report function.

Report kind Display Area 1 Display Area 2
Hour, H+D Sums for each hour Sums for the day
Day+Week Sums for each day Sums for the week
Day, D+M Sums for each day Sums for the month

• DUAL GRAPH
 Shows the data from two consecutive periods at the top and bottom of the display.

    

Channel number or tag
Numbers are abbreviated.

Display area 1

Display area 2

Display area 4

Display area 3

 The displayed report data varies depending on the report kind, which is set using 
the report function. Display areas 1 and 2 contain the same report data listed above 
for SINGLE GRAPH display.

Report kind Display Area 1 Display Area 2 Display Area 3 Display Area 4
Hour, H+D Sums for each hour Sums for the day Sums for each hour Sums for the day

(The data of the day before the data in 
display areas 1 and 2)

Day+Week Sums for each day Sums for the week Sums for each day Sums for the week
(The data of the week before the data in 
display areas 1 and 2)

Day, D+M Sums for each day Sums for the month Sums for each day Sums for the month
(The data of the month before the data in 
display areas 1 and 2)

4.10  Displaying Stacked Bar Graphs (/M1, /PM1, and /PWR1 Options)
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Note
 The numbers on the vertical axis of display areas 3 and 4 and the dates on the horizontal 

axis are abbreviated.
 Display areas 3 and 4 can only display the data from the period immediately preceding that 

of display area 1 and 2.

• Selecting a Bar
 When SINGLE GRAPH is selected, you can move the cursor to a bar that you want to 

check, and view the sums of each channel.

   

The sums of each channel and 
the sums of all channels of 
the report group at the cursor 
position

Cursor

• Power Failure and Time Adjustment Indications

   
Indicates a power failure
A “C” appears if more than one
report has been filed for the
same time period.

• Power failure
 A “P” indicates when a power failure occurred and a report was supposed to be 

filed. A “P” also indicates when the FX recovered from a power failure and the next 
report was filed.

• Time adjustment
 When a time adjustment causes a report to be filed twice because the time was 

moved back, the time adjustment is marked with a “C,” and the bar graph of the 
report that was filed first is used.

 If the data for a period does not exist because of a power failure or time adjustment, a 
bar graph for the period will not be displayed.

4.10  Displaying Stacked Bar Graphs (/M1, /PM1, and /PWR1 Options)



Blank Page



5-1IM 04L21B01-01EN

O
perations for C

hanging the D
isplayed C

ontents

3

2

1

4

5

6

7

8

9

10

11

12

13

14

App

Index

5.1 Setting Display Groups

Assign channels and set the group name for each display group. Set lines at specified 
positions in the waveform display range on the Trend display.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Group set, Trip 

line.

   

Setup Items
• Group number
 Select the target group number (1 to 10).

• Group
 • On/Off

 Turn On the groups you want to use.
 • Group name

 Set the group name. (up to 16 characters, A a # 1 )
 • CH set

 Set up to six channels using the measurement channels and computation channels 
(/M1, /PM1, and /PWR1 options).
• Enter the channel number using two or three digits.
• Separate each channel with a period.
• To specify a range of consecutive channels numbers, use a hyphen.
 Example: To assign channels 1 and 5 to 8, enter “001.005-008.”

Note
• The trend, digital, and bar graph displays are shown in the specified order.
• A channel can be assigned to multiple groups.
• The same channel cannot be assigned multiple times in a group.

Chapter 5 Operations for Changing the Displayed Contents
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Note
The channel settings of a display group can be copied to another group.

     

 Procedure
1. Select the copy source channel settings.
2. Press the Copy soft key.
3. Select the copy destination channel settings.
4. Press the Paste soft key. The channel settings are copied.

• Trip line
 Set lines at specified positions in the waveform display range on the Trend display.
 • 1, 2, 3 and 4

 Turn On the trip lines you want to display.
 • Position

 Set the position in the range of 0 to 100% of the display width.
 • Color

 The default colors are red, green, blue, and yellow. If you want to change the color, 
select from the 24 available colors.

 • Width
 Set the line width of the trip line in dots (1 to 3).

5.1  Setting Display Groups
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5.2 Displaying Tags or Channel Numbers

Display the channels using tags or channel numbers.

Setup Screen
• Tag/Channel
  Press MENU (switch to the setting mode), hold down FUNC for 3 s (switch to the 

basic setting mode), and select Environment > Operating Environment.

   

• Tag
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Tag, Memory, Delay.

   

Setup Items
• Operating environment > Tag/Channel
 This setting applies to all channels.

Setting Description 
Tag Displays tags. 
 If a tag has not been set, the channel number will be displayed.
Channel Displays channel numbers.

• First-CH, Last-CH
 Set the target channels. The target channels are common with the other items that are 

displayed on the screen.

• Tag > Characters
 Set the tag using up to 16 characters: A a # 1 .
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5.3 Setting the Trend Interval and Switching to the 
Secondary Trend Interval

Set the trend interval. Switch the trend interval to the secondary trend interval while the 
memory sampling is in progress. Automatically write messages when the trend interval is 
switched.
For a description of the function, see section 1.3.

Setup Screen
•  Switching the Trend Interval and Writing Messages (When Using the 

Secondary Trend Interval)
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > View, Message.

   

• Trend interval [/div] and Secondary interval [/div]
  Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend/

Save interval.

   

Setup Items
• View > Trend rate switching
 On: Enables the function that switches the trend interval while the memory sampling 

is in progress. The “Second interval [/div]” item is displayed in the setting mode.
* When the trend rate switching function is On, the FX cannot be configured to record both the 

display and event data (see section 6.1).

• Message > Change message
 On: Writes the time the interval is switched and the new trend interval as a message 

when the trend interval is switched.
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• Trend interval [/div] and Second interval [/div]
 Select the time corresponding to 1 division of the time axis on the trend display from 

below: You cannot specify a trend interval that is faster than the scan interval.
 15s,1 30s, 1min, 2min, 5min, 10min, 15min, 20min, 30min, 1h, 2h, 4h, 10h

1 Selectable on the FX1002 and FX1004

Note
If the trend interval is set greater than or equal to 1h/div, the month, day, and hour at the grid 
position are displayed on the screen. The display format can be changed by setting the date 
format.

    
Month, day, and hour at the grid position.

Procedure
• Switching the Trend Interval

1. In the operation mode, press FUNC.
The Function menu appears.

2. Press the Normal speed soft key or Second speed soft key.
The trend interval is switched. A message is written on the trend display (when the change 
message is turned ON).
Display example: 10:53 1min/div

Note
Only the displayed time axis changes when you switch to the secondary trend interval. The 
data sampling interval does not change. 

5.3  Setting the Trend Interval and Switching to the Secondary Trend Interval
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5.4 Writing Messages

Write messages.

Setup Screen
• Message Write Group
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > View, Message.

   

• Setting the Messages
 Press MENU (to switch to setting mode), and select the Menu tab > Message.

   

  

Setup Items
• Message
 • Write group

 This setting applies only for messages that are written using keys.
Settings Description
Common Write the message to all groups.
Separate Write the message to the displayed group.

 • Power-fail message
 See section 5.15.

 • Change message
 See section 5.3.
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• Message No.
 Select the message number (1 to 100). Messages 1 to 10 are common with free 

messages.* If a message is changed as a free message, the old message is 
overwritten.
* Messages that are written by creating the message on the spot.

• Message > Characters
 Set the message. (up to 32 characters, A a # 1 )

Procedure
• Writing Messages
 Messages cannot be written when the memory sampling is stopped.

1. Display the group to write the message.
• If a screen unrelated to a group such as the overview is displayed, messages 

are written to all groups even when Write group is set to Separate.
• Messages are written to all groups regardless of the displayed screen when 

Write group is set to Common.

2. Press FUNC.
The Function menu appears.

3. Press the Message soft key.

4. Press the soft key corresponding to the desired message number range (example: 
[1-10]).
A list of message is displayed.

     

5. Press the soft key corresponding to the number of the message you want to 
write.
A message mark, time, and message are shown on the trend display.

     Message

5.4  Writing Messages
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• Writing Free Messages
 Create a message on the spot and write it.

1. Display the group to write the message.

2. Press FUNC.
The Function menu appears.

3. Press the Free message soft key.

4. Press a message number soft key.
The message entry window appears.

5. Enter the message. (up to 32 characters, A a # 1 )

6.  Select ENT and press DISP/ENTER.
A message mark, time, and message are shown on the trend display.

 

• Writing Add Messages
 Add messages to the past data positions. This operation can be carried out on the 

past section of the data that is currently being memory sampled.

1.  Carry out the procedure below to show the historical trend of the data that is 
currently being memory sampled.
Press DISP/ENTER and select TREND HISTORY > (group name) > DISP/ENTER

2. Press the arrow keys to move the cursor to the position you want to write the 
message.

3. Write the message according to the procedure given in “Writing Messages” or 
“Writing Free Messages.” Use the Add Message or Add Free Message soft key.

     

Add message

Cursor
(yellow line)

Explanation
• Display Color of Messages
 The message colors on the trend display are shown below. You cannot change them.

No. 1 2 3 4 5 6 7 8 9 10
Color Red Green Blue Blue violet  Brown Orange Yellow-green Light blue  Violet Gray

 The colors for messages 11 to 100 are repetitions of the colors above.

• Add Message
• The message timestamp is the time that the message is written. It is not the time 

stamp of the data at the position where the message is written.

    
Add message (displayed in blue)

Display example on the message 
summary

• Up to 50 messages can be written.
• Messages cannot be added to data in the internal memory that has already been 

saved to a file or data that has been loaded from the external storage medium.

5.4  Writing Messages
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5.5 Changing the Channel Display Colors

Change the channel display colors. The settings are applied to the trend and bar graph 
displays.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Color.

   

Setup Items
• Group of channel
 Select the target channels.

• Color
 To change the color, select from the following 24 colors.
 Red, green, blue, blue violet, brown, orange, yellow-green, light blue, violet, gray, lime, 

cyan, dark blue, yellow, light gray, purple, black, pink, light brown, light green, dark 
gray, olive, dark cyan, and spring green
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5.6 Displaying Channels in Display Zones

Specify a waveform display zone for each channel so that waveforms do not overlap.
For a description of the function, see section 1.3.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Zone, Scale

   

Setup Items
• First-CH, Last-CH
 Select the target channels. The target channels are common with the other items that 

are displayed on the screen.

• Zone > Lower, Zone > Upper
 Sets the zone in which the waveform is displayed. You can set Lower and Upper as 

a position (%) when taking the maximum display width to be 100%. Set Upper greater 
than Lower, and the zone width (Upper – Lower) greater than or equal to 5%.

 Lower: 0 to 95%
 Upper: 5 to 100%
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5.7 Displaying a Scale on the Trend Display

Display a scale on the trend display.
For a description of the function, see section 1.3.

Setup Screen
• Scale Position and Number of Scale Divisions
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Zone, Scale.

   

   

• Number of Displayed Scale Digits and Current Value Indicator
 Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend.

   

• Showing the Scales
  To show scales on the trend display, press DISP/ENTER (show the display selection 

menu) > the right arrow key (show the sub menu), and select SCALE ON (see 
section 4.2).

Setup Items
• First-CH, Last-CH
 Select the target channels. The target channels are common with the other items that 

are displayed on the screen.

• Scale > Position
 Select the scale display position on the trend display from 1 to 6. Select Off if you do 

not wish to display the scale.
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• Scale > Division
* This is not applied to the Log scale (/LG1 option).

 Set the number of divisions to make with the main scale marks on the trend display to 
a value from 4 to 12 or C10.

 C10: The scale is equally divided into 10 sections by main scale marks, and scale 
values are indicated at 0, 30, 50, 70, and 100% positions on the trend display.

 The figure below shows different scale divisions for when the span is from 0 to 100 
and the unit is M/H.

 Vertical Trend Display

Number of scale divisions: 4
Number of scale divisions: 5
Number of scale divisions: 6
Number of scale divisions: 7
Number of scale divisions: 8
Number of scale divisions: 9

Number of scale divisions: 10
Number of scale divisions: 11
Number of scale divisions: 12
Number of scale divisions: C10

Scale display position

1
2
3
4
5
6

 Horizontal Trend Display

 

6      5      4     3      2      1

Number of scale divisions: 4
Number of scale divisions: 5
Number of scale divisions: 6
Number of scale divisions: 7
Number of scale divisions: 8
Number of scale divisions: 9

Number of scale divisions: 10
Number of scale divisions: 11
Number of scale divisions: 12
Number of scale divisions: C10

Scale display position

5.7  Displaying a Scale on the Trend Display
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Note
• If the scales of multiple channels are set to the same position, the scale of the channel 

assigned first to the group is displayed.
 Example: If the order of assignment of a group is 003.002.001, and the scale display 

position of all channels is set to 1, the scale of channel 3 is displayed at display position 1.
• Even if some of the scale display positions are skipped, the scale is packed towards display 

position 1.
 Example: Suppose the assignment of channels to a group is 001.002.003, and the display 

positions of the scales are set to 1, 3, and 6, respectively. The scales are actually displayed 
at positions 1, 2, and 3, respectively.

• The scale is divided into 4 to 12 sections by the main scale marks. The section between 
the main scale marks is divided into 5 or 10 subsections by medium and small scale marks. 
However, small scale marks are not displayed in the following cases.
• When the resolution of the input range is smaller than the total number of small scale marks.
• When zone display is used.
• When partial expanded display is used (numbers are displayed at the ends of the scale 

and at the boundary position).
• The scale values are displayed according to the following rules.

• If the number of scale divisions is 4 to 6 for the vertical trend display, values are 
displayed at all main scale marks. If the number of scale divisions is greater, the values 
are displayed at every other main scale marks.

• Scale upper and lower limits are displayed at the ends of the scale.
• Scale values are displayed up to 3 digits excluding the minus sign. However, if the 

integer part of values at the ends of the scale is both 1 digit or the integer part is zero, 2 
digits are displayed.

 Example: If the scale is –0.05 to 0.50, the lower limit is “–0.0” and the upper limit is “0.5.”
• If the integer part of either end of the scale is 2 or 3 digits, the fractional part is truncated.
 Example: If the scale is 0.1 to 100.0, the lower limit is “0” and the upper limit is “100.”
• If the integer part of either end of the scale is 4 or more digits, the value is displayed 

using a 3-digit mantissa and exponent like “×10” or “×102”.
 Example: If the scale is 10 to 2000, the lower limit is “1” and the upper limit is “200 × 10”.

• The unit is displayed near the center of the scale. If partial expanded display is used, 
the display position is offset from the center. For the vertical trend display, the number of 
characters that can be displayed is up to six. For the horizontal trend display, the number of 
characters that can be displayed is up to three. However, if the scale digit display is set to 
Fine, up to four characters are displayed.

• Trend > Scale > Digit
* This is not applied to the Log scale (/LG1 option).

 Fine: When the scale values are displayed using two digits, you can change it so 
that they are displayed using three digits.

 For example, if the scale range is “49.0 to 50.0” and you select “Normal,” the scale 
values are displayed using two digits (“49” for example, see Note above). If you select 
“Fine,” the scale values are displayed using three digits as shown below.

   

• Trend > Scale > Value indicator
The current value is displayed as a mark or a bar graph.

   

Bar graph

5.7  Displaying a Scale on the Trend Display
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5.8 Displaying Alarm Point Marks and Color Scale 
Band on the Scale

Display alarm point marks on the scale. Display the specified range with a color band.
For a description of the function, see section 1.3.
When using the Log scale (/LG1 option), set the mantissa and the exponent to set the 
color scale band.
For the setting procedure, see the next page and section 3.13.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Alarm mark or Color scale band.
 • Alarm mark  • Color scale band

    

Setup Items

   

Alarm point mark
Color scale band

• First-CH, Last-CH
 Select the target channels. The target channels are common with the other items that 

are displayed on the screen.

• Alarm mark
 Displays marks indicating the values of the high and low limit alarms, delay high and 

low limit alarms, and difference high and low limit alarms. This setting is common with 
the bar graph display.

 • Alarm mark > Mark kind
Settings Description Mark
Alarm  The alarm mark is green under normal circumstances. It becomes 

red when an alarm occurs.
or

Fixed Displays a fixed color.

 • Alarm mark > Indicate on Scale
 To display alarm point marks, select On.

 • Alarm mark color > Alarm 1, Alarm 2, Alarm 3, and Alarm 4
 If the Mark kind is set to Fixed, specify the color of the alarm point marks. 
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• Color scale band
 Displays a specified section of the measurement range using a color band on the 

scale. This setting is common with the bar graph display.
 • Color scale band > Band area

Settings Description
In Displays the area inside using the color band.
Out Displays the area outside using the color band.
Off Disables the function.

 • Color scale band > Color
 Set the display color.

 • Color scale band > Display position > Lower, Upper
*  When you are using the Log scale (/LG1 option), set the settings by specifying the 

mantissas and exponents (see section 3.13).
 Specify the display position. Set a value within the span or scale range.
 Lower: Lower limit of the area.
 Upper: Upper limit of the area.

5.8  Displaying Alarm Point Marks and Color Scale Band on the Scale
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5.9 Partially Expanding the Waveform

Expand a part of a waveform (shrink the other parts) on the display.
* You cannot specify a channel that is set to Log scale (/LG1 option).

We recommend that you display the scale when viewing partially expanded channels. 
The numbers for the ends of the scale and the boundary position are displayed, and 
you can identify the expanded and reduced areas easily. However, numbers are not 
displayed for other scale marks.
For a description of the function, see section 1.3.

Setup Screen
• Turning ON/OFF the Partial Expanded Display Function
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > View, Message.

   

• Partially Expanded Display Method
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Partial.

   

Setup Items
• View > Partial
 If you select On, the Partial setup item appears in the setting mode.

• First-CH, Last-CH
 Select the target channels.

• Partial > On/Off
 To enable partial expanded display, select On.

• Partial > Expand
 Set the position where the value specified by Boundary is to be displayed within the 

display span in the range of 1 to 99.
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 • Partial > Boundary
 Set the value that is to be the boundary between the reduced section and the 

expanded section in the range of “minimum span value + 1 digit to maximum span 
value – 1 digit.” For channels that are set to scaling, the selectable range is “minimum 
scale value + 1 digit to maximum scale value – 1 digit.”

 Example: Input range: –6 V to 6V. Expand: 30. Boundary: 0
  The –6 V to 0 V range is displayed in the 0% to 30% range, and the 0 V 

to 6 V range is displayed in the 30% to 100% range.

5.9  Partially Expanding the Waveform
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5.10 Changing the Display Layout, Clearing of the 
Waveform at Start, Message Display Direction, 
Waveform Line Width, and Grid

Change the display layout, clearing of the waveform at start, waveform line width, and 
grid.
For a description of the function, see section 1.3.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend.

   

Setup Items
• Trend > Direction
 Set the display direction of the trends to Horizontal, Vertical, or Wide.

• Trend > Trend clear
Settings Description
On Clears the displayed waveform when the memory sampling is started.
Off Does not clear the waveform when the memory sampling is started.

• Trend > Message direction
 Set the display direction of messages to Horizontal or Vertical. When the trend is set 

to Vertical, the message direction is fixed to Horizontal.

• Trend > Trend line
 Set the line width of the trend in dots (1 to 3).

• Trend > Grid
 Select the number of grids to be displayed in the waveform display area of the trend 

display.
Settings Description
4 to 12 Displays a grid that divides the display width into 4 to 12 sections.
Auto Displays the same number of grids as the number of scale divisions of the first 

assigned channel of the group. When the target channel is set to Log scale (/LG1 
option), the logarithmic grid is used.
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5.11 Changing the Bar Graph Display Method

Change the bar graph display method.
For a description of the function, see section 1.3.

Setup Screen
• Display Direction
 Press MENU (to switch to setting mode), and select the Menu tab > Display > Bar 

graph.

   

• Base Position and the Number of Scale Divisions
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Bar graph.

   

Setup Items
• Bar graph > Direction
 Set the display direction of bar graphs to Horizontal or Vertical.

• First-CH, Last-CH
 Set the target channels. The target channels are common with the other items that are 

displayed on the screen.

• Bar graph > Base position
 Set the bar graph base position to Normal, Center, Lower, or Upper. This setting is 

applied when you are displaying the current value on the scale as a bar graph on the 
bar graph and trend displays.
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When the Display Direction of the Bar Graph Is Vertical
• Normal
 Value at the bottom of the bar graph: Span lower limit or span upper limit (or scale 

lower limit or scale upper limit), whichever is less
 Value at the top of the bar graph: Span lower limit or span upper limit (or scale lower 

limit or scale upper limit), whichever is greater
 Starting point of the bar: Bottom edge
• Center
 Value at the bottom of the bar graph: Same as with Normal.
 Value at the top of the bar graph: Same as with Normal.
 Starting point of the bar: Center
• Lower
 Value at the bottom of the bar graph: Span lower limit (or scale lower limit)
 Value at the top of the bar graph: Span upper limit (or scale upper limit)
 Starting point of the bar: Bottom edge
• Upper
 Value at the bottom of the bar graph: Same as with Lower.
 Value at the top of the bar graph: Same as with Lower.
 Starting point of the bar: Top edge

   

Normal Center Lower Upper

VS

VL

VS

VL

Vlower

Vupper

Vlower

Vupper

Vupper: Span upper limit (or scale upper limit)
Vlower: Span lower limit (or scale lower limit)
VL: Vlower or Vupper, whichever is greater
VS: Vlower or Vupper, whichever is less
     : Starting point of the bar

Normal Center Lower Upper

0.0

–100.0

0.0

–100.0

–100.0

0.0

–100.0

0.0

Example: When the span lower and upper limits of the input 
range are 0.0 and –100.0, respectively.

5.11  Changing the Bar Graph Display Method
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When the Display Direction of the Bar Graph Is Horizontal
The span lower limit (or scale lower limit) becomes the left edge of the bar graph, and the 
span upper limit (or scale upper limit) becomes the right edge of the bar graph.
• Starting point of the bar
 Normal: Left edge or right edge, whichever is less
 Center: Center
 Lower: Left edge
 Upper: Right edge

   Center

Normal

Upper

Lower
Vlower (Vlower < Vupper)

(Vlower > Vupper)

Vupper

Vlower Vupper

Vlower Vupper

Vlower Vupper

Vupper: Span upper limit (or scale upper limit)
Vlower: Span lower limit (or scale lower limit)
    : Starting point of the bar

   Center

Normal

Upper

Lower

0.0 –100.0

0.0 –100.0

0.0 –100.0

0.0 –100.0

Example: When the span lower and upper limits of the input 
range are 0.0 and –100.0, respectively

When Displaying the Current Value on the Scale Using the Bar Graph

   

(Vlower < Vupper)

Center

Normal

Upper

Lower

Vlower Vupper

(Vlower > Vupper)

Normal Center Lower Upper

Vlower

Vupper

• Bar graph > Division
 Select the number of main scale marks from 4 to 12.

5.11  Changing the Bar Graph Display Method
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5.12 Changing the Background Color of the Display

Change the background color of the display. This setting is applied to the operation 
screens.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Display > 

Monitor.

   

Setup Items
• Monitor > Background > Display
 Set the background color of the operation screen to White (default setting) or Black.

• Monitor > Background > Historical trend
 Select the background color of the historical trend display from the following:
 Settings: White, Black (default setting), Cream, and Lightgray
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5.13 Automatically Switching Display Groups

Automatically switch the displayed group at a specified interval.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Display > 

Monitor.

   

 

Setup Items
• Monitor > Scroll time
 Set the switching interval from the available settings between 5 s and 1 min. The 

groups switch in ascending order.
 Select whether to automatically switch on the display selection menu.
 See section 4.2
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5.14 Automatically Switching Back to the Default 
Display

Show a preset display when there is no operation for a specific time.

Setup Screen
 Press MENU (to switch to setting mode), and select the Menu tab > Display > 

Monitor.

   

Setup Items
• Monitor > Jump default display
 Returns to a preset display if there is no key operation for a specific time.

Settings Description
1min to 1h Time until switching the display.
Off Disables the function.

Procedure
• Specifying the Display to be Shown

1. Show the operation display you want to designate.

2. In the operation mode, press FUNC.
The Function menu appears.

3. Press the Standard display soft key.
The display is registered.
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5.15 Writing a Message When the FX Recovers from 
a Power Failure

A message is written to the trend display when the FX recovers from a power failure 
while memory sampling is in progress.

Setup Screen
• Power-fail message
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > View, Message.

   

Setup Items
• Message > Power-fail message

Settings Description
On A message is written when the FX recovers from a power failure while memory 

sampling is in progress.
 Display example: 15:12  Power Off  2005/10/25 15:12:57

Off Disables the function.



5-26 IM 04L21B01-01EN

5.16 Changing the Function menu and Display 
Selection Menu

You can change the contents of the Function menu, which is displayed when you press 
FUNC, and the display selection menu, which is displayed when you press DISP/ENTER.

Setup Screen
• Function menu
 Press MENU (to switch to setting mode), and select the Menu tab > Menu customize 

> Function menu.

   

Number indicating 
the display order

Menu name
White: Used
Gray:  Not used

• Display Menu
  Press MENU (to switch to setting mode), and select the Menu tab > Menu customize 

> Display menu.

   

Separator

Setup Items
• Enabling and Disabling the Function menu
 Items whose menu name is white are shown.

1.  Press the arrow keys to select a menu item.

2. Press the View or Hide soft key.
If you press the Hide soft key, the menu name is displayed in gray, and does not appear in 
the Function menu.

• Changing the Display Order of the Function menu Items
 Menu items are displayed in order by number. In addition, menu items appear when 

the corresponding function can be used.

1.  Press the arrow keys to select a menu item.

2.  Press the Select soft key.
The menu item is enclosed in a red frame.

3.  Press the arrow keys to select the destination.

4.  Press the Transfer soft key.
The menu item moves to the selected number position.
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• Description of Function menu Items
 For a description of each item, see section 4.1.

• Enabling/Disabling the Display Selection Menu and Sub Menu
 Items whose menu name is white are shown.

1.  Press the arrow keys to select a menu item.

2.  Press the View or Hide soft key.
If you press the Hide soft key, the menu name is displayed in gray, and does not appear in 
the display selection menu.

• Changing the Display Selection Menu/Sub Menu Positions
1. Press the arrow keys to select a menu item.

2. Press the Select soft key.
The menu item is enclosed in a red frame.

3. Press the arrow keys to select the destination.

4. Press the Transfer soft key.
The menu item moves to the selected position.

• Showing/Hiding Separators
1. Press the arrow keys to select a menu item.

2. Press the Separate soft key.
A separator (line) is displayed between the current item and the lower item.
If you select a menu item whose separator is already shown, this operation hides the 
separator.
You can set up to three separators in the display selection menu and each sub menu.

5.16  Changing the Function menu and Display Selection Menu
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• Description of the Display Selection Menus and Sub Menus
 Items with asterisk (*) are set to Hide by default.

Display Selection Menu Sub Menu Reference Section
TREND GROUP 1 to GROUP 10 Section 4.2
 ALL CHANNEL/GROUP CHANNEL Section 4.2
 SCALE ON/OFF Section 4.2
 DIGITAL OFF/ON Section 4.2
 MESSAGE DISP2/1 Section 4.2
 * TREND SPACE ON/OFF Section 4.2
 AUTO SCROLL ON/OFF Section 4.2
TREND HISTORY GROUP 1 to GROUP 10 Section 4.3
DIGITAL GROUP 1 to GROUP 10 Section 4.2
 AUTO SCROLL ON/OFF Section 4.2
BAR GROUP 1 to GROUP 10 Section 4.2
 AUTO SCROLL ON/OFF Section 4.2
OVERVIEW CURSOR OFF/ON Section 4.4
 JUMP TO ALM SUM Section 4.4
 JUMP TO TREND Section 4.4
 * JUMP TO DIGITAL Section 4.4
 * JUMP TO BAR Section 4.4
INFORMATION ALARM SUMMARY Section 4.6
 MESSAGE SUMMARY Section 4.7
 MEMORY SUMMARY Section 4.8
 * MODBUS CLIENT Section 4.5
 * MODBUS MASTER Section 4.5
 * RELAY Section 4.5
 REPORT DATA Section 4.5
 COLUMN BAR Section 4.10
 TO HISTORY Sections 4.6, 4.7, and 4.8
 TO HISTORY(DISP) Sections 4.6, 4.7, and 4.8
 TO HISTORY(EV) Sections 4.6, 4.7, and 4.8
 TO OVERVIEW Section 4.6
 DISP GROUP OFF/ON Section 4.7
 CHANGE SORT KEY Sections 4.6 and 4.7
 ASCENDING ORDER/ Sections 4.6 and 4.7
 DESCENDING ORDER
  DATA SAVE MODE Section 4.8
  SELECT SAVE Section 4.8
 * M.SAMPLE SAVE Section 4.8
 * REPORT SAVE Section 4.8
  ALL SAVE Section 4.8
 CHANGE DISP ITEM Section 4.7
 CHANGE DATA KIND Section 4.8
 FILENAME DISPLAY/TIME DISPLAY Section 4.8
 CHANGE REPORT CH Section 4.5
 SINGLE GRAPH/DUAL GRAPH Section 4.10
 SELECT COLUMN/SELECT GROUP Section 4.10
 REPORT GROUP 1 to 4 Section 4.10

 *Log LOGIN Section 4.9
 ERROR Section 4.9
 COMMUNICATION Section 4.9
 FTP Section 4.9
 MAIL Section 4.9
 WEB Section 4.9
 SNTP Section 4.9
 DHCP Section 4.9
 MODBUS Section 4.9

5.16  Changing the Function menu and Display Selection Menu
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6.1 Setting the Recording Conditions of the 
Measured Data

Set the method for recording the measured data.
For a description of the function, see section 1.4.

Setup Screen
• Data Type
  Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > A/D, Memory.

   

• Measurement Channels
 Press MENU (to switch to setting mode), and select the Menu tab > Meas channel > 

Tag, Memory, Delay.

   

• File Save Interval (Display Data)
 Press MENU (to switch to setting mode), and select the Menu tab > Display > Trend/

Save interval.

   

Chapter 6 Saving and Loading Data
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• Recording Conditions of Event Data*

 Press MENU (to switch to setting mode), and select the Menu tab > Data save > 
Event data.

   

* When you set the type of data that you want to save to “Display,” which is the default value, 
“Event data” is not displayed in the sub menu. Change the Data kind setting on the A/D, 
Memory screen in basic setting mode.

Setup Items
• Memory > Data kind

Settings Description
Display Records display data.
E+D Records display data and event data. This setting cannot be selected when 

the trend interval switching function is set to On.
Event Records event data.

• Memory sample > On/Off
 Turn On the target channels.

Settings Description
On Measured data is recorded. Waveforms are displayed on the trend display.
Off Measured data is not recorded. Even when registered in a display group, 

waveforms are not displayed in the trend display.

• Trend/Save interval > Trend interval [/div] (when recording display data)
 See the table below. You can only set trend intervals that are longer than the scan 

interval you set in Basic Setting Mode.

• Trend/Save interval > Save interval (when recording display data)
 Select the size of a record data file. The recorded data is divided by the file size 

specified here. The available settings vary depending on the number of memory 
sampling channels and the Trend interval setting.

Trend interval1 15 s2 30 s 1 min 2 min 5 min
Sample rate 500 ms 1 s 2 s 4 s 10 s
Selectable range 
of save interval

10 min to  
3 days

10 min to  
7 days

10 min to  
14 days

10 min to  
14 days

10 min to  
31 days

Trend interval1 10 min 15 min 20 min 30 min 1 h
Sample rate 20 s 30 s 40 s 1 min 2 min
Selectable range 
of save interval

10 min to  
31 days

10 min to  
31 days

1 hour to  
31 days

1 hour to  
31 days

1 hour to  
31 days

Trend interval1 2 h 4 h 10 h
Sample rate 4 min 8 min 20 min
Selectable range 
of save interval

2 hours to  
31 days

4 hours to  
31 days

8 hours to  
31 days

1 You cannot set a trend interval that corresponds to a sampling interval that is faster than the 
scan interval.

2 Selectable on the FX1002 and FX1004

• Trend/Save interval > Second interval [/div]
 See section 5.3.

6.1  Setting the Recording Conditions of the Measured Data
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• Event data (when recording event data)
 • Sample rate

 Select the data recording interval. Use the table under “Data length” for reference.
 • Mode

Settings Description
Free Records data continuously.
Single Records data when the trigger condition is met.
Repeat Records data each time the trigger condition is met.

 • Data length
 Select the size of a record data file. The recorded data is divided by the file size 

specified here. The available data lengths vary depending on the number of 
memory sampling channels and the Sample rate setting.
Sample rate1 125 ms 250 ms 500 ms 1 s 2 s
Selectable range 
of data length

10 min to  
1 day

10 min to  
2 days

10 min to  
3 days

10 min to  
7 days

10 min to  
14 days

Sample rate1 5 s 10 s 30 s 1 min 2 min
Selectable range 
of data length

10 min to  
31 days

10 min to  
31 days

1 hour to  
31 days

1 hour to  
31 days

1 hour to  
31 days

Sample rate1 5 min 10 min
Selectable range 
of data length

1 hour to  
31 days

1 hour to  
31 days

1 You cannot choose a sample rate that is higher than the scan interval.

 • Pre-trigger
 Specify the range when recording data before the trigger condition is met. Select 

the range as a percentage of the data length from 0, 5, 25, 50, 75, 95, and 100%. 
If you do not want to record the data existing before the trigger condition is met, 
select 0%.

 • Trigger signal > Key
 Select On if you want to activate the trigger using key operation.

Note
• Triggers can be applied using event action (see section 7.1).
• If the trigger condition is already met when you press START, recording starts.

6.1  Setting the Recording Conditions of the Measured Data
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6.2 Setting the Method for Saving the Data

This section explains how to select a method for saving measured data to an external 
storage medium.
For a description of the function, see section 1.4.

Setup Screen
• Auto save

* This is only valid on FXs that have a CF card slot.
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Security, Media save.

   

• File header, Data file name
 Press MENU (to switch to setting mode), and select the Menu tab > Data save > File 

header, File name.

   

• Save directory
* This is only valid on FXs that have a CF card slot or USB interface (/USB1 option).

  Press MENU (to switch to setting mode), and select the Menu tab > Data save > 
Save directory.
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Setup Items
• Save > Auto save

* This is only valid on FXs that have a CF card slot.
Settings Description
On Automatically saves the measured data to the CF card. Specify On to 

enable the media FIFO function.
Off Does not automatically save the data. Save the measured data manually to 

the CF card or USB flash memory (/USB1 option).

• Save > Media FIFO
* This is only valid on FXs that have a CF card slot.

 This item appears if Auto save is set to On.
Settings Description
On Enable media FIFO. Constantly retains the most recent data files in the CF 

card.
Off Disable media FIFO. Replace the CF card if the free space on the CF card 

drops low.

• File header > Characters
 Set the header to be written to the data file. (Up to 50 characters, A a # 1 )

• Data file name > Structure
 Sets the structure of the file name when saving data.

Settings Description
Date Serial number + user-assigned character string + date
Serial Serial number + user-assigned character string
Batch Serial number + batch name (when using the batch function)

• Data file name > Identified strings
Set the user-assigned section of the file name. (Up to 16 characters, A a # 1 )

 Symbols that can be used: #, %, (, ), +, -, ., @, °, and _.
 For details on the data file name, see section 1.4.

• Save directory > Directory name
* This is only valid on FXs that have a CF card slot or USB interface (/USB1 option).

 Set the name of the directory on the storage medium for saving the data on the 
external storage medium. (Up to 20 characters, A a # 1 )

 Symbols that can be used: #, %, (, ), +, -, ., @, °, and _.
 Strings that cannot be used: AUX, CON, PRN, NUL, CLOCK, COM1 to COM9, and 

LPT1 to LPT9.

6.2  Setting the Method for Saving the Data
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6.3 Using the Batch Function

Set the batch function.
For a description of the function, see section 1.5.

Setup Screen
• Batch Function
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Batch.

   

• Data file name
 Press MENU (to switch to setting mode), and select the Menu tab > Data save > File 

header, File name.

   

• Text Field
 Press MENU (to switch to setting mode), and select the Menu tab > Data save > 

Batch text.
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Setup Items
• Batch > On/Off
 Select On to use the batch function.

• Batch > Lot-No. digit
 Select the number of digits of the lot number from 4, 6, or 8. Select Off to disable the 

lot number.

• Batch > Auto increment
Settings Description
On Automatically sets the lot number of the next measurement to “the lot number of  

the current measurement + 1.”
Off Disables the operation described above.

• Data file name > Structure
 Batch:  Sets the names of the display data files or event data files to “serial number + 

batch name.”
 For details on the data file name, see section 1.4.

• Text field number
 Select a number from 1 to 8.

• Text field > Title of field or Characters
 Set the string.
 Title of field: (Up to 20 characters, A a # 1 ), Characters: (Up to 30 characters, A a # 1 )

Procedure
• Setting the Batch Name (Batch number + lot number) and Comment

1. In the operation mode, press FUNC.
The Function menu appears.

2. Press the Batch soft key.
A window appears for you to enter the batch name and comment.

3. Set the batch number. (Up to 32 characters, A a # 1 )
Symbols that can be used: #, %, (, ), +, -, ., @, °, and _.

If you are using the lot number, set the lot number.

4.  Set batch comments 1, 2, and 3. (Up to 50 characters each, A a # 1 )

5. Press DISP/ENTER.

Note
• Batch numbers and lot numbers cannot be changed after memory start.
• You can change the comment as many times as you wish before executing memory start. 

After memory start, only the comments that are not specified can be entered. You can 
change the comment as many times as you wish while the window for setting the comment 
is displayed. The last specified comment is valid.

• The comment is cleared when memory stop is executed.
• The batch number, lot number, and comments are saved to the display data file or event 

data file. They are not saved to the setup file.

6.3  Using the Batch Function
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• Displaying Text Field Settings
1. In the operation mode, press FUNC.

The Function menu appears.

2. Press the Text field soft key.
The text field settings appear.

   

6.3  Using the Batch Function
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6.4 Starting and Stopping Recording and Saving 
Measured Data

This section explains how to start recording and save measured data to the internal 
memory.
You can also save the measured data that is stored in internal memory to an external 
storage medium.

* This is only valid on FXs that have a CF card slot or USB interface (/USB1 option).
For a description of the function, see section 1.4.

Procedure
• Starting the Recording (Memory Start)
 Press START. The internal memory icon in the status display section changes from 

the stop icon to memory sampling icon.
• When recording display data or event data in free mode, recording starts.
• When recording event data in trigger mode, the FX enters the trigger-wait condition.

• Applying a Trigger to Start the Recording
Carry out the procedure below when the FX is waiting for a trigger.

 Trigger through Key Operation
 The procedure below can be carried out when recording event data in trigger mode 

and the FX is configured so that the start trigger is applied through key operation.

1. Press FUNC.
The Function menu appears.

2. Press the Trigger soft key.
The recording starts.

  Trigger by an Event (Event action function must be configured. See 
section 7.1.)

 Recording starts when an event occurs.

• Automatically Saving Measured Data
 Automatic saving takes place when Auto save is set to On (see section 6.2 for details).
 The save destination is the CF card.

* This is only valid on FXs that have a CF card slot.
 Have the CF card inserted in the slot at all times. While the memory sampling is in 

progress, the measured data recorded in the internal memory is automatically saved 
to the CF card.

 Action when Media FIFO is not enabled: If data is not completely saved to the external 
storage medium such as due to insufficient free space, the next time that data is 
automatically saved, the unsaved data will be saved.
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• Creating a Display Data File or an Event Data File
 This operation can be carried out when recording display data or when recording 

event data in Free mode. The file is created in the internal memory.
 If Auto save is set to On, the data file is saved to the CF card at the same time.

1. In the operation mode, press FUNC.
The Function menu appears.

2. Press the Save display or Save event soft key.
The display data or event data is saved to the CF card.

     
Time 

Saved the previous time 

Save operation 

File File File 
Saved this time 

• Saving Measured Data Manually (Collectively Storing Unsaved Data)
 This is the case for manually saving where Auto save is set to Off (see section 6.2 for 

details).
 You can save to a CF card or to USB flash memory (/USB1 option). The procedure for 

saving unsaved data to a CF card is described below.
 For the procedure to save data to the USB flash memory, see section 2.11.

1. Insert the CF card.
A confirmation window containing the message “There is data which is not saved to media. 
Do you want to store to media?” appears.

2.  Select Yes and press DISP/ENTER.
The unsaved data in internal memory will be saved to the CF card.

3. Follow these steps to remove the CF card.
Press FUNC (to display the Function menu) > Media eject soft key > CF soft key.
When the message “Media can be removed safely” appears, remove the CF card.

Note
• If there is not enough space on the external storage medium, the message “Not enough free 

space on media” appears, and the data is not saved. If this message appears, replace the 
external storage medium. Then, carry out the procedure again.

• You cannot abort the data save operation while it is in progress.

6.4  Starting/Stopping the Recording and Saving the Measured data



6-11IM 04L21B01-01EN

Saving and Loading D
ata

3

2

1

4

5

6

7

8

9

10

11

12

13

14

App

Index

• Stopping the Recording (Memory Stop)
1. Press STOP. A confirmation window is displayed.

If you are using the batch function, the batch name and comment are displayed 
on the screen.

     

2. Select Yes using the arrow keys and press DISP/ENTER.
If the FX is equipped with computation functions (/M1, /PM1, and /PWR1 
options), select Mem+Math or Memory, and then press DISP/ENTER.

The internal memory icon in the status display section changes to the stop icon.

•  Saving the Data in the Internal Memory Collectively or Selectively 
through Key Operation

 See section 4.8.

Explanation
• Operations That Start Simultaneously with Memory Start

• Waveform display updating on the trend display.
• Report (/M1, /PM1, and /PWR1 options)
• The computation function (/M1, /PM1, and /PWR1 options) can be configured to 

start simultaneously with memory start.
 See section 9.4.

• Operations That Stop Simultaneously with Memory Stop
• Waveform display updating on the trend display.
• Report (/M1, /PM1, and /PWR1 options)
• Computation function (/M1, /PM1, and /PWR1 options): When selected in the 

procedure described above.

• Performance While Data Is Being Saved
 If the internal memory or external storage medium is continuously accessed, the 

following phenomena may occur.
• Files being saved to the external storage medium drop out.
• Accessing the FX through communications takes a long time
In such case, take the following measures.
• If you are creating data files at short intervals consecutively using the event action 

function, increase the data file save interval.
• If you are creating numerous files in a single directory on the external storage 

medium, change the destination directory name at approximately every 1000 files.

6.4  Starting/Stopping the Recording and Saving the Measured data
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•  Changing Settings and Performing File Operations during Recording 
(Memory sampling)

 You cannot change the following settings.
• Basic settings
• Input range
• Memory sampling on/off
• Computation channel calculation expressions and constants
• TLOG
• Trend interval
• File save interval
• Timer and match time timer
• VT Ratio, CT Ratio, and low-cut power

6.4  Starting/Stopping the Recording and Saving the Measured data
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6.5 Manually Saving the Measured Data (Manual 
Sample)

Save the instantaneous values of all channels (excluding those set to Skip or Off) 
through key operation.
For a description of the function, see section 1.4.

Procedure
1. In the operation mode, press FUNC.

The Function menu appears.

2.  Press the Manual sample soft key.
Manual sampling is executed.

Explanation
• Number of Manual Sampled Data Set in the Internal Memory
 The number of manual sampled data set in the internal memory is displayed on the 

memory summary display (see section 1.3)

• Saving Manual Sampled Data
* This is only valid on FXs that have a CF card slot or USB interface (/USB1 option).

• If auto save is On, the manual sampled data is saved to the CF card when you 
carry out manual sampling.

• If Auto save is set to Off, save the manual sampled data to the CF card or USB 
flash memory (/USB1 option) according to the procedure for manually saving the 
data (see section 6.4).

• You can save the manual sampled data to the CF card or USB flash memory (/
USB1 option) according to the procedure for manually saving the data (see section 
4.8) regardless of the Auto save setting.

• Manual sampled data is saved as a tab-separated text file (see appendix 3).

Note
 Even if the FX does not have a CF card slot, you can still execute manual sampling. 

However, you cannot load data. To load data, the FX must be equipped with a 
communication interface (/C2, /C3, or /C7 option) or the USB interface (/USB1 option).
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6.6 Saving the Screen Image Data (Snapshot)

Save the current screen image data to the CF card. This operation is called snapshot, 
and the screen image data file is called snapshot data file.
For a description of the function, see section 1.4.

Procedure
1.  In the operation mode, press FUNC.

The Function menu appears.

2. Press the Snap shot soft key.
A message indicating that the message “Execution is complete” is displayed, and the 
snapshot data file is saved to the CF card.
Image of the soft keys and the message window are not saved.

Note
• If you assign the snapshot function to the USER key, you can take snapshots in all modes 

(operation mode, setting mode, and basic setting mode). However, error messages will not 
be saved.

• If the FX does not have a CF card slot, you can execute snapshots, but the operation will not 
be performed. However, if the FTP transfer operation is enabled (/C7 option), the operation 
will be performed.

Explanation
• File Format
 The snapshot data file is in PNG format.

• File Name
 See section 1.4.



6-15IM 04L21B01-01EN

Saving and Loading D
ata

3

2

1

4

5

6

7

8

9

10

11

12

13

14

App

Index

6.7 Managing the Files on the External Storage 
Medium

This section explains how to display a list of stored files and the amount of available 
memory, delete files and directories, and format external storage media.

This is only valid on FXs that have a CF card slot or USB interface (/USB1 option).

Procedure
•  Displaying Files, Deleting Files, and Checking Available Memory on the 

External Storage Medium
Carry out the procedure below to show the display.

 Press MENU (to switch to setting mode), and select the File tab > File list, delete > 
press the CF or USB soft key* > and press DISP/ENTER.
* When a CF card and a USB flash memory (/USB1 option) are being used.

   

 Displaying a List of Files in a Directory and Checking the Free Space
 Press the arrow keys to select a directory, and press DISP/ENTER. The files in the 

directory are displayed. The root directory is denoted by [/].

   

: Sorted in order with the oldest 
timestamp first.

: Sorted in order with the most 
recent timestamp first.

 Sorting Files and Directories
 The files and directories can be sorted by the update date/time.
 Each time you press the Sort soft key, the files and directories are sorted in order from 

the oldest or the latest update date/time. A mark indicating the sort order is displayed 
by Date/Time. 

 If the File Name Does Not Fit in the Display Space
 Press the  soft key once to shift the file name to the left by a character.
 Press the  soft key once to shift the file name to the right by a character.
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 Deleting a File
 Press the arrow keys to select the file to be deleted, and press the Delete soft key. A 

confirmation window appears. Select Yes, and press DISP/ENTER.
 The file is deleted.

 Deleting a Directory
 First, delete all the files in the directory.
 Select the directory you want to delete. The rest of the procedure is the same as 

deleting a file.

 Checking the Free Space
 The free space on the storage medium is shown at the lower right of the screen.

• Formatting External Storage Media
 Formatting will remove the contents of the external storage medium.

1. Carry out the procedure below to show the display.
 Press MENU (to switch to setting mode), and select the File tab > Format. Press 

the CF or USB soft key*, and then press DISP/ENTER.
 * When a CF card and a USB flash memory (/USB1 option) are being used.

     

2. Enter the volume name and press DISP/ENTER. (Up to 11 characters, A 1 )
A confirmation window opens.

3. Select Yes and press DISP/ENTER.
The external storage medium will be formatted.

Explanation
• Format Type

Size Type
Storage medium smaller than or equal to 512 MB FAT16
Storage medium greater than 512 MB FAT32

6.7  Managing the Files on the External Storage Medium
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6.8 Loading and Displaying Measured Data from 
External Storage Media

Load the display or event data file saved on the external storage medium and display the 
waveform. The loaded data is shown on the historical trend display.
For the operations on the historical trend display, see section 4.3.

This is only valid on FXs that have a CF card slot or USB interface (/USB1 option).

Procedure
• Loading a File

1. Carry out the procedure below to show the display.

 Press MENU (to switch to setting mode), and select the File tab > Load display 
data or Load event data. Press the CF or USB soft key*, and then press DISP/
ENTER.
*  When a CF card and a USB flash memory (/USB1 option) are being used.

     

2. Press the arrow keys to select a directory, and press DISP/ENTER. The files in 
the directory are displayed. The root directory is denoted by [/].

3. Press the arrow keys to select a file, and press DISP/ENTER.
The file is loaded, and the waveform is displayed in the historical trend.

     

Note
• The extension of display data files is .DAD. The extension of event data files is .DAE.
• For details on how to use the Sort, , and  soft keys, see section 6.7.
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6.9 Saving/Loading the Setup Data

This section explains how to save and load setup data from external storage media.
This is only valid on FXs that have a CF card slot or USB interface (/USB1 option).

Procedure
• Saving the Setup Data

1. Carry out the procedure below to show the display.

 Press MENU (to switch to setting mode), and select the File tab > Save settings. 
Press the CF or USB soft key, and then press DISP/ENTER.

     

2. Set the file name. (Up to 32 characters, A a # 1 )
Symbols that can be used: #, %, (, ), +, -, ., @, °, and _.
Strings that cannot be used: AUX, CON, PRN, NUL, CLOCK, COM1 to COM9, and LPT1 to 
LPT9.
To cancel the operation, press ESC.

3. Press DISP/ENTER.
The setup data is saved.

• Loading the Setup Data for the Setting Mode
1. Carry out the procedure below to show the display.

 Press MENU (to switch to setting mode), and select the File tab > Load settings. 
Press the CF or USB soft key, and then press DISP/ENTER.

     

2. Use DISP/ENTER and arrow keys to select the setup file to be loaded.
* Setup data files are stored in the root directory [/].
To cancel the operation, press ESC.

3. Press DISP/ENTER.
The setup data is loaded.

Note
For details on how to use the Sort, , and  keys, see section 6.7.
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• Loading the Setup Data for the Setting Mode and Basic Setting Mode
1. Carry out the procedure below to show the display.

 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to 
basic setting mode), and select the File/Initialize tab > Load settings. Press the 
CF or USB soft key*, and then press DISP/ENTER.
* When you are using a CF card and USB flash memory (/USB1 option).

     

2. Use DISP/ENTER and arrow keys to select the setup file to be loaded.
* Setup data files are stored in the root directory [/].
To cancel the operation, press ESC.

3. Press DISP/ENTER.
The setup data is loaded.

Note
For details on how to use the Sort, , and  keys, see section 6.7.

Explanation
• Setup Data File

• The setup data file extension is .PDL.
• The following settings are also saved.

• Current monitor display conditions
• Monitor auto recovery registration data

• Loading Setup Data
• Only the setup data of the setting mode is loaded in the setting mode. However, 

settings that contradict the setup data of the basic setting mode are not loaded.
• The monitor display conditions and default display are also loaded.
• If the loaded setup data is not applied, check the error log (see section 4.9).

Note
• While loading the setup data, key operations, operations via communications, and 

operations via remote input are not available.
• While setup data is being loaded, event action operations are invalid. Any events that occur 

while setup data is being loaded will be ignored.

6.9  Saving/Loading the Setup Data
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7.1 Setting the Event Action Function (Including 
the remote control function of the /R1 and /
PM1 options and the USER key)

A specified action is carried out when an event occurs. This function is called event 
action. Follow the procedure in this section to also set the remote control function (/R1 
and /PM1 options) and the USER key.
For a description of the function, see section 1.6.

Setup Screen
• Event and Action
 Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event 

action > Event action.

   

• Timer
 Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event 

action > Timer.
• When set to relaive time  • When set to absolute time

    

• Match Time
 Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event 

action > Match time timer.

   

Chapter 7 Customizing Actions Using the Event Action and Remote Control Functions  
(/R1 and /PM1 Options)
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Setup Items
• Logic box number
 You can set up to 40.

• Event action > Event
 The condition to execute the action.

Settings Description
None Not use.
Remote Select the remote control input terminal number.
Relay  Select the alarm output relay number. During Edge operation, a change 

from deactivated to activated is an event.

Switch  Select the internal switch number. During Edge operation, a change from off 
to on is an event.

Timer Select the timer number.
Matchtime Select the match timer number.
Alarm  During Edge operation, a change from “no alarms are active” to “at least  

 one alarm is active” is an event.
USER key -

• Event action > Action
 The action to be executed when an event occurs.

Settings Description
Memory -
Start -
Stop -
Trigger Can be specified when the FX is configured to record event data.
AlarmACK Cannot be specified when the event is set to Relay, Switch, or Alarm.
Math Can be specified on FXs with the /M1, /PM1, or /PWR1 option.
MathStrt Start computation. Can be specified on FXs with the /M1, /PM1, or /PWR1 option.
MathStop Stop computation. Can be specified on FXs with the /M1, /PM1, or /PWR1 option.
Math rst Reset computation. Can be specified on FXs with the /M1, /PM1, or /PWR1 option.
SaveDisp Can be specified when the FX is configured to record display data.
SaveEvt Can be specified when the FX is configured to record event data.
Message Set the message number to write the message and the destination. Set the  
 message destination to all groups (All) or a group number.
Snap Snapshot
Rate1/2 Can be specified when the function for switching between the trend interval and  
 the secondary trend interval is enabled.
M.sample Manual sampling
TimerRst Cannot be specified when the event is set to Timer.
Group Specify the number of the group to be displayed.
Flag Can be specified on FXs with the /M1, /PM1, or /PWR1 option.
Time adj Can be specified only when the event is set to Remote.
PnlLoad Can be specified only when the event is set to Remote.

7.1  Setting the Event Action Function  
(Including the remote control function of the /R1 and /PM1 options and the USER key)
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• Timer
 Timer used by event action. Used also in the TLOG computation of the computation 

function.
* The timer cannot be changed while memory sampling or computation is in progress.

 • Timer No.
 Up to four timers (1 to 4) can be set.

 When Using an Absolute Timer
 • Mode

 Select Absolute.
 • Interval

 Select the interval from the available settings between 1min to 24h.
 • Ref.time

 Set the time in the range of hour 0 to hour 23.

 When Using a Relative Timer
 • Mode

 Select Relative.
 • Interval

 Set the interval in the range of 00:01 (1 min) to 24:00 (24 hours).
 • Reset at Math Start

 On: Resets the timer when computation is started. The resetting of the timer is not 
considered to be a timeout. Even if the timer is used as an event, the action is not 
executed.

• Match Time Timer
 Set the time match condition used in event action.

* The condition cannot be changed while memory sampling or computation is in progress.

 • Timer number
 You can set up to four match time conditions (1 to 4).

 • Kind
Setting Description
Day The condition is matched once a day.
Week The condition is matched once a week.
Month The condition is matched once a month.

 Set the items with check marks in the following table depending on the Kind setting.

Setup Item
Kind

Day Week Month
Day  
Day of the week 
Hour:Minute   

 • Month
 Specify the month.

 • Day
 Set the day.

 • Day of the week
 Set the day of the week.

 • Hour:Minute
 Set the time in the range of 00:00 to 23:59.

 • Timer action
Settings Description
Single Executes the action once when the condition is met.
Repeat Executes the action at every specified time.

7.1  Setting the Event Action Function  
(Including the remote control function of the /R1 and /PM1 options and the USER key)
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Procedure
• Resetting the Relative Timer

1. In the operation mode, press FUNC.
The Function menu appears.

2. Press the Timer reset soft key.

3. Press the soft key corresponding to timer you want to reset. Select All to reset all 
timers.
The relative timer is reset.

Explanation
• Resetting the Relative Timer
 Restarts the timer.

• The resetting of the timer is considered to be a timeout. (If the timer is used as an 
event, the action is executed.)

• If you use a timer with the TLOG computation function (/M1, /PM1, and /PWR1 
options), and have specified the resetting at each interval for the computed value, 
the TLOG computed results will be reset.

7.1  Setting the Event Action Function  
(Including the remote control function of the /R1 and /PM1 options and the USER key)
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7.2 Setup Examples of Event Action

Example 1:  Starting/Stopping the Memory Sampling through Remote Control 
(/R1 Option)

Starts/Stops the memory sampling when a signal is applied to remote control input 
terminal 2. Use logic box number 1.

• Setup Screen and Setup Items
 Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event 

action > Event action.

   

<Operation>
If the input to the remote control input terminal 2 is turned ON when memory sampling 
is stopped, memory sampling starts. If the remote control input is turned OFF when 
memory sampling is in progress, memory sampling stops.

Example 2: Writing a Message When an Alarm Occurs
Write the message “Channel 1 Alarm” to group 1 when an alarm occurs on channel 1. 
Use logic box number 2.

• Setup Screen and Setup Items
 Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event 

action > Event action.

   

<Other Settings>
• Set an alarm to channel 1 and output to internal switch 3.
• Register “Channel 1 alarm” in message number 4.
For the procedure to set the alarm, see section 3.7.
For the procedure to set the message, see section 5.4.
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Example 3: Saving the Data Every Day at Hour 17
Save the recorded data to the CF card every day at hour 17. Use logic box number 3. 
Use match time condition 1.

• Setup Screen and Setup Items
 Logic box number 3
 Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event 

action > Event action.

   

 Match Time Condition
 Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event 

action > Match time timer.

   

<Other Settings>
Set the display data to be saved automatically. Set the file save interval to 1day or 
longer. If a file save interval shorter than 1day is specified, the data is also saved at the 
file save interval.
For the procedure to set the recording conditions of the display data, see section 6.1.

7.2  Setup Examples of Event Action
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 Example 4:  Releasing the Alarm Output Using the USER Key (Alarm 
Acknowledge Operation)

Release the activated alarm output by pressing the USER key. Use logic box number 4.

• Setup Screen and Setup Items
 Press MENU (to switch to setting mode), and select the Menu tab > Timer, Event 

action > Event action.

   

<Operation>
Press the USER key to release the activated alarm indication and relay output.

<Related Settings>
Set the alarm indication and alarm output relay operation to Hold.
For the procedure to set the alarm indication operation and alarm output relay operation, 
see section 3.5.

7.2  Setup Examples of Event Action
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8.1 Disabling the Key Operation (Key Lock 
Function)

Disable the key operation.
For a description of the function, see section 1.7.

Setup Screen
• Selecting the Key Lock Function
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Security, Media save.

   

• Key Operation to Be Disabled
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Keylock > Key action, Media* or Action of 
Function.

* On FXs that do not have a CF card slot or USB interface (/USB1 option), the sub menu item 
is “Key action.” In addition, the “Media/USB” group of setup items is not displayed.

 • Key action, Media   • Action of Function

    

Setup Items
• Security > Key
 Select Keylock.

Settings Description
Keylock Enables the key lock function. The Keylock item is displayed in the basic setting 

mode menu.
Login Enables the login function. See section 8.2.

• Keylock > Password
 The password used to release the key lock. (Up to 8 characters, A a # 1 )
 The password is displayed as “********”.

• Key action, Media/USB, or Action of Function
 Select whether to lock each item.

Settings Description
Free Key lock not applied.
Lock Disables the operation.

Chapter 8 Using the Security Function
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Procedure
• Locking the Keys

1. In the operation mode, press FUNC.
The Function menu appears.

2. Press the Keylock soft key.
The key lock is activated. The key lock icon appears in the status display section.

• Releasing the Key Lock
1. In the operation mode, press FUNC.

The Function menu appears.

2. Press the Keylock soft key.
A window appears for you to enter the password.

     

3. Enter the password and press DISP/ENTER.
The key lock is released. The key lock icon in the status display section disappears.
* The password that you entered is displayed as “********.”

8.1  Disabling the Key Operation (Key Lock Function)
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8.2 Enabling Only Registered Users to Operate the 
FX (Login Function)

With the login function, only registered users can operate the FX.
For a description of the function, see section 1.7.

Setup Screen
• Login Function
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Security, Media save.
* On FXs that do not have a CF card slot, the sub menu item is “Security.” In addition, the “Save” 

group of setup items is not displayed.
 On FXs that do not have the Ethernet communication interface (/C7 option), the 

“Communication” setup item in the following figure is not displayed.

   

• Logout Method
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Login > Basic settings.

   

• Registering Administrators
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Login > Admin settings.
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• Registering Users
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Login > User settings.

   

• User Privileges
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Login > Authority of user >Key action, 
Media* or Action of Function.

* On FXs that do not have a CF card slot and USB interface (/USB1 option), the sub menu 
item is “Key action.” In addition, the “Media/USB” group of setup items in the following figure 
is not displayed.

    

Setup Items
You can configure the login function separately for login through keys and login through 
communication commands (/C7 option).
• Security > Key
 Select Login.

Settings Description
Login Enables only registered users to operate the FX using keys. The Login item is 

displayed in the basic setting mode menu.
Keylock Enables the key lock function. See section 8.1.
Off Disables the security functions.

• Security > Communication (/C7 option)
Settings Description
Login Enables only registered users to operate the FX via communications. The 

Login item is displayed in the basic setting mode menu.
Off Disables the security functions.

• User basic settings > Auto logout
Settings Description
Off Does not log out until the logout operation is executed.
1min to 10min Automatically logs out when there is no key operation for a specified time.

8.2  Enabling Only Registered Users to Operate the FX (Login Function)
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• User basic settings > Operation without login
 Sets the operation that the user can carry out when logged out.

Settings Description
Off Only login operation is available.
Display Allows the user to switch the operation screen in addition to the login operation.

• Admin number
 Up to five administrators can be registered. Be sure to register at least one 

administrator. At least one administrator must be registered to use the login function.

• Admin settings > Mode
 The available settings vary depending on the Security setting.

Settings Description
Off Not register.
Key Log into the FX using keys.
Comm* Log into the FX using communication commands.
Web* Log into the operator page and monitor page of the FX using a Web browser.
Key+Comm* Log into the FX using keys and using communication commands.
* Ethernet communication (/C7 option)

• Admin settings > User name
 Set the user name. (Up to 20 characters, A a # 1 )

• You cannot register user names that are already registered.
• You cannot register “quit” or a user name containing all spaces.

• Admin settings > Password
 Set the password (up to 8 characters, A a # 1 )
 Unregistered password is displayed as “????????.” An entered password is displayed 

as “********.”
• You cannot register “quit” or a password containing all spaces.

• User number
 Up to 30 users can be registered.

• User settings > Mode
 The available settings vary depending on the Security setting.

Settings Description
Off Not register.
Key Log into the FX using keys.
Comm* Log into the FX using communication commands.
Web* Log into the monitor page of the FX using a Web browser.
Key+Comm* Log into the FX using keys and using communication commands.
* Ethernet communication (/C7 option)

• User settings > User name, Password
 See the explanation for the administrator user name and password.

• Authority of user
Settings Description
Off No limitations on the operation.
1 to 10 Registration number of the operation limitation.

• Authority of user > Key action, Media/USB, Action of Function
 Set “Authority of user” to a number between 1 and 10.
 See section 8.1.

8.2  Enabling Only Registered Users to Operate the FX (Login Function)
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8.3 Logging in and Logging Out

This section explains the procedure to log into the FX using keys. For the procedure for 
using communication commands to log into the FX, see the Communication Interface 
User’s Manual, IM 04L21B01-17EN.

Procedure
• Logging In

1. In the operation mode, press FUNC.
A list of registered user names appears.

     

2. Press the arrow keys to select a user name, and press DISP/ENTER.
A window appears for you to enter the password.

     

3. Enter the password* and press DISP/ENTER.
The FX is ready to be operated using keys. The name of the user that is logged in is 
displayed in the status display section.

* The password that you enter is displayed as “********.”

• Logging Out
 Using Keys

1. In the operation mode, press FUNC.
The Function menu appears.

2. Press the Logout soft key.
You are logged out from the FX. The user name in the status indication section disappears.

 Auto Logout
 If auto logout is enabled, you are automatically logged out if there is no key operation 

for a specified time.



8-7IM 04L21B01-01EN

U
sing the Security Function

3

2

1

4

5

6

7

8

9

10

11

12

13

14

App

Index

• Changing the Password
 Using Keys

1. In the operation mode, press FUNC.
The Function menu appears.

2. Press the Password change soft key.
A window appears for you to enter the current password.

3. Enter the current password, select ENT, and press DISP/ENTER.
A window appears for you to enter the new password.

4. Enter the new password, select ENT, and press DISP/ENTER.
A window appears for you to enter the new password again.

5. Enter the new password, select ENT, and press DISP/ENTER.
The window closes, and the new password is activated.

8.3  Logging in and Logging Out
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9.1 Setting the Expression, Measurement Range, 
Alarm, Tag, and Data Storage on Computation 
Channels

This section explains how to set a computation channel’s expression, measurement 
range, tag, alarm, and recording On/Off. You cannot set expressions or constants while 
memory sampling or computation is in progress.
For a description of the function, see section 1.8.
For the power measurement (/PWR1 option) expression, see section 3.12. 

Setup Screen
• Expression and Alarm
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Expression, Alarm.

   

• Constants Used in Expressions
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Constant.

   

• Tag, Memory Sampling On/Off, and Alarm Delay Time of Computation  
 Channels
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Tag, Memory, Delay.

   

Chapter 9 Computation and Report Functions (/M1, /PM1, and /PWR1 Options)
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• Conditions of TLOG Computation and Rolling Average
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

TLOG, Rolling average.

   

•  Display for Computation Errors and Handling of Overflow Data in 
Statistical Computation

 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 
setting mode), and select the Environment tab > Math.

   

Setup Items
• First-CH/Last-CH
 Set the target channels.

• Expression/Span
 • Math On/Off

 Select On for channels to be used.
 • Calculation expression

 Enter the expression using up to 120 characters.
 Pressing the Input soft key displays a window used to enter the expression.
 Press the M1/M2 soft key* to switch between a screen used to enter values and 

characters and a screen used to enter operators and functions. Use soft keys, 
arrow keys, and DISP/ENTER to enter an expression.

* On FXs with the power monitor function (/PWR1 option), there is also an M3 soft key.

   

 For details on how to write expressions, see section 9.2.

Note
You cannot use both a USB keyboard (/USB1 option) and the FX keys at the same time to 
enter expressions. If you press a soft key or other FX key while you are using a USB keyboard 
to enter an expression, the expression that you have entered up to that point will be cleared.

9.1  Setting the Expression, Measurement Range, Alarm, Tag, and Data Storage on Computation Channels
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 • Span_L, Span_U
 Set the measurement range.
 Selectable range of values: –9999999 to 99999999
 Selectable decimal places: X.XXXX, XX.XXX, XXX.XX, XXXX.X

 • Unit
 Set the unit of the computed value (Up to 6 characters, A a # 1 ).

• Alarm
 The available alarm types are high limit alarm, low limit alarm, delay high limit alarm, 

and delay low limit alarm.
 The range of alarm values is as follows:

Type Value
H, L, T, t Within –9999999 to 99999999 excluding the decimal point
 

 For details on setting alarms, see section 3.7.
* If the Math On/Off or calculation expression is changed, the alarms for that channel are turned 

Off.

• Alarm delay > Time
 Set the alarm delay time using an integer in the range of 1 to 3600 s.

• Tag > Characters
 Set the tag using up to 16 characters: A a # 1 )

• Constant
 • Number of constant

 Select the constant (K01 to K60) to set.
 • Value

 The selectable range is as follows:
 –9.9999E+29 to –1.0000E–30, 0, 1.0000E–30 to 9.9999E+29
 The number of significant digits of a constant is five. When specifying the constant 

using exponential notation, set the mantissa less than or equal to 5 digits and the 
exponent less than or equal to 2 digits.

• TLOG
 • Timer No.

 Select the timer number to use.
 For details on setting the timer, see section 7.1.

 • Sum scale
 Set the sum scale to /s to /h to match the unit of the measured value.
 Example: If the unit of the measured value is “m3/min,” select /min.
 Off: Sums as-is the measured data per scan interval.

 • Reset
 To reset the TLOG computed value at each interval, select On.

9.1  Setting the Expression, Measurement Range, Alarm, Tag, and Data Storage on Computation Channels
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• Rolling average
 • On/Off

 To take the rolling average of the measured results, select On.
 • Interval

 Select the sampling interval when taking the rolling average from the following: The 
sampling interval takes on a value that is an integer multiple of the scan interval. 
For example, if the sampling interval is set to 5 s when the scan interval is 2 s, the 
actual sampling interval is 6 s.

 • Number of samples
 Set the number of samples for the rolling average using an integer between 1 and 

1500.
 The rolling average time is equal to the sampling interval × the number of samples.

Note
• If the number of data points in the moving average has not reached the specified number 

of samples immediately after computation is started, the average of the available data is 
calculated.

• Computation error data is excluded from the rolling average computation.
• If the computed data exceeds the upper or lower limit, the data is clipped at the upper or 

lower limit, and the rolling average is computed. The upper and lower limit is “±100000000” 
excluding the decimal point. The decimal place is the same as that of the span lower limit.

• Memory sample > On/Off
 Select On  to record the computed data of the target channels.

Settings Description
On Computed data is recorded. Waveforms are displayed on the trend display.
Off  Computed data is not recorded. Even when registered in a display group, 

waveforms are not displayed in the trend display.

• Math
 • Value on Error

 Specify whether to set the display for a computation error to +Over or –Over.
 • Value on Overflow > SUM, AVE

 Specify how to handle overflow data when it is detected in the SUM or AVE 
computation of TLOG or CLOG. This setting is also applied to report generation.

Settings Description
Error Sets the computed result to computation error.
Skip Discards the overflow data and continues the computation.
Limit Uses a limit value in place of the overflow data and continues the computation.

 • Value on Overflow > MAX, MIN, P-P
 Specify how to handle overflow data when it is detected in the MAX, MIN, or P-P 

computation of TLOG or CLOG. This setting is also applied to report generation.
Settings Description
Over Uses the overflow data as-is.
Skip Discards the overflow data and continues the computation.

9.1  Setting the Expression, Measurement Range, Alarm, Tag, and Data Storage on Computation Channels
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9.2 Writing Expressions

This section explains the meaning and how to write expressions.

Common Items
Follow the rules below when writing expressions.
• Use up to 120 characters to write expressions.
• The precedence of computing terms can be specified using parentheses.
• Specify the channels in the expression using channel numbers.
 Example: 1, 12, and 101
 Do not include channels that are set to Log scale (/LG1 option) in a computation 

channel expression. If you include these channels, an error will be returned as the 
measured result.
See section 3.13, “Using the Log Scale to Perform Measurements.”

• The one-digit number of constants (K), communication input data (C), remote input 
terminal status (D), pulse input (P, Q), internal switch (S), alarm output relay status (I), 
and flag (F) in the expression can be denoted as in “01” and “1.”

 Example: K01, K1, C01, C1, D01, D1, P01, P1, Q01, Q1, S01, S1, I01, I1, F01, and F1.
• The data of the previous scan is used in the computation for its own channel number 

and channel numbers greater than its own channel number in the expression.
• Write special computations (HOLD, RESET, and CARRY) and conditional expressions 

at the beginning of expressions.
• You can specify the power measurement elements: active power, regenerative power, 

reactive power (lead and lag), apparent power, voltage, current, frequency, and power 
factor (/PWR1 option)

 See section 3.12, “Measuring Power.”
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Order of Precedence in Computations
The order of precedence of computation in expressions is as follows:

Type Computing Element
          (high order of precedence)
Function ABS(), SQR(), LOG(), LN(), EXP(), 

TLOG.MAX(), TLOG.MIN(), TLOG.AVE(), 
TLOG.SUM(), TLOG.P-P(), CLOG.MAX(), 
CLOG.MIN(), CLOG.AVE(), CLOG.SUM(),  
CLOG.P-P()

Special computation and conditional expression PRE, HOLD, RESET, CARRY, [a?b:c]
Power **
Logical negation NOT
Multiplication and division *, /
Addition and subtraction +, –
Greater than and less than .GT., .LT., GE., LE.
Equal and not equal .EQ., .NE.
Logical product AND
Logical sum and exclusive logical sum OR, XOR
  (low order of precedence)

Limitations
The following limitations exists in writing expressions.

Type Limitations
TLOG computation A computing element cannot be written inside the parentheses.

Only one TLOG computation can be specified in a single expression.
CLOG computation Number of channels that can be written in the parentheses is 30 channels or less.

A computing element cannot be written inside the parentheses.
Only one CLOG computation can be specified in a single expression.

PRE A computing element cannot be written inside the parentheses.
HOLD(a):b Can only be written at the beginning of an expression.

Only one HOLD computation can be specified in a single expression.
RESET(a):b Can only be written at the beginning of an expression.

Only one RESET computation can be specified in a single expression.
CARRY(a):b Can only be written at the beginning of an expression.

Only one CARRY computation can be specified in a single expression.
Only TLOG.SUM can be written in “b.”

Conditional equation
[a?b:c]

RESET, CARRY, or HOLD cannot be written to “a,” “b,” or “c.” Other computing 
elements cannot be combined (example: [a?b:c]+001). However, coditional 
equations can be specified for a, b, and c.

9.2  Writing Expressions
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Four Arithmetic Operation
Expression Example
• Addition 001+002
  (Determines the sum of the measured values of channel 1 and channel 2.)
• Subtraction 001–002
  (Determines the difference of the measured values of channel 1 and  

channel 2.)
• Multiplication 001*K03
  (Multiplies constant K03 to the measured value of channel 1.)
• Division 001/K02
  (Divides the measured value of channel 1 by constant K02.)

Power and Other Computations
Expression Example
• Power 001**002
         (Determines the measured value of channel 1 to the power of 

the measured value of channel 2.)
• Square root SQR(002)
  (Determines the square root of the measured value of channel 2.)
• Absolute value ABS(002)
  (Determines the absolute value of the measured value of 

channel 2.)
• Common logarithm LOG(001)
  (Determines the common logarithm (log10) of the measured 

value of channel 1.)
• Natural logarithm LN(001)
  (Determines the natural logarithm of the measured value of 

channel 1.)
• Exponent EXP(001)
  (Determines e to the power of the measured value of channel 1.)

Relational Computation
Expression Example
002.LT.003
If the measured value of channel 2 is less than the measured value of channel 3, the 
computed result is “1.” Otherwise, the result is “0.”

002.GT.003
If the measured value of channel 2 is greater than the measured value of channel 3, the 
computed result is “1.” Otherwise, the result is “0.”

002.EQ.003
If the measured value of channel 2 is equal to the measured value of channel 3, the 
computed result is “1.” Otherwise, the result is “0.”

002.NE.003
If the measured value of channel 2 is not equal to the measured value of channel 3, the 
computed result is “1.” Otherwise, the result is “0.”

002.GE.003
If the measured value of channel 2 is greater than or equal to the measured value of 
channel 3, the computed result is “1.” Otherwise, the result is “0.”

002.LE.003
If the measured value of channel 2 is less than or equal to the measured value of channel 3, 
the computed result is “1.” Otherwise, the result is “0.”

9.2  Writing Expressions
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Logical Computation
Checks whether the two data values, e1 and e2 (e1 only for NOT), are zeroes or non-
zeroes, and computes according to the conditions.
AND
Logical product
(Syntax) e1ANDe2
(Condition) If the two data values e1 and e2 are both non-zeroes, the computed 

result is “1.” Otherwise, it is “0.”
(Explanation) e1 = 0, e2 = 0 → e1ANDe2 = 0
 e1 ≠ 0, e2 = 0 → e1ANDe2 = 0
 e1 = 0, e2 ≠ 0 → e1ANDe2 = 0
 e1 ≠ 0, e2 ≠ 0 → e1ANDe2 = 1

OR
Logical sum
(Syntax) e1ORe2
(Condition) If the two data values e1 and e2 are both zeroes, the computed result is 

“0.” Otherwise, it is “1.”
(Explanation) e1 = 0, e2 = 0 → e1ORe2 = 0
 e1 ≠ 0, e2 = 0 → e1ORe2 = 1
 e1 = 0, e2 ≠ 0 → e1ORe2 = 1
 e1 ≠ 0, e2 ≠ 0 → e1ORe2 = 1
 
XOR
Exclusive OR
(Syntax) e1XORe2
(Condition) If the two data values e1 and e2 are zero and non-zero or non-zero and 

zero, the computed result is “1.” Otherwise, it is “0.”
(Explanation) e1 = 0, e2 = 0 → e1XORe2 = 0
 e1 ≠ 0, e2 = 0 → e1XORe2 = 1
 e1 = 0, e2 ≠ 0 → e1XORe2 = 1
 e1 ≠ 0, e2 ≠ 0 → e1XORe2 = 0
 
NOT
Logical negation
(Syntax) NOTe1
(Condition) The result is the inverse of the status of data e1 (zero or non-zero).
(Explanation) e1 = 0  → NOTe1 = 1
 e1 ≠ 0  → NOTe1 = 0

Expression Example
01-02OR03.GT.04
Determines the OR of the computed results of “01-02” and “03.GT.04”.

9.2  Writing Expressions
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TLOG Computation
In the explanation below, an expression containing a computing element, an internal 
switch (S), a relay (I), a flag (F), and power measurement elements—voltage, current, 
frequency, and power factor—cannot be written in e1. In addition, only one TLOG 
computation can be specified in a single computing equation.
TLOG.MAX( )
Maximum value
(Syntax)    TLOG.MAX(e1)
(Condition)   Determines the maximum value of channel e1.

TLOG.MIN( )
Minimum value
(Syntax)    TLOG.MIN(e1)
(Condition)   Determines the minimum value of channel e1.

TLOG.AVE( )
Average value
(Syntax)    TLOG.AVE(e1)
(Condition)   Determines the average value of channel e1.

TLOG.SUM( )
Sum value
(Syntax)    TLOG.SUM(e1)
(Condition)   Determines the sum of channel e1.

TLOG.P-P( )
Maximum - minimum value
(Syntax)    TLOG.P-P(e1)
(Condition)   Determines the maximum - minimum value of channel e1.

Expression Example
TLOG.MAX(01)+K01*SQR(02)

Examples of Equations That Are Not Allowed
TLOG.AVE(01)+TLOG.AVE(02)
Reason: TLOG appears twice in one equation.

TLOG.AVE(ABS(01))
Reason: A computing element is used inside the parentheses.

9.2  Writing Expressions
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CLOG Computation
Only data of measurement channels and computation channels can be used in the 
CLOG computation. Up to 30 channels can be written in the parentheses.
In the explanation below, an expression containing a computing element cannot be 
written to e1, etc. In addition, only one CLOG computation can be specified in a single 
computing equation.
CLOG.SUM( )
Sum value
(Syntax) CLOG.SUM(e1.e2.e4-e6)
(Condition) Determines the sum of the data of channels e1, e2, e4, e5, and e6 that 

are measured at the same time.

CLOG.MAX( )
Maximum value
(Syntax) CLOG.MAX(e1.e2.e4-e6)
(Condition) Determines the maximum value among the data of channels e1, e2, e4, 

e5, and e6 that are measured at the same time.

CLOG.MIN( )
Minimum value
(Syntax) CLOG.MIN(e1.e2.e5.e7)
(Condition) Determines the minimum value among the data of channels e1, e2, e5, 

and e7 that are measured at the same time.

CLOG.AVE( )
Average value
(Syntax) CLOG.AVE(e1-e6)
(Condition) Determines the average value among the data of channels e1 to e6 that 

are measured at the same time.

CLOG.P-P( )
Maximum - minimum value
(Syntax) CLOG.P-P(e1.e2.e5.e7)
(Condition) Determines the difference between the maximum and minimum values 

among the data of channels e1, e2, e5, and e7 that are measured at the 
same time.

Expression Example
CLOG.MAX(001.002.104-106)+K01*SQR(002)

Examples of Equations That Are Not Allowed
CLOG.AVE(001.003.005)+CLOG.AVE(002.004.006)
Reason: CLOG appears twice in one equation.

CLOG.AVE(001.ABS(001))
Reason: A computing element is used inside the parentheses.

9.2  Writing Expressions
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Special Computation
PRE( )
(Syntax) PRE(e1)
(Condition) Determines the previous value of e1.

HOLD(a):b
(Syntax) HOLD(a):b
(Condition) When a is zero, b is carried out to derive the computed value. 

Otherwise, the previous computed value is held.

RESET(a):b
(Syntax) RESET(a):b
(Condition) When a is zero, b is carried out to derive the computed value. 

Otherwise, the previous computed value of b is reset, and b is carried 
out to derive the computed value.

CARRY(a):b
(Syntax) CARRY(a):b
(Condition) Only TLOG.SUM can be specified for b. If the computed value X of b is 

less than a, the computed result is X. If X is greater than or equal to a, 
the computed result is the excess (X – a).

(Description) When a value such as the flow rate is summed and the threshold value 
is reached or exceeded, the sum value is reset while carrying over the 
amount that exceeded the threshold value.

Expression Example
Expression that sums the values of channel 1 and resets the value when it reaches or 
exceeds 10000
K01 = 10000
CARRY(K01):TLOG.SUM(001)

Examples of Equations That Are Not Allowed
002+HOLD(K01):TLOG.SUM(001)
Reason: HOLD is not at the beginning of the expression.

RESET(101.GT.K01):TLOG.SUM(001)+RESET(101.GT.K01):002
Reason: RESET appears twice in one equation.

Conditional Expression
[a?b:c]
(Syntax) [001.GT.K01?002:003]
(Condition) If the measured value of channel 1 is greater than constant K01, the 

computed result is the measured value of channel 2. Otherwise, the 
computed result is the measured value of channel 3.

Examples of Equations That Are Not Allowed
[001.GT.K01?002:003]*K02
Reason: Used in combination with another computing element.

Nested Conditional Expressions
A conditional expression can be written to Expression1, Expression2, and Expression3 
in the equation [Expression1?Expression2:Expression3]. For example, the following 
expression is allowed:  
[Equation1?[Equation2-1?Equation2-2:Equation2-3]:[Equation3-1?Equation3-2:Equation3-3]]
Expressions can be nested as long as the number of characters of the expression does 
not exceed 120 characters.

9.2  Writing Expressions
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9.3 Displaying the Computation Channels

Computation channels can be assigned to groups and displayed in a similar manner to 
measurement channels.
For a description of the function, see section 1.8.

Setup Screen
• Color
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Color.

   

• Zone Display and Scale Display
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Zone, Scale.

   

• Bar Graph Display
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Bar.
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• Partial Expanded Display
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Partial.
*   The Partial command appears in the menu if you set Partial to On in basic setting mode 

under View, Message on the Environment tab.

   

• Alarm Marks
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Alarm mark.

   

• Color Scale Band
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Color scale band.

   

9.3  Displaying the Computation Channels
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Setup Items
• Group of channel, First-CH, and Last-CH
 Select the target channel range.

• Color
 See section 5.5.

• Zone
 See section 5.6.

• Partial
 See section 5.9.

• Bar graph
 See section 5.11.

• Scale
 See section 5.7.

• Alarm mark color and Color scale band
 See section 5.8.

9.3  Displaying the Computation Channels
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9.4 Starting/Stopping Computation, Resetting 
Computation, and Releasing Computation Data 
Dropout Display

Setup Screen
• Action Taken When the START Key Is Pressed
 Press MENU (to switch to setting mode), and select the Menu tab > Math channel > 

Math start action.

   

Setup Items
• Math start action > Math start

Settings Description
Off Does not start the computation even when the START key is pressed.
Start Starts the computation when the START key is pressed.
Rst+St Resets the computed result up to then and starts the computation when the 

START key is pressed.

Procedure
• Starting the Computation
 •  Starting the Computation Simultaneously with the Memory Sampling

 Press START. Computation starts simultaneously with the start of the memory 
sampling. The computation icon appears in the status display section.
* Math start must be set to Start or Rst+St.

 • Starting Only the Computation
1. In the operation mode, press FUNC.

The Function menu appears.

2. Press the Math start soft key.
Computation starts, and the computation icon is displayed in the status display section.
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• Stopping the Computation
 • Stopping the Computation Simultaneously with the Memory Sampling

1. Press STOP.
A confirmation dialog box appears.

     

2. Select Mem+Math and press DISP/ENTER.
The memory sampling and computation stop, and the computation icon in the status display 
section disappears.

 • Stopping Only the Computation
1. In the operation mode, press FUNC.

The Function menu appears.

2. Press the Math stop soft key.
The computation stops, and the computation icon in the status display section disappears.

Note
When the computation is stopped, the computed data of the computation channel is held at the 
value that existed immediately before the computation is stopped. When memory sampling is in 
progress, the held value is recorded.

• Resetting the Computed Results on all Computation Channels
1. In the operation mode, press FUNC.

The Function menu appears.

2. Press the Math reset soft key.
The computed results of all computation channels are reset.

• Releasing the Computation Data Dropout Display
 This operation can be carried out when a computation data dropout occurs. When a 

computation data dropout occurs, the computation icon turns yellow.

1. In the operation mode, press FUNC.
The Function menu appears.

2. Press the Math ACK soft key.
The computation icon returns to white.
Math ACK is displayed on the Function menu only when a computation data dropout 
occurs.

Note
A computation data dropout occurs when the computation process cannot be completed within 
the scan interval. If computation data dropout occurs frequently, lessen the load on the CPU by 
reducing the number of computation channels or setting a longer scan interval. If a computation 
data dropout occurs during memory sampling, the data immediately before the dropout is 
recorded as the computed data of the scan interval in which the dropout occurred.

9.4  Starting/Stopping Computation, Resetting Computation, and Releasing Computation Data Dropout 
Display
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9.5 Creating Reports

Set how the reports are created.
For a description of the function, see section 1.8.

Setup Screen
• Report Computation Type
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Environment tab > Report.

   

• Report Type and Time of Creation
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Report > Basic settings.

   

• Source Channels
 Press MENU (to switch to setting mode), hold down FUNC for 3 s (to switch to basic 

setting mode), and select the Menu tab > Report > Report settings.
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Setup Items
• Report > Report select > 1, 2, 3, and 4
 Select the type of data to output as reports. The only data type that can be set more 

than once is Off. You cannot set 1 to Off.
Settings Description
Off Does not output reports.
Ave Outputs the average value.
Max Outputs the maximum value.
Min Outputs the minimum value.
Sum Outputs the sum value.
Inst Outputs the instantaneous value.

• Report > File type
 Set this item when creating two types of reports such as daily report and monthly 

report.
Settings Description
Separate Saves each type of report to a separate file. For information about how files are  
 divided, see section 1.4.
Combine Saves two types of report data in a single file.

• Report set > Report kind
 Select the type of report to be created.

Settings Description
Hour Creates hourly reports.
Day Creates daily reports.
H+D Creates hourly and daily reports.
Day+Week Creates daily and weekly reports.
D+M Creates daily and monthly reports.

• Report set > Basic setting > Date/Day of the week, Time (hour)
 Set the date or day of the week and the time when the report is to be created. The 

specified date/time is when the report file is divided. Set the values in the range 
indicated below. Items with a dash are invalid.
Report Type Date Day of Week Time
Hour - - 0 to 23
Day 1 to 28* - 0 to 23
H+D - - 0 to 23
Day+Week - SUN to SAT 0 to 23
D+M 1 to 28* - 0 to 23
* You cannot specify 29, 30, or 31.

 Report Time and Date/Time When the Report File Is Divided
 Example: When the Date of a daily report is set to 1 and the Time (hour) is set to 

18:00
 A daily report is created every day at hour 18.
 The file storing the report is divided at 18:00 on day 1 of each month.

9.5  Creating Reports
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• Report channel number
 The report is output in order by this number.

• Report channel number > On/Off
 Select On for the report channels to be used.

• Report channel number > Channel
 Set the channel to assign to the report channel. All channels can be assigned, but 

reports are not created for channels set to Skip or Off even if they are assigned. 
Errors are returned for any reports for channels that are set to Log scale (/LG1 option).

 In the stacked bar graph display (see section 4.10 for details), report data is displayed 
in the following groups. However, only channels that have the same unit as the first 
channel in the group are displayed.

Report Group FX1002 and FX1004 FX1006, FX1008, FX1010, and FX1012
1 R01 to R06 R01 to R06
2 R07 to R12 R07 to R12
3 - R13 to R18
4 - R19 to R24

• Report channel number > Sum scale
 Set the sum scale to /s to /day to match the unit of the measured value.
 Example: If the unit of the measured value is “m3/min,” select /min.
 Off: Sums as-is the measured data per scan interval.

• Handling of Overflow Data
 Overflow data is handled in the same way as it is in statistical computations (TLOG 

and CLOG).
 See section 9.1.

Procedure
• Starting/Stopping the Report Function
 Starting the memory sampling starts the report function. Likewise, stopping the 

memory sampling stops the report function.

• Displaying the Reports
 See section 4.5.

• Saving the Reports
 See section 1.4.

9.5  Creating Reports
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10.1 A List of Messages

There are cases in which error codes and messages are displayed on the screen during 
operation. A list of the possible error codes and messages are given in the table below. 
Communication error codes and messages are also listed.
Error responses to communication commands are output in English.

Errors Related to Parameter Settings
• Setting Errors
Code Message Explanation/Countermeasures/Ref. section
1 System error. Contact your nearest YOKOGAWA dealer.
2 Incorrect date or time setting. Enter a correct value.
3 A disabled channel is selected. Specify a channel that is not set to Skip or Off.

Specify a channel that is installed.
4 Incorrect function parameter. See chapter 3 the communication manual.
5 The input numerical value exceeds the set range. Enter a proper value.
6 Incorrect input character string. Enter a proper character string.
7 Too many characters. Enter the correct number of characters.
8 Incorrect input mode. Specify a correct mode.

See section 3.3.
9 Incorrect input range code. Specify a correct range code.

See section 3.3.
11 Range settings are not same within the selected channels. Specify channels with the same range setting.

See section 3.9.
21 Cannot set an alarm for a skipped channel. Cannot be specified on channels set to Skip.

See section 3.7.
22 The upper and lower span limits are equal. Cannot be set to the same value.

See section 3.3.
23 The upper and lower scale limits are equal. Cannot be set to the same value.

See section 3.3.
24 The lower limit of the span band is greater than the upper limit. Set the lower limit less than the upper limit.

See section 3.3.
25 The lower limit of the scale band is greater than the upper limit. Set the lower limit less than the upper limit.

See section 3.3.
26 The scale band is wider than 16 decades of the entire scale. The Log scale width must be 15 decades or less.

See section 3.13.
27 The scale band is less than 1 decade of the entire scale. The absolute value of the difference between the Log 

scale upper limit’s exponent and the Log scale lower 
limit’s exponent must be at least 1. See section 3.13.

28 Incorrect combination of mantissa and exponent. Log scale range setting error.
See section 3.13.

30 The partial boundary value exceeds the range of the span. Set the boundary value in the range of “the minimum 
span value + 1 digit” to “the maximum span value – 1 
digit.”
See section 5.9.

31 Partial-expansion display is set ON for a SKIPPED channel or 
a LOG channel.

Cannot be specified on channels set to Skip.
See sections 3.3 and 5.9

35 The upper and lower limits of the display band are equal. Set the upper limit greater than the lower limit + 5.
See section 5.6.

36 The lower limit of the display band is greater than the upper 
limit.

Set the upper limit greater than the lower limit + 5.
See section 5.6.

37 The display band is narrower than 4% of the entire display. Set the upper limit greater than the lower limit + 5.
See section 5.6.

38 The lower limit of display position is greater than the upper 
limit.

In the Log scale settings, the channel’s color scale band 
display position has been set so that Scale_L is greater 
than or equal to Scale_U.
See section 3.13.

40 Incorrect group set character string. Check the syntax.
See section 5.1.
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Code Message Explanation/Countermeasures/Ref. section
41 There is no specified input channel. Specify a channel that is installed.

Operation Guide and section 5.1.
42 Exceeded the number of channels which can be set. Up to 6 channels per group.

See section 5.1.
43 A channel number cannot repeat in a group. Check that a channel is not registered twice.

See section 5.1.
45 There is no character string saved in the clipboard. Copy a character string to the clipboard.
46 The character string saved in the clipboard is too long. Paste a character string with the specified number of 

characters.
47 Start and end time cannot match. Check the starting and ending times.

See section 2.1.
48 Invalid or missing DST time settings. Check the starting and ending times.

See section 2.1.
49 “Secondary rated power * 1.2 * VT ratio * CT ratio” is greater 

than 10GW.
Configure the settings so that “Secondary rated power × 
1.2 × VT ratio × CT ratio” is less than 10 GW.
See section 3.12.

50 Can’t be set correctly due to a power measurement section 
problem.

An error has occurred in the power measurement 
section, so the setting cannot be made.
Contact your nearest YOKOGAWA dealer to have your 
FX serviced.
See section 3.12.

61 There is no channel specified by the MATH expression. Check the channel number specified by the expression.
See sections 1.8 and 9.1.

62 MATH expression grammar is incorrect. Check that the expression grammar is correct.
See section 9.2.

63 MATH expression sequence is incorrect. Check that the operator used in the expression in 
relation to the applicable operands meets the grammar 
requirements.
See section 9.2.

64 MATH upper and lower span values are equal. Set the upper limit not equal to the lower limit.
See section 9.1.

65 Too many operators for MATH expression. The maximum number of operators in an expression 
has been exceeded. Reduce the number of operators, 
such as by splitting up the expression into multiple 
computation channels.See section 9.2.

70 Nonexistent constant specified in MATH expression. Check the constant number specified by the expression. 
See section 9.1.

71 Set range of the MATH constant is exceeded. Check the selectable range.
See section 9.1.

80 This username is already registered. Register another user name.
See section 8.2.

81 All space or ‘quit’ string cannot be specified. Change the character string.
See section 8.2.

84 The login password has not been set up. Set a password.
See section 8.2.

85 The login password is incorrect. Check the password. If you lost the password, ask your 
administrator to reset it.
See sections 8.2 and 8.3.

86 The key-lock release password is incorrect. Check the password. If you lost the password, it must 
be reset.
See section 8.1.

87 This key is locked. Release the key lock.
See section 8.1.

88 This function is locked. Release the key lock.
See section 8.1.

89 Press [FUNC] key to login. Log in.
See section 8.3.

90 No permission to enter to the SETUP mode. Check the keylock or login settings.
See sections 8.2 and 8.3.
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Code Message Explanation/Countermeasures/Ref. section
91 Password is incorrect. Enter the correct password. If you lost the password, it 

must be reset.
See sections 8.2 and 8.3.

92 Press [ESC] key to change to the operation mode. Press the ESC key.
93 String including space or all space cannot be specified. Spaces are not allowed in the Web browser user name 

and password.
See section 1.5 in the communication manual.

94 More than one address cannot be specified. Only a single sender is allowed.
See section 1.4 in the communication manual.

95 Number entered exceeds channel number range. 
Use another command.

Check the syntax of the Modbus command.
See sections 1.10 and 2.6 in the communication 
manual.

96 This menu is locked. Check the key lock setting. Release the key lock.
See section 8.1.

100 IP address doesn’t belong to class A, B, or C. Check the IP address.
See section 1.3 in the communication manual.

101 The result of the masked IP address is all 0s or 1s. Check the subnet mask.
See section 1.3 in the communication manual.

102 SUBNET mask is incorrect. Check the subnet mask.
See section 1.3 in the communication manual.

103 The net part of default gateway is not equal to that of IP 
address.

Check the IP address.
See section 1.3 in the communication manual.

105 This port number is already in use. Please enter a different 
number.

Enter a different port number for each function.
See section 6.1 in the communication manual.

110 This user name is not registered. Log in as a registered user.
See section 8.3.

113 Password entered is incorrect. Enter the correct password.
See section 8.3.

116 This user name cannot be specified. The user name is reserved.
See section 8.2.

119 This user name is unable to use this mode. A user-level user cannot enter the Basic Setting mode
See section 8.2.

120 Measured value is incorrect. (in ascending order) Set the calibration correction value to a value greater 
than the previous value.
See section 3.9.

122 Measured value exceeds the range setting. Check the channel input or the channel range setting.
See sections 3.3 and 3.9.

124 Password entry cannot be performed. You cannot enter a password.
125 Character entry cannot be performed. A display used to enter character screens is not being 

shown on the FX.
See section 2.10.

126 You cannot use the same password. Specify a different password.
See section 8.3.

127 Report kind overlaps and cannot be set up. Change the overlapped report data type.
See section 9.5.

128 “Logout” cannot be set to “Hide”. See sections 5.16 and 8.3.
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• Execution Errors
Code Message Explanation/Countermeasures/Ref. section
150 This action is not possible because sampling is in progress. Stop the memory sampling and then execute.

See section 6.4.
151 This action is not possible during sampling or calculating. Stop the memory sampling and then execute.

See sections 6.4 and 9.4.
152 This action is not possible because saving is in progress. Wait until the saving is complete.
153 This action is not possible because formatting is in progress. Wait until the formatting is complete.
154 Message not accepted because message limit was reached. The limit is 50 messages.

See section 5.4.
155 The message is not written while sampling is stopped. Start the memory sampling and then execute.

See section 6.4.
156 There are no channels to be saved to the memory. Set the channels to be saved.

See sections 6.1 and 9.1.
157 This function is not possible at this time. Check the FX status.
158 Exceeds time deviation setting. When synchronizing the clock through remote control. 
159 It is outside the postscript message write-in range. Add message can be written to the past section of the 

data being memory sampled.
See section 5.4.
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Operation Errors
Code Message Explanation/Countermeasures/Ref. section
200 Operation aborted because an error was found in media. Use another storage medium or format it.

See section 6.7.
201 Not enough free space on media. There is not enough free space on media or the number 

of directories exceeded the limit. Use another storage 
medium.
See section 1.4.

202 Media is read-only. Make it writable.
210 Media has not been inserted. Insert a storage medium into the drive.
211 Media is damaged or not formatted. Remove the medium and set it again. If an error still 

occurs, replace or format the medium.
See section 6.7.

212 Format error. Try formatting again.
See section 6.7.

213 The file is read-only. Access another file or make the file writable.
214 There is no file or directory. Specified a file in which data is being added. Tried to 

save a file which does not exists in the internal memory. 
215 Exceeded the allowable number of directories or files. Replace a storage medium. Delete unneeded files and 

directories. 
See section 6.7.

216 The file or directory name is incorrect. Use alphanumeric characters and symbols.
See section 6.2.

217 Unknown file type. Check the extension.
See section Appendix 2.

218 This directory or file now exists. Delete it or change the name. See section 6.2.
219 Invalid file or directory operation. Tried to delete multiple directory levels. Or, tried to 

delete a directory containing files.
Delete the files and directories in the directory first 
before executing the operation.
See section 6.7.

220 The file is already in use. Try again later. Wait until the file is accessible.
221 This action is not possible because FTP transmission is in 

progress.
Execute after FTP data transfer is complete.

222 Media is not recognized. Remove and reset the storage medium.
231 Abnormal setting exists in file. Specify another file.
232 There is no available data. Appears when displaying historical trends. Specify 

another file.
233 The specified historical data do not exist. Appears when switching to historical trend from 

information display. 
See section 4.5.

234 The specified channel is not assigned to the display group. Appears when switching to trend, digital, or bar graph 
from overview. 
See sections 4.4 and 5.1.
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Communication Application Errors
• Errors Related to E-mail and Web Server
260 IP address is not set or ethernet function is not available. The IP address is not specified.

Check the IP address.
See section 1.3 in the communication manual.

261 SMTP server is not found. Occurs when the SMTP server is specified by name.
• Check the DNS setting.
• Check the SMTP server name.
See sections 1.3 and 1.4 in the communication manual.

262 Cannot initiate E-mail transmission. • The host name of the FX is not correct. Check the host 
name.

• The port number of the SMTP server is not correct. 
Check the port number.

See sections 1.3 and 1.4 in the communication manual.
263 Sender’s address rejected by the server. Check the sender’s address.

Section 1.4 in the communication manual
264 Some recipients’ addresses are invalid. Check the recipients’ addresses.

See section 1.4 in the communication manual.
265 SMTP protocol error. May occur if a network failure (cable problems, duplicate 

addresses, network device failure, and so on) occurs in 
the middle of the e-mail transmission.

266 Ethernet cable is not connected. Check the cable connection.
See section 1.3 in the communication manual.

267 Could not connect to SMTP server. • Check to see that the SMTP server is connected to the 
network.

• If the SMTP server name is specified using an IP 
address, check to see that the IP address is correct.

See section 1.4 in the communication manual.
268 E-mail transmission request failed. Contact your nearest YOKOGAWA dealer.
269 E-mail transfer error. May occur if a network failure (cable problems, duplicate 

addresses, network device failure, and so on) occurs in 
the middle of the e-mail transmission.

270 Could not connect to POP3 server Check the connection settings.
See section 1.4 in the communication manual.

271 Not able to login to the POP3 server. Check the login name and the password.
See section 1.4 in the communication manual.

272 SMTP authentication failed. Make sure that the user name and password that you are 
using for authentication are recognized by the server.
See section 1.4 in the communication manual.

273 The server requested an unsupported authentication 
method.

Change the server configuration.
See section 1.4 in the communication manual.

275 The current image cannot be output to the Web. The setup display cannot be output to the Web browser. 
This message is displayed on the Web browser.

276 Image data currently being created. Unable to perform key 
operation.

Try again a little later. This message is displayed on the 
Web browser.

277 Could not output screen to Web. Failed to create the image. This message is displayed on 
the Web browser.
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• Errors Related to the FTP Client, SNTP, and DHCP
For a description of the FTP client function of the FX, see the Communication Interface 
User’s Manual, IM 04L41B01-17EN. The detail code does not appear in the error 
message on the screen. You can view the code on the FTP log display of the FX or using 
the FTP log output via communications.

Code Message
280 IP address is not set or FTP function is not available.

Further details are provided by the character string that appears after error code 280.
Character String and Details
HOSTADDR

 An IP address has not been assigned to the FX.
 Check the IP address.

DORMANT
 Internal processing error.1

LINK
 Data link is disconnected.
 Check the cable connection.

281 FTP mail box operation error.
Further details are provided by the character string that appears after error code 281.
Character String and Details
MAIL
 Internal processing error.1

STATUS
 Internal processing error.1

TIMEOUT
 Internal processing error.1

PRIORITY
 Internal processing error.1

NVRAM
 Internal processing error.1

282 FTP control connection error.
Further details are provided by the character string that appears after error code 282.
Character String and Details
HOSTNAME
 Failed the DNS lookup (search the IP address corresponding to the host name).
 Check the DNS setting and the destination host name.
TCPIP
 Internal processing error.1

UNREACH
 Failed to connect to a control connection server.
 Check the address setting and that the server is running.
OOBINLINE

 Internal processing error.1

NAME
 Internal processing error.1

CTRL
 The control connection does not exist.
 Check that the server does not drop the connection and that it responds within the proper time period.

IAC
 Failed to respond in the TELNET sequence.
 Check that the server does not drop the connection and that it responds within the proper time period.
ECHO

 Failed to transmit data on the control connection.
 Check that the server does not drop the connection and that it responds within the proper time period.

REPLY
 Failed to receive data on the control connection.
 Check that the server does not drop the connection and that it responds within the proper time period.

SERVER
 The server is not in a condition to provide the service.
 Check that the server is in a condition in which service can be provided.
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Code Message
283 FTP command was not accepted.

Further details are provided by the character string that appears after error code 283.
Character String and Details
USER
 Failed to verify the user name.
 Check the user name setting.

PASS
 Failed to verify the password.
 Check the password setting.

ACCT
 Failed to verify the account.
 Check the account setting.
TYPE
 Failed to change the transfer type.
 Check that the server supports the binary transfer mode.

CWD
 Failed to change the directory.
 Check the initial path setting.
PORT
 Failed to set the transfer connection.
 Check that the security function is disabled.

PASV
 Failed to set the transfer connection.
 Check that the server supports PASV commands.
SCAN
 Failed to read the transfer connection settings.
 Check that proper response to the PASV command is received from the server.

284 FTP transfer setting error.
Further details are provided by the character string that appears after error code 284.
Character String and Details
MODE
 Internal processing error.1

LOCAL
 Internal processing error.1

REMOTE
 The destination file name is not correct.
 Check that you have the authority to create or overwrite files.

ABORT
 File transfer abort was requested by the server.
 Check the server for the reason for the abort request.
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Code Message
285 FTP data connection error.

Further details are provided by the character string that appears after error code 285.
Character String and Details
SOCKET
 Failed to create a socket for the transfer connection.2

BIND
 Failed the transfer connection command.2

CONNECT
 Failed the transfer connection.2

LISTEN
 Failed the transfer connection reception.2

ACCEPT
 Failed to accept the transfer connection.2

SOCKNAME
 Internal processing error.1

RECV
 Failed to receive data over the transfer connection.2

SEND
 Failed to send data over the transfer connection.2

286 FTP file transfer error.
290 SNTP access failure.

Further details are provided by the character string that appears after error code 290.
Character String and Details
DORMANT

 Internal processing error.1

LINK
 Data link is disconnected.
 Check the cable connection.

291 SNTP server does not respond.
Further details are provided by the character string that appears after error code 291.
Character String and Details
TIMEOUT
 Check that the server is running.2

292 Incorrect SNTP server setting.
Further details are provided by the character string that appears after error code 292.
Character String and Details
HOSTNAME
 Failed the DNS lookup (search the IP address corresponding to the host name).
 Check the DNS setting and the SNTP server name.

TCPIP
 Internal processing error.1

293 Invalid SNTP server reply.
Further details are provided by the character string that appears after error code 293.
Character String and Details
SEND
 A correct IP address has not been assigned to the FX.
 Check the IP address.

BROKEN
 There is a problem with the SNTP server.
 If this error occurs even after executing SNTP manually several times, check the SNTP server.
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Code Message
294 No time correction because excess time deviation with SNTP server. 

Further details are provided by the character string that appears after error code 294.
Character String and Details
OVER
 This error occurs when periodic SNTP is executed by the auto setting of the clock and the 

clock is not adjusted because the time difference between the FX and the SNTP server is 
greater than or equal to 10 minutes.

 Check the time on the FX and the SNTP server.
295 IP address was released because DHCP setting is invalid.

Further details are provided by the character string that appears after error code 295.
Character String and Details
REJECT
 Address obtained by DHCP is inappropriate.

296 DHCP access failure.
Further details are provided by the character string that appears after error code 296.
Character String and Details
ESEND
 Failed to transmit to the DHCP.

ESERVER
 DHCP server not found.

ESERVFAIL
 No response from the DHCP server.

ERENEWED
 Address renewal rejected.

EEXTENDED
 Address lease extension rejected.

EEXPIRED
 Address lease period expired.

297 Registration of the hostname to the DNS server failed.
Further details are provided by the character string that appears after error code 297.
Character String and Details
INTERNAL
 Failed to register the host name (transmission error, reception timeout, etc.).

FORMERR
 Failed to register the host name (format error: DNS message syntax error).

SERVFAIL
 Failed to register the host name (server failure: DNS server processing error).

NXDOMAIN
 Failed to register the host name (non existent domain).

NOTIMP
 Failed to register the host name (not implemented).

REFUSED
 Failed to register the host name (operation refused).

YXDOMAIN
 Failed to register the host name (name exists).

YXRRSET
 Failed to register the host name (RR set exists).

NXRRSET
 Failed to register the host name (RR set does not exist).

NOTAUTH
 Failed to register the host name (not authoritative for zone).

NOTZONE
 Failed to register the host name (different from zone section).

NONAME
 Host name not entered on the FX.
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Code Message
298 Deletion of the hostname to the DNS server failed.

Further details are provided by the character string that appears after error code 298.
Character String and Details
INTERNAL
 Failed to delete the host name (transmission error, reception timeout, etc.).

FORMERR
 Failed to delete the host name (format error: DNS message syntax error).
SERVFAIL
 Failed to delete the host name (server failure: DNS server processing error).
NXDOMAIN
 Failed to delete the host name (non existent domain).

NOTIMP
 Failed to delete the host name (not implemented).

REFUSED
 Failed to delete the host name (operation refused).

YXDOMAIN
 Failed to delete the host name (name exists).
YXRRSET
 Failed to delete the host name (RR set exists).

NXRRSET
 Failed to delete the host name (RR set does not exist).
NOTAUTH
 Failed to delete the host name (not authoritative for zone).

NOTZONE
 Failed to delete the host name (different from zone section).

NOTLINKED
4 Physical layer was disconnected when removing the host name.

1 Contact your nearest YOKOGAWA dealer.
2 These errors may occur if the network experiences trouble during the data transmission  

(bad cable connection, duplicate addresses, network equipment failure).

Note
• The FTP client function on the FX has a timer function that drops the connection if there is 

no data transfer for two minutes. If the server does not respond within this time period, the 
transfer fails.

• The FTP client function on the FX overwrites files without a warning if files with the same 
name exist at the transfer destination unless the server returns a negative response.
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Communication Errors
For information about the FX communication functions, see the Communication Interface 
User’s Manual, IM 04L41B01-17EN.

•  Errors during Setting and Basic Setting Modes, Output Communication 
Command Execution, and Setup Data Loading

Code Message
300 Command is too long.
301 Too many number of commands delimited with ‘;’.
302 This command has not been defined.
303 Data request command can not be enumerated with sub-delimiter.
350 Command is not permitted to the current user level.

351 This command cannot be specified in the current mode.
352 The option is not installed.
353 This command cannot be specified in the current setting.
354 This command is not available during sampling or calculating.

•  Memory Access Errors during Setting and Basic Setting Modes and Output 
Communication Command Execution

An English error message is returned via the communication interface. These messages 
are not displayed on the FX.

Code Message
362 There are no data to send ‘NEXT’ or ‘RESEND’.
363 All data have already been transferred.
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• Maintenance and Test Communication Command Errors
An English error message is returned via the communication interface. These messages 
are not displayed on the FX.

Code Message
390 Command error.
391 Delimiter error.
392 Parameter error.
393 No permission.
394 No such connection.
395 Use ‘quit’ to close this connection.
396 Failed to disconnect.
397 No TCP control block.
398 Format error.

• Other Communication Errors
An English error message is returned via the communication interface. These messages 
are not displayed on the FX.

Code Message
400 Input username.

Enter the name of a user that is registered on the FX and that is allowed to log into the FX through communication 
commands.

401 Input password.
Enter the password.

402 Select username from ‘admin’ or ‘user’.
Select “admin” or “user” to specify the user level to connect to.

403 Login incorrect, try again!
The login failed. Enter the information again, starting with the user name.

404 No more login at the specified level is acceptable.
Connecting would cause the maximum number of simultaneous connections (administrator: 1, normal user: 2 to be 
exceeded. Connect to a different level, or exit by entering “quit.”

420 Connection has been lost.
The connection has been lost.

421 The number of simultaneous connection has been exceeded.
The maximum number of simultaneous connections has been reached, so no further connections can be made.

422 Communication has timed-out.
Communication timed out so the connection was closed.
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Status Messages
Code Message
500 Execution is complete.
501 Please wait a moment...
503 Data are being saved to media...
504 File is being loaded from media...
505 Formatting...
506 Memory save to media was interrupted.
508 There is no file or directory.
509 Press [DISP/ENTER] key to display file name.
510 Range cannot be changed during sampling or calculating.
511 MATH expression cannot be changed during sampling or calculating.
513 Post process in progress.
514 Now loading historical data.
515 Data save is completed.
516 Files are now being sorted.
520 Connecting to the line...
521 The data file is being transferred.
530 Media can be removed safely.
531 Media was removed compulsorily.
532 USB device has been connected.
533 USB device cannot be recognized.
534 There was no data which is not saved to media.
535 Media was recognized.
542 Media read error.
543 Flash write error.
550 The A/D calibration is being executed...
551 FTP test is being executed...
552 E-mail test is being executed...
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Code Message
560 Now connecting to SNTP server.
561 Now adjusting the time.
562 Ethernet cable is disconnected.

Further details are provided by the character string that appears after error code 562.
Character String and Details
ON

 Detected that an Ethernet cable was connected.
OFF

 Detected that an Ethernet cable was disconnected.
563 The command is sent to DHCP. 

Further details are provided by the character string that appears after error code 563.
Character String and Details
RENEW

 Requesting address renewal to the DHCP server.
564 The response was received from DHCP.

Further details are provided by the character string that appears after error code 564.
Character String and Details
RENEWED

 Address renewal complete.
EXTENDED
 Address release extension request complete.

RELEASED
 Address release complete.

565 IP address was set.
Further details are provided by the character string that appears after error code 565.
Character String and Details
IPCONFIG

 Assigned the IP address.
566 It is a setting that doesn’t register hostname to the DNS server.

Further details are provided by the character string that appears after error code 566.
Character String and Details
NOREQUEST
 Configured not to register the host name.

567 The hostname was registered to DNS server.
Further details are provided by the character string that appears after error code 567.
Character String and Details
UPDATE
 Registered the host name to the DNS server.

568 The hostname was deleted from DNS server.
Further details are provided by the character string that appears after error code 568.
Character String and Details
REMOVE
 Assigned the IP address.
OFF

 Deleted the host name from the DNS server.
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Warning Messages
Code Message Ref. Section
600 Measured data and Settings have been initialized. –
601 Measured data have been initialized. –
610 This username is already registered. See section 8.2.
614 Calibration settings are reset because of range setting change. See section 3.9.

System Errors
Servicing is required when a system error occurs. If this happens, contact your nearest 
YOKOGAWA dealer.

Code Message Description
901 ROM failure. −
902 RAM failure. −
910 A/D memory failure for all input channels. −
915 Failed to measure power. The FX temporarily failed to measure one of the elements 

used to calculate the power.
916 The power measurement function failed. This is displayed when a malfunction is detected in the 

power measurement section.
The computation icon is displayed in red.

921 Channel 1 A/D calibration value error. −
925 A/D calibration error. −
930 Memory acquisition failure. −
940 The Ethernet module is down. −
950 Incorrect number for the A/D calibration. −
951 Failed to write A/D calibration value. −
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10.2 Troubleshooting

  

Is the power supply  
connected properly? 

Is the power  
supplied properly? 

NO 

NO 

NO 

YES 

YES 

YES 

Does not function (nothing is displayed). 

Is the power switch  
turned ON? Does the  
switch work properly? 

Connect properly. 

Turn ON the power properly. 

Contact your nearest YOKOGAWA  
dealer. 

Supply the power at the specified  
voltage and frequency. 
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Does the input meet
the specifications?

NO

NO

NO

NO

NO

YES

YES

YES

YES

• Large measurement errors
• Trend or digital wave value fluctuation
• Trend going off the scale beyond either 0% or 100%

YES

• Adjust the span and range
 settings (section 3.3).
• If you use input calibration
 (/CC1 option), check the set values
 for correction points (section 3.9).
  
  

Change the input wiring to meet
the specifications.

Is the input wiring correct?

• Attach the input terminal cover
 correctly.  
• Protect the input terminal from fans
 and other sources of wind.
• Keep the temperature fluctuation
 near the input terminal to a
 minimum.
  

Are the range/span
settings appropriate?

Are you taking
measures against noise?

Are
you keeping

the environmental temperature
constant (TC

input)?

• Separate the input wiring from the
 noise source.
• Ground the recorder.
• Ground the measured object.
• Insulate the TC from the measured
 object.
• Use shielded cables for input.
• Change the integration time
 of the input A/D converter
 (section 3.1).  
• Use the moving average of the
 input (section 3.4).
  

• Wire correctly
• Install the terminal block correctly.
• Fasten the terminal screws
 correctly.
• Insulate the RTD from the ground.
• If burnt, replace the TC.

Is the input wiring parallel
with other equipment?

NO

NO

YES

YES

Is the RJC setting
correct (TC input)?

• Stop the TC burnout upscale/
 downscale function of other
 equipment.
• Ground the FX and other
 equipment at one point.
• Disconnect parallel wiring
 (for example, use a
 double-element TC)

Configure correctly.

Contact your nearest YOKOGAWA
dealer to have your FX serviced.

Section 3.2

Section 13.1

10.2  Troubleshooting
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Taking measures  
against noise? 

NO 

YES 

• Move the input and communication wires  
 away from the noise source. 
• Ground the recorder. 
• Use shielded cables for input and  
 communication wires. 
• Insert an isolation transformer into the  
 power line. 
• Insert a power line filter into the power line. 
• If an inductive load is used in the alarm  
 output line, insert a serge suppressor in  
 the line. 

Contact your nearest YOKOGAWA  
dealer. 

Display and other functions do not work properly. 

Are all of
the typical conditions for

displaying the item
satisfied?

NO

YES

• Make sure that the menu item is set
 to be displayed using the menu
 customize function.  
   If the item is not set to be displayed,
 then set it to be displayed
 (see section 5.16).
 • Confirm that the FX is equipped
 with the options required for that
 menu item.
  Contact your nearest YOKOGAWA

dealer to have your FX serviced.

Items on the display selection menu or
function menu are not displayed.

10.2  Troubleshooting
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11.1 Periodic Inspection

Check the operation periodically to keep the FX in good working order. 
Perform the following inspections, and then contact your YOKOGAWA dealer if 
necessary.
• Is the display and storage functioning properly?
 If not, see chapter 10, “Troubleshooting.”
• Has the brightness of the LCD backlight deteriorated?

Service Life of Consumable Parts

The service lives for parts that wear down are shown in the following table.
These service lives are estimated values that have been calculated assuming that the 
product is used under standard operating conditions. These values are not guaranteed.

Item Replacement Period Part Name

LCD 8 years LCD

Battery 10 years Sub board

Rubber packing for  
dust and water protection 5 years Packing

Aluminum electrolytic  
capacitor

5 years* Power supply assembly

5 years* AD assembly

* The replacement period when the FX is used at the upper limit of the normal operating 
temperature (50°C) varies depending on the usage environment temperature and the FX 
specifications. When the usage environment temperature is 30°C, the replacement period 
may be 10 years or more.

Note
• The service life of the LCD indicates the point in time when the LCD brightness is half of its 

initial value. The brighter that you set the LCD, the shorter its replacement period becomes. 
The decrease in the LCD brightness varies depending on the usage conditions, and the 
judgment of the LCD’s brightness is subjective.

• With the passage of time, the LCD may be tinged yellow. The brighter that you set the LCD, 
the faster it will discolor.

• If the rubber packing has come loose, attach it so that the protrusions are on the bottom 
as shown in the figure below. Attaching it upside down will hamper the dust proofing and 
waterproofing. Attach it firmly, depressing the rib lightly with a finger.

     

Chapter 11 Maintenance
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11.2 Calibrating the FX

It is recommended that the FX be calibrated once a year to assure its measurement 
accuracy.
Calibration service is also provided by YOKOGAWA dealers.
For details, contact your nearest YOKOGAWA dealer.

Required Instruments
Calibration instruments with the following resolution are required for calibrating the FX.
Recommended Instruments
• DC voltage standard: Fluke 9100 or equivalent
  Main specifications
  Output accuracy: ±(0.005% + 1 µV)
• Decade resistance box: Yokogawa Meters & Instruments Model 2793-01 

or equivalent
  Main specifications
  Accuracy of output range 0.1 to 500 Ω:  

±(0.01% +2 mΩ)
  Resolution: 0.001 Ω
• 0°C standard temperature device: ZC-114/ZA-10 by Coper Electronics or equivalent
  Main specifications
  Standard temperature stability accuracy: ±0.05°C
For information on purchasing the calibration instruments, contact your nearest 
YOKOGAWA dealer.

Calibration Procedure
1. Wire the FX and the calibration instrument as shown in the following figure, and 

adequately warm up the instruments (the warm-up time of the FX is at least 30 
minutes).

2. Check that the operating environment such as ambient temperature and humidity 
is within the standard operating conditions (see section 13.6).

3. Apply appropriate input signals corresponding to 0, 50, and 100% of the input 
range and calculate the errors from the readings.
If the error does not fall within the accuracy range of the specifications, contact your nearest 
YOKOGAWA dealer.

Note
For thermocouple inputs, you must measure the temperature of the input terminal and apply a 
voltage taking into account the reference junction temperature.

DC Voltage Measurement (Example for the FX1012)

  

DC voltage standard

+
-Input terminal

+
-
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Temperature Measurement Using an RTD (Example for the FX1012)

  

Decade resistance box

The resistance of three lead 
wires must be equal.

(Model 2793-01 from Yokogawa 
Meters & Instruments Corporation)

b

A
B

Input terminal

Temperature Measurement Using a Thermocouple  
(Example for the FX1012)

Thermocouple wires or TC 
extension wires

Thermocouple 
wires

Copper 
wires

Copper wires

DC voltage standard

+
-

(0 °C standard temperature device  ZC-114/ZA-10 by Coper Electronics)

Input terminal

RJC of TC Input
As the measurement terminal of the FX is generally at room temperature, the actual 
output of the thermocouple is different from the values given on the thermoelectromotive 
force table based on 0°C. The FX performs compensation by measuring the temperature 
at the input terminal and adding the corresponding thermoelectromotive force to the 
actual output of the thermocouple. Therefore, when the measurement terminal is shorted 
(equivalent to the case when the detector tip is 0°C), the measured value indicates the 
temperature of the input terminal.
When calibrating the FX, this compensation voltage (thermoelectromotive force of 0°C 
reference corresponding to the input terminal temperature) must be subtracted from the 
output of the standard generator before application. As shown in the figure, by using the 
0°C standard temperature device to compensate the reference junction at 0°C, you can 
input the thermoelectromotive force of 0°C reference from the DC voltage standard and 
perform the calibration.

11.2  Calibrating the FX
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12.1 Installation Location

Install the FX indoors in an environment that meets the following conditions:
• Instrumentation Panel
 The FX is designed to be installed in an instrumentation panel.
• Well-Ventilated Location
 To prevent overheating, install the FX in a well-ventilated location. For the panel cut 

dimensions when arranging multiple FXs, see section 12.3. When other instruments 
are installed next to the FX, follow the panel cut dimensions to provide adequate 
space around the FX.

• Minimal Mechanical Vibrations
 Install the FX in a location that has minimal mechanical vibrations. Installing the FX in 

a location that is subject to large levels of mechanical vibration will not only put added 
stress on its components, it may also impede ordinary measurement.

• Level Location
 Install the FX in a level location so that it is not slanted to the left or the right (however, 

the FX can be inclined up to 30 degrees backward for panel mounting).

Note
Condensation may form when moving the FX from an environment whose temperature or 
humidity is low to an environment whose temperature or humidity is high, or when there 
is a sudden change in temperature. Temperature or humidity changes may also result in 
thermocouple measurement errors. In these kinds of circumstances, let the FX adjust to the 
new environment for at least an hour before using it.

Do not install the FX in the following places.
• Outdoors
• In Direct Sunlight or Near Heat Sources
 Install the FX in a place that is near room temperature (23°C) and that is not subject to 

large temperature fluctuations. Placing the FX in direct sunlight or near heat sources 
can cause adverse effects on the internal circuitry.

• Where an Excessive Amount of Soot, Steam, Moisture, Dust, or Corrosive Gases 
Are Present

 Soot, steam, moisture, dust, and corrosive gases will adversely affect the FX. Avoid 
installing the FX in such locations.

• Near Strong Magnetic Field Sources
 Do not bring magnets or instruments that produce electromagnetic fields close to the 

FX. Operating the FX near strong magnetic fields can cause measurement errors.
• Where the Display Is Difficult to See
 The FX uses an LCD screen, so it is difficult to view the display from an extreme 

angle. Install the FX so that the user can view the display directly from the front.

Chapter 12 Installation and Wiring
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12.2 Installation Procedure

Use a steel panel that is 2 mm to 26 mm thick.
1. Insert the FX through the front of the panel.
2. Mount the FX to the panel using the included mounting brackets as shown in the 

figure below.
• Use two mounting brackets to support the top and bottom or the left and right 

sides of the case (remove the stickers that are covering the holes before you 
attach the brackets).

• Follow the procedure below to mount the FX to the panel.
• First, attach the two mounting brackets and temporarily tighten the mounting 

screws.
• Next, fix the FX in place by tightening the mounting screws with the 

appropriate torque. When the FX is approximately perpendicular to the panel, 
press the mounting brackets so that they are in contact with the case, and 
fully tighten the mounting screws.

• Tighten the mounting bracket screws until you hear clicks.

CAUTION
• Using more than the appropriate torque to tighten the screws can deform the case 

or damage the brackets.
• Be sure not to insert foreign objects or tools into the case through the mounting 

bracket holes.
• Do not touch the screw at the top of the mounting bracket (A). Loosening or 

tightening this screw may cause the FX to malfunction.

Panel Mounting Diagram

  

Front

Panel

Panel
Mounting bracketMounting bracket

Torque driver
(Phillips or flat blade)

Mounting screw

FX case

Attach firmly

(In the figure, the mounting brackets are used on the top and bottom of the case.)

Mounting screw

Screws temporarily fastened Fixed

Rubber packing for dust 
and water protection
(except side-by-side 
mounting)

A

Note
To achieve sufficient dust proofing and waterproofing, attach the included rubber packing to the 
FX, and then mount the FX in the middle of the panel cut out.
However, do not use the rubber packing if you are mounting two instruments side by side or 
one on top of the other.



12-3IM 04L21B01-01EN

Installation and W
iring

3

2

1

4

5

6

7

8

9

10

11

12

13

14

App

Index

12.3 External Dimensions and Panel Cut 
Dimensions

13
6.

5
+0

.4 0

Unit: mm (approx. inch)
If not specified, the tolerance is ±3%.
However, in cases of less than 10mm, the tolerance is ±0.3 mm.

Panel thickness

(Dimensions after attaching 
the mounting bracket)

If not installing the rubber packing for dust and water protection,
*1: 20.2 (0.80), *2: 163.7 (6.44), *3: 110.0 (4.33).

(*1) (*2)

(*3)

(Dimensions after attaching 
the mounting bracket)

13
6.

5 
(5

.3
7)

14
4.

0 
(5

.6
7)

16
1.

7 
(6

.3
7)

72
.0

   
(2

.8
3)

72
.0

 (2
.8

3)

12
.6

 
(0

.5
0)

12
.6

 (0
.5

0)
± 

0.
3 

(0
.0

1)

(2.74)

74.5 (2.93)

161.7 (6.37)
22.2 (0.87) 161.7 (6.37)

108.0 (4.25)
144.0 (5.67)

2 to 26 
(0.08 to 1.02)

Mounting bracket

69.5

Panel cut dimensions

MIN 175 
     (6.89)

L+ 2 (0.08)
0

137 (5.39)+ 2 (0.08)
0

Side-by side mounting 
(vertically; max. 3 units)

137 
(5.39)

MIN 175 
     (6.89)

0

L + 2 (0.08)
0

Side-by-side mounting 
(horizontally)

137 (5.39)+ 2 (0.08)
0

137 
(5.39)

+ 2 (0.08)
0

Single-unit mounting

L+ 2 (0.08)
0

2
3
4
5
6
7
8
9

10
n

282 (11.10)
426 (16.77)

in mm (approx. inches)

570 (22.44)
714 (28.11)
858 (33.78)

1434 (56.46)
1290 (50.79)
1146 (45.12)
1002 (39.45)

(144 × n) – 6 [(5.67 × n) – 0.24]

Units

+ 2 (0.08)

External dimensions
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12.4 Input Signal Wiring

WARNING
• To prevent electric shock while wiring, make sure that the power supply is turned 

off.

CAUTION
• Applying a strong tension to the input and output signal cables connected to the FX 

may damage the cables or the FX terminals. To avoid applying tension directly to 
the terminals, fix all cables to the rear of the mounting panel.

• To prevent fire, use signal cables with a temperature rating of 70°C or more.
• Do not apply voltages that exceed the following values to the input terminals. Doing 

so may damage the FX.
 • Maximum input voltage: ±60 VDC
 •  Maximum common mode voltage:  ±60 VDC (under measurement category II 

conditions)
• The FX is an installation category II product.

Precautions to Be Taken While Wiring
Take the following precautions when wiring the input signal cables.
When using a screw terminal, we recommend that you use a crimp-on lug with an 
insulation sleeve (designed for 3 mm screws).

   Crimp-on lug (designed for 3 mm screws) with an insulation sleeve

Take measures to prevent noise from entering the measurement circuit.
• Move the measurement circuit away from the power cable (power circuit) and ground 

circuit.
• Ideally, the object being measured should not generate noise. However, if this is 

unavoidable, isolate the measurement circuit from the object. Also, ground the object 
being measured.

• Shielded wires should be used to minimize the noise caused by electrostatic induction. 
Connect the shield to the ground terminal of the FX as necessary (make sure you are 
not grounding at two points).

• To minimize noise caused by electromagnetic induction, twist the measurement circuit 
wires at short, equal intervals.

• Make sure to earth ground the protective ground terminal through minimum resistance 
(less than 100 Ω).

When using internal reference junction compensation on the thermocouple input, 
take measures to stabilize the temperature at the input terminal.
• Always use the terminal cover.
• Do not use thick wires which may cause large heat dissipation (we recommend a 

cross sectional area of 0.5 mm2 or less).
• Make sure that the ambient temperature remains reasonably stable. Large 

temperature fluctuations can occur if a nearby fan turns on or off.

Connecting the input wires in parallel with other devices can cause signal 
degradation, affecting all connected devices. If you need to make a parallel 
connection, then
• Turn the burnout detection function off.
• Ground the instruments to the same point.
• Do not turn other instruments on or off during operation. This can have adverse effects 

on the other instruments.
• RTDs cannot be wired in parallel.
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Wiring Procedure
A terminal cover is attached to the measuring input terminal block on the rear panel. A 
label indicating the terminal arrangement is affixed to the cover.

1. Turn the recorder off, and remove the terminal cover. To remove the cover, pull the 
right-and-left pawls.

2. Connect the signal cables to the terminals.
Recommended torque for tightening the screws 0.5 N•m

3. Replace the terminal cover.

12.4  Input Signal Wiring



12-6 IM 04L21B01-01EN

Arrangement of the Input Terminals

   

Input terminal block

   

Input terminal block 
of the FX1002

Input terminal block 
of the FX1004

Input terminal block 
of the FX1006

Input terminal block 
of the FX1008

Input terminal block 
of the FX1010

Input terminal block 
of the FX1012

For TC input, use shielded compensating lead wires for wiring.
For RTD input, lead wire resistance per wire of 10 Ω or less. Make the resistances of 
the three wires equal.
For DCA input, example: for 4 to 20 mA input, use a shunt resistor of 250 Ω ± 0.1%.

+/A

/b

CH1

–/B

CH2

+/A

/b

CH1

–/B

CH2CH3CH4

+/A

/b

CH1

–/B

CH2CH3CH4CH5CH6

+/A

/b

CH1

CH7

–/B

CH2

CH8

CH3CH4CH5CH6

+/A

/b

CH1

CH7

–/B

CH2

CH8CH9CH10

CH3CH4CH5CH6

+/A

/b

CH1

CH7

–/B

CH2

CH8CH9CH10CH11CH12

CH3CH4CH5CH6

12.4  Input Signal Wiring
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– +
+

–
DC voltage input

TC inputDC voltage input or DI (on/off) input

RTD input DC current input

DC current input

Shunt resistor
Example: For 4 to 20 mA input, use 
a shunt resistor of 250 Ω ± 0.1%.

– +

–

+

– +

ABb

Lead wire resistance per 
wire of 10 Ω or less.
Make the resistances of 
the three wires equal.

A

b
B

Compensating 
lead wire

Note
RTD input terminals A and B are isolated on each channel. Terminal b is shorted internally 
across all channels. However, terminal b is also isolated on each channel on models with the 
/N2 option (3 leg isolated RTD).

12.4  Input Signal Wiring
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12.5 Optional Terminal Wiring

WARNING
• To prevent electric shock while wiring, make sure that the power supply is turned 

off.
• If a voltage of more than 30 VAC or 60 VDC is to be applied to the output 

terminals, use ring-tongue crimp-on lugs with insulation sleeves on all terminals 
to prevent the signal cables from slipping out when the screws become loose. 
Furthermore, use double-insulated cables (dielectric strength of 3000 VAC or 
more) for the signal cables on which a voltage of 30 VAC or 60 VDC or more is 
to be applied. For all other signal cables, use basic insulated cables (dielectric 
strength of 1500 VAC). To prevent electric shock, attach the terminal cover after 
wiring and make sure not to touch the terminals.

CAUTION
• Use the following circuit voltages for the connection to the alarm/FAIL/status 

output terminal.
• When the connection is to Mains Circuits (primary power supply circuits):  

150 V or less
• When the connection is to circuits derived from Mains Circuits (secondary 

power supply circuits): 250 V or less
 (Keep the Mains Circuit voltage at 300 V or less, and use an isolation 

transformer.)
• To prevent fire, use signal cables with a temperature rating of 70°C or more.
• Applying a strong tension to the input and output signal cables connected to 

the FX may damage the cables or the FX terminals. To avoid applying tension 
directly to the terminals, fix all cables to the rear of the mounting panel.

• Do not short the transmitter power supply output terminal or apply external 
voltage to it. Doing so may damage the instrument.

• When using the transmitter power supply output terminal, do not use current that 
is equal to or greater than the maximum output current (25 mADC). Doing so 
may damage the instrument.

Note
For remote control wiring, use shielded wires to reduce noise. Connect the shield to the 
functional ground terminal or the ground terminal of the FX.

Precautions to Be Taken While Wiring
We recommend that you use crimp-on lugs (designed for 3 mm screws) with 
insulation sleeves to connect to the optional terminals.

   Crimp-on lug (designed for 3 mm screws) with an insulation sleeve

Wiring Procedure
As shown in the figure on the next page, the optional terminal block is located on the rear 
panel. The optional terminal block is only available when one of the following options, 
which require I/O, is installed in the FX.
 Alarm output relay (/A[ ] or /A4A), FAIL/status output relay (/F1), remote control 

function (/R1), 24 V transmitter power supply output (/TPS[ ]), pulse input (/PM1), 
power monitor (/PWR1), or communication interface (/C3)

Dedicated cover is attached to the optional terminal block.
1. Turn off the recorder and remove the terminal cover.
2. Connect the signal cables to the terminals. The recommended torque for tightening 

the screws is 0.5 N•m.
3. Replace the terminal cover.
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Arrangement of the Optional Terminals

   
Optional terminal block

12.5  Optional Terminal Wiring
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The following figures show the terminal positions for each option when only that option is 
installed. Even if you have installed a number of options, the individual terminal positions 
of the options do not change (except for the case where you have installed both the 
/TPS2 and /A1 options; in this case, the /A1 terminal positions are different).

1 to 8: Remote control terminal 
 number
C: Common

NC: Normally closed
C: Common
NO: Normally opened

NC
Remote control inputAlarm output, FAIL, Status

H and L
Pulse input

+ and –

Transmitter power supply 
output

Symbols such as “NC” indicate the terminal functions.

A terminal that is not used.

Alarm outputAlarm output

Alarm outputAlarm output

Alarm output Alarm output

Alarm output

Memory 
end

Remote control input Remote control inputPulse input

Voltage inputCurrent 
input

Current 
input

Transmitter power supply output Transmitter power supply output

NCCNO

/A1 /A2

01

NCCNO

02

NCCNO

01

NCCNONCCNO

0102

NCCNO

NCCNONCCNO

02

NCCNO

03

NCCNO

04

NCCNO

/A3 /A4A

01

NCCNO

NCCNONCCNO

02

0506

CNOCNOCNOCNOCNOCNO

CNOCNOCNOCNOCNOCNO

RS-422A/485

NCCNO

03

NCCNO

04 010203040506

070809101112

FAIL

/C3 /F1

FG SG SDB SDA RDB RDA

/PM1 /R1

L H L H L H 4 23 1 C5 8 7 6 4 23 1 C5

/PWR1

3S 1L 1S P1P2P33L

/TPS2 /TPS4

+- +- +- +-+- +-

/A1 when installed in the FX with a /TPS2

12.5  Optional Terminal Wiring
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Alarm Output Terminal (/A1, /A2, and /A3), FAIL Output Terminal and Memory 
End Output Terminal (/F1)

C NCNO

Output format: Relay contact
Contact rating: 250 VAC (50/60 Hz)/3 A, 

250 VDC/0.1 A (load resistance)
Withstand voltage: 1600 VAC (50/60 Hz) for one 
 minute (between output 
 terminals and the ground 

terminal)

During normal 
operation

When a failure 
occurs

When power 
is turned off

NO C NC

During normal 
operation

NO C NC

When the 
specified 

status occurs

NO C NC

NO C NC NO C NC NO C NC
When power 
is turned off

FAIL output
(/F1)

Other output 
(/F1)

Alarm Output Terminal (/A4A)

CNO

Output format: Relay contact
Contact rating: 250 VAC (50/60 Hz)/3 A, 
 250 VDC/0.1 A (load resistance)
Withstand voltage: 1600 VAC (50/60 Hz) for one 
 minute (between output terminals 
 and the ground terminal)

During normal 
operation

When the specified 
status occurs

NO CAlarm output NO C

Remote Control Input Terminal (/R1)

C
1 to 8

• Transistor input (open collector)

Internal circuit• Relay contact input (voltage-free contact)

1 C2345678

Withstand voltage: 1000 VDC for one minute 
between input terminals 
and the ground terminal

Input format:
  Photocoupler isolation 
  Shared common (C)
Allowable input voltage: 
5 VDC

5 V
Contact open at 200 Ω or less
Contact closed at 100 kΩ or greater

On voltage: 0.5 V or less (30 mADC)
Leakage current when turned off: 0.25 mA or less

1 C2345678

Pulse Input Terminal (/PM1)

H
L

Withstand voltage: 1000 VDC for one minute 
between input terminals 
and the ground terminal

Input format:
  Photocoupler isolation 
  Shared common (L)
Allowable input voltage: 
30 VDC

5 V
Internal circuit

• Transistor input (open collector)

• Relay contact input (voltage-free contact)
Contact open at 200 Ω or less
Contact closed at 100 kΩ or greater

On voltage: 0.5 V or less (30 mADC)
Leakage current when turned off: 0.25 mA or less

8

L H L H L H

L H L H L H

7 6

8 7 6

24 VDC Transmitter Power Supply Output Terminal (/TPS2, /TPS4)
Connect the FX to the transmitter as shown below.

Transmitter

Current
FX

Transmitter 
power supply 
output terminal

Input terminal
Shunt resistor: 250 Ω

To reduce noise, use a shielded cable for wiring.
Connect the shield to the ground terminal of the FX.

+

+

–

–

Note

12.5  Optional Terminal Wiring
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Serial Communication Interface (/C2 and /C3)
Connecting to the RS-232 Connector (/C2)

2 1 3 4 5

6 7 98

2  RD (Received Data) Data received from the PC. Input signal to the FX.
3  SD (Send Data) Data transmitted to the PC. Output signal from the FX.
5  SG (Signal Ground) Signal ground.
7  RS (Request to Send) Handshaking signal when receiving data from the PC.
  Output signal from the FX.
8  CS (Clear to Send) Handshaking signal when transmitting data to the PC. 

Input signal to the FX.
* Pins 1, 4, 6, and 9 are not used.(Male)

Connecting to the RS-422A/485 Connector (/C3)

FG (Frame Ground)  Case ground of the FX
SG (Signal Ground)  Signal ground
SDB (Send Data B)  Send data B (+)
SDA (Send Data A)  Send data A (–)
RDB (Received Data B)  Receive data B (+)
RDA (Received Data A)  Receive data A (–)

Two-wire system

FG      SG      SDB    SDA   RDB   RDA

Electric potential of the shield

Four-wire system

Shield

FG      SG      SDB    SDA   RDB   RDA

Recommended length of stripped wire: 9 mm. Recommended tightening torque: 0.4 to 0.5 N•m

Cable
 There are two types of cables available: the four-wire cable and the two-wire cable, which is used only for the 
Modbus protocol.
The cable must meet the following specifications.
• Type: Shielded twisted pair cable. 3 pairs, 24 AWG or more (four wire); 2 pairs, 24 AWG or 

more (two wires).
• Characteristic impedance: 100Ω
• Capacitance: 50 pF/m
• Total cable length: Up to 1.2 km

Connecting to the USB Port (/USB1)
The USB port complies with USB revision 1.1.
The USB port is installed on the FX’s front panel.

Connecting to the Ethernet Port (/C7)

CAUTION
Do not connect an Ethernet cable whose plug does not comply with FCC 
specifications. If you do, the FX may malfunction.

  

Ethernet port
Indicators

Checking the Connection and Communication Status
You can use the indicators that are located above the Ethernet port to check the 
connection status of the Ethernet interface.

Indicator Connection Status of the Ethernet Interface
Illuminated (green) The Ethernet interface is electrically connected.
Blinking (red) Data is being transmitted.
Off The Ethernet interface is not electrically connected.

12.5  Optional Terminal Wiring
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Checking the Connection Status on the FX Display
• Checking the Connection Status in the Status Indication Section of the FX Display
 You can use the Ethernet Link indicator that is located on the right side of the status 

indication display section of the basic setting mode display to check the connection 
status of the Ethernet interface. To display the basic setting mode display, press 
MENU to display the setting menu, and then hold down FUNC for 3 seconds or more.

•  Checking the Connection Status in the Upper Right Corner of the Communication Log 
Display of the FX

 You can use the Link indicator that is located in the upper right of the communication 
log display to check the connection status of the Ethernet interface.

Indicator Connection Status of the Ethernet Interface
Illuminated (green) The Ethernet interface is electrically connected.
Off The Ethernet interface is not electrically connected.

Connecting to the Power Measurement Terminal (/PWR1)

WARNING
• To prevent electric shock while wiring, make sure that the power supply is turned 

off.

CAUTION
• If you are not using a VT and a CT, do not ground the input circuit.
• If you are wiring through conduits (metal tubes designed for wiring), install the 

CT (current transformer) inside a panel.
• Wire the voltage input and the current input within the same circuit.

Single-phase two-wire system

 

P1P21S1L

Power supply
1 2

K

L
CT

Load

Fuse

k

l

VT

U

V

1L
1S

P1
P2

u

v

12.5  Optional Terminal Wiring



12-14 IM 04L21B01-01EN

Single-phase three-wire system
For a single-phase three-wire system, connect wires to the terminal block as follows.

 

P1P2P31S1L3S3L

u

u

v
v

Power supply
1 N 2

K

L
CT

K

L
CT

Load

Fuse

VT

k

l k

l

1L
1S

2L
2S

P0
P2

P1U

U

V
V

Three-phase three-wire system

 

P1P2P31S1L3S3L

Power supply
1 2 3

K

L
CT

K

L
CT

Load

Fuse

VT

R
(A)

S
(B)

T
(C)

k

l k

l

1L
1S

3L
3S

P1

P3
P2

U

U

V
V

u

u

v
v
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12.6 Wiring the Power Supply

Precautions to Be Taken While Wiring the Power Supply
Make sure to follow the warnings below when wiring the power supply. Failure to do so 
may cause electric shock or damage to the instrument.

WARNING
• To prevent electric shock, ensure that the power supply is turned off.
• To prevent fire, use 600 V PVC insulated wires (AWG20 to AWG16; JISC3307) 

or wires or cables with equivalent or better performance.
• Make sure to earth ground the protective earth terminal through a grounding 

resistance of 100 Ω or less before you turn on the power.
• Use crimp-on lugs (designed for 4 mm screws) with insulation sleeves to 

connect both the power cord and the protective ground.

     Crimp-on lug (designed for 4 mm screws) with an insulation sleeve

• To prevent electric shock, be sure to close the transparent cover for the power 
supply wires.

• Provide a power switch (double-pole type) on the power supply line to separate 
the FX from the main power supply. Use labels to indicate that this switch is for 
cutting off the power supply to the FX and to indicate ON and OFF.

 Switch specifications  Steady-state current rating: 1 A or more (other than 
/P1); 3 A or more (/P1)

      Inrush current rating: 60 A or more (other than /P1); 
70 A or more (/P1)

      Use a switch that complies with IEC60947-1 and 
IEC60947-3.

• Connect a fuse (between 2 A and 15 A) to the power supply line.
• Do not add a switch or fuse to the ground line.

Use a power supply that meets the following conditions:
Item Condition (Other than /P1) Condition (/P1)

Rated supply voltage 100 to 240 VAC 24 VDC/AC
Allowable power supply 
voltage range

90 to 132, 180 to 264 VAC 21.6 to 26.4 VDC/AC

Rated power supply 
frequency

50/60 Hz 50/60 Hz (for AC)

Allowable power supply 
frequency range

50/60 Hz ± 2% 50/60 Hz ± 2% (for AC)

Maximum power 
consumption

35 VA (100 V), 45 VA (240 V) 18 VA (for DC), 30 VA (for AC)

Note
Do not use a supply voltage of 132 to 180 VAC, as this may have adverse effects on the 
measurement accuracy.
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Wiring Procedure
1. Turn off the FX power supply, and then remove the transparent power supply 

terminal cover.
2. Connect the power cord and the protective ground cord to the power supply 

terminal. Use ring-tongue crimp-on lugs (designed for 4 mm screws) with insulation 
sleeves. The appropriate tightening torque for the screws is 1.4 to 1.5 N•m.

     

Terminal arrangement

Protective grounding cord

Power cord

Other than /P1

/P1

3. Attach the transparent power supply terminal cover.

12.6  Wiring the Power Supply
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13.1 Signal Input and Alarms

Measurement Input
Item Specifications

Number of inputs, scan interval, and A/D integration time

Model No. of  
Measurement Channels Scan Interval A/D converter integration 

time
FX1002 2

125 ms, 250 ms AUTO1, 50 Hz, 60 Hz
FX1004 4
FX1006 6

1 s, 2 s, 5 s
AUTO1, 50 Hz, 60 Hz,

100 ms2
FX1008 8
FX1010 10
FX1012 12

1  AUTO: The FX automatically switches between 50 Hz and 60 Hz depending on the power 
supply frequency.

2  You can only set the integration time to 100 ms on models FX1006 through FX1012. If you 
set the integration time to 100 ms, you can only set the scan interval to 2 or 5 seconds.

Input Type DC voltage, 1-5V, thermocouple (TC), resistance temperature detector (RTD), ON/OFF input (DI), 
and DC current (by adding an external shut resistor)

Measurement range and measurable range

Input Type Range Measurable Range
DC voltage 20 mV –20.000 to 20.000 mV

60 mV –60.00 to 60.00 mV
200 mV –200.00 to 200.00 mV
1 V –1.0000 to 1.0000 V
2 V –2.0000 to 2.0000 V
6 V –6.000 to 6.000 V
20 V –20.000 to 20.000 V
50 V –50.00 to 50.00 V

1-5V 1 to 5 V6 0.800 to 5.200 V
Thermocouple R1 0.0 to 1760.0°C 32.0 to 3200.0°F

S1 0.0 to 1760.0°C 32.0 to 3200.0°F
B1 0.0 to 1820.0°C 32.0 to 3308.0°F
K1 –200.0 to 1370.0°C –328.0 to 2498.0°F
E1 –200.0 to 800.0°C –328.0 to 1472.0°F
J1 –200.0 to 1100.0°C –328.0 to 2012.0°F
T1 –200.0 to 400.0°C –328.0 to 752.0°F
N1 –270.0 to 1300.0°C –454.0 to 2372.0°F
W2 0.0 to 2315.0°C 32.0 to 4199.0°F
L3 –200.0 to 900.0°C –328.0 to 1652.0°F
U3 –200.0 to 400.0°C –328.0 to 752.0°F
WRe4 0.0 to 2400.0°C 32.0 to 4352.0°F

RTD Pt (Pt100)5 –200.0 to 600.0°C –328.0 to 1112.0°F
JPt(JPt100)5 –200.0 to 550.0°C –328.0 to 1022.0°F

DI Level 0: Less than 2.4 V.  1: 2.4 V or higher (judged at the 6 V range)
Contact7 0: Open. 1: Closed (parallel capacitance of 0.01 μF or less)

1 R, S, B, K, E, J, T, N: IEC584-1 (1995), DIN IEC584, JIS C1602-1995
2 W: W-5%Re/W-26%Re (Hoskins Mfg. Co.), ASTM E988
3 L: Fe–CuNi, DIN43710, U: Cu–CuNi, DIN43710
4 WRe: W-3%Re/W-25%Re (Hoskins Mfg. Co.)
5 Pt100: JIS C1604-1997, IEC751-1995, DIN IEC751-1996
 JPt100: JIS C1604-1989, JIS C1606-1989. Measuring current i = 1 mA (Pt100, JPt100).
6  The range for linear scaling of 1-5V inputs. Burnout detection and low-cut functions are 

available.
7 The detected current value is approximately 10 μA.

Chapter 13 Specifications
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Item Specifications
Thermocouple burnout Burnout upscale/downscale selectable (for each channel).

Normal: 2 kΩ or less, Burnout: 100 kΩ or more (parallel capacitance of 0.01 µF or less)
Detection current: Approx. 10 µA

1-5 range burnout Burnout upscale/downscale selectable (for each channel).
Burnout detection:  Greater than “scale upper limit + 10% of scale width” (upscale), or  

“scale lower limit – less than 5% of scale width” (downscale)
TC reference junction compensation

Internal reference junction compensation or external reference junction compensation
Filter function Takes the moving average of the input values (for each channel).  

Moving average data points: 2 to 400
Computation

Difference computation Computable range: DC voltage, TC, RTD, and DI
Linear scaling Computable range: DC voltage, TC, RTD, and DI

Scalable range: –30000 to 30000. The decimal place is within 4 digits to the right 
of the decimal point.

Unit: Up to 6 characters in length
Over value detection: The value can be set to over value when ±5% of the scale range 

is exceeded.
Square root computation Takes the square root of the input and apply linear scaling

Computable type: DC voltage
Scalable range and unit: Same as linear scaling
Low-cut: Set the low-cut value in the range of 0.0% to 5.0% of the span.
Over value detection: Same as linear scaling

1-5V Computable range: 1 to 5 V
Scalable range and unit: Same as linear scaling
Low-cut: The low-cut point is fixed to the span lower limit.
Over value detection: Same as linear scaling

Alarms
Item Specifications

Number of alarms Up to 4 alarms (levels) per measurement channel
Alarm type  High limit, low limit, difference high limit, difference low limit, high limit on rate-of-change alarm, low 

limit on rate-of-change alarm, delay high limit, and delay low limit
Alarm delay time 1 to 3600 s (for each channel)
Rate-of-change calculation interval of rate-of-change alarms
 1 to 32 times the scan interval (common to all channels)

Alarm output Output to the internal switch
 Number of internal switches: 30
 Internal switch operation: AND/OR operation selectable

Hysteresis High and low limit alarm: 0.0 to 5.0% of the span (common to all channels)
 Difference high and low limit alarms: 0.0 to 5.0% of the span (common to all channels)

Display  Displays the status on the respective operation screen and an alarm icon on the status display 
section when an alarm occurs.

 Display operation: Hold or not hold the display until the alarm acknowledge operation.

Alarm hide function (alarm no logging function)
  Not display alarms nor record to the alarm summary (for each channel)

Alarm information Displays a log of alarm occurrences on the alarm summary.

13.1  Signal Input and Alarms
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13.2 Display

Display
Item Specifications
Display* 5.7-inch TFT color LCD (240 × 320 dots)
Brightness 8 levels
Backlight saver function Dim or turn off the LCD backlight if there is no key operation for a specified time.
*  A section of the LCD monitor may contain pixels that are always on or off. The brightness of the LCD may also not be uniform 

due to the characteristics of the LCD. This is not a malfunction.

Displayed Information
Item Specifications
Display groups Assign channels to groups on the trend display, digital display, and bar graph display and display.
 Number of groups 10
 Number of channels that can be assigned to each group

  Up to six
Display color Channel: Select from 24 colors
 Background:  White or black (excludes the Overview display). See the item on the Historical trend 

display for information on that display.)
Trend display
 Waveform line width Select from 1, 2, and 3 dots
 Display method Orthogonal axis display with time axis (T) and measured value axis (Y)
  Layout: Vertical, horizontal, or wide
  Trend intervals:  15 s, 30 s, 1 min, 2 min, 5 min, 10 min, 15 min, 20 min, 30 min, 1 h, 2 h, 4 h, or  

10 h/div for the FX1002 and FX1004. 
 30 s, 1 min, 2 min, 5 min, 10 min, 15 min, 20 min, 30 min, 1 h, 2 h, 4 h, or 10 h/div 
for the FX1006, FX1008, FX1010, and FX1012.

  Switchable to the secondary trend interval.
 Scale Display a scale for each channel.
  Current value bar graph, color scale band, and alarm point marks can be displayed on the scale.

 Others  Grid (divisions: 4 to 12), trip line (line width: 1, 2, or 3 dots), message, zone display, and partial 
expanded display

Digital Display Displays measured values numerically
 Update rate 1 s (scan interval if the scan interval is greater than 1 s)
Bar graph display Displays the measured value on a bar graph

 Direction Vertical or horizontal
 Base position End or center
 Update rate 1 s (scan interval if the scan interval is greater than 1 s)
 Scale Display a scale for each channel
  Color scale band, and alarm point marks can be displayed on the scale.

Historical trend display 
  Redisplays the display data or event data in the internal memory or external storage medium1

 Display formats All screen or half screen (only when the display data is being redisplayed)
 Time axis operation  The time axis can be reduced or expanded, and data can be displayed continuously.

 Add message Messages can be added.
 Background color Select from white, cream, black, or light gray.

Overview Display Displays the measured values of all channels and the alarm statuses.
1 On FXs that have a CF card slot or USB interface (/USB1 option)
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Item Specifications
Information display

 Alarm summary display Displays a log of up to 1000 alarms.
   Specify an alarm with the cursor and jump to the corresponding section on the historical trend 

display.
 Message summary display 

 Time and content of up to 450 messages (including 50 add messages)
   Specify a message with the cursor and jump to the corresponding section on the historical trend 

display.
 Memory summary display Displays the information of the data in the memory.
  Specify a file with the cursor and jump to the corresponding section on the historical trend display.
  Save the data in the internal memory to the external storage medium* using keys.
  * On FXs that have a CF card slot or USB interface (/USB1 option)
 Report (/M1, /PM1, and /PWR1)
  Displays report data from the internal memory

 Stacked bar graph (/M1, /PM1, and /PWR1) 
   Displays the report data of each report group in a stacked bar graph. However, only channels that 

have the same unit of measurement as the first channel in the group are displayed.
  Display formats:  H+D (hourly data is used for the display), Day+Week (daily data is used for the 

display), D+M (daily data is used for the display)
  Report groups:  Report channels are arranged in groups of six starting with the first report channel 

(R01). The group arrangements are fixed.
  Scale/grid: Fixed at four divisions
  Update interval: 1 s

 Status Display Relay status display: Displays the ON/OFF status of the alarm output relay and internal switch.
  Modbus client status (/C7): Displays the communication status on the Modbus client
  Modbus master status (/C2, /C3): Displays the communication status on the Modbus master

Log display  Displays the login log, error log, communication log (/C2, /C3, and /C7), FTP log (/C7), Web log 
(/C7), e-mail log (/C7), SNTP log (/C7), and DHCP log (/C7)

System information display  Displays the number of measurement and computation channels, options, MAC address, firmware 
version, and internal memory capacity.

Network information display (/C7) Displays the FX network setup information

13.2  Display
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Other Displayed Information
Item Specifications

Tag display Tag
   Up to 16 characters
    Displayable characters: Alphanumeric, katakana, hiragana, Hangul, Cyrillic, kanji, and Simplified 

Chinese characters.

Message Write messages to the trend display.
 Number of messages 100
 Maximum number of saved messages
  400
 Character  Up to 32 characters (alphanumeric, katakana, hiragana, Hangul, kanji, and Simplified Chinese 

characters)
 Write method Write a preset message or write an arbitrary message on the spot.
 Write destination Select only the displayed group or all groups.
 Auto message Write a message when the FX recovers from a power failure while memory sampling is in progress.
  Write a message when the trend interval is switched during memory sampling.

Add message Write messages to the past data positions.
 Message The same as the “Message” item above
 Maximum number of saved messages
  50

Status display section Displays the FX status in the upper part of the display
 Displayed contents  Year, month, day, time, displayed group name/display name, user name (when the login function 

is in use), batch name (when the batch function is in use), internal memory status, external 
storage medium status (on FXs with a CF card slot), alarm status, function usage status (key lock, 
computation function—/M1, /PM1, /PWR1), and e-mail (/C7)

Auto switching of displayed groups
  Switches the display group at a given interval.
  Interval: Select from the available settings between 5 s and 1 min.

Default display Specify the display to be shown automatically when keys are not operated.
  Time until the display switches: Select from the available settings between 1 min and 1 h.

Display language  Selectable from English, Japanese, German, French, Chinese, Italian, Spanish, Portuguese, 
Russian, and Korean.

Display selection menu customization
 Show/hide and change the positions of each item in the display menus and sub menus
 Insert/delete separators.

Function menu customization
 Show/hide and change the display positions of each item.

13.2  Display
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13.3 Data Saving Function

Configuration
Item Specifications
Internal memory Temporarily saves various types of data.
 Medium Flash memory
External storage medium (on FXs with a CF card slot)
 Medium CF card
 Format FAT32 or FAT16

Data Type
Item Specifications
FX data types and file name extensions
Data Type Extension Notes
Display data .DAD
Event data .DAE
Manual sampled data .DAM
Screen image data .PNG
Setup data .PDL
Report data .DAR /M1, /PM1, and /PWR1

Display Data and Event Data
Item Specifications
Internal memory
 File storage capacity 400 MB
 Number of files Up to 400
 Operation FIFO (First In First Out)
Display data
 Target Measurement/computation channel
 Sampling intervals Synchronized to the trend interval.
 Content Maximum or minimum value per sampling interval
 Data size  Measurement channel data: 4 bytes/data value. Computation channel data: 8 bytes/data value.
 File size Up to 8 MB
 Data format Binary
 Recording Records data at all times.
Event data
 Target Measurement/computation channel.
 Sampling interval Determined by the sample rate.
   125 ms, 250 ms, 500 ms, (FX1002 and FX1004 only) 

1 s, 2 s, 5 s, 10 s, 30 s, 1 min, 2 min, 5 min, or 10 min 
The sampling interval cannot be shorter than the scan interval.

 Content Data per sampling interval
 Data size  Measurement channel data: 2 bytes/data value. Computation channel data: 4 bytes/data value.
 File size Up to 8 MB
 Data format Binary
 Mode Free: Records data at all times.
  Trigger: Starts recording data when a certain event occurs and records for the specified interval.
Combinations of saved data Display data only, event data only, or display data and event data.
File size See appendix 1.
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Manual Sampled Data
Item Specifications

Contents Measured value at an arbitrary time
Maximum number of data values that the internal memory can store 
  400
Data format Text

Report Data (/M1, /PM1, and /PWR1)
Item Specifications

Contents Report at each scheduled time of report
Maximum number of reports that the internal memory can store 
 100
Data format Text

Snapshot Data
Item Specifications

Contents Displayed screen image data
Data format PNG
Output destination CF card or communication output

Saving Data to the External Storage Medium (On FXs with a CF card slot or the 
/USB1 option)
Item Specifications

Data Saving Saves the data in the internal memory to the external storage medium.
 Manual save Saves when the external storage medium is inserted with a key operation.
 Auto save* Display data: Every file save interval
  Event data: Every data length
  Manual sampled data: When manual sampling is executed.
  Report data: When report is created.
  Snapshot data: When a snapshot is taken
 Auto save operation*  Select “save data only if there is sufficient free space on the CF card” or “constantly retain the most 

recent data files in the CF card (media FIFO).”
  * This is only valid on FXs that have a CF card slot.

File name  Select from “sequence number+user-assigned string+date,” “sequence number+user-assigned 
string,” or “sequence number+batch name.”

Save destination  Auto save: CF card (only valid on FXs that have a CF card slot)
Manual save: CF card or USB flash memory (/USB1) 
Directory name: Specify using up to 20 characters.

Setup Data (On FXs with a CF card slot or the /USB1 option)
Item Specifications

Contents FX setup data
Data format Binary
File name Specify using up to 32 characters.
Output/read destination (for saving/loading): CF card or USB flash memory (/USB1)

Data File Loading (On FXs with a CF card slot or the /USB1 option)
Item Specifications

Function Load and show the display data or event data in a CF card or USB flash memory (/USB1).

Miscellaneous
Item Specifications

Header comment  Add up to 50 characters of comment to display data, event data, manual sampled data, or report 
data file.

13.3  Data Saving Function
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13.4 Other Standard Functions

Event Action Function
Item Specifications

Event action Execute a specified operation when a given event occurs.
Number of settings 40
Events Remote control input, etc.
 Timer Number of timers: 4
 Match time timer Number of timers: 4

Action Specify memory start/stop, alarm ACK, etc.
  There are limitations on the combinations of events and actions.

Security Function
Item Specifications

Key lock function  Limitations to key operation, access to the external storage medium (on FXs with a CF card slot or 
the /USB1 option), and various operations

Login function Only registered users can operate the FX.
 System administrators 5 administrators (with total operation access)
 Users 30 users (with access to operations based on their user access rights)
 User access rights setting  Limitations to key operation, access to the external storage medium (on FXs with a CF card slot or 

the /USB1 option), and various operations
 Automatic logout function Users are logged out automatically if there are no key operations for the specified period of time.

Time Related Functions
Item Specifications

Clock With a calendar function
 Accuracy  ±50 ppm (0 to 50°C); does not include the delay (1 second or less) that occurs when the power is 

turned on

Time setting  Set by way of key operations, communication commands (/C2, /C3, and /C7), the event action 
function, or the SNTP client function (/C7)

Time adjustment method 
 While memory sampling Corrects the time by 40 ms for each second.
   Limit in which the time is gradually adjusted: Select from the available settings between 10 s and 5 

min.
  If the time is outside the limit, the time is immediately corrected.
  Cannot be used after hour 0 on January 1st, 2038.
 While memory is stopped Immediately change the time.

DST The date/time for switching between standard time and DST can be specified.
Time zone Sets the time difference from GMT.
Date format Select YYYY/MM/DD, MM/DD/YYYY, DD/MM/YYYY, or DD.MM.YYYY.

Types of Characters That Can Be Handled
Item Specifications

Characters Alphabet characters, numbers, and symbols (limitation exists)

Miscellaneous
Item Specifications

Decimal point type Period or comma
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Batch Function
Item Specifications

Function Data management using batch names. Enter text fields and batch comments in the data file.
Batch name Added to the file name of the display data and event data.
 Structure Batch number (up to 32 characters) + lot number (up to 8 digits)

Text field  Adds text to the display data and event data. There are 8 available text fields. Up to 20 title 
characters and 30 other characters can be entered per field.

Batch comment Adds text to the display data and event data. Up to 3 comments with 50 characters or less.

13.4  Other Standard Functions
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13.5 Options

Alarm Output Relay (/A1, /A2, /A3, and /A4A)
Item Specifications

Action Outputs relay contact signals from the terminals on the rear panel when alarms occur.
Number of outputs 2 (/A1), 4 (/A2), 6 (/A3), and 12 (/A4A)
Relay contact rating 250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistance load)
Output format 2 (/A1), 4 (/A2), 6 (/A3): NO-C-NC, and 12 (/A4A): NO-C
Relay operation Energized/deenergized, AND/OR, hold/non-hold, and reflash settings are selectable.

RS-232 Interface (/C2) and RS-422A/485 Interface (/C3)
Item Specifications

Connection EIA RS-232(/C2) or EIA RS-422/485(/C3)
Protocol Dedicated protocol or Modbus protocol
Synchronization Start-stop synchronization
Transmission mode (RS-422A/485)  
  Four-wire half-duplex multi-drop connection (1:N (N = 1 to 32))
Data rate 1200, 2400, 4800, 9600, 19200, or 38400 bps
Data length 7 or 8 bits
Stop bit 1 bit
Parity Odd, even, or none
Handshaking Off:Off, XON:XON, XON:RS, and CS:RS
Communication distance (RS-422A/485) 
  1200 m
Modbus master  Reading information such as measured data from other instruments and writing this information to 

registers
Modbus slave  Reading data from measurement and computation channels (/M1, /PM1, and /PWR1) 

Reading and writing communication input data (/M1, /PM1, and /PWR1) 
Some control commands such as memory start

Ethernet Communication Interface (/C7)
Item Specifications

Electrical and mechanical specifications
  Conforms to IEEE 802.3 (Ethernet frames conform to the DIX specification).

Medium Ethernet (10BASE-T)
Protocol  Dedicated protocol as well as the TCP, IP, UDP, ICMP, ARP, DHCP, HTTP, FTP, SMTP, SNTP, and 

Modbus protocols

E-mail client Automatically send e-mail at specified times.
FTP client Automatically transfer the following types of data files to the FTP server:
  Display data, event data, snapshot data, and report data (/M1, /PM1, and /PWR1)

FTP Server Moving and deleting files on the FX, managing directories, and generating file lists
Web server Displaying the FX screen on a Web browser
SNTP client Setting the FX time to the results of an SNTP server query
 Cannot be used after hour 0 on January 1st, 2036.

SNTP server Generating the FX’s time. Time resolution: 5 ms
 Cannot be used after hour 0 on January 1st, 2036.

DHCP client Automatically obtain the network address settings from the DHCP server.
Modbus client Reads data from another device and writes to the registers.
Modbus server  Reading data from measurement and computation channels (/M1, /PM1, and /PWR1) 

Reading and writing communication input data (/M1, /PM1, and /PWR1)
  Some control commands such as memory start. Modbus client access limitations.

Setting/Measurement server Using the dedicated protocol, control and configure the FX, and generate data from the FX
Maintenance/test server Outputs connection information and network information.
Instrument information server
  Generating the information (such as the serial number and model name) of the connected FX
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FAIL/Status Output Relay (/F1)
Item Specifications

FAIL output Relay contact output on CPU error
 Relay operation Energized during normal operation and de-energized on system error.

Status output Output a relay contact signal when a selected condition occurs.
  A combination of the following conditions can be selected:
   Low memory, memory failure, media error, A/D hardware error, burnout detection, communication 

error (Modbus master or client communication error), memory sampling stop.
 Relay operation Relay is energized when a condition occurs.

Relay contact rating 250 VAC (50/60 Hz)/3 A, 250 VDC/0.1 A (for resistance load)

Computation Function (including the report function) (/M1)
Item Specifications
Number of computation channels  
 FX1002 and FX1004: 12 channels (101 to 112)
 FX1006, FX1008, FX1010, and FX1012: 24 channels (101 to 124)

Operation  General arithmetic operations:  Four arithmetic operations, square root, absolute, common logarithm, 
natural logarithm, exponential, and power

 Relational operations: <, ≤, >, ≥, =, and ≠
 Logic operations: AND, OR, NOT, and XOR
 Statistical operations: TLOG and CLOG
 Special operations: PRE, HOLD, RESET, and CARRY
 Conditional operation: [a?b:c]
Computation accuracy  Double-precision floating point 
Data that can be used
 Channel data Measurement and computation channels
 Constants 60 constants
 Communication input data 24
 Remote control input status 0/1 (/R1)
 Pulse input Counts the number of pulses (/PM1)
 Status input Internal switch, alarm output relay (/A[ ] and /A4A), flags

Rolling average Performs moving average on the computed results.
Measurement range –9999999 to 99999999
 Decimal place: 0 to 4 digits to the right of the decimal point
Unit  Up to 6 characters in length 

Sum scales: Off, /s, /min, /h, /day
Alarms High limit, low limit, delay high limit, and delay low limit
 Hysteresis: High and low limit alarm: 0.0% to 5.0% of the span.
Display Same as the measurement channels
Data saving Same as the measurement channels
Report function Number of report channels: 12 or 24 (same as the number of computation channels)
 Computation types: Average, maximum, minimum, sum, or instantaneous value
 Report types: Hourly, daily, hourly + daily, daily + weekly, daily + monthly

3-Wire Isolated RTD Input (/N2)
Item Specifications

Input terminal All the RTD input terminals (A, B, and b) are isolated on each channel.
 Applies to the FX1006, FX1008, FX1010, and FX1012
 Note:  On the FX1002 and FX1004 standard models, the A, B, and b terminals are already isolated 

on each channel.

13.5  Options
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Extended Input (/N3F)
Item Specifications

Measurement/display accuracy 
  Under standard operating conditions

Input Type Measuring Range Measurement Accuracy Max. 
Resolution

Kp vs Au7Fe 0.0 to 300.0 K 0 to 20 K Within ±4.5 K
0.1 K

20 to 300 K Within ±2.5 K
PLATINEL 0.0 to 1400.0°C ±(0.25% of rdg + 2.3°C)

0.1°C

PR40-20 0.0 to 1900.0°C 0 to 450°C Accuracy not guaranteed
450 to 750°C ±(0.9% of rdg + 3.2°C)
750 to 1100°C ±(0.9% of rdg + 1.3°C)
1100 to 1900°C ±(0.9% of rdg + 0.4°C)

Thermocouple NiNiMo 0.0 to 1310.0°C ±(0.25% of rdg + 0.7°C)
W/WRe26 0.0 to 2400.0°C 0 to 400°C ±15.0°C

400 to 2400°C ±(0.2% of rdg + 2.0°C)
Type N  (AWG14) 0.0 to 1300.0°C ±(0.2% of rdg + 1.3°C)
XK GOST –200.0 to 600.0 –200 to –100°C ±(0.25% of rdg  + 1.0°C)

–100 to 600°C ±(0.25% of rdg + 0.8°C)
Ni100 (SAMA) –200.0 to 250.0°C ±(0.15% of rdg + 0.4°C)
Ni100 (DIN) –60.0 to 180.0°C ±(0.15% of rdg + 0.4°C)
Ni120 –70.0 to 200.0°C ±(0.15% of rdg + 0.4°C)

RTD1 Pt100 GOST –200.0 to 600.0°C ±(0.15% of rdg  + 0.3°C)
Cu100 GOST –200.0 to 200.0°C ±(0.15% of rdg  + 0.3°C)
Cu50 GOST –200.0 to 200.0°C ±(0.4% of rdg  + 0.5°C)
Pt200 (WEED) –100.0 to 450.0°C ±(0.3% of rdg  + 0.6°C)

1 Measuring current i = 1 mA

Input source resistance Thermocouple input: 2 kΩ or less
  RTD input: 1 Ω or less per wire (The resistance of all three wires must be equal).
Ambient temperature influence (with temperature variation of 10°C)
 TC input ±(0.1% of rdg + 0.05% of range) or less, excluding the error of reference junction compensation
 RTD input ±(0.2% of range + 2 digits) or less
Input source resistance
 TC input With variation of +1 kΩ: ±10 µV or less
 RTD input  With variation of 1 Ω per wire (resistance of all three wires must be equal):  ±(0.1% of rdg + 1 digit) 

or less
  With maximum difference of 100 mΩ between wires: Approx. 1 °C

Remote Control (/R1)
Item Specifications

Number of input terminals 8
Input type  Isolated from the main circuitry through a photocoupler, built-in isolated power supply for the input 

terminals, and shared common.
Input type and signal level 
 Voltage-free contact Contact closed at 200 Ω or less and contact open at 100 kΩ or greater.
 Open collector ON voltage: 0.5 V or less (sink current 30 mA or more), leakage current when OFF: 0.25 mA or less
Allowable input voltage 5 VDC
Signal type Level or edge (250 ms or more)
Action Executes a specified action by applying a given signal to the remote signal input terminal.
  Action assignment: Set using the event action function

13.5  Options
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24 VDC Transmitter Power Supply (/TPS2 and /TPS4)
Item Specifications
Number of loops 2 (/TPS2) or 4 (/TPS4)
Output voltage 22.8 to 25.2 VDC (under rated load current)
Rated output current 4 to 20 mADC
Max. output current 25 mADC (overcurrent protection operation current: approx. 68 mADC)
Allowable conductor resistance  
  RL ≤ (17.8 – minimum transmitter operation voltage)/0.02 A
   where 17.8 V is the result obtained by subtracting the maximum drop voltage of 5 V when the load 

shunt resistance is 250 Ω from the minimum output voltage of 22.8 V
Max. length of wiring 2 km (when using the CEV cable)
Insulation resistance 20 MΩ or more at 500 VDC between output terminal and ground
Dielectric strength 500 VAC (50/60 Hz, I = 10mA) for one minute between output terminal and ground
  500 VAC (50/60 Hz, I = 10mA) for one minute between output terminals

USB Interface (/USB1)
Item Specifications
USB port Complies with Rev. 1.1 and host function
Number of ports 1 (front panel)
Power supply 5 V, 500 mA
Connectable devices Only connect the devices listed below to prevent damage to the devices.
 Keyboard Complies with HID Class Ver. 1.1
  104 keyboard/89 keyboard (US) and 109 keyboard/89 keyboard (Japanese)
  Number connectable units: 1
 External medium USB flash memory
  Does not guarantee the operation of all USB flash memories.
  External medium such as a hard disk, ZIP, MO, and optical discs are not supported.
  Number connectable units: 1

Pulse Input (/PM1)
Item Specifications
Pulse input
 Number of inputs 3 (8 when using the remote control input terminals)
 Input type  Isolated from the main circuitry through a photocoupler and built-in isolated power supply for the 

input terminals.
  Shared common for pulse inputs. 

 Input type and signal level Voltage-free contact Contact closed at 200 Ω or less and contact open at 100 kΩ or greater
  Open collector ON voltage: 0.5 V or less (sink current 30 mA or more), leakage current when  

OFF: 0.25 mA or less
 Counting Counts the rising edges of pulses.
  For voltage-free contact input: Contact open to contact close
  For open collector: Voltage level of the terminal H from high to low
 Allowable input voltage 30 VDC
 Max. sampling pulse period 100 Hz
 Minimum detected pulse width 
  5 ms or more for both low (closed) and high (open)
 Pulse detection period Approx. 3.9 ms (256 Hz)
 Pulse measuring accuracy ±1 pulse
 Pulse count interval Scan interval or 1 s
 Miscellaneous Pulse input terminals can be used as remote control input terminals, isolated from remote control  
  input terminals

Remote control Number of inputs: 5. Same as remote control (/R1) for the other specifications
Computation function Same as the computation function (/M1)

Calibration Correction (/CC1)
Item Specifications
Calibration correction method 
  Corrects the measured value of each channel using segment linearizer approximation.
  Number of segment points: 2 to 16 (including the start and end points)

  

13.5  Options
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DC/AC 24 V power supply (/P1)
Item Specifications

Rated supply voltage 24 VDC and 24 VAC (50/60Hz)
Allowable power supply voltage range
  21.6V to 26.4 VDC/AC
Insulation resistance Between power terminal and earth: 20 MΩor greater at 500 VDC.
Withstand voltage Between power terminal and earth: 500 VAC at 50/60 Hz for one minute
Rated power supply frequency (for AC)
  50/60 Hz 
Allowable power supply frequency range (for AC)
  50 Hz ±2%, 60 Hz ±2%
Power supply fluctuation:
  With variation within 21.6 to 26.4 VDC/AC: ±1digit or less
Power supply frequency fluctuation (for AC):
  With variation of ±2 Hz from rated power supply frequency: ±(0.1% of rdg+1digit) or less
Rated power consumption 18 VA (for DC), 30 VA (for AC)
Power consumption  

Supply voltage   LCD backlight off Normal Maximum
24 VDC     5 VA 7 VA 18 VA
24 VAC (50/60Hz)   8 VA 12 VA 30 VA

Log Scale (/LG1)
Item Specifications

Function  A logarithmic voltage that has been converted from a physical value is applied to the FX, and then 
the FX’s Log scale (logarithmic scale) is used to display and record the physical value.

Input type Log input: Logarithmic input (LogType1)
   Log linear input: Input that is linear on a logarithmic scale (LogType2)
   Pseudo log input: An input that supports pseudo logs. (LogType2)
   Nonlinear log input: An input that supports nonlinear logs on which calibration correction (/CC1 

option) is applied.
  Calibration correction is performed using voltage values. (LogType1)

Range 20 mV, 60 mV, 200 mV, 2 V, 6 V, 20 V, 50 V, and 1 V
Unitl Up to 6 characters
Scalable range

Log input (LogType1)
1.00E–15 to 1.00E+15 (15 decades maximum)
Lower limit mantissa range: 1.00 to 9.99. Upper limit mantissa range: 1.00 to 9.99.
Scale_L < Scale_U
If the lower limit mantissa is 1.00, the difference between the exponents must be 1 or more. 
If the lower limit mantissa is a value other than 1.00, the difference between the exponents must 
be 2 or more.

Log linear input/Pseudo Log Input (LogType2)
Lower limit mantissa range: 1.00 to 9.99. Upper limit mantissa range: N/A (the value is the same 
as the lower limit mantissa).
If the lower limit mantissa is 1.00, the value must be between 1.00E–15 and 1.00E+15, the 
difference between the exponents must be 1 or more, and the maximum decades is 15. 
If the lower limit mantissa is a value other than 1.00, the value must be between 1.01E–15 and 
9.99E+14, the difference between the exponents must be 1 or more and the maximum decades is 14.

Alarm
 Kind High limit, low limit, delay high limit, and delay low limit
 Range 1.00E–16 to 1.00E+16, mantissa: 1.00 to 9.99
 Hysteresis 0% (fixed)

Color scale band range 1.00E–16 to 1.00E+16, mantissa: 1.00 to 9.99
  The display position lower limit must be less than the display position upper limit.
Number of mantissa display digits 2 or 3
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Power Monitor (/PWR1)
Unless otherwise specified, the performance values listed here were recorded under the following standard operating conditions: 
23 ± 2°C, 55 ± 10%RH; power supply frequency: 50/60 Hz ± 1% or less; rated input: ±1% or less, power factor: 1 ± 1% or less; 
warm-up time: 30 minutes or more; and a location in which oscillations and other factors do not affect the operation of the 
instrument.

Item Specifications

Measurement element  By including power measurement elements in an expression, you can measure a variety of power 
values.

   Active power, regenerative electric power, reactive power, apparent power, voltage, current, 
frequency, power factor (LEAD: –, LAG: +), and

   electric energy (active energy, regenerative energy, reactive energy—LAG: +, reactive energy—
LEAD: —, and apparent energy)

*  The LEAD/LAG sign is calculated from the phase difference between P1 (voltage) and I1 
(current).

Phase and wiring system Single-phase two-wire system, single-phase three-wire system, and three-phase three-wire system
Frequency 45 to 65 Hz
Rated input voltage

Rated Voltage  Voltage Range (Variable)  Allowable Input Voltage Crest 
Factor
120 V     120 V    150 V   2
240 V     240 V    300 V   2

Rated input current

Rated Current  Current Range (Fixed)  Allowable Input Current Crest 
Factor
1 A      1 A    1.2 A   2

Allowable input range  150 Vrms (when the voltage range is set to 120 V), 300 Vrms (when the voltage range is set to 240 V), 
and 1.2 A (when using current input)

Rated input power and measuring range
Single-phase two-wire system

Input (AC) Input Measuring Range1 Approximate Consumed VA
Rated Power Voltage Current

120 V/1 A 100 W –120 to 120 W 0.2 VA
0.2 VA

240 V/1 A 200 W –240 to 240 W 0.4 VA

Single-phase three-wire system

Input (AC) Input Measuring Range Approximate Consumed VA
Rated Power Voltage Current

200 V/1 A 200 W –240 to 240 W 0.2 VA/phase 0.2 VA/phase

Three-phase three-wire system

Input (AC) Input Measuring Range Approximate Consumed VA
Rated Power Voltage Current

120 V/1 A 200 W –240 to 240 W 0.2 VA/phase
0.2 VA/phase

240 V/1 A 400 W –480 to 480 W 0.4 VA/phase

  The input measuring range when you are using a VT and CT is calculated using the following  
  equation. The measuring range must be within the input measuring ranges listed above, and the  
  primary side input power2 must be less than 10 GW.
  1 Input measuring range (W) = Primary side input power2 in W/(VT ratio × CT ratio).
  2 Primary side input power = Secondary side rated power in W × 1.2 × VT ratio × CT ratio.
Measuring range Power factor: (LEAD) 0.5 to 1 to (LAG) 0.5
  Frequency: 45 to 65 Hz

13.5  Options
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Item Specifications
Measurement accuracy  The performance values listed here were recorded under the following standard operating 

conditions: 23 ± 2°C, 55 ± 10%RH; power supply frequency: 50/60 Hz ± 1% or less; rated input: ±
1% or less, power factor: 1 ± 1% or less; warm-up time: 30 minutes or more; and a location in which 
vibrations and other factors do not affect the operation of the instrument.

  Active power (W): ±1.0% of range 
  Voltage (V): ±1.0% of range
  Current (A): ±1.0% of range
  Apparent power, reactive power, and power factor:  Value calculated from the measured values ± 1 

digit
  Expressions (V and A are rms values)

Apparent Power (VA) Reactive Power (Q)
(Without using the 

reactive power 
measurement method)

Power Factor(PF)

Single-
phase two-
wire system

VA = V × A Q =   ((VA)2 – P2)

ΣP/ΣVA
(Without using the reactive 
power measurement 
method)

Single-
phase, 
three-wire 
system

VAi = Vi × Ai
i = 1, 2
ΣVA = VA1 + VA2

Qi =   ((VAi)2 – Pi2)
i = 1, 2
ΣQ = Q1 + Q2

Three-phase 
three-wire 
system

VAi = Vi × Ai
i = 1, 3
ΣVA =  3/2(VA1 + VA3)

Qi =   ((VAi)2 – Pi2)
i= 1, 3
ΣQ = Q1 + Q3

*  The FX’s apparent power (VA), reactive power (Q), power factor (PF), and phase (deg) 
are determined from the voltage(V), current(A), and active power(P) by means of digital 
computations. Therefore, for distorted signal input, the value obtained on the FX may 
differ from that obtained on other instruments that use a different method.

*  Make sure that the voltage input is at least 10% of the rated value and the current input 
is at least 5% of the rated value.

*  In the Σ Q computation, each phase’s Q value is computed as negative (–) if the current 
input is leading the voltage input and as positive (+) if the current input is lagging the 
voltage input.

Frequency: ±1.0 Hz
* The frequency of the voltage line input to voltage P1 is output in units of Hz.

Response time 2 seconds
Continuous overload Within the degree of accuracy (rated voltage and rated current × 1.2 applied for 2 hours) 
Instantaneous overload  Within the degree of accuracy (rated voltage × 1.5 applied for 10 seconds, rated current × 2 applied 

for 10 seconds, rated current × 10 applied for 3 seconds)
Dielectric strength 2500 VAC (50/60 Hz) for 1 minute (between the current input, voltage input, and earth)
Insulation resistance 100 MΩ (500 VDC between the current input, voltage input, and earth)
Computation functions The same as the computation function (/M1)
Effects of the operating conditions
 Ambient temperature ±0.05%/°C (under the following conditions: 0 to 50°C, 0.05 In ≤ I ≤ Imax, power factor = 1)
  ±0.07%/°C (under the following conditions: 0 to 50°C, 0.1 In ≤ I ≤ Imax, power factor = 0.5)
  In: Rated current
 Voltage variation Within the degree of accuracy (90 to 132 VAC or 180 to 250 VAC; frequency is 50 or 60 Hz)
 External magnetic fields 400 A/m or less
  Active power and voltage: ±1.0% of range
 Effect of the input frequency 
  For a change within 45 to 65 Hz, the effect on the active power, voltage, and current is within the  
  accuracies.
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13.6 General Specifications

Construction
Item Specifications
Mounting Flush panel mounting (on a vertical plane)
Mounting angle Inclined backward up to 30 degrees from a horizontal plane.
Allowable panel thickness 2 to 26 mm
Material Case: Metal plate
  Bezel and display cover: Polycarbonate
Color Case: Grayish blue green (Munsell 2.0B5.0/1.7 or equivalent)
 Bezel: Charcoal gray light (Munsell 10B3.6/0.3 or equivalent)
Front panel Water and dust proof: Complies with IEC529-IP65, except side-by-side mounting
External dimensions 144 (W) × 144 (H) × 161.7 (D) mm (D: depth from the panel mounting plane)
Weight  FX1002, FX1004, FX1006: 1.3 kg 

FX1008, FX1010, FX1012: 1.4 kg 
(Not including options)

Normal Operating Conditions
Item Specifications
Supply voltage 90 to 132, 180 to 250 VAC
Power supply frequency 50 Hz ± 2%, 60 Hz ± 2%
Ambient temperature 0 to 50°C
Ambient humidity 20 to 80%RH (at 5 to 40°C), 10 to 50% (at 40 to 50°C)
Vibration 10 to 60 Hz, 0.2 m/s2

Shock Not allowed
Magnetic field 400 A/m or less (DC and 50/60 Hz)
Noise Normal mode (50/60 Hz) 
 DC voltage The peak value including the signal must be less than 1.2 times the measuring range.
 Thermocouple The peak value including the signal must be less than 1.2 times the measuring thermal electromotive force.
 RTD 50 mV or less
 Common mode noise 250 VACrms or less for all ranges (50/60 Hz)
 Maximum noise voltage between channels
  FX1xxx-x-x-H: 250 VACrms (50 or 60 Hz) or less
  FX1xxx-x-x-L: 60 VACrms (50 or 60 Hz) or less
Mounting position Can be inclined up to 30 degrees backward. Left and right horizontal.
Warm-up time At least 30 minutes after power on
Installation location Indoors
Operating altitude 2000 m or less

Power Supply
Item Specifications
Rated supply voltage 100 to 240 VAC
Allowable power supply voltage range  
  90 to 132, 180 to 264 VAC
Rated power supply frequency 50 Hz, 60 Hz
Power consumption  Supply voltage  LCD backlight off Normal  Maximum

100 VAC     10 VA   15 VA  35 VA
240 VAC     15 VA   20 VA  45 VA

Allowable interruption time Less than 1 cycle of the power supply frequency
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Isolation
Item Specifications
Insulation resistance  Between the Ethernet, RS-422A/485, and insulation terminals and earth: 20 MΩ or greater at 500 VDC
Withstand voltage Between the power terminal and earth: 2300 VAC at 50/60 Hz for one minute
  Between the contact output terminal and earth: 1600 VAC at 50/60 Hz for one minute
  Between the measurement input terminal and earth: 1500 VAC at 50/60 Hz for one minute

Between the measurement input terminals (excluding the RTD input terminal of the FX1006, 
FX1008, FX1010, FX1012):

   FX1xxx-x-x-H: 1000 VAC (50 or 60 Hz) for 1 minute
   FX1xxx-x-x-L: 400 VAC (50 or 60 Hz) for 1 minute
  Between the remote input terminal and earth: 1000 VDC for one minute
  Between the pulse input terminal and earth: 1000 VDC for one minute
  Between the power monitor input terminals (current input, voltage input, and earth): 2500 VAC (50 

or 60 Hz) for 1 minute
Ground Grounding resistance: 100 Ω or less

Transport and Storage Conditions
Item Specifications
Ambient temperature –25 to 60°C
Ambient humidity 5 to 95%RH (no condensation)
Vibration 10 to 60 Hz, 4.9 m/s2 maximum
Shock 392 m/s2 maximum (in packaged condition)

Supported Standards
Item Specifications
CSA CSA22.2 No.61010.1, installation category II1, pollution degree 22, and measurement category II3
UL  UL61010-1 (CSA NRTL/C)
CE 
 EMC directive EN61326-1 compliance, Class A Table 2
  EN61000-3-2 compliance
  EN61000-3-3 compliance
  EN55011 Class A Group 1
 Low voltage directive EN61010-1, installation category II1, pollution degree 22, and measurement category II3

C-Tick EN55011 compliance, Class A Group 1
1 Installation category (overvoltage category) II: Describes a number which defines a transient overvoltage condition. Iimplies the regulation for 

impulse withstand voltage. “II” applies to electrical equipment which is supplied from the fixed installation like a distribution board.
2 Pollution degree 2: Describes the degree to which a solid, liquid, or gas which deteriorates dielectric strength or surface resistivity is adhering. “2” 

applies to normal indoor atmosphere. Normally, only non-conductive pollution occurs.
3 Measurement category II: Applies to measuring circuits connected to low voltage installation, and electrical instruments supplied with power 

from fixed equipment such as electric switchboards.
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Standard Performance
Item Specifications
Measurement/display accuracy
  Standard operating conditions: 
   Temperature:  23 ± 2°C
   Humidity:  55 ± 10%RH
   Power supply voltage: 90 to 132 or 180 to 250 VAC
   Power supply frequency: 50/60 Hz ± 1%
   Warm-up time:  At least 30 minutes.
  Other ambient conditions such as vibration should not adversely affect the operation.

Input Type Range Measurement Accuracy (Digital display) Digital Display
Max. Resolution

DC voltage

20 mV ±(0.05% of rdg + 12 digits) 1 μV
60 mV

±(0.05% of rdg  + 3 digits)
10 μV

200 mV 10 μV
1 V 100 μV
2 V ±(0.05% of rdg + 12 digits) 100 μV

1 to 5 V

±(0.05% of rdg + 3 digits)

1 mV
6 V 1 mV
20 V 1 mV
50 V 10 mV

Thermocouple
(Not including 
the accuracy of 
reference junction 
compensation; when 
the burnout detection 
function is off.)

R ±(0.15% of rdg + 1°C) 
R, S  0 to 100°C: ±3.7°C, 
 100 to 300°C: ±1.5°C
B   400 to 600°C: ±2°C; accuracy not guaranteed for 

temperatures less than 400°C

0.1°C

S

B

K ±(0.15% of rdg + 0.7°C)
–200 to –100°C: ±(0.15% of rdg + 1°C)

E ±(0.15% of rdg + 0.5°C)
–200 to –100°C: ±(0.15% of rdg + 0.7°C)J

T
N ±(0.15% of rdg + 0.7°C)

–200 to 0°C: ±(0.35% of rdg  +  0.7°C)
Accuracy not guaranteed for temperatures less than –200°C.

W ±(0.15% of rdg + 1°C)
L ±(0.15% of rdg + 0.5°C)

–200 to –100°C: ±(0.15% of rdg + 0.7°C)U
WRe ±(0.2% of rdg + 2.5°C)

0 to 200°C: ±4.0°C
RTD Pt100 ±(0.15% of rdg + 0.3°C)

JPt100
DI Voltage Threshold level (Vth=2.4 V) accuracy ± 0.1 V

Contact With parallel capacitance of 0.01 μF or less, 1 kΩ or less: 1 (ON). 100 kΩ or more: 0 (OFF)

Measuring accuracy in case of scaling
  Accuracy during scaling (digits) = measurement accuracy (digits) × multiplier + 2 digits (rounded up)
  * Fractions rounded up
   where the multiplier = scaling span (digits)/measuring span (digits).
  Example  For 1-5 V range (A/D integration time is 16.7 ms or more), measurement span of 1.000 to 

5.000 V, and scaling span of 0.000 to 2.000
     The measuring accuracy for 5 V input is as follows.
    Measuring accuracy (1-5 Vrange) =  ±(0.05% × 5 V + 3 digits) = ±(0.0025 V [3 digits] + 3 

digits) = ±6 digits
    Multiplier = {2000 digits (0.000 to 2.000)}/4000 digits (1.000 to 5.000) = 0.5
    Thus, accuracy during scaling = ±(6 × 0.5 + 2) digits = 5 digits (rounded up)
Reference junction compensation accuracy 
    When measuring temperature greater than or equal to 0 °C and when input terminal temperature is 

balanced
Type R, S, W, WRe: ±1.0°C
Type K, J, E, T, N, L, and U: ±0.5°C 
Type B: Internal reference compensation is fixed to 0°C

13.6  General Specifications
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Item Specifications
Maximum input voltage ±60 VDC (continuous)
Input resistance 1 V range or less and TC: 10 MΩ or more
  2 V range or higher: Approx. 1 MΩ
Input source resistance 
 Volt, TC 2 kΩ or less
 RTD input 10 Ω or less per wire (The resistance of all three wires must be equal).
Bias current 10 nA or less (except when burnout detection function is enabled)
Maximum common mode noise voltage 
  250 VACrms (50 Hz/60 Hz)
Maximum noise voltage between channels 
  FX1xxx-x-x-H  250VACrms (50/60Hz)
  FX1xxx-x-x-L  60VACrms (50/60Hz)
Interference across channels 120 dB (when the input source resistance is 500 Ω and the input to other channels is 60 VDC)
Common mode rejection ratio
 When the A/D integration time is 20 ms 
  120 dB (50 Hz ± 0.1%, 500 Ω unbalanced, between the minus terminal and ground)
 When the A/D integration time is 16.7 ms 
  120 dB (60 Hz ± 0.1%, 500 Ω unbalanced, between the minus terminal and ground)
Normal mode rejection ratio 
 When the A/D integration time is 20 ms 
  40 dB or more (50 Hz ± 0.1%)
 When the A/D integration time is 16.7 ms 
  40 dB or more (60 Hz ± 0.1%)

Effects of Operating Conditions
Item Specifications
Ambient temperature (with temperature variation of 10°C) 
 DC voltage, TC range ±(0.1% of rdg + 0.05% of range) or less
  * Excluding the error of reference junction compensation
 RTD range ±(0.1% of rdg + 2 digits) or less
Power supply fluctuation With variation within 90 to 132 V and 180 to 250 VAC (50/60 Hz): 
   Accuracy specifications are satisfied.
  With variation of ±2 Hz from rated power frequency (power supply voltage 100 VAC): 
   Accuracy specifications are satisfied.
Magnetic field AC (50/60 Hz) and DC 400 A/m fields: ±(0.1% of rdg + 10 digits) or less
Input source resistance 
 DC voltage range With variation of +1 kΩ:
   1 V range or less: ±10 µV or less
   2 V range or higher: ±0.15% of rdg or less
 TC range With variation of +1 kΩ: ±10 µV or less
 RTD range (Pt100) With variation of 10 Ω per wire (resistance of all three wires must be equal):  ±(0.1% of rdg + 1 digits) or less

  With maximum difference of 40 mΩ between wires:  Approx. 0.1 °C
Effects of vibration  Effects from a sinusoidal vibration along all three axis at a frequency between 10 to 60 Hz and an 

acceleration of 0.2 m/s2:  ±(0.1% of rdg + 1 digit) or less

Miscellaneous
Item Specifications
Memory backup A built-in lithium battery backs up the settings and runs the clock
  Battery life: Approximately 10 years (at room temperature)

13.6  General Specifications
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13.7 External Dimensions

See section 12.3.
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14.1 Setting Mode Menu Map and Setup Items

Run Modes

Power on

Basic setting mode

MENU key
or ESC key

DISP/ENTER
key

DISP/ENTER
key ESC key

Setting modeOperation mode

MENU key

MENU key
or

ESC key

Mode Transition Diagram

Operation display Setting menu display

Setup display

Basic setting
menu display

Setup display

Hold down FUNC 
for 3 s

End menu > DISP/ENTER
or

ESC > DISP/ENTER

The FX has three modes.
Mode Description
Operation mode A mode for performing measurements.
Setting mode A mode for configuring settings, such as the input range and the 

measurement method. Most settings can be changed when memory 
sampling is in progress.

Basic setting mode A mode for configuring basic settings, such as the scan interval and 
the measured data save method. You cannot switch to this mode 
when memory sampling is in progress.

Chapter 14 Setup Items
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Setting Mode Menu

   

Date/Time

Menu

Date&Time

Daylight Saving Time

Meas channel Range, Alarm

Tag, Memory, Delay

Math channel Expression, Alarm

Moving average

Color

Zone, Scale

Bar graph

Partial

Alarm mark

Color scale band

Calibration correction

Constant

Tag, Memory, Delay

TLOG, Rolling average

Color

Zone, Scale

Bar graph

Partial

Alarm mark

Color scale band

Math start action

Timer, Event action Timer

Match time timer

Event action

Data save File header, File name

Save directory

Power

Menu customize

Event data

Batch text

Group set, Trip line

Message

Display Trend/Save interval

Trend

Bar graph

LCD

Monitor

Function menu

Display menu
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Load display data

Load event data

Load settings

Save settings

File list/delete

Format

File

14.1  Setting Mode Menu Map and Setup Items



14-4 IM 04L21B01-01EN

Setup Items in Setting Mode
Menu tab
Date/Time > Date&Time
Setup Item Selectable Range or Selections Default Value Setting
Date&Time > Time set − 2011/01/01

00:00:00

Date/Time > Daylight Saving Time
Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not
Start time > Month JAN/FEB/MAR/APR/MAY/JUN/JUL/AUG/SEP/OCT/NOV/DEC MAR
Start time > Day order 1st/2nd/3rd/4th/Last 2nd
Start time > Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
Start time > Hour of the day Numerical value (0 to 23) 2
End time > Month JAN/FEB/MAR/APR/MAY/JUN/JUL/AUG/SEP/OCT/NOV/DEC NOV
End time > Day order 1st/2nd/3rd/4th/Last 1st
End time > Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
End time > Hour of the day Numerical value (0 to 23) 1

Meas channel > Range, Alarm
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Range > Mode Skip/Volt/TC/RTD/Scale/Delta/DI/ Volt

1-5V/LogType1/LogType2/Sqrt
Mode = Volt

Range 20mV/60mV/200mV/2V/6V/20V/50V/1V 2V
Span Lower Numerical value (depends on the range) −
Span Upper Numerical value (depends on the range) −

Mode = TC
Range R/S/B/K/E/J/T/N/W/L/U/WRe (Options may add additional 

settings.)
R

Span Lower Numerical value (depends on the range) −
Span Upper Numerical value (depends on the range) −

Mode = RTD
Range Pt/JPt (Options may add additional settings.) Pt
Span Lower Numerical value (depends on the range) −
Span Upper Numerical value (depends on the range) −

Mode = Scale
Type Volt/TC/RTD/DI Volt
Range Depends on the type −
Span Lower Numerical value (depends on the range) −
Span Upper Numerical value (depends on the range) −
Scale Lower Numerical value (–30000 to 30000; decimal place: 0 to 4) 0.00
Scale Upper Numerical value (–30000 to 30000) 200.00
Unit 6 characters or less

Mode = Delta
Type Volt/TC/RTD/DI Volt
Range Depends on the type −
Span Lower Numerical value (depends on the range) −
Span Upper Numerical value (depends on the range) −
Ref.CH Meas channel number −

14.1  Setting Mode Menu Map and Setup Items
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Setup Item Selectable Range or Selections Default Value Setting
Mode = DI

Range Level/Cont Level
Span Lower Numerical value (0 or 1) 0
Span Upper Numerical value (0 or 1) 1

Mode = 1-5V
Range 1-5V 1-5V
Span Lower Numerical value (0.800 to 5.200) 1.000
Span Upper Numerical value (0.800 to 5.200) 5.000
Scale Lower Numerical value (–30000 to 30000; decimal place: 0 to 4) 0.00
Scale Upper Numerical value (–30000 to 30000) 200.00
Unit 6 characters or less −
Low-cut On/Off Off

Mode = Sqrt
Range 20mV/60mV/200mV/2V/6V/20V/50V/1V
Span Lower Numerical value (depends on the range) −
Span Upper Numerical value (depends on the range) −
Scale Lower Numerical value (–30000 to 30000; decimal place: 0 to 4) 0.00
Scale Upper Numerical value (–30000 to 30000) 200.00
Unit 6 characters or less −
Low-cut On/Off Off
Low-cut value Numerical value (0.0 to 5.0) 0.5

Mode = LogType1
Range 20mV/60mV/200mV/2V/6V/20V/50V/1V 2V
Span Lower Numerical value (depends on the range) –2.0000
Span Upper Numerical value (depends on the range) 2.0000
Scale Lower Mantissa (1.00 to 9.99) and exponent (–15 to 15) 2.00E0
Scale Upper Mantissa (1.00 to 9.99) and exponent (–15 to 15) 2.00E14
Unit 6 characters or less −

Mode = LogType2
Range 20mV/60mV/200mV/2V/6V/20V/50V/1V 2V
Span Lower Numerical value (depends on the range) –2.0000
Span Upper Numerical value (depends on the range) 2.0000
Scale Lower Mantissa (1.00 to 9.99) and exponent (–15 to 15) 2.00E0
Scale Upper Mantissa (automatically set to the same value as Scale Lower) 

and exponent (–15 to 15)
−

Unit 6 characters or less −
Alarm

1, 2, 3, 4 On/Off Off
Type H: High/L: Low/h: delta H/l: delta L/ H

R: rate H/r: rate L/T: delay H/t: delay L
Value Numerical value

When Mode is LogType, this is set with the mantissa and the 
exponent.
The range is 1.00E–16 to 1.00E+16 (the mantissa range is 1.00 
to 9.99)

−

Relay On/Off Off
Number I01/I02/. . . /I06, I11/I12/. . . /I16 (depends on the options) I01

S01/S02/S03/. . . /S29/S30
Detect On/Off On

Meas channel > Tag, Memory, Delay
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Tag > Characters 16 characters or less −
Memory sample > On/Off On/Off On
Alarm delay > Time Numerical value (1 to 3600; in seconds) 10

Meas channel > Moving average
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
On/Off On/Off Off
Count Numerical value (2 to 400) 2

14.1  Setting Mode Menu Map and Setup Items
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Meas channel > Color
Setup Item Selectable Range or Selections Default Value Setting
Group of channel Channel number 001 to 006
Color Red/Green/Blue/B.violet/Brown/Orange/Y.green/Lightblue/Violet/ Red to orange

Gray/Lime/Cyan/Darkblue/Yellow/Lightgray/
Purple/Black/Pink/L.brown/L.green/Darkgray/Olive/
DarkCyan/S.green (24 colors)

Meas channel > Zone, Scale
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Zone > Lower Numerical value (0 to 95) 0
Zone > Upper Numerical value (5 to 100) 100
Scale > Position Off/1/2/3/4/5/6 1
Scale > Division 4/5/6/7/8/9/10/11/12/C10 10

Meas channel > Bar graph
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Base position Normal/Center/Lower/Upper Normal
Division 4/5/6/7/8/9/10/11/12 10

Meas channel > Partial
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
On/Off On/Off Off
Expand Numerical value (1 to 99%) 50
Boundary Numerical value (span lower + 1 digit to span upper – 

1 digit)
0.0000

Meas channel > Alarm mark
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Mark kind Alarm/Fixed Alarm
Indicate on Scale On/Off Off
Alarm mark color > Alarm 1 Red/Green/. . . /S.green (24 colors) Red
Alarm mark color > Alarm 2 The same as Alarm 1 Orange
Alarm mark color > Alarm 3 The same as Alarm 1 Orange
Alarm mark color > Alarm 4 The same as Alarm 1 Red

Meas channel > Color scale band
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Band area Off/In/Out Off
Color Red/Green/. . . /S.green (24 colors) Lime
Display position > Lower Numerical value (measuring range)

When Mode is LogType, this is set with the mantissa 
and the exponent.
The range is 1.00E–16 to 1.00E+16 (the mantissa 
range is 1.00 to 9.99)

0.0000

Display position > Upper The same as Lower 0.0100

14.1  Setting Mode Menu Map and Setup Items
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Meas channel > Calibration correction
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Number of set points Off/2/3/4/5/6/7/8/9/10/11/12/13/14/15/16 Off
1 to n > MES val Input (value in the measuring range)/measured value −
1 to n > True val Numerical value (measuring range) −

Math channel > Expression, Alarm
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
Math On/Off On/Off Off
Calculation expression 120 characters or less −
Span Lower Numerical value (–9999999 to 99999999;  

decimal place: 0 to 4)
–200.00

Span Upper Numerical value (–9999999 to 99999999;  
decimal place: 0 to 4)

200.00

Unit 6 characters or less −
Math alarm

1, 2, 3, 4 On/Off Off
Type H: High/L: Low/T: delay H/t: delay L −
Value Numerical value −
Relay On/Off Off
No. I01/I02/. . . /I06, I11/I12/. . . /I16 (depends on the options) I01

S01/S02/S03/. . . /S29/S30
Detect On/Off On

Math channel > Constant
Setup Item Selectable Range or Selections Default Value Setting
Number of constant Numerical value (K01 to K60) K01
Value Numerical value (–9.9999E+29 to –1.0000E–30, 0, 1

1.0000E–30 to 9.9999E+29)

Math channel > Tag, Memory, Delay
Except for the channel numbers, setup items and values are the same as those for measurement channels.

Math channel > TLOG, Rolling average
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 101
TLOG > Timer No. 1/2/3/4 1
TLOG > Sum scale Off, /s, /min, /h Off
TLOG > Reset On/Off Off
Rolling average > On/Off On/Off Off
Rolling average > Interval 1s/2s/3s/4s/5s/6s/10s/12s/15s/20s/30s/ 10s

1min/2min/3min/4min/5min/6min/10min/12min/
15min/20min/30min/1h

Rolling average > Number of samples Numerical value (1 to 1500) 1

14.1  Setting Mode Menu Map and Setup Items
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Math channel > Color
Except for the channel numbers, setup items and values are the same as those for measurement channels.

Math channel > Zone, Scale
Except for the channel numbers, setup items and values are the same as those for measurement channels.

Math channel > Bar graph
Except for the channel numbers, setup items and values are the same as those for measurement channels.

Math channel > Partial
Except for the channel numbers, setup items and values are the same as those for measurement channels.

Math channel > Alarm mark
Except for the channel numbers, setup items and values are the same as those for measurement channels.

Math channel > Color scale band
Except for the channel numbers, setup items and values are the same as those for measurement channels.

Math channel > Math start action
Setup Item Selectable Range or Selections Default Value Setting
Math start Off/Start/Rst+St Start

Display > Trend/Save interval
Setup Item Selectable Range or Selections Default Value Setting
Trend interval (/div) 15s/30s/1min/2min/5min/10min/15min/20min/

30min/1h/2h/4h/10h (depends on the model)
1min

Save interval 10min to 31day (depends on the trend interval) 1h
Second interval (/div) 15s/30s/1min/2min/5min/10min/15min/20min/

30min/1h/2h/4h/10h (depends on the model)
1min

Display > Trend
Setup Item Selectable Range or Selections Default Value Setting
Direction Horizontal/Vertical/Wide Vertical
Trend clear On/Off Off
Message direction Horizontal/Vertical Horizontal
Scale > Digit Normal/Fine Normal
Scale > Value indicator Mark/Bargraph Mark
Trend line 1/2/3 2
grid Auto/4/5/6/7/8/9/10/11/12 Auto

Display > Bar graph
Setup Item Selectable Range or Selections Default Value Setting
Direction Horizontal/Vertical Vertical

Display > LCD
Setup Item Selectable Range or Selections Default Value Setting
Brightness 1/2/3/4/5/6/7/8 2
Backlight saver > Mode Off/Dimmer/Timeoff Off
Backlight saver > Saver time 1min/2min/5min/10min/30min/1h 1h
Backlight saver > Restore Key, Key+Alarm Key+Alarm

14.1  Setting Mode Menu Map and Setup Items
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Display > Monitor
Setup Item Selectable Range or Selections Default Value Setting
Background > Display White/Black White
Background > Historical trend White/Cream/Black/Lightgray Black
Scroll time 5s/10s/20s/30s/1min 10s
Jump default display Off/1min/2min/5min/10min/20min/30min/1h Off

Group set, Trip line
Setup Item Selectable Range or Selections Default Value Setting
Group number Numerical value (1 to 10) 1
Group set > On/Off On/Off Groups 1 to 4: On

Groups 5 to 10: Off

Group set > Group name 16 characters or less For example, “GROUP1”
Group set > CH set 39 characters or less Depends on the model
Trip line > 1 On/Off Off
Trip line > 2 On/Off Off
Trip line > 3 On/Off Off
Trip line > 4 On/Off Off
Trip line > Position Numerical value (0 to 100) 50
Trip line > Color Red/Green/. . . /S.green (24 colors) 1: Red. 2: Green.

3: Blue. 4: Yellow.
Trip line > Width 1/2/3 2

Message
Setup Item Selectable Range or Selections Default Value Setting
Message No. 1-10/11-20/21-30/31-40/41-50/51-60/ 11-20

61-70/71-80/81-90/91-100
1 to 100 32 characters or less −

Timer, Event action > Timer
Setup Item Selectable Range or Selections Default Value Setting
Timer No. Numerical value (1 to 4) 1
Mode Off/Relative/Absolute Off
Relative > Interval Numerical value (00:01 to 24:00) 01:00
Relative > Reset at Math Start On/Off On
Absolute > Interval 1min/2min/3min/4min/5min/6min/10min/ 1h

12min/15min/20min/30min/1h/2h/3h/4h/
6h/8h/12h/24h

Absolute > Ref.time Numerical value (0 to 23) 0:00

Timer, Event action > Match time timer
Setup Item Selectable Range or Selections Default Value Setting
Timer number Numerical value (1 to 4) 1
Kind Off/Day/Week/Month Off
Day Numerical value (1 to 28) 1
Day of the week SUN/MON/TUE/WED/THU/FRI/SAT SUN
Hour:Minute Numerical value (00:00 to 23:59) 00:00
Timer action Single/Repeat Repeat

14.1  Setting Mode Menu Map and Setup Items
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Timer, Event action > Event action
Setup Item Selectable Range or Selections Default Value Setting
Logic box number Numerical value (1 to 40) 1
Event None/Remote/Relay/Switch/Timer/Match time timer/

Alarm/UserKey
None

Remote > Remote number 1/2/3/4/5/6/7/8 1
Relay > Relay number I01/I02/. . . /I06, I11/I12/. . . /I16 (depends on the 

options)
I01

Switch > Switch No. S01/S02/S03/. . . /S29/S30 S01
Timer > Timer No. 1/2/3/4 1
Match time timer > Timer number 1/2/3/4 1

Action MemoryStart/Stop, MemoryStart, MemoryStop, 
Trigger, AlarmACK, MathStart/Stop, MathStart, 
MathStop, MathReset, SaveDisplay, SaveEvent, 
Message, Snapshot, DisplayRate1/2, 
ManualSample, TimerReset, DisplayGroupChange, 
Flag, PanelLoad, TimeAdjust (depends on settings 
such as the event settings)

DisplayGroup
Change

Message > Message No. Numerical value (1 to 100) 1
Message > Write to All/Select All
Message > Group number 1/2/3/4/5/6/7/8/9/10 1
Group > Group number 1/2/3/4/5/6/7/8/9/10 1
Flag > Flag number 1/2/3/4/5/6/7/8 1
TimerReset > Timer No. 1/2/3/4 1
PanelLoad > Setting file number 1/2/3 1

Data save > File header, File name
Setup Item Selectable Range or Selections Default Value Setting
File header > Characters 50 characters or less −
Data file name > Structure Date/Serial/Batch Date
Data file name > Identified strings 16 characters or less −

Data save > Save directory
Setup Item Selectable Range or Selections Default Value Setting
Directory name 20 characters or less DATA0

Data save > Event data
Setup Item Selectable Range or Selections Default Value Setting
Sample rate 125ms/250ms/500ms/1s/2s/5s/10s/ 1s

30s/1min/2min/5min/10min (depends on the model)
Mode Free/Single/Repeat Free
Data length 10min to 31day (depends on the sample rate) 1h
Pre-trigger 0/5/25/50/75/95/100 0
Trigger signal > Key On/Off On

Data save > Batch text
Setup Item Selectable Range or Selections Default Value Setting
Text field number Numerical value (1 to 8) 1
Text field > Title of field 20 characters or less −
Text field > Characters 30 characters or less −

14.1  Setting Mode Menu Map and Setup Items



14-11IM 04L21B01-01EN

Setup Item
s

3

2

1

4

5

6

7

8

9

10

11

12

13

14

App

Index

Power
Setup Item Selectable Range or Selections Default Value Setting
VT ratio Numerical value (1.0 to 6000.0) 1.0
CT ratio Numerical value (0.05 to 32000) 1.00
Low-cut power Numerical value (0.05 to 20.00) 0.05%

Menu customize
Setup Item Selectable Range or Selections Default Value Setting
Function menu Select/Hide/View/Transfer −
Display menu Separate/Select/Hide/View/Transfer −

File tab
Load display data
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF

Load event data
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF

Load settings
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF

Save settings
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF
File name 32 characters or less −

File list/delete
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF

Format
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB CF
Format > Volume name 11 characters or less −

14.1  Setting Mode Menu Map and Setup Items
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14.2 Basic Setting Mode Menu Map and Setup Items

Run Modes

Power on

Basic setting mode

MENU key
or ESC key

DISP/ENTER
key

DISP/ENTER
key ESC key

Setting modeOperation mode

MENU key

MENU key
or

ESC key

Mode Transition Diagram

Operation display Setting menu display

Setup display

Basic setting
menu display

Setup display

Hold down FUNC 
for 3 s

End menu > DISP/ENTER
or

ESC > DISP/ENTER

The FX has three modes.
Mode Description
Operation mode A mode for performing measurements.
Setting mode A mode for configuring settings, such as the input range and the 

measurement method. Most settings can be changed when memory 
sampling is in progress.

Basic setting mode A mode for configuring basic settings, such as the scan interval and 
the measured data save method. You cannot switch to this mode 
when memory sampling is in progress.
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Basic Setting Mode Menu

   

Operating environment

Environment

View, Message

Input, Alarm

Security, Media save

Batch

Communication Service port

POP3 Details

FTP Server Details

Math

Report

LOG Input

End

14.2  Basic Setting Mode Menu Map and Setup Items



14-14 IM 04L21B01-01EN

  

Report Basic settings

Report settings

Communication (Ethernet) IP-address

Host settings

Modbus master

Communication (Serial) Basic settings

DNS settings

Keepalive, Timeout

Server modes

Allowed Modbus clients

Server

Recipients

POP3 settings

Alarm settings

Scheduled settings

System settings

Report settings

E-Mail

Basic settings

Command settings

Basic settings

Modbus server settings

Command settings

FTP connection

FTP transfer file

Modbus client

SNTP client

FTP client

Web page

Date&Time

Status relay

Power

End

Alarm

Menu

Basic settings

Switch, Relay

Hysteresis

Keylock Key action, Media

Action of Function

Login Basic settings

Key action, Media

Admin settings

Action of Function

User settings

Authority of user

A/D, Memory

Burnout, RJC

Basic settings
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Load settings

File/Initialize

Initialize

Media eject

End

CF

USB
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Setup Items in Basic Setting Mode
Environment tab
Operating environment
Setup Item Selectable Range or Selections Default Value Setting
Tag/Channel Tag/Channel Tag
Language English/Japanese/German/French/Chinese/Italian/

Spanish/Portuguese/Russian/Korean
English

Temperature C/F C
Decimal Point Type Point/Comma Point

View, Message
Setup Item Selectable Range or Selections Default Value Setting
View > Trend type T-Y T-Y
View > Partial On/Off Off
View > Trend rate switching On/Off Off
Message > Write group Common/Separate Common
Message > Power-fail message On/Off Off
Message > Change message On/Off Off

Input, Alarm
Setup Item Selectable Range or Selections Default Value Setting
Input > Value on over-range Free/Over Over
Alarm > No logging On/Off Off

Security, Media save
Setup Item Selectable Range or Selections Default Value Setting
Security > Key Off/Login/Keylock Off
Security > Communication Off/Login Off
Save > Auto save On/Off On
Save > Media FIFO On/Off Off

Batch
Setup Item Selectable Range or Selections Default Value Setting
On/Off On/Off Off
Lot-No. digit Off/4/6/8 6
Auto increment On/Off On

Communication > Service port
Setup Item Selectable Range or Selections Default Value Setting
FTP Numerical value (1 to 65535) 21
HTTP Numerical value (1 to 65535) 80
SNTP Numerical value (1 to 65535) 123
Modbus Numerical value (1 to 65535) 502

Communication > POP3 Details
Setup Item Selectable Range or Selections Default Value Setting
POP3 Before SMTP > Send delay [second] 0 to 10 2
POP3 Login PLAIN/APOP PLAIN

Communication > FTP Server Details
Setup Item Selectable Range or Selections Default Value Setting
Output Directory Format MS-DOS/UNIX MS-DOS

14.2  Basic Setting Mode Menu Map and Setup Items
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Math
Setup Item Selectable Range or Selections Default Value Setting
Value on Error +Over/–Over +Over
Value on Overflow > SUM, AVE Error/Skip/Limit Skip
Value on Overflow > MAX, MIN, P-P Over/Skip Over

Report
Setup Item Selectable Range or Selections Default Value Setting
Report select > 1 Max/Min/Ave/Sum/Inst Ave
Report select > 2 Off/Max/Min/Ave/Sum/Inst Max
Report select > 3 Off/Max/Min/Ave/Sum/Inst Min
Report select > 4 Off/Max/Min/Ave/Sum/Inst Sum
File type Separate/Combine Separate

LOG Input
Setup Item Selectable Range or Selections Default Value Setting
Display digits > Digits 2/3 3
Input > LogType2 Linear/Pseudo Linear

End
Setup Item Selectable Range or Selections Default Value Setting
Do you want to store and make the new 
settings take effect?

Yes/No/Cancel −

14.2  Basic Setting Mode Menu Map and Setup Items
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Menu tab
Alarm > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
Reflash On/Off Off
Rate of change > Decrease 1 to 32 1
Rate of change > Increase 1 to 32 1
Indicator Hold/Nonhold Nonhold

Alarm > Switch, Relay
Setup Item Selectable Range or Selections Default Value Setting
Internal Switch > AND None/S01/S01-S02/. . . /S01-S29/S01-S30 None
Relay > AND None/I01/I01 to I02/. . . /I01 to I16 (depends on the 

options)
None

Relay > Action Energize/De_energ Energize
Relay > Hold Hold/Nonhold Nonhold
Relay > Relay Action on Ack Normal/Reset Normal

Alarm > Hysteresis
Setup Item Selectable Range or Selections Default Value Setting
Meas CH > High/Low Numerical value (0.0 to 5.0) 0.5
Meas CH > Delta High/Low Numerical value (0.0 to 5.0) 0.0
Math channel > High/Low Numerical value (0.0 to 5.0) 0.0

A/D, Memory

Setup Item Selectable Range or Selections Default Value Setting
Scan interval > Scan mode Normal Normal

Normal > Scan interval 125ms/250ms (FX1002, FX1004) 125ms
1s/2s/5s (FX1006, FX1008, FX1010, FX1012) 1s

Normal >A/D integrate Auto/50Hz/60Hz/100ms Auto
Memory > Data kind Display/E+D/Event Display

Burnout, RJC
Setup Item Selectable Range or Selections Default Value Setting
First-CH, Last-CH Channel number 001
Burnout set Off/Up/Down Off
RJC > Mode Internal/External Internal
RJC > Volt Numerical value (–20000 to 20000) μV 0

Keylock > Key action, Media
Setup Item Selectable Range or Selections Default Value Setting
Password 8 characters or less ********
Key action > START Free/Lock Free
Key action > STOP Free/Lock Free
Key action > MENU Free/Lock Free
Key action > USER Free/Lock Free
Key action > DISP/ENTER Free/Lock Free
Media/USB > External media Free/Lock Free
Media/USB > Load settings Free/Lock Free

14.2  Basic Setting Mode Menu Map and Setup Items
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Keylock > Action of Function
Setup Item Selectable Range or Selections Default Value Setting
AlarmACK Free/Lock Free
Message/Batch Free/Lock Free
Math Free/Lock Free
Data save Free/Lock Free
E-mail/FTP Free/Lock Free
Time set Free/Lock Free
Display Function Free/Lock Free

Login > Basic settings

Setup Item Selectable Range or Selections Default Value Setting
Auto logout Off/1min/2min/5min/10min Off
Operation without Login Off/Display Off

Login > Admin settings
Setup Item Selectable Range or Selections Default Value Setting
Admin number Numerical value (1 to 5) 1
Mode Off/Key/Key+Comm/Comm* Off
User name 20 characters or less For example, 

“Admin1”
Password 8 characters or less ????????

* This can only be selected when you are using communications to log onto the FX.

Login > User settings
Setup Item Selectable Range or Selections Default Value Setting
User number Numerical value (1 to 30) 1
Mode Off/Key/Comm/Web/Key+Comm Off
User name 20 characters or less For example, 

“User1”
Password 8 characters or less ????????
Authority of user Off/1/2/3/4/5/6/7/8/9/10 Off

Login > Authority of user > Key action, Media
Setup Item Selectable Range or Selections Default Value Setting
Authority of user Numerical value (1 to 10) 1
Key action > START Free/Lock Free
Key action > STOP Free/Lock Free
Key action > MENU Free/Lock Free
Key action > USER Free/Lock Free
Key action > DISP/ENTER Free/Lock Free
Media/USB > External media Free/Lock Free
Media/USB > Load settings Free/Lock Free

Login > Authority of user > Action of Function
Setup Item Selectable Range or Selections Default Value Setting
Authority of user Numerical value (1 to 10) 1
AlarmACK Free/Lock Free
Message/Batch Free/Lock Free
Math Free/Lock Free
Data save Free/Lock Free
E-mail/FTP Free/Lock Free
Time set Free/Lock Free
Display Function Free/Lock Free

14.2  Basic Setting Mode Menu Map and Setup Items
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Report > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
Report kind Off/Hour/Day/Hour+Day/Day+Week/ 

Day+Month
Off

Date Numerical value (1 to 28) 1
Day of the week (Day+week) SUN/MON/TUE/WED/THU/FRI/SAT SUN
Time (hour) Numerical value (0 to 23) 0:00

Report > Report settings
Setup Item Selectable Range or Selections Default Value Setting
Report channel number FX1002, FX1004: R01 to R12

FX1006, FX1008, FX1010,  FX1012: R01 to R24
R01

On/Off On/Off On (only for 
the meas 
channels, Off 
for all other 
channels)

Channel Channel number Depends on 
the model

Sum scale Off, /s, /min, /h, /day /s

Time settings
Setup Item Selectable Range or Selections Default Value Setting
Time zone (HHMM) Numerical value (–1300 to 1300) 900
Time deviation limit Off/10s/20s/30s/1min/2min/3min/4min/5min 30s
Date format Y/M/D, M/D/Y, D/M/Y, D.M.Y Y/M/D

Communication (Ethernet) > IP-address
Setup Item Selectable Range or Selections Default Value Setting
DHCP Use/Not Not
DNS accession Use/Not Use
Host-name register Use/Not Use
Fixed IP-address > IP-address Numerical value (0.0.0.0 to 255.255.255.255) 0.0.0.0
Fixed IP-address > Subnet mask Numerical value (0.0.0.0 to 255.255.255.255) 0.0.0.0
Fixed IP-address > Default gateway Numerical value (0.0.0.0 to 255.255.255.255) 0.0.0.0

Communication (Ethernet) > Host settings
Setup Item Selectable Range or Selections Default Value Setting
Host name 64 characters or less −
Domain name 64 characters or less −

Communication (Ethernet) > DNS settings
Setup Item Selectable Range or Selections Default Value Setting
Server search order > Primary Numerical value (0.0.0.0 to 255.255.255.255) 0.0.0.0
Server search order > Secondary Numerical value (0.0.0.0 to 255.255.255.255) 0.0.0.0
Domain suffix search order > Primary 64 characters or less −
Domain suffix search order > Secondary 64 characters or less −

Communication (Ethernet) > Keepalive, Timeout
Setup Item Selectable Range or Selections Default Value Setting
Keepalive On/Off On
Application time out > On/Off On/Off Off
Application time out > Time Numerical value (1 to 120 minutes) 1

14.2  Basic Setting Mode Menu Map and Setup Items



14-21IM 04L21B01-01EN

Setup Item
s

3

2

1

4

5

6

7

8

9

10

11

12

13

14

App

Index

Communication (Ethernet) > Server > Server modes
Setup Item Selectable Range or Selections Default Value Setting
FTP Use/Not Not
Web Use/Not Use
SNTP Use/Not Not
Modbus Use/Not Not

Communication (Ethernet) > Server > Allowed Modbus clients
Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not
Client number Numerical value (1 to 10) 1
On/Off On/Off Off
Allowed IP Address Numerical value (0.0.0.0 to 255.255.255.255) 0.0.0.0

Communication (Ethernet) > Web page
Setup Item Selectable Range or Selections Default Value Setting
Page type Operator/Monitor Operator
Page type = Operator

Web page > On/Off On/Off Off
Access control Off/Admin Off
Command Use/Not Not

Page type = Monitor
On/Off On/Off Off
Access control Off/Admin/User Off

Communication (Ethernet) > E-Mail > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
SMTP server name 64 characters or less −
Port number Numerical value (0 to 65535) 25
Security Off/PbS/Auth Off
SMTP authorization > User name  
(when Auth is selected)

32 characters or less −

SMTP authorization > Password  
(when Auth is selected)

32 characters or less −

Communication (Ethernet) > E-Mail > Recipients
Setup Item Selectable Range or Selections Default Value Setting
Recipient 1 150 characters or less −
Recipient 2 150 characters or less −
Sender 64 characters or less −

Communication (Ethernet) > E-Mail > POP3 settings
Setup Item Selectable Range or Selections Default Value Setting
POP3 Server name 64 characters or less −
Port number Numerical value (0 to 65535) 110
Login name 32 characters or less −
Password 32 characters or less ******. . . ***
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Communication (Ethernet) > E-Mail > Alarm settings
Setup Item Selectable Range or Selections Default Value Setting
Recipient 1 On/Off Off
Recipient 2 On/Off Off
Active Alarms > Alarm 1 On/Off Off
Active Alarms > Alarm 2 On/Off Off
Active Alarms > Alarm 3 On/Off Off
Active Alarms > Alarm 4 On/Off Off
Include INST On/Off Off
Include source URL On/Off Off
Subject 32 characters or less Alarm_summary
Header 1 64 characters or less −
Header 2 64 characters or less −

Communication (Ethernet) > E-Mail > Scheduled settings
Setup Item Selectable Range or Selections Default Value Setting
Recipient 1 On/Off Off
Interval 1h/2h/3h/4h/6h/8h/12h/24h 24h
Ref.time Numerical value (00:00 to 23:59) 00:00
Recipient 2 On/Off Off
Interval 1h/2h/3h/4h/6h/8h/12h/24h 24h
Ref.time Numerical value (00:00 to 23:59) 00:00
Include INST On/Off Off
Include source URL On/Off Off
Subject 32 characters or less Periodic_data
Header 1 64 characters or less −
Header 2 64 characters or less −

Communication (Ethernet) > E-Mail > System settings
Setup Item Selectable Range or Selections Default Value Setting
Recipient 1 On/Off Off
Recipient 2 On/Off Off
Include source URL On/Off Off
Subject 32 characters or less System_warning
Header 1 64 characters or less −
Header 2 64 characters or less −

Communication (Ethernet) > E-Mail > Report settings
Setup Item Selectable Range or Selections Default Value Setting
Recipient 1 On/Off Off
Recipient 2 On/Off Off
Include source URL On/Off Off
Subject 32 characters or less Report_data
Header 1 64 characters or less −
Header 2 64 characters or less −

Communication (Ethernet) > FTP Client > FTP transfer file
Setup Item Selectable Range or Selections Default Value Setting
FTP transfer file > Disp&Event data On/Off Off
FTP transfer file > Report On/Off Off
FTP transfer file > Snapshot On/Off Off

14.2  Basic Setting Mode Menu Map and Setup Items
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Communication (Ethernet) > FTP Client > FTP connection
Setup Item Selectable Range or Selections Default Value Setting
FTP connection Primary/Secondary Primary
FTP server name 64 characters or less −
Port number Numerical value (0 to 65535) 21
Login name 32 characters or less −
Password 32 characters or less ******. . . ***
Account 32 characters or less −
PASV mode On/Off Off
Initial path 64 characters or less −

Communication (Ethernet) > SNTP client
Setup Item Selectable Range or Selections Default Value Setting
Use/Not Use/Not Not
Server name 64 characters or less −
Port number Numerical value (0 to 65535) 123
Access interval Off/1h/8h/12h/24h 8h
Access reference time Numerical value (00:00 to 23:59) 00:00
Access timeout 10s/30s/90s 30s
Time adjust on Start action On/Off Off

Communication (Ethernet) > Modbus client > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
Read cycle 1s/2s/5s/10s 1s
Retry interval Off/10s/20s/30s/1min/2min/5min/10min/20min/

30min/1h
2min

Communication (Ethernet) > Modbus client > Modbus server settings
Setup Item Selectable Range or Selections Default Value Setting
Server number 1-8/9-16 1-8
Port Numerical value (0 to 65535) 502
Modbus server name 64 characters or less −
Unit Auto/Fixed Auto
No. 0 to 255 1

Communication (Ethernet) > Modbus client > Command settings
Setup Item Selectable Range or Selections Default Value Setting
Client command number 1-8/9-16 1-8
1 to 16 Off/R-M/W/W-M Off
First Depends on the command type −
Last Depends on the command type −
Server 1/2/3/. . . /15/16 1
Regi. Numerical value (register number) 30001
Type INT16/UINT16/INT32_B/INT32_L/UINT32_B/ INT16

UINT32_L/FLOAT_B/FLOAT_L
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Communication (Serial) > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
Baud rate 1200/2400/4800/9600/19200/38400 9600
Data length 7/8 8
Parity Odd/Even/None Even
Handshaking Off:Off/XON:XON/XON:RS/CS:RS Off:Off
Address Numerical value (1 to 99) 1
Protocol Normal/Modbus/Modbus-M Normal

Communication (Serial) > Modbus master > Basic settings
Setup Item Selectable Range or Selections Default Value Setting
Read cycle 1s/2s/5s/10s 1s
Timeout 125ms/250ms/500ms/1s/2s/5s/10s/1min 1s
Retrials Off/1/2/3/4/5/10/20 1
Inter-block delay Off/5ms/10ms/15ms/45ms/100ms Off
Auto recovery Off/1min/2min/5min/10min/20min/30min/1h 2min

Communication (Serial) > Modbus master > Command settings
Setup Item Selectable Range or Selections Default Value Setting
Master command number 1-8/9-16 1-8
1 to 16 Off/R-M/W/W-M Off
First Depends on the command type −
Last Depends on the command type −
Addr. Numerical value (1 to 247) 1
Regi. Numerical value (register number) 30001
Type INT16/UINT16/INT32_B/INT32_L/UINT32_B/ INT16

UINT32_L/FLOAT_B/FLOAT_L

Status relay
Setup Item Selectable Range or Selections Default Value Setting
Memory/Media status On/Off Off
Measurement error On/Off Off
Communication error On/Off Off
Memory stop On/Off Off

Power
Setup Item Selectable Range or Selections Default Value Setting
Phase and wire system 1P2W (single-phase two-wire system), 1P3W 

(single-phase three-wire system), 3P3W (three-
phase three-wire system)

3P3W

Input voltage 120V/240V 240V

End
Setup Item Selectable Range or Selections Default Value Setting
Do you want to store and make the new 
settings take effect?

Yes/No/Cancel −
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File/Initialize tab
Load settings
Setup Item Selectable Range or Selections Default Value Setting
Kind CF/USB (depends on the options) CF

Initialize
Setup Item Selectable Range or Selections Default Value Setting
Kind Clear 1/Clear 2/Clear 3 Clear 3

Media eject
Setup Item Selectable Range or Selections Default Value Setting
Media eject CF/USB (depends on the options) −

End
Setup Item Selectable Range or Selections Default Value Setting
Do you want to store and make the new 
settings take effect?

Yes/No/Cancel −

14.2  Basic Setting Mode Menu Map and Setup Items
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Appendix 1 File Size of Display Data and Event Data

The maximum size of a single display data file or event data file is 8 MB. This section 
takes a look at some data recording cases and calculates the approximate sampling time 
required to create an 8 MB file for each case. Use this as a guideline for the sampling 
time of a single data file.

Sampled Data Size
• Data Size of Display Data and Event Data

Channel Display Data Event Data
Measurement channel 4 bytes/channel 2 bytes/channel
Computation channel 8 bytes/channel 4 bytes/channel

 Time data common to all channels is added for each sample.
Time data 8 bytes/sample

• Data Size per Sample
 Display Data
 (Number of measurement channels×4 bytes) + (number of computation channels×8 

bytes) + 8 bytes (time data)

 Event Data
 (Number of measurement channels×2 bytes) + (number of computation channels×4 

bytes) + 8 bytes (time data)

Sampling Time for a Single File (8 MB)
The sampling time for a single file (8 MB) is calculated as follows:
Number of samples × sampling interval.
The number of samples is calculated as follows:
8 MB/(the data size per sample)

Only Display Data
If the display data from the 12 measurement channels and the 24 computation channels 
is recorded at the trend interval of 30 min/div and the display data’s sampling interval is 
60 seconds:

Number of samples
= 8 MB/(8 bytes + 12 × 4 bytes + 24 × 8 bytes) = Approximately 32,258 samples

Sampling time per file (8 MB) 
= 32,258 × 60 seconds = 1,935,480 seconds = Approximately 22 days

Only Event Data
If the event data from the 12 measurement channels and the 24 computation channels is 
recorded at the sampling interval of 1 second:

Number of samples
= 8 MB/(8 bytes + 12 × 2 bytes + 24 × 4 bytes) = Approximately 62,500 samples

Sampling time per file (8 MB) 
= 62,500 × 1 seconds = 62,500 seconds = Approximately 17 hours

Appendix
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Display data and event data
Display data file size = 8 MB
Event data file size = 8 MB
You can use these figures to calculate the sampling time per file in the same manner as 
was used for the case of “only display data” or “only event data.”

You can save multiple files such as those described above to the internal memory or to 
an external memory device (the number of files that can be stored is limited by the size 
of the internal memory or external memory device).

Calculation Examples of the Sampling Time for a Single File (8 MB)
Examples of the sampling time for a single file (8 MB) are shown below. You cannot 
actually set recording conditions so that the sampling time exceeds 31 days. If the 
sampling time exceeds 31 days, the file will be divided even if it is not 8 MB in size.

4 Measurement Channels and No Computation Channels
Display data file
Trend interval (time/
div)

15 s 30 s 1 min 2 min 5 min 10 min

Sampling interval 0.5 s 1 s 2 s 4 s 10 s 20 s
Sampling time 
(approx.)

42.7 hours 3 days 7 days 14 days 35 days 
(-> 31 days)

71 days 
(-> 31 days)

Event data file
Sampling interval 125 ms 0.5 s 1 s 2 s 5 s 10 s
Sampling time 
(approx.)

15.4 days 2 days 5 days 10 days 25 days 51 days 
(-> 31 days)

12 Measurement Channels and 24 Computation Channels
Display data file
Trend interval (time/
div)

30 s 1 min 5 min 10 min 30 min 1 hour

Sampling interval 1 s 2 s 10 s 20 s 1 min 2 min
Sampling time 
(approx.)

9 hours 17.9 hours 3 days 7 days 22 days 44 days 
(-> 31 days)

Event data file
Sampling interval 1 s 2 s 5 s 10 s 30 s 1 min
Sampling time 
(approx.)

17.3 hours 1.4 days 3.6 days 7.2 days 21 days 43 days 
(-> 31 days)

Appendix 1  File Size of Display Data and Event Data
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Appendix 2 Types of Data Files That the FX Can 
Create and How They Can Be Used

This section will explain the types of data files that the FX can create and how they can 
be used.
Data Type Extension Format Display Method1

FX DAQ Application
Display data DAD Binary (undisclosed) Yes Yes Yes2 

Event data DAE Binary (undisclosed) Yes Yes Yes2 

Report data DAR Text (see appendix 3) - Yes Yes
Manual sampled data DAM Text (see appendix 3) - - Yes
Setup data PDL Binary (undisclosed) - Yes -
Snapshot data PNG PNG (general format) - - Yes
1 FX: FX main unit, DAQ: DAQSTANDARD, Application: Software application.
2  The data format can be converted on DAQSTANDARD and displayed on a software application 

such as Microsoft Excel.
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Appendix 3 Text File Data Format

This section explains the format of text files. The FX can create the following text files: 
manual sampled data files and report files.
In the explanation below, CRLF represents a terminator.

Format of the Manual Sample Data File
• The manual sampled data is output using numerical values and strings in text format 

delimited by tabs.
• Values of measurement channels set to Skip and computation channels set to Off are 

not output.
• The data is appended to the file each time manual sample operation is performed.

Format
YRECCRLF

Manual Sample Data Version 1.01.00CRLF

Model FX1000CRLF

Language Code shift-JIS CRLF

File Status ffffffff CRLF

Serial No. III···I CRLF

File Header HHH···H CRLF

Ch ccccc ccccc ··· cccccCRLF

Tag ttt···t ttt···t ··· ttt···tCRLF

Unit uuuuuu uuuuuu ··· uuuuuuCRLF

yyyy/mo/dd hh:mi:ss nnn···n nnn···n ··· nnn···nCRLF

ffffffff File status (8 characters)
Complete  Completed. (A file with 100 manually sampled 

data acquisitions that is now complete.)
Progress  Data is being added. (An incomplete file that 

does not yet have 100 manually sampled data 
acquisitions.)

Decrease  The file is defective. (A file that is missing some 
of the manually sampled data that was stored 
on it.)

III···I Serial number of the FX (16 characters)
HHH···H File header (50 characters)
ccccc Channel number (5 characters)
ttt···t Tag (16 characters)
uuuuuu Unit (6 characters)
yyyy/mo/dd hh:mi:ss Sampling year, month, day, and time (19 characters)
nnn···n Measured value (13 characters)
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File Output Example
Below is a manual sample data example of channels 1, 2, 3, and 4.

YREC

Manual Sample Data Version 1.00.00

Model FX1000

Language Code shift-JIS

File Status Progress

Serial No. S5E701600

File Header 

Ch CH001 CH002 CH003 CH004

Tag abc def hij klmn

Unit °C V m3/h %

2005/10/01 08:57:22 213.8 0.517 368.4 68.9

2005/10/01 08:57:28 208.6 0.494 363.0 68.1

Note
• Output when error data, overrange data, or computation overflow data is detected

Channel Data Output
Measurement channels Error (Space)

+over range (includes burnout detection) 99999
–over range (includes burnout detection) –99999

Computation channel Error 999999999
Positive computation overflow 999999999
(when the value exceeds 99999999)
Negative computation overflow –999999999
(when the value falls below –9999999)
The decimal place that was specified when the span for 
the channel was specified applies to the output values. For 
example, if the span setting of the channel is “200.0,” then 
“999999999” is output when the value exceeds “9999999.9” 
and “–999999999” is output when the value is below 
“–999999.9.”

• A new manual sampled data file is created in the following cases.
• A measurement channel is changed to Skip from a range other than Skip.
• A measurement channel is changed from Skip to a range other than Skip.
• A computation channel is changed from On to Off or Off to On.
• The unit is changed.

Appendix 3  Text File Data Format



App-6 IM 04L21B01-01EN

Report File Format
• The hourly, daily, weekly, and monthly reports are output using numeric values and 

strings in text format delimited by tabs.
• Values of measurement channels set to Skip and computation channels set to Off are 

not output.
• The data is appended to this file every time a report is created.

Format
YRECCRLF

Report Data Version 1.00.00CRLFF

Model FX1000CRLF

Language Code shift-JIS CRLF

File Status ffffffff CRLF

Serial No. III···I CRLF

File Header HHH···H CRLF

Report Set RRR···R CRLF

File Data rrr···r CRLF

Math Set MMM MMM MMM MMMMCRLF

Start Time YYYY/MO/DD HH:MI:SS   CRLF

Ch ccccc ccccc ··· cccccCRLF

Tag ttt···t ttt···t ··· ttt···tCRLF

Unit uuuuuu uuuuuu ··· uuuuuuCRLF

Data Type sss···s CRLF

Time yyyy/mo/dd hh:mi:ss CRLF

Status eeeeeeeeee CRLF

Ave nnn···n nnn···n ··· nnn···nCRLF

Max nnn···n nnn···n ··· nnn···nCRLF

Min nnn···n nnn···n ··· nnn···nCRLF

Sum nnn···n nnn···n ··· nnn···nCRLF

ffffffff File status (8 characters)
 Complete  Completed. (A file with the necessary number of 

acquisitions for its report type, for example one 
acquisition for an Hourly report type, that is now 
complete.)

 Progress  Data is being added. (An incomplete file that does 
not yet have the necessary number of acquisitions 
for its report type.)

 Decrease  The file is defective. (A file that is missing some of 
the report data that was stored on it.)

III···I Serial number of the FX (16 characters)
HHH···H File header (50 characters)
RRR···R Report setting (setting on the FX) (13 characters)
 Hourly 

 Daily 

 Hourly+Daily 

 Daily+Weekly 

 Daily+Monthly 
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rrr···r Contents of the report file (13 characters)
 Hourly 

 Daily 

 Hourly+Daily 

 Daily+Weekly 

 Daily+Monthly 

 Example: When the FX is set to Hourly+Daily and   
  Combine, Hourly+Daily is output.
  When the FX is set to Hourly+Daily and   
  Separate, the hourly report is output as Hourly,  
  and the daily report as Daily.
MMMM Report items (16 characters (including tabs that are counted 

as one character each), up to four types)
 Ave 

 Max 

 Min 

 Sum 

 Inst Instantaneous value
YYYY/MO/DD HH:MI:SS Report start year, month, day, and time (19 characters)
ccccc Channel number (5 characters)
ttt···t Tag (16 characters)
uuuuuu Unit (6 characters)
eeeeeeeeee Status (output the events that occurred while creating report  

data) (10 characters)
 Bo Burn out detected
 Er Error (error detection)
 Ov Over (overrange/computation overflow detection)
 Pw Power failure (power failure occurrence)
 Cg Change (time change present) 
SSS···S Report type (7 characters)
 Hourly 

 Daily 

 Weekly 

 Monthly 

yyyy/mo/dd hh:mi:ss Report year, month, day, and time (19 characters)
nnn···n Average, maximum, minimum, sum, or instantaneous value 

(13 characters)

Appendix 3  Text File Data Format
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File Output Example
Below is an example of an hourly report of 4 channels while creating hourly and daily 
reports and saving each type of report to a separate file.

YREC

Report Data Version 1.00.00

Model FX1000

Language Code shift-JIS

File Status Complete

Serial No. S5E701600

File Header 

Report Set Hourly+Daily

File Data Hourly

Math Set Ave Max Min Sum

Start Time 2005/10/01 08:10:56

Ch CH001 CH002 CH003 CH004

Tag abc def hij klmn

Unit °C V m3/h %

Data Type Hourly

Time 2005/10/01 09:00:00

Status

Ave 91.5 -0.039 241.1 48.6

Max 259.8 0.726 416.5 76.6

Min -59.9 -0.727 83.4 23.3

Sum 3.293636E+05 -1.392980E+02 8.680871E+05 1.748983E+05

Appendix 3  Text File Data Format
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Note
• When the channel data is in the condition shown in the table below, the Er, Ov, or Bo status 

is output to a report.

Data Condition Status
Error    Er

Measurement channels
Positive over range Ov

Negative over range Ov

Burn out detection Bo

Computation channels
Positive computation overflow (when the value exceeds 1.79E + 308) Ov

Negative computation overflow (when the value falls below –1.79E + 308) Ov

• The report output value of Ave, Max, Min, Sum, and Inst varies depending on the channel 
data condition as shown in the table below.

Item    Data Condition of Measurement Channels Report   
       Output Value
Ave    When all of the data are errors or over range (Space)
Max,    • When all of the data are errors (Space)
Min,    • For +over range (includes burnout detection) 99999
Inst   • For –over range (includes burnout detection) –99999
Sum    • When all of the data are errors or over range (Space)
     • When the sum value exceeds approx. 3.4E + 38 9.999999E+99
     • When the sum value is below approx. –3.4E + 38 –9.999999E+99

Item    Data Condition of Computation Channels Report   
        Output Value
Ave    When all of the data are errors or computation overflow (Space)
Max,    • When all of the data are errors (Space)
Min,    •  When the maximum value or instantaneous value  999999999

exceeds 99999999*

Inst   •  When the minimum value or instantaneous value is  –999999999
less than –9999999*

Sum    • When all of the data are errors or computation overflow (Space)
     • When the sum value exceeds approx. 3.4E + 38 9.999999E+99
     • When the sum value is below approx. –3.4E + 38 –9.999999E+99
* The decimal place that was specified when the span for the channel was specified 

applies to the maximum and minimum values or the instantaneous values. For example, 
if the span setting of the channel is “200.0,” then “999999999” is output when the value 
exceeds “9999999.9” and “–999999999” is output when the value is below “–999999.9.”

Appendix 3  Text File Data Format
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Symbols
** ............................................................................................. 9-7
[a?b:c] ....................................................................................9-11
-Over ..................................................................................... 1-14
+Over .................................................................................... 1-14
3 leg isolated RTD input ......................................................13-11
24 VDC transmitter power supply ....................................... 13-13
24 V power supply .............................................................. 13-14

A
ABS ........................................................................................ 9-7
absolute time mode .............................................................. 1-34
action .................................................................................... 1-35
Active or regenerative electric power ................................... 3-21
Active power ......................................................................... 3-21
added messages .................................................................. 1-16
A/D integration time ................................................................ 3-1
administrator ................................................................. 1-39, 8-5
alarm............................................................................. 1-5, 13-2
alarm ACK .............................................................................. 1-8
alarm delay time ..................................................................... 9-3
alarm hide function ................................................................. 1-6
alarm indication ...................................................................... 1-6
alarm mark indication ........................................................... 5-14
alarm output relay ............................................... 1-7, 3-9, 13-10
alarm settings ....................................................................... 3-12
alarm summary ........................................................... 1-17, 4-19
alarm value ........................................................................... 3-13
all channel ............................................................................ 4-13
all channel display ........................................................ 4-6, 4-13
all data display ...................................................................... 4-12
AND ........................................................................................ 9-8
AND/OR .................................................................................. 1-7
Apparent power .................................................................... 3-21
auto increment ........................................................................ 6-7
auto logout ............................................................ 1-39, 8-4, 8-6
automatic message writing ................................................... 1-12
auto save ...................................................................... 1-28, 6-5
auto scroll ............................................................................... 4-6

B
background color ........................................................ 1-22, 5-22
background color (historical trend) ....................................... 4-15
backlight saver.............................................................. 1-22, 2-8
bar graph, base position ....................................................... 5-19
bar graph display .......................................................... 1-15, 4-4
batch comment ............................................................. 1-32, 6-7
batch function ............................................................... 6-7, 13-9
batch name ............................................................................. 6-7
brightness ..................................................................... 1-22, 2-8
burnout ......................................................................... 1-14, 3-2
burnout Detection ................................................................... 1-2

C
calibration ..............................................................................11-2
calibration correction ........................................ 1-3, 3-16, 13-13
CARRY ..................................................................................9-11
change message .................................................................... 5-4
changing settings during recording....................................... 6-12
channel (computation) .......................................................... 1-40
channel display colors ............................................................ 5-9
channel number ...................................................................... 5-3

CLOG computation ............................................................... 9-10
color scale band ................................................................... 5-15
comma .................................................................................. 2-14
communication application errors ......................................... 10-6
communication errors ......................................................... 10-12
communication functions .................................................... 13-10
communication log................................................................ 4-26
computation channel .............................................................. 9-1
computation data dropout ........................................... 1-43, 9-16
computation error ................................................................... 9-4
computation function .................................................1-40, 13-11
computations, reset .............................................................. 9-16
computation types ................................................................ 1-40
conditional expression ...........................................................9-11
configuration (storage).......................................................... 13-6
constant .............................................................. 3-18, 3-24, 9-1
construction ........................................................................ 13-17
continuing data ......................................................................4-11
count (moving average) .......................................................... 3-7
creating data files ................................................................. 1-29
CT Ratio ............................................................................... 3-23
current value display............................................................. 5-13
cursor (historical trend) ..........................................................4-11
cursor time ............................................................................ 4-14
customizing the menus ................................................. 1-21, 4-3

D
data display section ................................................................ 1-9
data file loading .................................................................... 13-7
data kind ................................................................................. 6-2
data length .............................................................................. 6-3
data save mode .......................................................... 2-13, 4-23
data that can be used in equations....................................... 1-42
data type ............................................................................... 13-6
data types ............................................................................. 1-23
date format ................................................................... 1-49, 2-4
date/time ................................................................................. 2-1
decimal point type................................................................. 2-14
de-energize............................................................................. 1-8
delay high limit alarm .............................................................. 1-5
delay low limit alarm ............................................................... 1-5
deleting a file ........................................................................ 6-16
detect (alarm hide function) .................................................. 3-14
DHCP log .............................................................................. 4-28
difference computation ........................................................... 1-3
difference lower limit alarm ..................................................... 1-5
difference upper limit alarm .................................................... 1-5
digital display ................................................................ 1-14, 4-4
digit (scale value).................................................................. 5-13
directory (data save) ............................................................. 1-28
display color (channels) .......................................................... 5-9
display color (messages) ........................................................ 5-8
display data ...................................................... 1-23, 1-25, 13-6
display direction (bar graphs) ............................................... 5-19
display direction (messages) ................................................ 5-18
display direction (trend) ........................................................ 5-18
displayed information............................................................ 13-3
displayed language............................................................... 1-50
display group .......................................................................... 5-1
display (LCD) ........................................................................ 13-3
display menu ................................................................ 4-1, 5-28
display, parts of ....................................................................... 1-9
display selection menu ................................................. 4-1, 5-28
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display zone.......................................................................... 5-10
divided (report file) ................................................................ 9-18
division (scale) ...................................................................... 5-12
DST (daylight saving time) ........................................... 1-50, 2-1
data files that the FX can create .........................................App-3

E
effects of operating conditions ............................................ 13-20
e-mail log .............................................................................. 4-27
energize .................................................................................. 1-8
EQ .......................................................................................... 9-7
error codes ........................................................................... 10-1
error data .............................................................................. 1-46
error log ................................................................................ 4-26
error messages..................................................................... 10-1
errors related to parameter settings ..................................... 10-1
event ..................................................................................... 1-33
event action ........................................................ 1-33, 7-1, 13-8
event data ......................................................... 1-23, 1-25, 13-6
EXP ........................................................................................ 9-7
exponent ............................................................................... 3-30
expressions (computation) ..................................................... 9-5
extended input type ............................................................ 13-12
extension (file) ...................................................................... 1-30
external dimensions............................................................ 13-21
external storage medium ...................................................... 1-28

F
FAIL output ................................................................. 1-47, 2-10
FAIL/status output relay .......................................................13-11
file header ............................................................................... 6-5
file list display ....................................................................... 6-15
firmware version ..................................................................... 2-5
fixed (alarm mark) ................................................................. 5-14
flag ........................................................................................ 1-42
flow of data recording and storage ....................................... 1-24
formatting.............................................................................. 6-16
format type............................................................................ 6-16
four arithmetic operation ......................................................... 9-7
free (event data) ........................................................... 1-26, 6-3
free messages .............................................................. 1-12, 5-8
free space ............................................................................. 6-16
FTP log ................................................................................. 4-26
Function menu ........................................................................ 4-2

G
GE .......................................................................................... 9-7
gradually correcting the internal clock .................................. 1-49
graph display .......................................................................... 1-9
grid........................................................................................ 5-18
groups..................................................................................... 5-1
group set................................................................................. 5-1
GT ........................................................................................... 9-7

H
historical trend display .................................................. 1-16, 4-8
HOLD.....................................................................................9-11
hold (alarm indication) ............................................................ 1-6
hold (alarm output relay)......................................................... 1-8
hysteresis ..................................................................... 1-5, 3-10

I
identified strings...................................................................... 6-5
indicator .................................................................................. 3-9
information on the displayed measured data........................ 4-15
initialize ................................................................................... 2-9

input processing ..................................................................... 1-2
input range.............................................................................. 3-3
input type ........................................................................ 1-1, 3-5
integration time ....................................................................... 1-1
internal memory .................................................................... 1-24
internal switch ....................................................... 1-8, 1-33, 3-9
interval (rate-of-change alarm) ....................................... 1-5, 3-8
invalid keys ........................................................................... 2-12
isolation .............................................................................. 13-18

J
jump default display .............................................................. 5-24

K
key lock......................................................................... 1-38, 8-1

L
LAG ...................................................................................... 3-21
LCD ........................................................................................ 1-9
LE ........................................................................................... 9-7
LEAD .................................................................................... 3-21
limitations (expressions) ......................................................... 9-6
linear scaling........................................................................... 1-3
line width of the trend ........................................................... 5-18
LN ........................................................................................... 9-7
loading a file ......................................................................... 6-17
loading setup data ................................................................ 6-19
LOG ........................................................................................ 9-7
Logarithmic DC voltage .......................................................... 1-1
log display............................................................................. 1-21
logging in ................................................................................ 8-6
logging out .............................................................................. 8-6
logical computation ................................................................. 9-8
login function ........................................................................ 1-39
login log ................................................................................ 4-25
Log input ............................................................................... 3-28
log into the FX ........................................................................ 8-6
Log linear input ..................................................................... 3-28
log scale (logarithmic scale) ................................................. 3-28
LogType1 .............................................................................. 3-30
LogType2 .............................................................................. 3-31
lot-No. digit ............................................................................. 6-7
lot number............................................................................. 1-32
low-cut ............................................................................ 1-3, 3-6
Low-cut power ...................................................................... 3-23
LT ............................................................................................ 9-7

M
MAC address .......................................................................... 2-5
maintenance ..........................................................................11-1
maintenance and test communication command errors ..... 10-13
mantissa ............................................................................... 3-31
manuals .......................................................................................i
manual sampled data ............................. 1-23, 1-27, 6-13, 13-7
manual sampled data (format)............................................App-4
manual save ......................................................................... 1-29
match time timer ........................................................... 1-33, 7-3
math start action ................................................................... 9-15
measurement channel ............................................................ 1-1
measurement input ............................................................... 13-1
measure soft key .................................................................. 3-16
media FIFO................................................................... 1-29, 6-5
memory backup .................................................................. 13-20
memory sample ...................................................................... 6-2
memory start ........................................................................... 6-9
memory stop ..........................................................................6-11
memory summary ....................................................... 1-19, 4-22
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message colors ...................................................................... 5-8
message display ........................................................... 4-6, 4-13
message display methods .................................................... 4-21
messages ..................................................................... 1-12, 5-6
messages (errors, status, etc) .............................................. 10-1
message summary ..................................................... 1-18, 4-20
modbus status display .......................................................... 4-18
modbus status log ................................................................ 4-28
Modbus master status display .............................................. 1-21
mode (input range) ................................................................. 3-4
moving average ...................................................................... 1-2

N
NE........................................................................................... 9-7
network information screen .................................................... 2-5
next soft key ........................................................................... 4-2
No logging .............................................................................3-11
non-hold (alarm indication) ..................................................... 1-6
non-hold (alarm output relay) ................................................. 1-8
Nonlinear Log Input .............................................................. 3-28
normal operating conditions ............................................... 13-17
NOT ........................................................................................ 9-8
number of pulses per minute ................................................ 3-18
numeric display............................................................. 1-14, 4-6

O
operation errors .................................................................... 10-5
operation logs ....................................................................... 4-25
operations that can be carried out when logged out............. 1-39
OR .......................................................................................... 9-8
order of precedence (computation) ........................................ 9-6
overflow data ................................................................ 1-46, 9-4
overview display ......................................................... 1-17, 4-16

P
partial expanded display ............................................. 1-13, 5-16
password change ................................................................... 8-7
Phase and wire system ........................................................ 3-23
point ...................................................................................... 2-14
power computations ............................................................... 9-7
power factor .......................................................................... 3-21
power-fail message .............................................................. 5-25
power failure operation ......................................................... 1-46
power monitor function ......................................................... 3-21
power supply ...................................................................... 13-17
power supply for transmitter ................................................. 1-50
PRE .......................................................................................9-11
preset display ....................................................................... 5-24
pre-trigger ............................................................................... 6-3
pretrigger .............................................................................. 1-26
processing order of computation .......................................... 1-42
progress of the save operation ............................................. 4-24
Pseudo Log Input ................................................................. 3-28
pulse input .................................................................. 1-3, 13-13
pulse sum value.................................................................... 3-17

R
range (input range) ................................................................. 3-5
rate-of-change alarm .............................................................. 1-5
Reactive power ..................................................................... 3-21
recording conditions (display data) ....................................... 1-25
recording conditions (event data) ......................................... 1-26
ref. CH .................................................................................... 3-6
reference junction compensation.................................... 1-2, 3-2
reflash ............................................................................. 1-7, 3-8
Regenerative electric power ................................................. 3-21
relational computation ............................................................ 9-7

relative time mode ................................................................ 1-34
Relay Action on Ack ................................................................ 3-9
relay, deactivated time ............................................................ 1-7
relay status display ..................................................... 1-21, 4-18
releasing the key lock ............................................................. 8-2
remote control function ......................................................... 1-33
remote controller ID ................................................................ 2-5
remote control (/R1)............................................................ 13-12
repeat (event data) ............................................................... 1-26
report .................................................................................... 9-17
report channel....................................................................... 9-19
report data ........................................................ 1-23, 1-27, 13-7
report display ........................................................................ 4-17
report file (format) ...............................................................App-6
report function....................................................................... 1-45
report group .......................................................................... 9-19
RESET ...................................................................................9-11
resets the computed result (Rst+St) ..................................... 9-15
reset the sum value .............................................................. 3-18
resetting the computed results ............................................. 9-16
resetting the relative timer ...................................................... 7-4
reset (TLOG) ........................................................................ 1-44
revisions ..................................................................................... ii
rolling average .............................................................. 1-43, 9-4
RS-232 interface................................................................. 13-10
RS-422A/485 interface ....................................................... 13-10

S
sample rate ............................................................................. 6-3
save directory ......................................................................... 6-5
save interval ........................................................................... 6-2
saving measured data (automatically) .................................... 6-9
saving measured data (manually) ........................................ 6-10
saving setup data ................................................................. 6-18
saving the data ..................................................................... 4-23
scale ....................................................................4-6, 4-13, 5-11
scale lower.............................................................................. 3-5
screen image data ...................................................... 1-23, 6-14
scroll time ............................................................................. 5-23
secondary interval .................................................................. 5-5
security ................................................................................... 8-4
security function.................................................................... 13-8
selecting a bar ...................................................................... 4-31
separators............................................................................. 5-27
setup data ................................................................... 1-23, 1-31
single/dual graph display ...................................................... 4-30
single (event data) ................................................................ 1-26
single-phase three-wire system ............................................ 3-23
single-phase two-wire system .............................................. 3-23
snapshot ..................................................................... 6-14, 13-7
snapshot data ............................................................. 1-23, 1-31
SNTP log .............................................................................. 4-28
sort item ................................................................................ 4-19
span lower .............................................................................. 3-5
Special computation ..............................................................9-11
special data .......................................................................... 1-46
SQR ........................................................................................ 9-7
square root computation ......................................................... 1-3
stacked bar graph ....................................................... 1-20, 4-29
standard display soft key ...................................................... 5-24
standard performance ........................................................ 13-19
standards ............................................................................ 13-18
standard temperature device .................................................11-2
starting the computation ....................................................... 9-15
start the recording................................................................... 6-9
status display section ........................................................... 1-10
status messages................................................................. 10-14
status output ............................................................... 1-47, 2-10
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status relay ........................................................................... 2-10
stopping the recording ...........................................................6-11
storage media, formatting ..................................................... 6-16
structure of the file name ........................................................ 6-5
sub menu ...................................................................... 4-1, 5-28
sum scale ............................................................................. 1-45
symbols that can be entered ................................................ 2-12
system display ...................................................................... 1-50
system errors ...................................................................... 10-16

T
tag........................................................................................... 5-3
tag detail ................................................................................. 4-6
tag display .............................................................................. 4-1
temperature unit ..................................................................... 3-3
text field ........................................................................ 1-32, 6-7
text file data format .............................................................App-4
three-phase three-wire system ............................................. 3-23
time at the grid position .......................................................... 5-5
time axis ............................................................................... 4-14
time deviation limit .................................................................. 2-3
timer .............................................................................. 1-34, 7-3
timer action ............................................................................. 7-3
time related functions ........................................................... 13-8
time set ................................................................................... 2-1
time zone ...................................................................... 1-49, 2-2
TLOG ...................................................................................... 9-3
TLOG computation ....................................................... 1-43, 9-9
trademarks.................................................................................. ii
transport and storage conditions ........................................ 13-18
trend display ........................................................................... 4-4
trend display (T-Y) .................................................................1-11
trend history ............................................................................ 4-8
trend interval ......................................................... 1-12, 5-4, 6-2
trend rate switching ................................................................ 5-4
trend sapce ............................................................................. 4-7
trigger ..................................................................................... 6-9
trigger signal ........................................................................... 6-3
trip line .................................................................................... 5-2
troubleshooting ................................................................... 10-17
types of characters ............................................................... 13-8

U
unit in computations.............................................................. 1-42
unsaved data ........................................................................ 1-29
update interval (measured values) ......................................... 1-9
updating of the waveform ..................................................... 1-12
USB flash memory................................................................ 2-13
USB interface ........................................................... 1-50, 13-13
user............................................................................... 1-39, 8-5
USER key ..................................................................... 1-33, 7-1

V
value indicator ...................................................................... 5-13
value on over-range.............................................................. 3-20
VT Ratio ................................................................................ 3-23

W
warning messages.............................................................. 10-16
web log ................................................................................. 4-27

X
XOR ........................................................................................ 9-8

Z
zone display.......................................................................... 1-13
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